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T B T H25 T e et ettt et 361
A FFTAEEZE PRI TUZR oottt ettt et et ettt ettt 361
BT A T T ettt ettt et ettt ettt ettt ettt ee e 363
K £ e X TSSO S ST TSRS RTRURRPRRPRRU 366
JEBHHEZE T BT oottt ettt et et ettt ettt ettt e et ettt 366
B A T e e e e et 368
B T A 77 e et ettt ettt 368
F A I B FRTEEAE DL oottt ettt ettt et et e et eae e, 369
i1 R S a1 s OSSOSO RPRURTURURURPRON 369
B 7 A B R 2 ettt et ettt 372
B NI T 2 T BT TETBE oottt ettt ettt ettt e ettt ettt 377
P e 151 R s o (SR B iy OSSR 378
7E WINCC 8 FH ZH B 78 B AE T FETIR oottt 380
B T T et ettt ettt et e et e e e e e e e e e ean 381
B R S et e et en 382
T R R S e ettt et 383
TG AS T B I TE LA 17 ettt ettt ettt ettt 392
HJE CPU JE AP ERAE, SFC 25 e 394
) CPU JG b ZAE 73845, SFC A BATCH H20HE e 399
A T B T TE] B EEAAE M oottt ettt ettt ettt ettt e et et en e 402
B BT T AEL + v eve et ettt et e e e ee et et e e e e e e e e e e e e e e e e e e e e e et e ae et ettt et et ettt et et e e e e e e e 402
T EEL B T 0TI e ettt et 405
A TR P N B S VA R 7 K 1 oY RSSO SO S USROS USRS P PSR 407
T A T R T Bl oottt ettt ettt ettt ettt ettt ettt ettt ettt 411
7RI B ettt ettt ettt 411
SET T T T ERITE JELELEE] oottt ettt ettt et e e et et er e eren s 413
i R S G = ST U SO RU ST RURURURPRON 414
T 22 et ettt et 414
A T BT AR 2 ettt ettt ettt 416
P TR et ettt een 417
BL V7.0 SPA A i R A 77 e e 417
R T oottt ettt ettt ettt ettt ettt ettt ettt e 418
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12

B.9.4 I SQL SOIVET ..ottt ettt ettt 420
B.9.4.1 BT SQL SIVEI FI I ZE oo 420
6.9.4.2 HE SQL Server 2005 [ S R i e s 422
B.9.5 Al F TP R oottt ettt ettt ettt 423
B.9.5. 1 B FTP Gt oottt ettt ettt et ettt ettt et ettt 423
oI (O 4ot 2y VA L i, (© 110 IO 426
6.10.1  FEZRGEHI T ERAE THIEEEIIAE 2 oot e, 426
B.10.2  RGSTEFEITIVEEE .ottt ettt et e et et et ee et et e et et et e e e et 428
B.10.3 T ettt ettt ettt e et 429
B.10.4  APL T SBS 14T T ettt ettt ettt ettt 429
B.10.5 A T M e ettt s 430
B.10.8 B oK oottt ettt ettt ettt ettt et ettt et e et ettt e et et e et et ee e 430
B.10.7 T T T0 BRI 7 oottt et ettt et ettt 432
6.10.8  HATFHATIELE ZE T T IEL? oottt ettt ettt e et et e et et e et et e et eee et e e e eee e 435
B.10.9 I T T A T 2T T oottt ettt ettt ettt ettt ettt ettt et e ettt 437
BAT CH i T R R B . eoeeeeeeeeee et e et et e e e et e e e ee e et eeeeeeeeseseeseease st eeeeeeeeseaseemeeseameaseaseameeresesemeenesnerennens 439
7.1 71 et et ettt et et ettt ettt ettt ettt et ettt et et ettt ettt et et et et e e enen e e s 439
7.2 B A oottt ettt ettt ettt ettt ettt ettt ettt ettt ee e 441
721 BN BATCH B T GRS oottt et e e et e e e e 441
7.2.2  ffH BATCH FC T AR HIZEESR oottt e e 442
72,3 T T A oottt ettt ettt ettt ettt ettt ettt ettt 443
7.2 3 TR I R oottt et ettt ettt 443
7.2.3.2  FHT 8 SUIREB T TUIIIEIT oottt ettt ettt et e e e eee et ettt eee e e e eeeee e 446
702,33 T H T ] T T oottt ettt ettt ettt ettt ettt ettt ettt ettt 447
T.2.3.4 U HIEEAERT B oo ettt ettt et ettt 449
2,35 T B oottt ettt ettt ettt ettt 451
7.3 B T 1 d D e e et ettt ettt e e 452
A0 T B o 2Ty RO 452
T B ) T e ettt ettt e 452
7.3.1.2 75 BATCH B B 2E B0 T 25K oottt ettt ettt ettt eer e en e 453
7.3 R T oo ettt ettt 454
732 R I T ettt 454
7.3.2.2 AT ROP I LI T oo e ettt 455
7.3.2.3 A RPH R U T oottt ettt et ee e 456
7.3.24 AT ROP I RPH LI T oottt e 457
7.3.2.5 BATCH i 7 i 2 I R 2 715 e et e 458
7.3.2.6  FEML T B TCREIF Z I <ot et 460
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7.3.3 IR BRI T G5 R T 2R <ottt et et 462
3.3 I T R R Th 2R ettt ettt 462
7.3.3.2 TEHTFEIT (RP, RECIPE ProCEAUIE) .......ocvieeeeeeeeee e et 463
7.3.3.3 Tt 7 IGREY (RUP, Recipe Unit Procedure)...........c.covcueeveueeveeeeeeeeeieeeeeceeeeeeeee e 464
7.3.3.4 W14 (ROP, ReCipe OPEration)..........ccoveeeeeueeueeeeeeeeieeeeeeeeeeeeeeeeeeeeeeeee e e e e 464
7.3.3.5 HiJ#AE (ROP, recipe operation) HHIEL T P B ..o 464
73,308 o e e 465
T3 3. T L e e e ettt 465
73,38 B T T 2 oo e, 465
7.3.3. T e ettt 466
73,310 T AT 3 e ettt 466
7331 T 3 e et 466
73302 T ettt ettt 466
73,303 Tl e e et 466
73314 BB oottt ettt ettt et et ettt ettt ettt ettt e 467
723305 2 L A oo ettt ettt 467
73,318 T T A e ettt ettt 467
7.4 B T T 7 ettt ettt et ettt e et e et et e et e e e e 468
T4 T T 77 oottt et ettt ettt 468
T 4.2 T A T T ettt ettt ettt 470
T8 3 T i e ettt 472
7434 BT TR TT IR EATOIRIZITL <ot ee et et e ee e e e 472
7.4.3.2 AT R TT T BTG IITID oo e et e 474
7.4.3.3 AT T 7 4 0 BT oottt ettt 476
7434 IR TT B AFIETEELTG oottt 478
7.4.3.5 Af TGRS A AT IR EE IO oottt ettt e 480
7.4.3.6 A5 KFEII T B TEIIAE L T AN T8 Bl et 482
TA4 BB AR TET T TE R oottt ettt e e e et e et e eee et eeee et e eeeseeaaea 483
T A4 T TR T CaIA I ) oot et 483
T 442 R T N ) oot et ee e 484
FA S T U3 X1 ) TP 485
7444 TRITIEE CHRATIEEL) oot ettt et ee e ee e 486
TAAS5 FEETFED CHIATIEIL) oot ettt ettt ettt ettt et et ettt e ee e 487
TAAB HETE CHIATIEI) oottt et 489
TAAT AT 3 CaATIEI)  oeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeen 490
TA.4.8  FdE 3 CaI A I L) oot ettt oot 492
TAA9 T CHIATIEIE) e ettt et 493
TAAAQ LIS oottt ettt et 495
VA S B T NG N 1 OSSPSR 498
TABA2 AT T EERY oottt ettt 500
T A A3 0 G R T BT T e et e et 501

SIMATIC BATCH F i, V7.1 SP1
A, 03/2009, ASE02171120-01 13



HR

14

S N L [n T K i ORI 502
B T T T TR0 R 0 oo ettt 502
BB T e e 503
RN AR 2 ) O 505
B A T B T e e, 507
B B T B TR T I B oot e e 512
N T N L L 2 L 1. TS 513
R A B Tl T AL e e e e e et 514
B B T T Bk ettt ettt 516
e 0 =8 e SNSRI 519
T T B o ettt ettt 520
B BB oo ettt 522
B T B e ettt 525
R T T T E R 5 oottt et ettt 525
T E B T e 525
L D N A LR N1 42 Y SRS USRRR 526
I T e e e et 526
........................................................................................................................................ 527
(LT OSSR 527
ST S = B P 5T oo e, 529
WinCC % /L I SIMATIC BATCH 5525 PRSI o 530
S 1 SRRSO 532
= K | FOUUTURE RSSO USRS RURRRRRRORI 533
T4 BAT CH G i 2 S oo e e, 536
O R A O T T o O 1 S 538
B T B3 0 oo 539
B T 02T oot ettt ettt 539
oy - S 2 SR 539
B T B 0 e 540
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O BRI (BB oottt et ee et e et et et et e et ettt e et et e et et eae et et eae et et ereet et ereaneneanens 541
9.1 B VA.02 FI SB VB.0 ..ottt ettt ettt ettt et et ee et n e en e 541
0.1 1 BRI oo ettt ettt 541
0.1.2 B oK oo ettt ettt 544
0.1, B A I ettt ettt ettt ettt 546
TR I RS = 7 i T TT SRRSO 547
9.2 ASB VB.X FI| SB V7.0 SPT .ottt 550
9.2.1  FEARJFIHRIEIIR Lottt ettt ettt ettt et ettt ettt ettt 550
0,22 AT B oo ettt ettt 552
9.3 IASB VB.1 SP3 I V7.1 SP oo et 553
0,31 B I e ettt ettt 553
0.3, AT B oottt ettt ettt 555
9.4 MSB V7.0 SPA FI SB V7.1 SPT oo 556
9.5 BATIE At B 37 (SUIR, Software Update in RUN)......c...voveveeeeceeeeeeeee e 557
9.5.1  FFUATTIETE L LA T EEIH Lottt ettt et et et et et e et e e e e et e et e et e e ee e 557
e T A N = USROS 557
9.52.1 M SB V7.0 HHTE] SB V7.0 HE T .ottt ettt et ee e 557
9.5.2.2 A7 PC (i, Sl BEEEE) MIER T 558
9.5.2.3 SIMATIC PCS 7 V7.1 [ ZEEETEIR oo e 558
9.5.3  FAHIIFEEATCHIE CES THIT) oottt oottt ee ettt et e et e eren e 559
954  TFZEBATCH PC T .o et et 560
9.5.4.1 T2 BATCH PC Bl FEITE TN .o e, 560
9.5.4.2  TFZEHT 55 BATCOH 22 T HL ettt ettt ettt ettt ee e eeen e 561
0.5.4.3  T1Z BAT CH B T It e e 562
0.5.4.4  T1Z BATCH T 5 B8 oottt e 563
9.5.4.5  TFZEJT 55 BATCOH 22 T HL ettt ettt ettt ettt et ee e eeen e 564
0.5.5 R A I B TT ettt ettt ettt ettt 565
0.5.6  HHHE A P IR B TO oo e 565
957 i SUIR ®HH g4 PC EREAZHINEEMIEFEEIT oo 566
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11

16

5 R 567
10.1 B PR VIE T X oo e 567
10.2 T ettt e e e e et e et e e 570
10.3 e s OSSOSO 572
10,31 T A T L oo 572
10.3.2 T A T oo 573
(ORI e v NI N 2y 0 i = U OSSR 575
(O o i N g o S A NE R S A7 | v 1= USSR 576
10.3.5  ZERT T HE B B B R E T oo e oot 577
(O T £ 2 7 e vt = 3V NSRS 578
10.3.7 B I 2 T T B oo et 579
10.3.8 T B A Sl T oo et e e et e e ettt 579
R B e et e et e et e et et e amteaeteeateeantaaataeeeaeeaeeaateeaeeeaneeaateeaeeeaeaeateeaeeeareenaeeaaneearneneeneeaaneeannens 581
11.1 B I R T BT 1 T I oottt ettt 581
A T 2R eeeeeeeeeeeeeeieeeasesstesaeesaneeatesaseaaaneeaseaasaaane et aaneeanteaanteanteaaseeaneeatenate e st aateeatenaseeaneenare eenreennnes 583
== 1 SR 597
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SIMATIC BATCH FH Al #rE T e ? 1
1.1 fiAs 7.1 SP1

1.1.1 KA BRI E

SIMATIC BATCH Ji 4 K H 5 Hr
PLF SIMATIC BATCH JiiA ] 1% 5 % # SIMATIC BATCH V7.1 SP1:
e V\6.1SP3
e V7.0 SP1

FEER

EZMKREL, ISH LR (B "5,

1.1.2 FFEABCTT

HiLhhe

TV AE OSC GuE el R o ol T 7, #nT LUE A7 B 7" ThRe AT 4 FR (et
WA FR AT DA = (AR KA Rt A 7= P 47 ShC 7 1 A 1) 6 L 7 A7 31 2
J7"(Master recipes) SCAFd . Al 0K R 2 S A7 J B T AR

A AT BCC 3z H i 245" (Control system) >“ 717 it J5”(Save as recipe) H'.
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1.1 k4 7.1 SP1

1.1.3 LS5 ¥ 5 (OSC)

HiLhee
i H] SIMATIC BATCH V7.1 SP1, #itrl MBS ORI CAAH 2 A sh it Az v i e
Jrgiky . TRCRHERIEC T G H EAE S E S S BC T SR S A7 B K T
DMERE— 2P o A8 ATZOBT G D RE T DAZE B R o8 s 8 M ey, JFARIE f g fe
BATRAL A

EZER

HZAMRAE L, IS “BATCH 2] 0> fEL N Ty 45 1 S5 B 7

1.1.4 SIMATIC BATCH #%*

AE ¥ SIMATIC BATCH #i%

7. SIMATIC BATCH V7.1 SP1 1, A SCRFFE BATCH il o v S osdtt A8 7= Bl 11
SIMATIC BATCH i # (SBReport), SIMATIC BATCH 2355t A4 5 2440 %
FiR. Kk, “JF4h7(Start) > SIMATIC > BATCH > SBReport K 3% . fir & AN FAEALE

XA LUR g R

e )\ SIMATIC BATCH V7.1 SP1 ji&, Ui @ 4REAE BATCH 6o BoR
BATCH & %¥¥i .

o ST FH DL AR A SIMATIC BATCH LAARY 42X V7.0 QA 4 H B 5ds, nIff
H SBReport &G #ii AT R n M E. Ak, 7 PCS 7 DVD H1#
“Additional_Products > BATCH_Report_ V7.1 > setup” it 7 SBReport 12554
J¥o WAEMZS TSR] PC EHATILZEERET, M« % SIMATIC BATCH.

o UL xml MRS I H EBE S RAAT % Bof RIS H S EdE (xml Bt 198
fH.

SIMATIC BATCH FJIf, V7.1 SP1
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1.1.5

fai g

1.1/k4 7.1 SP1

SIMATIC BATCH &%t %

SIMATIC BATCH V7.1 SP1 AN SRR HT ) html £ 5XH) SIMATIC BATCH 3%
(SBReport), i Al i AR RAEE -

‘%4 SIMATIC BATCH Jil%5#+8¢ SIMATIC BATCH T AEuG HAA], ¥ H Sk £ m gk
R, I HAREHBOH .

“BATCH #:49.00" % BATCH $IE T ENTi ia

H SIMATIC BATCH V7.1 SP1 2, “BATCH 5 Hr Ly Hr 6 % 13T BN ¥ i

U AR . FTENFUEAE“BATCH # il rhuoy " LI B 1 o . A S &
“SH”(Export), HPEHTETIYE HR R 1K) BATCH ¥l 5 tH o4 PDF SCF.  ArdE/K b & 4T
EVRSEAR FH VR ST ENTIL S A1 PDF ST AT Ry o AndERSEAR IR A Jmy e i 8, DAH AR
SBReport [#147i Jai o

{5 B Zh G PDF SEAT IEARSINT, A HI 30 H 58 AR (Archive) eI - Hb (1) R4 2%

4
'T:;éo

7 BATCH #4047 194

M SIMATIC BATCH V7.1 SP1 2, 7EHRSIAM &8 xml Zl SCfF, X5 R IER 7
R, WRAE“RIN”(Options) >“¥ & (Settings) >“Ti H #% &”(Project settings) 1))
F4”(Archive) I HhiE TR 3 8) 614 PDF SC#4"(Automatically create PDF file),
DI L AH S () A AR DR AL A P74 R (1) PDF 3. AT AR 35" (Options) >“1¢
H”(Settings) >3 H 1% & (Project settings) T 1) H &”(Log) iE 1< 7 ¥% & PDF SCAF s
WEH . 1% PDF AR SCfEn] LS ] Acrobat Reader 7 i % A E, ] B k4T
FIET . IR I, ARV SO Ie i g & S 0l — AN P U AR 5 4% (CAS,
Central Archive Server) [#] *.bar {4,

5 CEPMEMREE) BBRRHE

SR E AN E (A o AR R e 2 WAL /N B LA T o

SIMATIC BATCH F i, V7.1 SP1
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1.2 V7.0 SP1

1.2 V7.0 SP1

1.21 BATCH CDV

fE/r
XFFHUAE PSR H (CDV), R P~ L AXHEAE R GAT MM 0415
B (settings) NI T PRIUET DR
o AEFLAE K2 1 (CDV)(Deactivate batch data management [CDV])
o HEES
FRAMAEFHIEEHE (CDV)
WP T SIEHE, WPKAEH] BATCH 4141“CDV”. X B AW AR BATCH
M EAEATAS AP R . SR AT IR AN S U BB . BB 8 CDV RS54 A H]
PP kIR BN B AR
HEES
REPRALAE = HR 77 5 (CDV) AT HLFSHENC S BATCH 31 EL IR 7 6 935 75
K AHEA =

BATCH CDV IR, FPCHE it (e R 5 P > TR 7S SR A R
NG FATERG O T AP R e MR BRI S A 2 e
A RN DR A

1.2.2 H T2 44 BT B3

“RE 2R T HE P TR

BUHE, X TAELBREAHELIREHY . S8, RS, MGl EARER. 7
XAREDLR, AR A R ERAE R ER TR T A, ISR AE 25447 (Sign) Xt
WHEIRE RS P i AR AR5 40 U R € (OK) F5BHLC PR G A

SIMATIC BATCH FJIf, V7.1 SP1
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SIMATIC BATCH 7177 #3115 ) GE ?
1.2 V7.0 SP1

1.2.3 BATCH R&HBNAHEFHRES®E

223 SIMATIC BATCH B THRES R E
GAEM R BT E S R B N 2 BN BATCH 4144

e BATCH A gh Pl fe*/BATCH JHa MAFE R UL AT 55 £ BTfT BATCH Ak 554
PRI R SR AN TR AR COA

o A HHEE B (CDV) WAE ) WIinCC il 5

BATCH A AEFHES IRE

B OTE R, WTE BATCH JFURVMAAR 7 I bR S s i il 2% #3155 (Server
Language). 7E“iEHLEE...”(Computer settings for ...) T E B 718 56 B 1 5 1%
HE. SHHGEF G, Fif BATCH 423 FEY CGHbA =ik %5 45 . CDV. SIMATIC
BATCH M4 #5Fil BATCH JFAathliFE/ ) 1) b F SR R HERERR 2 LIk B IG5 2
INe W IS BCR L RIS LASEI .

SIMATIC BATCH FJIf, V7.1 SP1
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1.2 V7.0 SP1

1.2.4 BATCH #t A= EHNES R E

BATCH #tAE =B EHIESRE
16 SIMATIC B3 1, 5 BATCH HEAE 74 & B4 WIinCC it BB H K135 35

WEHBES
1. {E SIMATIC B ELEs, JEFEIH 82 BUH SOk, SRS AE R SCeh ifidy
“SIMATIC BATCH”.

2. R AR P R B .. (Configure batch process cell...) SFEHE A ik $8 00 H 58 £ 1
BRI

3. Hui“i E"(Settings) 14
4. fTIT“R L0 " (System reaction) I+,
5. {5 N A RHE L+ T WInCC i B IE S .

by
#H

BAEBAT WA S YN BB S . Wik BATCH JHAR Y AREF O b BATCH %54 1
FEFF R Z), WESEH BATCH JHG AR PR G R ae. Bk LB R K S
4 WIinCC 35 B

SIMATIC BATCH Fit, V7.1 SP1
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1.2 V7.0 SP1

1.2.5 B~ BATCH RG22 E

B~ BATCH [R& 5B RE

WA BATCH &' HL (BCC Fl RE) & H PRSP ESHIL—/ N Ebr. B bs R
BATCH Al 5545 1 2tk 4.

RS BRI BT
s BATCH JIR 55 a3 KPRES, AR A =P (R
o LA RGSHCHITN. TR MG S TICRE, B PR SS A b T
A
o gt JREMCHET. MEEREHATARBRA PR, BERSHCH, HEH

RS54 PR AR 7R 0 e (Fault) . “K41464k"(Not initialized) B A 1% (Not
connected).

o IIfh: JRSSAAWIE. MRS AFIPRES A MFE"(Fault). “R¥ILH4L"(Not initialized) 54
“Ki%E#”(Not connected) .

BATCH R& 2 REH LT XHRER

2 bR BT TGS B RS LT, ST TEAE R E 1. BATCH fiRg5 43
AFRPERHEZINY . Sos BB TIACRE, Bk, XA BATCH Jiss#s rl 1]
AR B

o K¥liHL (Not initialized)
e ifi (Master)

e %M (Standby)

e i} (Stand-alone)

e [{[% (Fault)

e i JFi%H: (Disconnected)
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SIMATIC BATCH ' 1B 452 GE ?
1.2 V7.0 SP1

1.2.6 frrE A stk ID

e kR a4 MRS ID

U A A P v 1 R B T P A T k52 " (Restore) T4 T BT 48 SIMATIC BATCH ¥
i, ) SIMATIC BATCH &G4 0y s — At =40 ID=1.

i F“Pk 527 (Restore) i 2 FH 6 BATCH #diiny, 4 S H0H I AN 48 F 4tk 2k

ID, HJLATE“FTJF"(Open) A& HEH 45 2 JH Stk 1D, F8 2 1 JE stk 1D ¥ 5 fogs i
“Pk 57 (Restore) #ir4J5 T BATCH #5006 2 1 55 — ANtk 72

1.2.7 AMEETHEHE

MERBRAERIFAETAER S

FEATCMBR S IR, . A, A5 BRI TR . Tk
IS 7 10 BATCH LA TE (7 VS IIRAL AL, R LA K I Kb i e S8 .
TAE G A BATCH MUl & 65110 1. 1T LA S 04U RN I, 0T BATCH
BRI 0 G R S RE 7 B2 230

AT HTOULN BATCH BT H , LA G I o REAGRYE. BRI ) RIS D AT
AR

PATRE AR E LA
UER AR BATCH Hodfa it 73 o TAF HS (VIR Bt WIEAE T MR T RERS TR
WAL TAEH &7 (Without log book) &IEHE. IXRIRAR BRI A TAEH A&, A&
SENFA SO A IR A H S

SIMATIC BATCH F/if, V7.1 SP1
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1.2 V7.0 SP1
1.2.8 R Btk A i T 75 < PR AT A

SIMATIC BATCH 5 —Fuli i nl R A& F 4 . BIAE, O REW HISRMMER DL RS AR
FEI TG 7 S HAT R AR AR A “C5e R OO e B " 12 A IR
%."(Delete the object), H A REH AN H BRI L7 BATCH o #dT .
Rtk E“fkA: 77" (Batches) SCHFJer, BCRRE AP i H A BCRR CU#E th“MiBR AL 4 7" (Delete
batch) CAVARY) AR M2 R .

HEFRES .
EFxE/EHIL/BELE

REAHLAE = ‘

TIBR IS &R

UEE =g .

T BR b4 7= O

SIMATIC BATCH F i, V7.1 SP1
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1.2 V7.0 SP1

1.2.9 SIMATIC BATCH Hi&

Pt iase AT B
R FIFER SIMATIC BATCH 43 (“FF4"(Start) > SIMATIC > BATCH > SBReport) CUfE
FRUE PERERE D7 THEAT T 44k o

H & Hh i H 18 5 nTE“TE 57 (Language) LR 1) “4i4h (Extras) >“F 7 3B (User
settings) TR E

SIMATIC BATCH ¥ BH %

% T 2 il SBReport 2 4, 1 LI FE“SIMATIC BATCH §J& [ :5”(SIMATIC BATCH
Extended Log) i1k =F & SIMATIC BATCH. #:T#5ifi Crystal Reports #f, w4
FEAEF T2 2GSRI JE N A LA R T B P 541 R TR D RE it R 1) Y. FH A

1210  SIMATIC BATCH #"EH&

SQL Server 1 Crystal Reports
¥ HE RS T Microsoft SQL Server #il Crystal Reports %42 i s .

TARREE

WURSEER T HAE, BATCH #H L2k B K it A2 7= s IL =2 1) XML SCAFA
BATCH % J#1£i% % SQL ¥/, BATCH #5767 0¥f S 5 Crystal Reports R & &
7%, BN SQL it AR BUEE HAEARMEFT EDRAR. (CRGEMNR . HEAE = 1Eh . iy A &%
) Rl E SR,

BATCH #4E &7~

A 2o 07 NE T BATCH il 0 rh“8ii41h (Extras) >“Ti B % &"(Project settings)
S H A7 (Log) JEI-R Hr I8 6 14T ENABEAR o
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Thie

1.2 V7.0 SP1

R AEE A BoRIIRE T LR A PDF #0338 m] DUR I 2 L giah (Extras) >“Ti
H % &"(Project settings) )\“H &"(Log) LIk Hhik - F e fFJe. xR seff (i
FERFD MARREL, REMT IR L E N <IT A F>_<fib B = A RR>_<dttik ID>,
LI+ SIMATIC BATCH VA4 & 0¢ I AE 7™ (1 iy 24 40 7€ o

223%% SIMATIC BATCH I}, 3 SIMATIC BATCH H & al skt ., Hoe sl %
%7 SQL Server, HMW MRS H AR RS, WA T WIinCC, W& & wdk
T SQL Server, f#H TIURRZEMEN P EWtk. W& EEETI04 1 BATCH iz
Za%, WG PC (EARSZ & RS Lannedey HE,

SIMATIC BATCH Zz3E 40 14

NS TR R HE RS e ALE. Xk, X 4> SIMATIC BATCH JIR45 2%
LIESRY

SIMATIC BATCH % ' #L.:
e BATCH Base V7.0 47 SP1

e BATCH Client V7.0 045 SP1, "4y Crystal Reports &5 # A1“Y g H & #F1 ED
AR

SIMATIC BATCH Ji %5 %%:
o i/l WInCC T Ity 2 2he 311224 SQL Server 2005
e BATCH Base V7.0 47 SP1
e BATCH FastObjects V7.0 fi.{5 SP1
e BATCH Server V7.0 145 SP1
e BATCH Advanced Report V7.0 SP1
i
SQL Server

w2224 SQL Server ) PC R ZHA ) WIinCC filR%5%%, W) SQL Server 0] DL
TP HE"
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1.2 V7.0 SP1

BT ERRAR

B Y B H &K 5 “SBReport”[A] i 2285 . HiA {92 T Crystal Reports R % 7
B AL B R UEST ENBER . BOIA RIS L2 /e BATCH # il b0 A8y Jg H 27w Al H
“SBReport”. A[ il H 32 LB SN (Extras) >“1 B "(Settings) >“Ti H 1% &"(Project settings)
>“H&"(Log) MET B Ut s

TENRSS f Ledhelny, sxiind—M8r SQL 1 (“ReportConnect”) 224y it H &7 it 1
Med5 o UEAh, RE BT AR AR R B e, AR R

i

KT BATCH & HL, HERLLAT ) &

1T Crystal Report R % #rF #%ifiid DCOM (Distributed Component Object Model, 73
i N AAEXT AR {f FZ #2150 SQL Server, il BATCH % /' #LAI BATCH fik
554 1K) Windows By Jk i ¢ B 2 HH AH B IR B 24

Crystal Report 4T EIAAR 5 e 4 00 *rpte IXEESC MR —#EHI% L. X T BATCH
£t L MY TR e TN N oY 02 RN 1 2 o a3 | /N W 1 1 b 7 € S 1
5T WA U (Standard) IARVEST ENBER . X SERRIEFT BRI 2E 1 i) 4R i) 41
W SBReport A 147 4 1 A AR 7] o

Crystal Report %1125

28

Crystal Reports @il #s BAFAN G TIEAF KA — 5. T2, BN HIE f
“Business Objects” 4 5347 1) S A (R VF AT IE
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1.2.11

1.2 V7.0 SP1

FDA F1 SIMATIC BATCH

SIMATIC BATCH 3% & FDA (Food and Drug Administration of the United States of America, ZE®&
mS 4 REHRD) FEXK.

B TR ER

SIMATIC BATCH HiH 24 Tl Hlid& i ok s, a2 51 FDA IEER,

SIMATIC BATCH Ottt E A T 1 I A3 B 11/ i & B FLAT VPR 28 44 8 2 A il 7 20l 128
L W SRR AR (XML SR

A I TR AR A

o [if[a]Ek

3K

o EHH4

o N4,

WERSE ST SHUE (I, BRSO W2 F] A IH AR

e

SIMATIC BATCH [¥) ESIG

TR AR AR ZhE - Can* 3 3" F*s 1) ¥ ESIG (electronic signature,
B4, W, BIASHMHPRRE. M52, XERERE O 2]~ R

%,

B T RN S ESIG 28k, FEARCTT . ER A WA ESIG.  HittE” ESIG A
A, ESIG HAEM TIXLETCRMbREAL . Bboh, ARG (R, BANEANT) 4
HRXLESIG, MRfENH BE 4Rl

SCRIEN ESIG A7 1 £ n M4, AL UE DIREL g e 4.
THEENLAL SOPTIE R .t mT DAAEIRH e 8 R 2 s R sl i B B AU S M4 H o
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1.2 V7.0 SP1

AT EeH) ESIG &
XA

30

% F%84¢ (RUP/ROP/SUB):

BT

il

fe ik

TREF

s

BHF

O B
U S
AR R
Il '% 14 Vs
JER A
CINEZE N Aa s

i
L

5

it

s

ok

ok
LRSS
PTG R
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X Bt (RPH):

T

&k

f5ik

TRFF

A

ik

aks:
A TR S
A ORI R

Xt

T

Ak

f5 ik

TRFF

A

Hik

4k s
PUREis 6 eIve i
LB IO TR

X T AR -

FA A AR Ty
AT I AR Ty

SEARRCTT MPETH AT

SIMATIC BATCH FJIf, V7.1 SP1
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1.2 V7.0 SP1

X

o RATHIF AP
o R I A
o JEREETH AL

DA I AW

o KRATAN

o AXMRT; KA

ERBMRAAT

Xt ARG A IR S B 2 Bl % oK

AR

e T AT B X 2 5%

IO AR (AT S SO S A

SIMATIC BATCH LI UTC #&20 (Bt St a)) A A7 i A il k. Bl it Ab e
PRSI TR BB 2R 2R UTC #530. 524 x, SIMATIC BATCH GUI H )i i) 2 4

N A Hi I ) I LAAS I I 8] 2.7 o

32
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1.3 V7.0

1.3 V7.0

1.3.1 SIMATIC BATCH V7.0 3XR4 .8 %

PDF 3 f“bfpccapb.pdf’ f£fiti{t: SIMATIC BATCH %3¢ H 3%
<iw>:1Programme|SIEMENSI|BA TCH|Example|BFPccApil_doc F. MW XIHEET
“SIMATIC BATCH PCC API"3CRY (fURIEETERD o %R 48 T SIMATIC BATCH
ft) PCC-API 1.

PDF 3 ff“plugin_programminguide_english.pdf’ f7:-4i% 7 SIMATIC BATCH 2% H 5%
<tw>:|Programme|SIEMENS|BATCH|Example|Plugin| F. X5 T “SIMATIC
BATCH #iff %" (SIMATIC BATCH plugin concept) (IHRHESSENR) o« %R T
st SIMATIC BATCH i Ak g e

# B 3CAF“BFAPICMB.hip™ /i 7t SIMATIC BATCH ‘¢3¢ H 5%
<lw>:|Programme|SIEMENS|BATCH|Example|BFApi|_doc T . L& T“SIMATIC
BATCH V7.0 COM APi #58”(SIMATIC BATCH V7.0 COM APi Help) SCkY ({4 L5
FRD o %R H T SIMATIC BATCH R G0N TR 4 L4 11 (API).

SIMATIC BATCH F i, V7.1 SP1
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1.3 V7.0

1.3.2 # PCS 7 i H#&MHEE V7.0

A BT R T
LZHEH“SIMATIC BATCH PCS 7 V7.0" A2 i, B 4% LA R I H %
e 1 SIMATIC & Higsh, HEGHA PCS 7 3iH .
e 7E BATCH #&ihiHLpy, AR Cog it
o QLA B (& S0

HER
A PSR SR A QBRI BRI 2§ RS AT
e

SRR A A SR RO A

o AHIZFFM BATCH flexible V4.02 HE# 2] SB V7.0.

o A, HLZEH AR MALE SIMATIC BATCH V6.0/V6.0 SP1-X B¢ V6.1/V6.1 SP1 (1]
PCS 7 kA% PCS 7 V7.0,

e it BATCH flexible V4.02 FIH 4% 115 AF6. AF12. AF24. AF16S 1 TRANS %
WA, M V7.0 JTFUEEA T SZF i EA]. SIMATIC BATCH TR CBUN TX—4
AATRENE . IH KR DA 3 2 T MG 25— FE SR .

®  ASZFFI SIMATIC BATCH V5.3 A HEh# e, IXFE, b Z0HRME T i) S RF SRy
SRR T

B RHEAE I H B
IR IRAE SIMATIC A8 BLE% bl HIt 2L - 4L R HE IR, K5 B sh B AL LR I H £

e Ausrustungseigenschaften /& @ ME: AR, #AE 7 rhoE IR CHR & Bt
BRI A RE T, a4 =g F L #50"(Configure batch process cell) %}
THAE R R P B s A O RE e M AN R g . ARt R, O B J 1 () A4 PR A
IR AR BCAH [F] ) 2 FR

® B IPAR_ENUM &k

o N E Tk

WM SIMATIC BATCH V6.1 Z Hi AR AFE AL E S 2] V7.0, B EHAT 5 [ FRCAS P 75
PAETRAD . L E =5 a 1 B sh B R, A ERAEDE I\ V6.0 FIl V6.1 5854,

SIMATIC BATCH FJIf, V7.1 SP1
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1.3 V7.0

LAV E . EFHEA SIMATIC BATCH %35
Wit BATCH # i Hh0 N I g " RI“Pk 7 T, IR LA~ SO/, Bilan: . BeoT s
AR BRI J i B A%
T 0 et 4 F 2 2. 7F SIMATIC BATCH V6.0 5% 6.1 s gt 7 84 304

7t SIMATIC BATCH V7.0 1, R n[ itk SIMATIC BATCH V6.0 1 V6.1 1 KT A £ 4
SAFAE B B AR R SB V7.0 o AR VB3 A Aaifstia. XA, LK
T W SRR SR R I e TR,

SAFMGEH: SIMATIC BATCH §H #ii#
SHEdE cnic gy AXRERSE WTEAER SIMATIC BATCH ficA A i H .

IS
FM (PCS 7 - /A B IR SW B i) (PCS 7 - SW update with / without the
use of new functions)

3

TR N F (T 299)
FHi S7 B H %] V6.1 SP1| (1T 48)

SIMATIC BATCH F i, V7.1 SP1
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1.3 V7.0

1.3.3 AUV T IR

VFAIEF= i
M SIMATIC BATCH V7.0 j&, @Z0{#H SIMATIC BATCH B4 al k. a]
AJE S bR
e BATCH 10 UNIT

BATCH 20 UNIT

BATCH 40 UNIT

BATCH 100 UNIT
BATCH &P
UNIT F 3 S HA LS T B B IC . N AT T A P2 B kT 35 2 A M () B

W
=

SIMATIC BATCH [ (1 80)
VERTIER B (71 B4)
GAREHE (7 179)

SIMATIC BATCH Fit, V7.1 SP1
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1.3 V7.0
1.3.4 F P e e B vE G B U

fai g

PR sE M WS S AE P S A BRI RAE (i, A SIMATIC Logon) » Jf
FEF P LA A RO s (SRNG5S —6 PC L83 JaE#al M. 1
BATCH il o Lo ARGy 9 B h S 3R 4L 17 Ik Thg

FR 1
o THBCE: THBCELMRE RS E R
.

o KMKE: S BASRAE RO S

AP St
IR IRATIE ] T BATCH $5 6l o FHC J7 9 4 e X AN 2 LAY FH R«
o IR AMEH] SIMATIC Logon, A HIRE 481 Windows H (1 8= il 7™
o AL SIMATIC Logon, NI HFER{EH] SIMATIC Logon HRIE AT

o HIE T SIMATIC Logon [F“BRAH /" (Default user) L1, JUIZE 2 /i S s H
HH)5, SIMATIC Logon HBLLBRAH PS4 %8 5% . A Fid #ExT SIMATIC
BATCH &iEW (1. RIS IKs 4 sH F AR e — AN S TE G EE SCPF, IR OR A7 B A = S
e,

o UWIRFEAHPHEMEENZIERBZ G PC &, WA XS IEE BN ESCORS L/ (Y
R 1ED e e PC LR,

IR R AHE T HALA” B2 il JF HZirea 8o 7 HAIB” ERailifE &, WHE
W RS SR AT I R A B 122 b A (R TSP B I 2 15 B

PR P 5 s B30 A B 1) B

SUROE SO E R G 2% MUY I FES Y (BCC s BRE) [Nl Be. Wik
SIMATIC Logon 0 %%% FLW FHFE? A3, WS iin T8RS WA RS x
JEIRS, WA 2T SIMATIC LOGON /. Bei, 231 AN BATCH $ il o0 i H
PRSI G Ul T T 51— HI sk sy IR e Sk M T 4R

SIMATIC BATCH F i, V7.1 SP1
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1.3 V7.0

REFNERR

PN Sl 2 o i 0, PRI i B DR A7 2 Hdls 2 o

L& R (BCC M BRE) R/ EALAEIX LN I FE R JA Bl Ja ee2s, i A2 e
CR GG

BE) GRS R PN VAR
&S
Pk Rt .

B SR AT LS S8R (0 81 58 B T LU R B B WS TRAF IR SERE . BRI
FILA LB R] WA

SRR E . /ML T L
Fi 45 SIMATIC BATCH SHEHE 5 1 H 88 CHZETIE)
FFHEE RS RS OOMIRLE)

e AR ORAF 2 U G5 R T OT IR I 28 1, JF HAE B IR T TR I FOBr T T
WA . WA B S O, ARSI BT P INH% Shift

1.3.5 BATHERES
7& BATCH =470 BA & BATCH Ly dmfasth, nfUfEisfr oS, ah: it
ST (Options) > & (Settings) > /7 tix E"(User Settings) >“EF W
>"(Language tab>) K0S o g 1 5 R IEHE, AR5 5 i " (OK) #iiAHi A o

38
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1.3 V7.0

1.3.6 E| 2
SIMATIC & B8 h I ZRRAMTA RVFEH LR 245 "I\[]:]<>+;,?2"* = 1@ {} &

i
ZFREPH FI“EOP” & o8, 1 04E SIMATIC 4 H 28 ol ix S & B H T SFC 2K ff)
%o

BEAh, DU PR ARV Tands SRS A RKD) = B _ SR SMRRe ok 748

SR ARG (AR, B, £E SFC M IRFEXT B HE 4 “CONTSTRAT 1" 4
“contstrat1”, E/FRtb R SEAL JE AN e I I 47 TR SR A4 BRI B

WInCC 3 H i 4R AR R VFRE DU T 505 ., 5112 + =\ @* % [1{} <> ks
ASIOS MR AT BN FZ: 22"\ * % 44

DL R AT T IR SR " T\ %

DR EHART TSR 5 « 24" % .\ 2" @

YL

[ iR PCS 7 0S (WIinCC fi5 & %0)

TELA B P IRAE R FERT RNV TR. 16 SIMATIC & 3 g% rh AT 2
I, SEBUEDISEAERE IR 74T ME ISR A [ CRRIZD

1.3.7 B ITERE

7e“J@ M (Properties) X il AE 1“5 2 T4F H 2&5”(Change log book) &I, B T b4~
JCHE IR/ T (Master recipe). “fit4=7="(Batch). “FE”(Library). “2>3028%)"(Formula
category). “/Ax"(Formula) LA “Vikl(Materials) 4b, &N T — A8 51U 4

" (Computer name). X HbA = 62 B T HAT 10 4 O B VR AR 77 2o AL A TR o
RN A FR IR R AEBRAE AT VAL

i HH
L0 S ETAE RSk B L SIMATIC BATCH A4S, B3 o “pk & 7t 72 5\ 8l 5 1
B, Wk 2.

SIMATIC BATCH F i, V7.1 SP1
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1.3 V7.0
1.3.8 MR UNIT S 304 %% H
R~
“BEE"(Settings) X UFHE K B (Settings) £~ H I ThRE“ R AT BHIER UNIT S g firfy
A4 H”(With release delete all text entries in the UNIT block) 18 45 n] LAk 5 2 A 1H
(R S5 V.3 A 3 1D SV o
XA ] AN B XIS HE
1. 7F SIMATIC & #La% AP0 e 8 2e 0 o 11 b (9 B 03 SR, SR 5 sl bR A
.
2. fE b FacEsd, pidi“SIMATIC BATCH”,
3. e A P2 R T (Configure batch process cell) X 4iHE T, a4 2200 B 4% v 1)
S T2 A
4. TEA TS, it T (Settings) 124 .
5. MRS V" (System reaction) JETi .
bt | N
ERATRITGH, AUMER "IUNIT-BLOCK Bl i H (1) “fit 4 7= 4 71" (Batch name) Fl“ftik
ID"(Batch ID) SCASK H o A EHATICR N, WEEEFHISATAT A XI5 T T K% S AL AE
B R

40

TERATHICH, R HBRBLELTAR "IUNIT-BLOCK H T SUAS H o B ZEHAT IR MY,
TGS AT SV X TR % AERE

SIMATIC BATCH FJIf, V7.1 SP1
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1.3.9

1.3.10

1.3.11

faifr

BT

1.3 V7.0

RGSCFF IR AS T

FE“HE I (Options) =& (1 ¥ B"(Settings) >“Ti H # &”(Project Settings) iR A4
#il"(Versioning) &R &4 T RG L FFIRAIE HILhRE, th4h BATCH #3 h0 BL A
BATCH e 7y 4 s Hh 4R 44 T by

FE LT DU 2 18 25 SR AT IO RCAS Pk 72X, B B i iRA 2 )" (Free versioning) i /& “ R 4¢
YR RAFE )7 (System-supported versioning) .

IEIE T b R BR A B B BObR v R B RRA 2 ] (Free versioning)..

PUAE N AZIE BT 0 R 48 S R A 1217 (System-supported versioning) Sk in 3= i A5
BORIA S

E/CTT A IR TG R

T I S EC T B R R SR R @ 1 (Properties) iy &2 kT TR B
T (Properties of) XJUiHE, W NFrIEITR " (Dependencies).  {E X 1 HE
o, SITEICHE R I U R ARMIE R . AHRICR W LR Ee R R T

BRI SR L

SIMATIC BATCH V7.0 "4ERk T izl shag. AT A4, B EMEE

M, Wk SIMATIC BATCH % Hoc K42 M ISA-88 VA& i, el ARAET
] ERATRIE R . AE SIMATIC 45 Bl s o 7 DL R 41 S SSOA REBRENAT R L) S5 44 (1Bt
LIS

SIMATIC PCS 7 V7.0 it 1 2 Fh i R R my oK g AL BRI . I B R oy
PRIBE R PE, - HSepitiat 5 BARK T A EADG. T R AL A A E 1D,
HEEA B e B

SIMATIC BATCH FJIf, V7.1 SP1
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1.3 V7.0

1.3.12  AXREEHFMERKER

i
ATUAR =B vE nl A s EAT AR B b ORI 3T T AR PR e
o {EL) RGP AR R R
o LI F B A R A i
LI Sula D uR I ]
A S BRIIER

7 SIMATIC & 4% b O 58 FEA K TR B v A1 BATCH 20, o T-3h 6 g i R i

“B A TR S AR E P R
THET) RGP AR BT A I R i - & AT TR B0 B R R AR A8, i et 2D B
1. 7€ SIMATIC & BEZsh, B L PH i) &AN g AR m i
2. TR R S R (1) 5 )& 77 (Object properties).
3. FIIF“BRE k5" (Block Icon) 3T
4. FIE N E g 3kA5 B ki (Derive block icon from the plant hierarchy) & IEAE .

“ B Eh A BT T AR E R 45 R
Gk OS I, XN AYHIEIFR E 24 A B IR i i F 5 SN R AR 2

“$ X3 B B4 S AR E T P R
BT LR, e IAE SIMATIC 4 BLER 1 1) 2 242 DX F 3 28 peid R i
1. 7€ SIMATIC & BEZR I L) J240 (L) WED kB d i X s fF k.

2. b AR P S o ) T B 4" (Plant Hierarchy) >“Gil 22/ 58 &l
¥7”(Create/Update Block Icons).

SIMATIC BATCH F/if, V7.1 SP1
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1.3 V7.0

“F X 3 E B A R R I T 45 R
B Bl A S 3B DX el e o e o, LA o A ELE R A

“TEIER KB

LT A RAT AT TP AR A BB AR (R R o, 34 B D SRR AT -

1.
2.
3.

75 B it ds o 4T T 9T 7 (10 2 i
WS LAy A S0 E (File) >“F7J17(Open), 1 B SC/1“@Template_Batch.pdl”.
BRSO PR T S Bl b
— JUNIT
IEHR B AR 1 S8 7R B 43 e A 23 BC 45 14 5 TG I e A 45 A E R B
— UNIT
B bR T RC A V5.0 FRE UNIT_BLOCK M .

- |IEPH
“IEPH" B b5 T T AR P B s w4 B B

- EPH
I bR e T lC & V6.0 Jiit) EPH S .

- IEOP
“IEOP” B Bl b FH T A2 AR P /s e #8434

- EOP
Se P &R HBE TR V5.0 Tkt EOP Hefiif] .

FERSIRR SCAT HH B 6 I P i B o 4 JFG A 30 o R
PRI R ] R P A

TE“Zh 25 175" (Dynamic Wizard) % 1, bk A" (Standard Dynamics) F I
PCS 7 Thfig“ ¥ i #% % 1) 248 & (Connect faceplate to process tag).

1E B 7] 3" (Dynamic Wizard) 7, F.di“ T —2"(Next), AJ5HRdiAHIIGE"...".

JITA SR R HES) R AEAR S PR U AE o JE PR T, SRS P o “Hf e "(OK)
>“F—5"(Next) >“52 " (Finish).
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1.3 V7.0

“FEIERHSIR
O P 10 TR 0 T LA 3T AR R TR ) BT o R A

Ez’f__‘ﬁ:lat
7E WIinCC 15 RUAR G . “Bhas i e i i A F 2h 2 170 S 8l 2S48
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1.3 V7.0

1.3.13  HEBMES FHRERSH

fEi A
H SIMATIC BATCH V7.0 if2, ] LA{ERCTT # o0k (RUP, Recipe Unit Procedure). i
J7#4% (ROP, Recipe OPeration) LA Bt 7 BB (RPH, Recipe PHase) I Rl 5 241
R N 7 NS VN WD S = Ve S T = R ek [

MEEY R

A T LA X AE :

e 7E“RUP. ROP Fl1 RPH HjJ& 14" (Properties of RUPs, ROPs and RPHs) HXf iGHE
“ENPPER (Input material). “%i 8L (Output material) F1“2%1”(Parameters) 15
T, ARANSEATIIN T A (Formula) 41, s e (. F LK T G
155" (Edit expression) X[ iEAE. Tl DL N SE MR T 2 AH S B

o EHTUEELR AR . Ak X 7 D e AL alm i 4
" (Condition) ZEIH K&K i Huli fc 57 22" (New) FI“5E " (Change) KA1 IF 4 ) 5o
2k, PR R4S 7 (Process variable) 1E b #E% 1, “A"(Formula) 15
VE% 2, SRJEESE— D] IR I 2" (Next) . 7EFH 5 H IR0 1E HE iz
B MR IR 2 (Next) 164l . B s SR HE 2 T Tt S 30k e 1l
B AR GmRa"  k foh HO  AE rp )55 )" (Help) 241 w3145 5 245 KL .

SEVFRIBRAE AT A A
IR PEVURRIEAIERR (+5-307%) A RAEAT . AN — B O B T A (Bl
M SRR DLRCH R RIS

KR 1
o AREXTHCT R PAT HARIZ S .
o ASMALARRIE AL AL 5 BRI

o {rEilnd Ty, M AT S A REH API (Application Programming
Interface, R/ Fomfese 1) s AT B

SIMATIC BATCH F i, V7.1 SP1
A, 03/2009, ASE02171120-01 45



46

SIMATIC BATCH 174 i 315 1 3¢ 2

1.3 V7.0

1.3.14 I RPITCEFRSHHES

WHRAE BATCH $5sfil vy e v Brage ik 2E 7= i R o0 bR SO B b A B e o
Jt"(Update process cell) Zhfig, K&y kKAmMILE.
P o DL S ORHEAE 25 0T A IR RS o 200 T A 25 7E — BUARE 22 (1 ) 1) i

Ko WEREFHR B IZAAE, R AR s 2)"BATCH Fl thL A R I RS T
PR LT

Process cell update active

ser: PCST Syskemktesk
! Started on: SOE0103C
Ackive since: 28/2006 09:43:50 (UTC +2:00)

e Skatus: Saving new process cell ko the database
& Total progress: 16 %

SIMATIC BATCH FI}, V7.1 SP1
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1.4 V6.1 SP1

1.4.1 A ERARHEAER B T SR

PG FTP MR 45 28 VARS AR v H T2 A7 il DO LA P~ . HLoe vt B e 904
& f FTP RS, AU 2de i 4144 Win2000. Win2000 Server. WinXP &,
Win2003 Server #:/E R4 FTP Ikg5#s (5 B, 52 WAHNEAE R4 Windows #f
Ho

7E“BATCH il iy, i 550 H iy 2“1 0" (Options) >“i% &"(Settings), X541
“UAR4”(Archive) LI, £EFT I H“HE ikt B " (Change Settings) X HE o X RS 64 7= %
PR AT RE

Z AT AR“E H XML SC" s “SQLServer H ] BLOB™ YR B Asl.  7E 22 A IR
W1, 41 FDA (Food and Drug Administration, 3&[E &5 25 &R , BAGERHH
AT R (R XML SCPF) o EOTVEIAEA AT TR e A O, Rl
Windows FZ A 20852 TR N RLR

1.4.2 SIMATIC BATCH TR (¥ e fL 4 2

HE R EE B R B b
SIMATIC BATCH [t 41 A% SIMATIC PCS 7 il AR () 41 4 5 4 fif 5.

L OS %41%"(0OS compile) BTt FH e 1“4 e/ BB B K 45" (Generate/update block
icons) k224 UL K B 8l 4E s sh A4 T4 R b it e Bl b

FHXRUAE PCS7 M HKEEEM
B AR AR P kil ik OS It H g 2% R I 200 H 20 . TH B EARAE e R AT R B
ANGhe SHrHAR AT H B E bR R BOR
Bk L ZEEARIRFEANAS, A5 ] DAFE B E BRI THPathEPH” (144l J& 14
“THPathUNIT” k47 i 4.

SIMATIC BATCH FJIf, V7.1 SP1
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1.4 V6.1 SP1

1.4.3

14.4

BB

48

SIMATIC BATCH Ttk f) 7T E i 52 &

CL#E T 1EPH [k ) St 5 SFC_TYPE RIS —3, P MANE T SIMATIC
BATCH 1f & RAMFEM At . LR Ao % Sk 18 i 5.

o JTRBN. AFIEEN BRI 2R R M

o BUEASEPMEIRAS RIS, DR S B SR .

o URAFAE R P SRS S 4 W R s S s i SR 22 (R A 4 T SR S 8
o T IUNIT iR, a4 AE S8 T BEFPIR AR s i il s R T A

#%HE S7 Wi H % V6.1 SP1

HEIRATIF SB V6.1 SP1 Z R A3 H f#) SIMATIC BATCH AN iEHERN, THH4HE)
# iz SB V6.1 SP1.

AZHEM SB V6.0 Z i IhA Hahfsti. M SB V6.1 #4E % SB V6.1 SP1 I}, BATCH
e U AS T B R R SR R R S5 b s, AlESH AR g R R
JG"(Configure batch process cell) % 1 HE F1 1 ] 7 Hcdis A0k H Re e O A pe iR . 76
U FE AR, K AR 1 4 R R SRR 24 R B AR R (1 44

FARERL ML) A IO T2 TIT (35 H BT AT ) SIMATIC BATCH A, AR ESEIN
17, RVEEMRA X BHLRIRA X+1. H A% BATCH TRERZKY, XER:

e J\ SBV6.0 %% SB V6.0 SP1
® J\ SBV6.0+SP1 # 13| SB V6.0 SP2
e A SBV6.0+SP2 ##i#] SB V6.0 SP3
e A SBV6.0+SP3 ¥ #i#] SB V6.0 SP4
e A\ SBV6.0+SP4 ¥4t %] SB V6.1
e J\SBV6.1 %% SB V6.1 SP1

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01
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1.4 V6.1 SP1

ANSCFE SB V6.0 ZHITIRA A shi#ft. M SB V6.1 i El SB V6.1 SP1 i, BATCH
toE AT P AR RSB R I s, AR R R
JG”(Configure batch process cell) X i HE 41 ¥ FH P At 2R A0K A e O A e g s . 76
IEIE R, A2 (1) 48 BRI SR 7R 44 Bk a3 BCAH [ R 24 R

AL
fE#FEE] SIMATIC BATCH V6.1 SP1 i, @2 H C5EHifR 2 I H v T o H — 2.

WERAN AL ILEESR, TR LU R i ]«

o SIMATIC BATCH HA7AERIBITAT HI - Bt R AL R A il

o WA SRR H (e ] DA AR, WRE AR BIah 4
MRAEAE I H R Z A FR . R A PR onfE— M oIR .

BRI H C S A R AERE S OIS R R, PR P JCE e A Bk X8
FEEHHA

o I TEAKBIH, KR E SO KGR 1 CFC BI&T Hah . SEfl:
(DEPAR_ENUM Bt ENUM 2%, fEZIH Y, SO i @ i e 4..". “&
IO R A AT 1

o HRRTRPELU TR,

SIMATIC BATCH F i, V7.1 SP1
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1.4 V6.1 SP1

AR FE A

o BMijG, “HAHA 7L FEH T (Configure batch process cell) X iFAHE H i F #idi 2k
0K BB I AS B2

e SIMATIC BATCH (X% &2 i H v B AE il B ooy H . X FFEEH T4%
R PR R UL G iR T fE

o URERCZ I H I, TR H A R A2, A EE R
= VN IEEEE R (Ei iyt
— WRAFAEAR R B R P B (U BoR A RREIH P BERAD , LSRN Bk

NI P 5 2R e

o A LR I R T RS M EoR A RR, I H R T CFC KRk
B RERHAT R B . AEZ I, %2 500 H 1R I S 1 H TR
%" (Generate) #:4F, R G HAT %% (Propagate). “& " (Merge) 5“ ¥ #”(Update)
PRAERSE N o

o DA R T g e A SR TR T P AR BN, A S A e i R
JG"(Configure batch process cell) X iiHE 4 7Bl i D e LA BR 2 42 1 4
PHRA, S ANFEH TR E AT .

o P2 IH I R g IR I, e LS AR i FE (Configure batch process)
SR HE PP T A2 Bl T BE DL AR Rt A pe S A

o LR A SR 7 BT AT T AR S R S RS R, AT T e I A i T e AL
A bR . KR AR AR H 5 S R R S

W
=

MAEIEA (U0 541)

SIMATIC BATCH F/if, V7.1 SP1
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1.4.5

pa =

1.4 V6.1 SP1

SIMATIC BATCH V6.1 SP1 (RS S 58

PDF 3t f“bfpccapb.pdffii - SIMATIC BATCH 2235 H 5% <4z)4¢>:1Program
Files|SIEMENSI|BATCH|Example|BFPccApil_doc . Z AL RS “SIMATIC BATCH
PCC API" ({UHREIEIESRD o %30k 44 T SIMATIC BATCH [f) PCC-API Lifig.

Word 3 A“plugin_programminguide_english.doc”fi; T SIMATIC BATCH “%#5 H ik <#z)
#>\Program Files\SIEMENS\BATCH\Example\Plugln\ . iZ 405 04 “SIMATIC
BATCH Plug-in Concept” ({N42HEI5ERRD o« 1% CREAS T a5 i1 SIMATIC BATCH
OEGIER SN

B AHBFAPICMB.hIp”fiiT- SIMATIC BATCH 4235 H 3% <#z)/4%>:|Program
Files|ISIEMENSI|BATCH|ExamplelBFApil_doc . %35 SR “SIMATIC BATCH
V6.1 COM APi Help” (WL SETERRD o« %344 T SIMATIC BATCH R 411 W HFE
F# 1 (API, Application Programming Interface).

SIMATIC BATCH F i, V7.1 SP1
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1.5 V6.1

1.5

1.5.2

52

V6.1

BATCH Clients V6.1 + SP1 7 Windows XP Professional Fi&4T.
BATCH server V6.1 + 6.1 £ Windows Server 2003 5§ Advanced Server Fi&4T.

4k, &4 SIMATIC BATCH #4447 — 300 PO JVFATIE, LA N M 300 PO -
> 600 PO )& VFmT ik .

Pfib i BEEAERR “SIMATIC BATCH AT 1368”7, H @& RmmE .
it Teleperm M 84k & 444 SIMATIC BATCH 1] LU L5 8 [ T f%
Wil T S ThBEP A, TSI SIMATIC CONTROL INTERFACE (SCI) Jfii.

TE A P £E R S5 2% (SIS, Sequence Interception Server), Hog R AR EUL A
PR IPIRAEAR . XL T IERE] SIMATIC IT (19 5E m s B R GE 2K

RO SIS FHKE R4t .

TRAGTHAF

AR 2 RS ER, T RE R R AT 8 MRS (LT 5 1) .

I vt A I RE s B A 7 Fim, ) AR P S AU iY) SIMATIC A8 P
e BEANIH 1 TR TAF I AE BATCH X UHAHE 58 B o

BATCH 2 2 0 il HE H 1) 5 89 T g«
— IR ThRE, AR AN AR B HAT AR P I R R OB R PR A

— DUAE, PATIRUE" “GREETE A T BRI IR AT AT A R e, B T LA 1F
ST (AEEE ) B e E R B XA AT MR IR A ISR

— BESRTHTEI. BHL KRG CLR e NI RE

FE“HR T SO S g e, vl DU RS B e e S0 Hoa i Rl — AN Ek o) — AN
HIEAI TR XA LA IEE R A L R rh, 76 L) g ik £ 173 15+
1 TT

HGE TN EIENETIIRE (PRI TS .

SIMATIC BATCH SZ#F# Uhfg, RPJET-X 84w 7% OS

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01
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1.5V6.1

1.5.3 AERL A 4
IE T DL S B0 5 ok B VT A T BATCH JIR%5- 4%

1.5.4 [ AR

o FLIAERIREE M R IO AR Ty o ACS I T AR INIRICE, AR A A 4
o BRI IR 2 H

o W LIERCT 2 (RP, RUP) 5& SCHLIGII AT RIEFE I 0.  IRJEFELEFE FICT,
WAL IS e () AT itk $E.

o B T AEIEAT IR 3 Bl SR A S
P UAE AR SO ARHE P T3 0 Bo i c.  AAZ00 B S0 B R PR AT L7 S

o AT REBSBLEMB SR AMEELL (B TR,
LI W R T YN N EEA T4

— LI TP A 2R 5

— LUK R B AT hR % 0

o RAEGIXTEHE (OD, Operator Dialog) H i S £ k1. (&) Z %" (Hide parameter) i%
Ay e A, iERAE R AR W A B U (Process value modifiable) i35 1t
VTSNS B . “BE 7] 3 250 (Setpoint modifiable) 36 1 7t VA I S 1) 1
VB GONEHERR & 1 e (H

1.5.5 7F BatchCC #1 T4k

o A/ FHBT-LL SBX MR /LTy FEMATEN, RS PR S E]
BatchCC ', DMEAEST IR RE s Crh BERAE ] .

o IZERER A R L I T A BE T A GE A SIMATIC LOGOND .

o [IERE N HAE DL RAE LA AR BUOH BOR S R 41 A W 25 44 (ESIG, Electronic
signatures). XAERIH AL FDA CE A S 250 R HITT I 24 i A= o B 8 BRI
(GMP: Good Manufacturing Practice) ffJ %K,

SIMATIC BATCH F i, V7.1 SP1
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1.5 V6.1

1.5.6 AT RERAE
o YERUERTREIINA, Areh b S T A I T S ) 2T
o BRTIIIFMIFEINC I AN, BT SR eI Ty, e AN bR S DA SR
.
o 4iji T BATCH #iHI R 55 2% IR HERS I ) o

* “VZIER"(Effective immediately) L E1E 2 80E SO BRI B B 3h A R ZEH KLy By
B WASHIEXAThReH T LAPAE ] .

SIMATIC BATCH FJIf, V7.1 SP1
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1.6 V6.0

1.6 V6.0

1.6.1 TR AE B

BATCH flexible T fir 4% SIMATIC BATCH.

Windows 2000 3t %%

SIMATIC BATCH V6.0 7£ Windows 2000 #:1F &4: NI4T .
BEARBAF A, — B0 Rt A A 5

SIMATIC BATCH V6.0 FEA A e At A ok B A s rdg iy TR . Jld A
AHAF AT LB R 2 7% 150 NI R Gt A N I RE Y, 34 mT I A R 2 S
Jie WEE AR AR B RE YR 600 >, 1800 AEEE 2 I FEXT A

AIER AR

PESEAR AR LA A Il A8, wT LA ke SIMATIC BATCH V6.0 f1hfg. 4@
T R A AR AL

— HEAEFE R
=W
ROP 4

o BRI AR
APl #11

nfE R 52 W SIMATIC BATCH V6.0 (1) H iR SC
T XML (R R AR 2

A AR B E (B TIRE . AP e T PR 8D BLA RS S B LA XML A% =X
14, DMEREEAE XML AR e gt — P b3,

BATCH #t#%

b SIMATIC BATCH V6.0 JEA A0 — L6 1T BATCH fREHIHREE H 4.

TR, MR 2% BatchCC, Al LABEIN o A1T BN XML kg A2 1 H &
ARS AT

5 MES/ERP [#3 11

i Al 3k 4 F 40, SIMATIC BATCH API, a3 SIMATIC BATCH f7E £ Fl 5 £k Th fig
PekECE] OEM ARG L] MES/ERP N HFEF. % APl 2 042 {it—4 COM Z#%
(XML i Hitg O

SIMATIC BATCH F i, V7.1 SP1
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1.6 V6.0

JUAR

SIMATIC BATCH it: BATCH fil 25 4% BERE AT LA 45t fbAE B i B, Jf Al
N EE R CR G LLSEIUR AT HIPE G225 R R AR il i )

3 PCS 7 0OS

SIMATIC BATCH V6.0 il [fitik 5 PCS 7 OS B 4E/, ‘& ifdt 7 WInCC i 55
BATCH 11 3 2 A A 2 W) A8 A%

1.6.2 TRERGTHAS

Bl ThRe

56

BATCH JIx 45 #5 #1 BATCH %5 7 Hl

16 TREIMEL ) SIMATIC & 42 b 414 BATCH R4 4881 BATCH & /2 HLIN 77 BT
1A OS MRS 2ERE ML, LIS SIMATIC 55 H 88 5 3L 2E 77 f 45 24 1% o
Hlo

WA A PCS 7 #8041 B i) K PCS 7 15 H

SIMATIC BATCH V6.0 SZHf 75 70 A s A Gy sl iK1 PCS 7 T H XA . IX3%
7 BATCH wLLV; i) BT A A i, AT BERE DT 0] PCS 7 I5 H w9 T ml g R4 o]
o

Z I H T

SIMATIC BATCH V6.0 3 #f PCS 7 V6.0 1“2 Il H TF"Thfe.

BT RMPTRE (AR

PrATHEA =M Bty B BL MRS AP B SRR e e TRER S 4
i FDAE R, fE BATCH . R UKL F-I st A SR ALy st 81 i e

HERAE BRI 1
SIMATIC BATCH V6.0 55 n] g2 il s b S BrAb 38 18] ()42 o an s 77 0SB

— BB SFC 288, 1M nl il PCS 7 V6.0 ol F i ASIK) SFC brvE T H
G

- B ] BATCH ik (352 WL“BATCH $2 LR 73

SIMATIC BATCH FJIf, V7.1 SP1
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1.6 V6.0

o f{fiJi] SFC A

" H] PCS 7 V6.0 iy SFC MYk A= il E BT A SIMATIC BATCH e 4
BAEI BL. i H] SFC BB I HR A1/ Br SFC RBUBR £E L REVLAE K] CFC i
7~y Iy SFC RESCHIHiA CFC K3 SFC skl LISEAL CFC BityiB U nE
CFC K%&rh. R 7 W& AR B Befy SFC 2R, A il i% SFC RIU AR
QI K] SFC RIS A2 F 3 5T«

o 1) HKETMI) EH

ELRERGER) L] M b Gl ISA-88 itk ity 3 24 L) =g (G REspIc, #
TG BB L JFRUO N EHE A R . D SO AR O AR AR R,
PR LS I RS IRy e L) RS W SR TR SR R AR S0 B
R 2 SR AN O Z S

1.6.3 = TP RE A =

N T B AT IR LU RE s AE AT U TR) SR R A, s BATCH e 55 38 BT O TR S o
—HIUR ARG R A, RIWTEM & BATCH filk 55 de 2 IR BEAT 8 1 I 55 a5 I 55 i ik b
IR

JUARIEIE 504 BATCH M55 R Se L, Rk G AR A B S B IIRE. Dyt ™
SRR REfS Vs ) BATCH 25 4% (1 4 i Bt K AE PN A SO o BEAR S8 2 1) AWt 7]
SRR BREHD o W& BATCH R4 a% HILME, 5 — & 28 HAH R K 5L
YRR ELIatT .

SIMATIC BATCH F i, V7.1 SP1
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1.6 V6.0

1.6.4

58

tlf= 3Gy

JEMBCTT

/1] BATCH RC it as, nIGIEEEL % ISA-88 FRHE IR LA R 4 42 e )RR
e

- ML (RP, Recipe Procedure) - &5 1 2%

- W)y ¥ ICFE /7 (RUP, Recipe Unit Procedure) - 55 2 2%
— K J7#4E (ROP, Recipe Operation) - &% 3 2%

- F 7B B (RPH, Recipe phase) - %5 4 2

WAL 4 2.

AR CHPRLRIAE =5

Wy B A XFIRCFR,  nT DA T 5 F2 P A4 AN [F] 11 2 XTE BatchCC il gt

BRI ERC T D REMIR AL SR AN 75 BT — A PAT B AN C R 5 | ke ) o
B

WS
AN RN SRR T RIRC T R Peld 2  me )y, HAXZ mERAARRE. A
AN TR ARL R A = B A SR R AR o

LA T U] )

76 BATCH Py das b, nf LAKEE A BARI ek gy E e i Ry (56
ISA-88 t#fE) o TEXFMELL T, ¥R EHICHL T Al — MR oo, HonRER
P LA AL BERE ) (FRETI B M—4 %00, I eEI, thal DL S R
fBI% L TC o

IBAT A 6 4 i

AR RE AT IE A, T AR RS AT BE MR A I A B G W AR LA PR IE AT A TR) R
TEAE AR B LA T 7 S 6RE 7 (RUP, Recipe Unit Procedure) 587G, W“ia 47 3 1a) )
BIC L I Re R G, TR LU LR IE 2 —

- R
— BRI T3 1 9
SURCE S &l LT

D>
o

SIMATIC BATCH FJIf, V7.1 SP1
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1.6 V6.0

e iy #/E (ROP) &

1 BATCH By g e, v %G "roc Sl nl = A A 4e4E (ROP), 17 BatchCC
PO LA TR B . XS PR R R 2 R T B BE (RPH) 4584, mT %L R IEdE A

ESLWIE
= G R, BRI R B REANERRAT, DT A8 o v A fik 1 T G5 R B e
1B) 5

— SEAO (I, PEREE S A4 A) ROP th, SR IFF ROP i sctil
ROP 2 I, W EL# AL/ ) ROP LHEFF S0

o Filin
IS AR R DTS AEIA (RTBE SR SR
BRI 28 e TRER G AL . (BRI T, S R I
W4T DLW S BB e SR BN . S HOMRLIIRL, SRR T
PR 5

o ELEHLE
BRI NI, FTBEsE —AMREKSE S E T RL B, DMEASE A
. AEBCEDR 3 R B BN S 1 2 802 TERL PR 2 0 VA
WB CRABIED R4
— HSERTERDTBAE LIRS R BB CPLIBERE) WY, D AUER L

— BB AT B I BO EA R S, e R B I AT IT e (9
WA AT P I s S i)

SIMATIC BATCH FJIf, V7.1 SP1
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1.6 V6.0

1.6.5

60

7r BatchCC # T4k

S AR A AL 2 7 2 1

7t SIMATIC BATCH V6.0 1, K% BN FHFE A P~ k). A= r=4 i L&
BATCH i & 524 £E i 5 BatchCC [ /St .

f£. BatchCC i #f1: BURTRZH &

BatchCC 5 PCS 7 OS S r[FFEMI R . BeAgigin, it BBt A2
M PCS 7 OS it Jt M SIMATIC BATCH A& %I B, S/ & #0241 [F K

B A P
SIMATIC BATCH V6.0 3 #F PCS 7 ()44 H F & #“SIMATIC Logon”.
HL 1284

A REAEPAT HE LA (BT, AE R AL ™ B St A2 IR INHE
SIMATIC BATCH V6.0 "4 FDA SR 7254 .

SIMATIC BATCH FJIf, V7.1 SP1
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1.6 V6.0

1.6.6 BATCH #DO#k

fai g
SIMATIC BATCH V6.0 fJ7E TR RG] SFC KA [H tift. SIMATIC BATCH
V6.0 ] DAARSAE BT BOR A R bR i 1B, A4 55 mT g R 2 1Rl s b Ab PR P kAT
TV TR 1

B Osb S
e |EPH. IEOP

XL 7 T i B le s #4E  CFC IEISR A b TRl g% 1 o Tl A Y dx
B, R A A i o AR IE BIALBERR R, O A 12 I HE 2 AL PR e (RS
HE

e |EPAR. ...

W B RS IEPH B IEOP i) IEPAR ... 24 & 15 8 (AR HIC 77 24001
SPRfi. BN IEPAR BRE—ANSHUE. TR ReM AR R AL, AN L
HIEPAR Bt (SERY, PR AL, A/RAY . QURGRERERS . MR, RN, i
Bt .

e |UNIT_BLOCK
U AR T PRI C 393 T8) 2 e BORE TG -
e TAG_COLL
] T BEAE RS 2 A A AT R I R DA il st A P f R R I BB 7 51

SIMATIC BATCH F i, V7.1 SP1
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1.6 V6.0

1.6.7

62

EFXHEAT I ERAE
o [t
K PCS 7 OS _ER#AE s AR, DU I Bt T i
— T & &EAEM B SFC sS4
— BATCH #:03: IEOP. IEPH #1 IUNIT_BLOCK
o HERYIR
— SIMATIC BATCH #1E G~ DL s 77 sUfE PCS 7 OS L iR,
o HUEFTHYE SR
SIMATIC BATCH &4t 7 LU R b4/~ )8 she X (e # HIES )7 )3 s 7 221 s oo n]
) .
BAE A CORATREAE P B )E B A R A b .
SEHT: BRIy A SRR I BTSN, A I R 7 B A sh AR
B UK S feA =gy e i) H IR [a) J5 3l . 02046 5 e sl i TRl A H 3 .
o EATHAMRI IR
BEAE TR AN E LA P I B 2 fR, RN T e % (BC PR ek B EAE
G BD BONEEAN LA S (FSHIEC T AR EANERE, oo st e, — A
R, ELEFI B AT LI R . RS R A s in B,
HEAIH 44 .
o EfT#mIpHLAE S H &
A PRI AT IR R i AR P H . WA H AR S R st i a
MRTEC T A B R T # A B .
o IR HICEIE I AT R
L RAE TR RS T e T R e (A 15 4%, WAZAE BatchCC R i i%
TR CEHE . R R e (1 S ET I REAE NI G 2B BL i BATCH % 7 #L L3k
7o EFEHITHEEH ] LLE AT —& BATCH &L Tk . Fra e
BATCH % P ML k24 A5 ) BATCH R4 (ARt i)
— FERHIAN], BT ERA I R T PR A B A MR R A" A B S
MR TT 2 B R AT« 5216 U IR 30 T 1 R AT 2 R0 -
- ZBUCEEEILAEPE EAA SWBUE WA SRR, e adkeistT, HITRES
FEER,
SIMATIC BATCH FJJ}, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01
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2.1 SIMATIC BATCH 214 7?

SIMATIC BATCH 244 ?

SIMATIC BATCH #&—> SIMATIC PCS 7 F/F i, @k enldids. k). #dHmHe
SEANESE R GHE B R

T AL N i B W PR P B, T PCS 7 TR e it CFC A
SFC THHEAT AZMHl. S RRTRL 7 Rl S 17 S S A MBSk, A6 SIMATIC
BATCH. /] SIMATIC BATCH I, F7E 5/ Bufsk i) PC 1 LI TEAL I )y i
N e O

FERARREA = AT IR, ATWCSRIL BT B RN B A S i, i e ] DASEAT b B - L 5
B H A&

SIMATIC BATCH H] g i) 3 B 4T

SIMATIC BATCH & ] T & Fh &2 28R B (AR P2l e o M/NBRASE 4 A 77 B AR R AR )
fit4:77, SIMATIC BATCH #fg g4t Ac 3 3.

SIMATIC BATCH [f) &= ZHRFAE W1 F -

o IR EITRALRL T

o T C T G A [R] PR 1 T 2 s i 45 AT AW T 7 AT

o PEIHNS AL ok B 2 A T gn R B R A 1

o SERRIORPRAET R, FLAT VAN I B

o WA KT F O CORETEIT D AT A SR
o HEATRRITI R T, LEN TS SN PPS R TIEHE

o Pk B, HAY R

® XM NAMUR F1 ISA-88 #rift
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2.2 SIMATIC BATCH [¥1Zhg
SIMATIC BATCH 7Eflt A== id 72 B ah b KT G B BOA 3432 R . SIMATIC BATCH #
HEFITRERT 43 A LA R DYANFEA T 1] -
o [ R4
BN P B (1) I 5 R A
o LSS HLE:
FR A E R A e A A AT
o b
PAT . AR RIS R & A T2 P B A s A S A e 7, DA AT RRAR 2 i)
LT W
LI ) A& Yk = L
KA AL R S A P
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2.3.1

fai g

JB BFAL

2.3 SIMATIC BATCH 119411k

SIMATIC BATCH 44t

BATCH jBahth AR 7

BATCH JaghPhifFe 7> 1 5t L H 555

e L OS il

e SIMATIC BATCH 1% A7 it

o [i¥L SIMATIC BATCH #i#ls f7ift

o il WAL, FBhAEIE SIMATIC BATCH Jk 45 d v B

— BB 1 BATCH g5 & Fr/E TSN A 3 a3 BATCH Jash il fe . A PAE
SR CHNTD B A — B, I T HESR e IR

¥ BATCH Al Phl R eAk, b2 42 i e 55 s At A= = £t A 22 (SIMATIC BATCH
CDV) thx B3R BN XA IRSS e b I RE P AEAE S5 A b s B b bR il A
G ML AP Bt i BB R AL T Al IR

Wik PC 3z Ja BATCH Ja sh Wil R v SOX AN ik 55 s NI RE e A s s, Jf Bl

WA WoREATS R, 1EEH S Ay 2 “FFIR™(Start) > SIMATIC > BATCH >“BATCH jB3h
PriE#EF"(BATCH Launch Coordinator) J& si%F2)F .
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BATCH Bahth AT RGER R

66

BATCH i ahhilfey (EARS A Bonoh— N Ebn) AU & MIIGE. (RS Fr

(1) BATCH Jaaith iy Elbs Bty < Bon s, nJLA7E % & (Settings)

NRCEAARE. RN

e 33 WIinCC J5 H 3l 5 SIMATIC BATCH (SIMATIC BATCH starts automatically
after WinCC starts)

e JCit WIinCC J&15)a4h, #K B335 SIMATIC BATCH (SIMATIC BATCH starts
automatically regardless of WinCC)

e T35 SIMATIC BATCH (SIMATIC BATCH is started manually)

Ik CE R Sk IR 2 WInCC 5 H 3l )3 55 SIMATIC BATCH”(Start SIMATIC BATCH
automatically after starting WinCC). XX 7EFER0F)H8) WInCC IiH  (FiGisqT
A4 I BATCH JHath iyt A3lEs).

BT LAZE SIMATIC 45 BESS 1“2 A4k A 7= i B2 1. 70" (Configure batch process cell) X 1if Al
HZHAS B S PR ARE P R SRR . IR ST R, WA Y S B PR R A AR 4
PR T AT IR A I I e 5 B A 2 R AL

“JA %07 (Start) Thfg SR {E 5 5h/5% A7 (Startup/shutdown) . #1735 (Start) ¢+ BATCH
JE SRR A HE 5k 2 IR S B E N IEAEE AT RS . BEJG JE SR RE P4 8 3 73 A B
A~ BATCH N HFEF. 4T BATCH AR AL T IEFEZ AT RS QAR A2 X
SN R I AR A — ANkt =B I, A feiliid SIMATIC BATCH Zwfi#s (BCC
1 BRE) #EAT TAEAIE R

e
U 5 B AR A 8 (L= AR, AT PR Bl 5
o K7 PCIALE GHENATRM IP bk

A

TG R GE T (WIinCC kg5 LA IR &S as b TAHE R PC 1), KA T
BATCH i fefic (Bl 2 )5, A REEATHZ) WIinCC J& H 3 JH5) SIMATIC
BATCH”(Start SIMATIC BATCH automatically after starting WinCC) ¥ & . 1% K5k
WE, WA POTT R — RS, KRB % B, JIAREIE BATCH b F 50 f iy
N, B RSN ES), B — KRR .

ARG (WIinCC kg5 S A IR 5460 TN PC 1), H¥BHZE S 3)
WInCC J5 H 3l )5 5l SIMATIC BATCH”(Start SIMATIC BATCH automatically after
starting WinCC) % .

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01



S LR

2.3 SIMATIC BATCH 119411k

W
=

BATCH il lllk %54 (U2 68)
BATCH CDV (it 69)
JFi =) BATCH {7 il il 55 a4 (U1 343)
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2.3.2 BATCH #Z il k%25

& X
BATCH il Jilk 55 #5 & SIMATIC BATCH 1) — M 4HAT. BATCH il ik 55 s A 2E L5 3 2 1)
AR FAR A2 2 Fr A ™ A AT
BATCH =ik 45454 B M P Jtiin. BATCH #Hl RS #AE121T RG0FENL OUR
gitt) LRE).

Thee

KA RS 2 )5, BATCH #5523 (8 37 BT B8 Hb A== AT i B i i T
Y. SIMATIC BATCH [{fit -~ $dls (FELAdE) i {4772 SIMATIC BATCH [(J7E4k
B .

TR A Hdls GHED . 25 ERSS &1 PCS 7 OS (WInCC) id FE#iii R A&
GV N

FE H ML R G0 LR A A AR A T HRFR

76 AS HRAE B (AS ZbF STOP #:0) , B Bk h e SN R AR
“J& YL (Properties) >“AS 12172 $”(AS operating parameters) &K Nfii“¢E CPU )i )5
JA3)) SFC"(SFC start-up after CPU restart) [f/1 5, < H3hE AL SFC/SFC A sk fr
FORE . XS OL P FTERAE AT @R A B R RS S P S Bk S

T UiE.

SIMATIC BATCH Fit, V7.1 SP1
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2.3.3 BATCH CDV

& X
BATCH CDV (Ht/E/= & H#E) /& SIMATIC BATCH [J—AN4F. ' RHTRE. 17
it R SR A A Bt (1 i 55 s 41T

BATCH CDV ¥ H L H 7 Stifi. BATCH CDV &7 Windows 11454~ H 11— K]
bro FrREESCH R IAE AL HDRE o N I RE P IRPIRZS . BATCH CDV R#7E Batch )i
A TR IR BB AT R EHL LRSI LAE),

=
am>
("]

BATCH CDV 45 & $A7 LA =TT 55

o WAERIfA#E WIinCC i1 L.

o WUEMAAHE WInCC Ml EAl .  AUBIE R AEIZAT T BOAE A rh 2L AR I B A

o ORMILAE" . BEERE D . BRECIRES IEAE R 2 R e 2R E R

A S BT B H0E
BATCH CDV iR ss)a, Prfsce i A S 8ois 2 4] R G =3 1R 78 2 I 4 e
VN i

BeSh, SATHERGEEIRIE T FATREE T OB (USRI 105 A BB 5 2k
AR TR IR

]
R A WAL, B A R MR ™.

J Al

AR S HE N IEAE SR PIRAS,  IF LB T 102 (I B A B A Sl
FIFEN )5, A A REEN T ORH R . AR LW O REEL S 18], W JCik iR
A7 P WSC AR (10 00 B (A3 B Ml

KR it -

— BT S R R, A R PRI R (AT BB TN B . W R A
AT IEAE SR PRSI ORA7 R P I B A AN R e 2 Ja kA 2 B 8o T
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2.3.4 fLAE =34 5.0 (BatchCC)

& X

fe2E P40y (BatchCC) J& SIMATIC BATCH i FH T4t AR = BRI A A =42 il (g v o
411F. BatchCC EH 475 SIMATIC BATCH MKl . X &A% BatchCC Hidsk
P A s

HEAE PP AR GE £ Batch i 8 B R o EAT B EAEIZAT RGN LR B

&3 SIMATIC BATCH: Control Center - [ROP: batch_01 1 / TRP_1 /ROP_2] g |EI|1|
i] Program | Edit Control Planning Options  Yiew Window  Help i |ﬁ'|1|
Hﬂémdﬁ$M%EmWM»WHMIMQQ&QE

= 2=

EE Brewhi Shortcuts
-4 Libraries
- Master recipes A
Formulas i)
Orders 1104_164018_00
Materials

@ Permission management

batch_01 1

/
‘ 3

—— 2=

E n d I [~ Z0om
214

2 1p2]

!

B MEIN_MULTIPROJEKT | Status: running B T—!

SgAH| | BEEB|E|

L b

= <N0 Name > <no Narme > <no... | <no... | <nonames <. | <., | <., | <no names =
111

-

A 3
09.07.2008  [14:08 Liste: 9 Fenster: 127 |quii 2 |

O 8vnex [1208 4

SIMATIC BATCH F/If, V7.1 SP1
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Thek
1 FH At A= =3k b ey (BatchCC, Batch Control Center) 1] LT BA T #4E
o NEEAREEHIEE N AR e E R
o Jr kT BATCH ZhRgmA R
o ETHIE A FRANAH .
o EHIMLJTAIE 3 BATCH Mt Jy 4 2% LA A C J7 4574
o HIENIICHE HERAE) KA
o Gud. ARSI SAHRA 2 5
o i Sy R A SR R A AT B
o JHZRIEEEIRLAE AT
o MHLIEAE AT, IR AT IO HE R
o SRR AL H

SIMATIC BATCH FJIf, V7.1 SP1
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2.35 BATCH /7 4 5%

& X
BATCH W75 4 #5 & SIMATIC BATCH ) —#573, #4771 TG gt AME oo 32 e 75 M £
VERIBEIE A Fhii. id 7 807 LA SIMATIC PCS 7 TRE RGPtk = 1 B e 414 1)
BATCH *§ % A 5Eal, Wi oM & B .
== SIMATIC BATCH: Rezepteditor - Bib :tst - ¥01.00 I =10 =]
Recipe Edit Insert Wiew Options MWindow Help
DS FH S| s 2|5
de | ® QR ||| W2
Y @00+ |=Fas |
K gib :tst - ¥01.00 _ o] x|| ===
releases: Cath ||, allocates: Cath,, o _ZDDT_
| I 2 114
| ‘s =
| 2|
walt I 5
22 |SeC 24 IW
| b1
CIP_A ”*I
allocates: Cathl,
-
| H
End | ,
[ | »
|Status: in progress 'ﬂ A
0 SVN_ex IWA
Thge

f /1l BATCH Py G s 7T LLERAT DA $4: -

o QBT AT T AP ER AT

o EHIA IR AERAE (SMSSEEED
o USRI AR .

o D IMAE A H ) A AT RS AR A

o AERCTT .

i iZgn e E I, MS Windows F2Jip G IZhAE CUTRiG. BT00. R S A A
) AR AT R A S AT

SIMATIC BATCH FJif, V7.1 SP1
72 BRI, 03/2009, A5E02171120-01



S LR

2.3 SIMATIC BATCH 119411k

2.3.6 BATCH &EZiiRE

& X

1o AR AT AL TR O LA R T A S C AL A A«

ST KRR T BRI C 7 H B BATCH AR =il (T A 5t . IX G 8 C 5 b it
Bl ANPYR A DRSS ERA RE

A HAEAE HIAE R SR RUEREAT VA ESR i e iE . Hhg
FERR RS . I s . A L S RS R E E
DY S(HAR RTINS

1 ARG AL O P b ey H SRR R R A A A e P o
AU, TRl AT B A o

=
am>
("]

FEFTIT IR (BCJy Bdte A2 Hs) v, ol DU HT 2 20 H S SN Io K

[EEWAPE i Ra SV
Hc s oo RE
Py Ak
AT BB
Bl
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74

ActiveX #EHEIGHR

FEAT BN I IR) 54T B H &I, 76 Windows 2003 Server SP2 &, Windows XP SP2
BAERG P RS LA MBS E R

UL ActiveX AT ICER S TP S TC RIS H T e s AN 4. 21 AavFib i
fE? 7,

WER L R, PN ILHEAT AN

A T e S S A U 2 A ) R R e B T S (YU B)7(Start) >“i2477(Run) >
gpedit.msc) .

“THAHLEL & (Computer configuration) >“& B R ”(Administrative templates)
>“Windows Z1f"(Windows components) > Internet Explorer >“Internet & 4=
#il"(Internet system control) > 4> i1 [fi]"(Security page) >“A i vHHHLIX 15" (Zone of
local computer) >“¥IIAL FFIE 1T AN %24 1) ActiveX 44" (Initialize and run ActiveX
controls that are not secure). K i & MO TGS (Activated),  FERF LA &
UM B (Activate) .

R T B B B 3R

HA7“4k4L"(Continue) 115 AL J7 1 Bt (RP, Recipe phase) nJ il i Al #5 ¥ & f“4k
42"(Continue) ZET A FIZSAL ) RP SKIEH,  8AE HL I CHE 7 45 RN H 3B Hitk RP.
12 A SR I, A5 RP AT TRP (BT BEEA AR 2 PR - Il SR PR d Sk i
TH.

K AL = I B FE R

JAIPERI AN OS Uk b At = H AR 2 . BRIk, 7E3Eeihid =, IEAEE T It
A HAE T EN TS A & ol (. XFE, 7EPAT KL 2E =" (Close batch) 45,
HEAE RS AT RE AL 2 15 73 Bl N IEAE S (closing) BBk £k 17 (closed) «
BAHERIT

TR AR SOVFRE T U IR K it 3 H St th 1 A . A 7 SR s 1R B £
(Crystal Reports), in[HHATHRA HE BT HERE, LITEMRS A% 2Rl v ik
{841 “BATCH Advanced Report”#i1 SQL fili45 %5

SIMATIC BATCH FJIf, V7.1 SP1
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=
am>
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2.3 SIMATIC BATCH 119411k

BATCH Mk

M V6.0 F4fi, SIMATIC BATCH nl{fi fH TR RGiH SFC AL Thfe sk e AERAE R
BERA, ®i#, M V6.0 JFEAH SIMATIC BATCH 1Rt —self sk it 1 B, 14
A gm PR g LA FIRE R A T AR 1. IX S FTIE ) BATCH 32 1 Bl B e bt
SIMATIC BATCH izt (FiEZ WMl BATCH Bz LIEE (5T 151)" 543 -

BATCH #2 LB K% T SIMATIC BATCH 5 A zhik R4l B oo il R G AL BERE P 2 A]
(M. BATCH $:H Bl CFC Bt A5, R4 IhEERG AN 2] CFC K,
Atk AE SIMATIC A FE2E 1) AR AR A Y (K 2 R E e Y

BATCH 2 18RI SIMATIC BATCH — 2 H ml s B BA R Dhfe :

o EHARIETT:
I[EPH/IEOP S TSl HK . EA TR Bt LA il 2 A PEbR (Bt SFC_CTL &%
P B Ry FEdE < (BIAURSIECE 15D o ACPLBR e 20T RS st it
G L

LIS L BUE Gl L (PR Woa R LT
IUNIT_BLOCK HeH] S8t H 1

o UMHAIEEAL S RIAERE A H A P SRR SE B (A
TAG_COLL S T3t H 1.

o ALILBE AL FE(H:
IEPAR SJH FseBlst HiM. b2 iilisid IEPH/IEOP Huf db BRI T 28 (B
GEAHD BANRXLE, AEEPUE SRR (SCBMED S IEPAR B, IXAEAE AR
TR AE ) IEPHIEOP Skt Hdf 474t g A= Hidfs
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2.4 JHF SIMATIC BATCH 194185

2.4 FiF SIMATIC BATCH K407

2.4.1 SIMATIC BATCH & F HURS 281 R G514

EPHUIRS A R R 4
SIMATIC BATCH i % 73 At -4b B [7]— it R TG I H 1)L & BATCH & LRI — 6
BATCH 55 % L. BATCH J45 % A JE B AE 53 (HMI) 2100 CRITAE BRA0e e o 43D
[t) BATCH 75/ BLE2 (1t 5%

5 PCS70S A H

SIMATIC BATCH iz 1705543 PCS 7 OS.

o  HulymfRiEtlatrimin (g 5 7 S et AEE) th PCS 7 OS RO R F 2%
KALPE,  Hef)iEie, SIMATIC BATCH A5 B 1E 4 n] g Fa s bl o (4 11

e BATCH 4523 M1 PCS 7 #:4F Giuli ) OS R 45 28l B AE AN A T HENL LigdT. At
PR R R ICAL A, K BATCH R4S s Res -1k 3 51X Lot 2 P41 5 ) PCS 7 #:4F
k.,

e BATCH &/ MLl LAsphde—& PC _Ligfr, tHarbls OS &/ Hl—dE— 5t EHL
g4,

SIMATIC BATCH FJIf, V7.1 SP1
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2.4 )l F SIMATIC BATCH 1924 &0

HASHI LB
SIMATIC BATCH PCS70S: OS &F#l
BATCH fr%5 28 BATCH & #1 1 1/BATCH &4 2
( BATCH ##IfR%S 3. &
BEERS) . ™ oo
ok ) S—
KR ELk
PCS70S: PCS70S: I TR
0S R % 1 OSHEE2 | |
—
L, Lk | .,
TR EL
SIMATIC S7-400 SIMATIC S7-400
I‘II| HHHM I‘II| HHHM'
L L

HWH M PCS 7 #/ERMKKE PCS 7 W H

SIMATIC BATCH SZHrA &0 A s DLl K PCS 7 T HIX RS . IX RN R AE
TREASTIHITIELNRAEL, SIMATIC BATCH stnl LI PCS 7 T H 9 (4 F #:4E i
v, R AT L )2 30 H R T R g s

e BA PCS 7 OS Mt IiR (A PCS 7 #AE R

HAT A IEA BN IER T RS PCS 7 8E Qs et g /N2 b4
HANPCS70S, i%PCS70S fl BATCH R4 #3446 TRl G EN . it EN
B BAT — A i%ER: SIMATIC S7-400 [r$:11,

TRARGHHIE Bt

10 TRk SIMATIC & Higs b 41 4 BATCH JRS52:51 BATCH % S WL 5 v w4 A8 Ho
474 PCS 7 #4E vk OS 45451 OS —Ff, JEMiZb FEdls.

BATCH & P LM & A E &
— & BATCH JR%#si % nl % Hz: 32 & BATCH %' #l.

SIMATIC BATCH T, V7.1 SP1
5 FHF, 03/2009, ASE02171120-01 77



S I L

2.4 JHF SIMATIC BATCH 194185

24.2 BATCH I R4

SIMATIC BATCH $2ftZ il il- BATCH N FHFEF A A fEA R i 4
AR | LR Bl
1 L) 1 BATCH #5545~ P S fr ik R A
BATCH & P WL P — G irENL L, 5 PCS 7 0S
RS54 F1 OS % 7 Hl.
2 AL 2 BATCH #5545 T Bl i R4 A
BATCH &/ HLN R FAE— &1 5L L, 5 PCS70S
45250 OS % S BT
3 ARG 1 | BATCH Ik 55 28 F1 BT A B dif7 i RAEAE— G EHLL,
1M BATCH &) WL RSP AE 7 — B AL
5 PCS 7 OS JIk55#s 1 OS &/ HLor I -
SIMATIC BATCH A UL T =AM s 1817
e UiH DB: M/ BREIE A7k
o H4DB: M. A, YEEIEEE
o {rzk DB: #HbA - Huh it
BATCH k4523
BATCH Ik 45 24 F1 BATCH #t#5 45 B (Batch CDV) & /&7 T BATCH Ak%5%s L.
SIMATIC BATCH Fit, V7.1 SP1
78 PeET-F, 03/2009, ASE02171120-01
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BATCH Z& F #l
W IEFRAE BATCH % ) HL 43T LA R BATCH 2 7 HLN HI R 7
o kA==l (BatchCC)
e BATCH i Jj 4wl 4%
o APl M
B DA 8«

A A A N R wIAT I o A F 2 3 i W], nf 2% (s R4 PCS 7; PC 41
BRIFBLY (Process Control System PCS 7; PC Configuration and Authorizations) F
ﬂﬂo

243 5 MES/ERP f8:0

i1k SIMATIC BATCH 1) AP/ #2217 B4, w57 SIMATIC BATCH 7R 2 I B 2 D fie
5 OEM ARG s MES/ERP M FHFEFF %% . APl % Mt COM IE#: (XML Hidfs
%30

K APl 07 (W REFI AR IR B, 1S5 %] 8 1 R SO R 23 B .
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2.5 7k

2.5.1 SIMATIC BATCH =5

&5 A
SIMATIC BATCH #2fit— N EA— R4 H T2 08 e 5040 1 vT 3% B4
HEARMAEA
SRR RS AU A P I A A S BON SR HE S R . AR IS 2 AL DA
YA
BEXZH43
BATCH ZEF B AR BATCH [RE 2R AR
BATCH ##IfR% 25
BATCH #2 &/ HEFREEE
(BatchCC)
BATCH 1R &
BATCH #Osk
BATCH B 5 RS IEPH.
(BARES ) IEOP. TAG_COLL,
IUNIT_BLOCK. IEPAR...
BATCH L2
AN BERRAGN TRERELGES I HE .
- BATCH 10 UNIT V7.0
- BATCH 20 UNIT V7.0
- BATCH 40 UNIT V7.0
- BATCH 100 UNIT V7.0
- BATCH LRI
i

BATCH T#2: HIGINEEZ“ IUNIT_BLOCK'BATCH £ ez Fl. A ZFEH 50
B BosAErliE N BATCH ARSI HAGE . 35 W Bos oo™ i .

SIMATIC BATCH Fit, V7.1 SP1
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WlLE
2.5 2k
Gl 7<)
BRIEAIRAF AL, BT LA DU AT i
AIERE S
s 70 A
ERE S API 00
ROP &
(BEiR4E)
ZikEa MH
AR R FeVF{E BatchCC R4l itk
JE S FVFRR A 1ISA-88 Gt 4 RP. RUP. ROP fil RPH /244 i
]
ROP & (FE#4F) SOVF I M B ZE 15 A
G BRI A W ey DA ] A R U0
AR BT BRI A 5
API $%11 DK AE AN LB DI RE, 1305 MES JE4%
Z 1

WoRHLIUEL (UL 179)
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252 THREK

BEFER

SIMATIC BATCH ({fifif}- 35k 55 PCS 7 [ fF 3k Al [, SC1“pes7-readme.chm”efifix
SRR EIRA T U . WTECL N ER AR TR R BNZ S “FFUR"(Start) > SIMATIC >“7= & i
B”(Product Instructions) >“#i&”(English) >“PCS 7 - HXAX#4"(PCS 7 - Readme).

SIMATIC BATCH it %K :
o fifE EZ041 250 MB SRR ). 5 RS T H MBI, 3 7 E AT 2

8]

L

Bt PRI A e 4 0 B W] AR A N, SIMATIC BATCH iz 47 ] 1H] )

RE H B 1)

MB) .

A ORAEGE . B, THI IR S T HIAF 1] CRT 300

o —EHHTHTEIE T IREMFTEINL. Windows SZFr. EA BT ENThHE AT 4T B
WLAE S . AHAEH HP Laser Jet 3T ERHLAEE MR

BAFER

SIMATIC BATCH & —/> 32 i N, ZRATH MS Windows #:1E RS,  DAZil 2
UK 5T AE PC LA SIMATIC BATCH 4144

A

& Tk

BIERA

Microsoft Windows Server 2003 SP1, #%4 Internet Explorer
V6.0 SP1

Microsoft Windows XP Professional SP2, ¥ Internet
Explorer V6.0 SP2

Aol 7

Microsoft SQL Server 2005 SP1

fiE T TCP/IP

%2 W, Windows R 45k E

82
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M %2
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Nt

Ez%‘la:
o TR & Rt itk DVD b sb-readme.wri A T SIMATIC BATCH W& S
Ko

o X PCS7 I.] PC B ZRMTEAMER, WZ% (PCST - PC AN
(PCS 7 - PC Configuration and Authorization) /i .

SIMATIC BATCH Fri& B#E R G 15 IR

%4 SIMATIC BATCH 2 &, FEF44E Windows JTI /7 FiIZH 5 B b 41 A A 41 “SIMATIC
BATCH”, %4l %t SIMATIC BATCH JL52 - Ji“shdata” R 5¢ &V AR . ERA
LT, #4223 T SIMATIC BATCH (1 H P AR P AR HB A 31 5 o i 21 1) e il R
WAZ R B BT BN N

SIMATIC BATCH F i, V7.1 SP1
A, 03/2009, ASE02171120-01 83



S I L

2.5 gk

253 VFA]E 25 4

A B

IR A FTHE

¥ RATHE

84

TPV (B FATIE) A REAE ] SIMATIC BATCH #f4.  HUAH B shibiFal ik
EHLEE (ALM, Automation License Manager) k31 T AH N O 22 255 A0 VR AT UE 25 41 I
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BATCH %7 #Hl, TZAE SIMATIC EHLas Al HI IR 55 2 F1 25 . HLN IR P61 SIMATIC
PC uifxt b TR ARG ML) JZR A AT R oo, gL T3
BATCH /g% #5 il BATCH % 7 Hl. AU edmie OS Ak A= fE oo idis, SR
AT N
RIS miE s i, THAIABATCH NHFEF". BATCH MR PR EAN SIS
AR R4k 57 (Components ready) 145 B 7E i 2 A4 i 2% b .

mirEE
WEREAE R H AR, AT TR, F 223 Internet Explorer V6.0 SP2 5 5T )ik
PN
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5.2 5 SIMATIC BATCH ¥ T2

5.2.1 BITH TRSZH TREZ MEZEH
AP T R TR AE— & PC CRITH) L5EM, ufEZ G PC (21

HD L5ep.

BIH T
FENIHE A P R e, WRACE A A TR, WIESRTH (B—5 PC) H5gmk
TR,

ZUH LR

RS IR e, M2 S TREIMAEZ & PC LRI HEAT 4 2 W 6 2
XarpoE i 2 I H TR & PR PC B AE . TE A8 2 T H
%, B RRITH AN H S I E—GH R ESPC L.

5.2.2 HMINE T

5221 Bl gmiEm MR E 2 f5 Ak &

AP IR 200 ] T 4 iy 0 A3 2 199 2 rh R L TRt b, AR TR L 58
A ZIH

B, BOLREE MR I H TR w4 288 M SIMATIC BATCH V7.0 82, AT
2 100 H A R AT I H DABEAT SR AR T AAEREAN I H v G At A 2R

TR

1. 7& SIMATIC & B s hk BEELMBR M I H , Sy BT AR DS bk P i 242 T
H"(Multiproject) >“MIEx H F4s%E..."(Remove for Editing ...)-

2. SRJEILFEAH H SRl 2 BR AR AT AAA . NI H Bl 2 B ik At IE A Z I H
Fhmks . BBRIIHAEZ I0H AR . JGIEAEZ T H PR AT 44

3. MK BHITH, Haia I PR S 5 i 2“2 T B "(Multiproject) >“4w## J5 B HT N
Fi”(Reapply after Editing). X200 H s LRI 20 H HH . BAE, &rrbigk
HHE AN ZIHE .

SIMATIC BATCH FJIf, V7.1 SP1
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5.2 (/1] SIMATIC BATCH /1 1 7

PAUF 2B A AL BRI .
FESRBUS T REVEL 103, 1 e/ o8 e A

AR C A B PLC filiff 4%,

BIHE ) LRED R

AN B R R BRI AR s B XY 5

H CFC il SFC KR Al I Fgie. N HiffE &

XE{EH SIMATIC BATCH Gt fic /7 Fth A= =45 il i 4di B ES ZHASAH K.

5222 mrEAE:
&5 A
Fk
AT H TRRHASLH

£ANIE

T FIhEE

«S7T D

« 475 BATCH &4
« 4475 BATCH fR5588
« 487 SFC 2 #
«4AZ TH

QIR PSR B T REAE
YR ThRE

o XFIA :

ciRE: 271,08 JR
 WFERETT:

- 5323 OS

« T&

o XN FHEEFIEA

. IR

< 4R

- @5

o SIFHEE =41

o iR

o« IOHF

ES it&E#

-

L

112
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SIMATIC BATCH ] ES A/ &M 182

SIMATIC B8

487 BATCH BRESS8 A
BATCH &/ #

7
SFC : % SIMATIC BATCH
B2 SFC 38
*4

CFC : f#f SFC 3#!
ETI R ] L4} BATCH
7 EOReE
AE OS CFC B&

!
fEEHE OS
ML AEF=HFKH OS
s WMRFEE K EFHSMHM
STREE T

¢
¥

ERMmBEAE=RE
¥
iRy at AT
¥*
IRIFHEE SRS TR
v
Wi
iR ?
=
t£#£% 0S
)
THitE~I 28 THiE
ATC; P & ( ﬁ:‘?ﬁﬁﬁﬁ%ﬁﬂéﬁm )

iy ? TREER T E
g ( BATCH BR& % )

Ho

<
<

%) PCS 7 OS (WinCC) 7
BATCH BR& 8

ity 7 DREEETEN
2 ( BATCH &7 #l)

<

/83 BatchCC
RATEE THIE
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BBt AR A TR

L

WERAE T IEAYER] (CFCISFC K3, BEMFRCE . T) JRH5%) , WA S H i e
FICEE IR L R3] CPU (BATCH JiR454%. BATCH %)L, [RIIN 442000 Ly dtk A
AR A B A% 1L BIHRA DLk

FEBLZ R, IR G AT 4 OS.
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5.2.3 ZINH T

5.2.3.1 H

=550

KT 20 H TRRME RSO

Z AR ME— P
TG H B — B

(I FEFEHI RS PCS 7; TR ARZ) (Process Control System PCS 7; Engineering
System) FNHEHt 7 PCS 7 Z i H T M /. 1 /L “Electronic Manuals, PCS 7764 1
AR . X ANE RO, LB 1 AR T 200 H A K& % ST BiH
Z A RIAE HL

WAE PCS 7 AR B I G T 2 I H BN T A 308 R B 25 .

LU E B4 SIMATIC BATCH H4L LAt A i R 0] Bl A i) B D TR 20 B AH
Ko

Gy

WHERS, WL TR RS £ 4 ES PC, W F 4 FK B 7 B H # 4 4 FR b 4
FAT ES PC _EME—, ik 704 BRAE AT I H v AU

BATCH T H (3 H A 194 fisfe PCS 7 FRBEtp Il — K,

IAZSE SIMATIC 45 BEAR 1 7 W] e P AT ORI B, SR 26 PTG

YERRI, Hifs A CRMTTZIH R & ATH I — 2k, IXJCHIEH] T2 S WA SFC

SIMATIC BATCH FJIf, V7.1 SP1
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WHES
TR
Z I H T T IH B AUE R A —MiE S A RN , RIG S —FE S
A, WM B AL H K, SIMATIC BATCH R Gk IEfigmidte. JRBEEMMIES
BRI S B FRAA

ZIMETHE

TR
VIZVEZ B H IUH T FIZEA ] ) PC _EREE 2 A PC il Zs. wmird & ma 24
MRS (B4, —A> OS Fl—/> BATCH Jli554%) 54 PC ufi,
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524 EHPALIE LE

5241 nEE: ZHWEHNTESE

SIMATIC BATCH &£+ & #1210 B A5

HJefr SIMATIC st , 2GR ESPC Lald M2 UHE %, WETf S7
HH MY ES PC AHRHIIKEN (5 B, #EAEIX Y ES PC W2 I H ~41a S7 BiH . b
JaRl{fE£ & ESPC (PC 1, PC2, PC3%) LFINAHANSKN S7THiH. BATCH ks
REHE I —& ES PC (PC 1) LA%&.

P
AR, WELLZET g ES PC (fln1, HA5 BATCH RS20 HEHD Fa AR —
ATUH . BN TR UL G W, SRR T LR R B s 47

SIMATIC BATCH FJIf, V7.1 SP1
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ZIH
“UREBHLAE PSR B T X R AR
IR AITINEE : ik SIMATIC &2
« WFZWmAE : ES it&#l Py
- IRE: A, e S7Projt
OS MR, LT e E S7Proj2
c WFIRET: |- . N S7Proj3
- f£3% %] OS T =
* T&
o XFHL AR
. g
CHER
o 21
]
o JFFHEAE =324 _ .
. AR . S7Projt | S7Proi2
- iF || | H |
HXIEERIZMEN \ \
AIHRATIhEE -
< STED
< 4375 BATCH B #1
* B35 BATCH fR%5 8% ES it&#l 2 ES i 3
< 4075 SFC %R REil
* .ﬂ?& PH =y He =
R PR R R i ket
FIRATIRE PR AT i WEBIREF
o NFHEAEFERA MH bl
- EH
. /\iﬁdé
o X FHAE LS AT HRITHIThEE AIRITHIZhBE
. iE . STAR . STAS
« I « 75 BATCH B4l « 4875 BATCH B4
RS R - 475 BATCH BR% 28 - 4875 BATCH BR% 2
« 47 SFC R « 47 SFC K8
« 87 PH < 4875 PH
‘Ut E R RE T EERN HEIE SRS T IEES
A HRATINEE : B RTRITINAE :
o JWTFHEAE KA o T HLAE YA
. UREE . REE
o JFHEAE =45 o X FHEAE =241
o IDIF o IOIIF
< AR B - A4S B

SIMATIC BATCH /i, V7.1 SP1
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Zan

£ B+ SIMATIC BATCH [f] ES 475/ 4 Mt

5.2 1#/] SIMATIC BATCH /19 1 72

Configuration in the
multiproject

SIMATIC Manager

Create multiproject with projects

(PCS 7 wizard)
I

Configuration in the
equal priority
projects

¥

PCS 7 configuration (standard)

)

Configure BATCH server
and BATCH clients

¥

SFC: Create SFC types
for SIMATIC BATCH

F

Create
plant hierarchy

1

Compile OS

CFC: Create CFC charts
with SFC type instances or
BATCH interface
blocks

y

Batch validity checking

T
¥
L]

Compile batch process cell data

I

-

Configuration in the
multiproject

]
Specify message and batch-
relevant OSs
Update distribution board
and process cell if necessary

[

Generate and edit

batch types

Y

Batch validity checking

~

Collate and compile
batch process cell data

Validity Yes

Error compensation

error?

Transfer to the OS

i

Download batch process cell data

]

Runtime PC: Start PCS 7 OS
and BATCH server

i

Client PC: Start BatchCC
and read in total process cell data

SIMATIC BATCH Fjit, V7.1 SP1

EeEF M, 03/2009, ASE02171120-01
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BBt AR A TR

L

WERAE T IAYER] (CFCISFC K3, BEMFECE . 1) JRHAE) , WAAZI R g i e
FICH,  ELAAZIURE L AR A SR IR R A 14 B R A Bt R L 38 CPU (DB k45
#&. BATCH filig54%. BATCH %/ .

FESHU AL BUIE POl 2 3, WHUERi % OS.

SIMATIC BATCH FJIf, V7.1 SP1
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525 AR EZIE TR

5251 MR K 41 IR A F A B B v R S I

fai g

LEASCRY Y, FRATEA 4 SIMATIC BATCH B0 /i N2 I H TS, Horp b &3 1 £
P2 HS 2N AL O H 2 A2 H . X H LGS SIMATIC AS #h.
I (P71 e H NEF 2 0 H R e, B eiaA s a2 0 H
AT Z I H B R T, R ETIN A 2 I H IR, e FR e AT 146 Bl
FIEP X ZIH T

Hi¥ BATCH 3l H AL H AR Z I H AP AT gdt, DUk, X5F SIMATIC
BATCH )0 A2 WU H TR, AAZ07% [&— U LRI BR ). A TR A g L5300

EPALWAEATRE: HH

LA XL H TREAN S, R A2 H TR RS AES. Bk, fhA2m
H TREA A SR H 1 3

Bi B

HRZIH TRIPE, ES IR (PCS 7 V6.1+SP1 Z i H T 2414481 (PCS 7
V6.1+SP1 Configuration Guide for Multiproject Engineering) (7 ID & 22258951)
(http://support.automation.siemens.com/WW/view/en/22258951)
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Ri& HX IE3CHR
Hr%s
i
FEIE T H AL H 2T H B —#%, RA3% SIMATIC AS 411 (CPU
DD
ZIiH ZIH¥GZANIEH FEERR Tk, LB N2 B sk | MP
&, I H kSR A S BIH
ZIH TR Z I H I H A4S MPE
Frh L2 Ui H EfgfE e ES 23 H . CMP
HFrp 2T H TR fER i ES PC L2 I H KA ST H . EfId&sAE | CMPE
K 2% (AN A ES PC 1 AR$:[A 2
A2 IH —MZIH, AEHLPEA—ANTE DD g, B ST DMP
o
AR ZIH TR ZERAL, W TAE AR I TREA A, M ISEARALE T | DMPE
RAMER AT 0 Thhe.  ABAI7E A X TR g i T RE
i ] SIMATIC PCS 7 404441 PC. ES

SIMATIC BATCH ik £ T H LR EXR
4 ] SIMATIC BATCH #1147 DMPE, 70t i T #1325k

122

BT I H KRB S AS B

FEETHH W AEAT A REE REH, SRR E L. HFEBuiEs.

WAHEY M B PC 835 H b T PC B 2234 [R—AS PCS 7 fiiAS, ALFEAH N A4k T
FNT £E At

WAHE SIMATIC B H g th AT T A Cn“ABAE07 “BR" . “UIRY” . “EH3RE
2y

TEHHEASL T CMP L BEAEAS Lk T & 2. &2 BTG DMP [AAR . %
IRUE N E R PEAL R 450 ) 3P T DMP.,

CMP b HEfd H] SFC 2%, 4 DMPE " ANRE{# ] BATCH 4215 EPH. IEPH.
EOP. IEOP. EPAR. IEPAR fi AF .,

SIMATIC BATCH FJIf, V7.1 SP1
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o HfEft CMP K1 8udla e AT T 1413
— U SFC AL LI I H R € [ Bk

jj:T‘:,—‘-:I:‘

- HEFE,
o ARSI IAT Ktk SFC KA AR
o AREEMAIIH.
o —ANRITAREMAEZNIH
o A AR ARG I H v ) BT AL FR AL AU [ o

FHASIE TR A
PITAT 2 5 | T 08l P A A AR AR B0 8 A 7 R A A A Z0AE CMP AT
o L
— AL
- JCEFEYIR I e R
— ] A S

o GIFANIR SFC 257 (typical)
Typical AEBYBERAL, flln, In#he AHL Rk, 55, QXL B S, )
CATHEAT 78 3 MAR,  IXFE(E v AR LUS R SR R SEBIE T S PATATA] 5 5 o iR 2
TR K AR, A AH R ) B So) mT e e A b, B DA 25 J8r 4 A i 5K
il

o QY

o BUEANIL A E SR
o G AN

o OIS

o KB HIT

SR AE PRI REAS
e CFC K%
®  WinCC if F i i
o AL G, AT HAETS

SIMATIC BATCH FJIf, V7.1 SP1
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7E DMP AR AT SRR L Py 2%
o MicTr. b FRA

o IR

EPR—IZI 7 84T DMPE?
58 SIMATIC BATCH ¥) DMPE iR M Be I %) 3= 2 i 48 3 2ok 88 o

HH P B CYGE BT SR AR S TC DI RE T, AT R 2 A 3 Bt A 7= S e b iy
BB 2o AR IEAE A $li 2 mh 1 Kl SUVE, AU AR IR 2 A 1
BEAR A I A IR

B, XN 2D HOR S B S R RN R, B, dedB O A TR N T

AR (BT 125):  £E CMP FHRSRIIN BRI H A2 3= 50

AUR 2 (V1 126):  7£ DMP Rk &M H J R, B .
VR 3 (U1 128):  {& DMP Hgaf . PAFIIERSI0H o

SR 4 (U0 129):  4E CMP R RIFH AL H .

SIMATIC BATCH Fit, V7.1 SP1
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525.2 B 1. 7E CMP HIEMNFMRT B & EHHREE

DR G 4 110 A8 (R 0 H A 205G BEAT VAR, ARJE PR A2 0 H IR . B PR AR 1

Bk
CAE R TR B TP H L MP AT H . 3L AS 108 X%, T.J-
JEG HEA 3 BN L

TR

1. R I H AR H P IH

2. NZIUH P IERAS T 2 AEIR T o eI H SR, i BT bR SR
P 2“2 T H"(Multiproject) > 2 Tt H # MEx"(Remove From Multiproject).

3. IR ERR . “SCH(File) >*J3#5"(Archive) >“/&”(Libraries) &I+ > i LI E
FHEEHHE"(OK) > EFAFE KA IHORAT -
WAL ERAREE P AT, WAL A CMP A28 AS TiH , 1Y . DMP
o [E) 2 DA A N TR

B
7

FRIRIUH A 8 2 A7 A ZIP S0, e %3155 DMP.

SIMATIC BATCH FJIf, V7.1 SP1
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5.2.5.3

ikl

R

i

126

SE2: £ DMP FIkRIHHATE K EHIEE, BEORE

MR 2 T H A IR R 250 H ATAR . (8 = 2 2 L ZIP SO AARIE B T TRE A A] . AE
AL, AE 2 CMP RIH AE S S A IR, I SAVERTILEEAT HE— 2P I 41 25 S Bt e R st

(AS. OS 1 BATCH i fE#:0) .

C2ME] TR SR CMP R0 H AN 3 K s

LI RO 40 R T B o A TRt L h AT (i AT 55
1. WERHARER AR A —A AS TUH 5 A A Z IUH (I H [ 4%, 35 RS H B A L

JEAEH, ARJE1E DMP BRI H .

2. BRI H il s 4 21050 A 302 T H (1 H AR A2

“CA"(File) >“f# 45" (Retrieve) > i FE SR 5T " (Open) > %EH EiF XA G&#
M E"(OK) >“Hi & "(OK) > 2 B EMEREIZ I H Y5 FH? "(Do you want to remove
the references to the multiproject?) “Z"(Yes) >“Z"(Yes)

3. fE[—H g Ik AR B HAR . TIPS A I ITH , IIER e A 7 o

JG”(Batch process cell) %%, FHIHIER ISA-88 2571 X I e T 250 AS Hidik
(MAC #itil) o CAEN S7 EE T REAEH . 0] 2088 5 IAOC N RS .

— EREIUH, ARG EEE O g R A I AR R, R A IR L
“Ii%”(Delete).

— (ET) MK, aEdpe Ak B eSOk, A R R RS A N B R
P%”(Object properties) > 7E“1SA-88 7 5 X "(ISA-88 type definition) 3T 1)k +¢
HEFPIE R <H M >"(<neutral>), RJ5 >“TfiE"(OK). MIBRITA 29+ I i
BATCH #riR4F.

- AES AT 2 T H NI E R
EFEZ I H S, FTIFIRGESE T e $“ % BT B "(Multiproject) >“# A\ % T H
#”(Insert into Multiproject) > %&£ 1 H 55 3= £ 248 J5 s b i e "(OK) o B4l NI
578 A HH P

SIMATIC BATCH FJIf, V7.1 SP1
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5. 5 I 5 43 2RI H F I 2 2 B A A TR D
WEFR TR SO, TIPSR F ¥ it *% 1 B "(Multiproject) >* ¥ %751 H "(Adjust
Projects) > 741 JFIUXHEHERR, JEHFII B LR LLK " (Ethernet) T, 4R #eifi
“PIT(Execute). 7EHIILIOMTRHE, JEHE IH NI I FFA A5 7 ok LA
AF* 35 (Merged) G T, 7E“G 376 Hh, EHEERMSCI, BE FRESD
fif. SRJE - HE"(OK) >N fiT"(Apply)-

6. A TR IEATINK, H&—M AS 2| OS 1) S7 % .
F17F NetPro > 1%E# AS (1) CPU > fEIEHER Tk H— AN BRI E, FTIFIRBESE I
Pl N BT B2 (Insert New Connection) > 754 A 1i%4%”(Insert New Connection)
SHEHEF, EEESCEIe L2 H . xxx”(In Multiproject: xxx), ZEF“WinCC 1 ]
" (WinCC Application) Jf-#iifi“fi 52 "(OK) > fE"J& 'k - S7 ¥ (Properties - S7
Connection) X AGHE - (RIERZEAR T, WAINCIR R 812 o b FEA AT AR P-4 1 Ll
“tfi 2" (OK).

7. R A I R R TN B AR A BT E .
FEL) B Ik R 2 10 H S, SRS FE RS B B B A BT 2 (Insert New
Object) >“#tA4E: =1t 72 5. 70" (Batch Process Cell).

8. & A R ICI R AL,
EPETIZ e, FEPEESE Hrh s X 4 )& 7 (Object properties) > 71 J& P4 %] THHE )
“ISA-88 %5z X "(ISA-88 type definition) JETH-KH, %1 L ¥ 0"(Process cell) 1
XTSI " (OK)e  HEAEF= I R H oG S s LR AR (T 5.

9. CMP Jrfy ot H p it dte A= i 2 e i 2 Aot 5 5 MP i R s il /] 2 o2&
SRR T IR IR A

- WEMWAZHH DI H A ¥ CMP I H 4585 DMP Hh# i 5 4 FRikfT
P SRR A A o

— LA Z I H 10 T H e 2R AL B
10. G JF N EPTHRATIL H K] AS .
1. 18 OS, RJa%iiFIf H k.

12 BFteA  IRE T, AR ARRI A I, S IR e, R AR I 2 OS
I F A e df

13. it A =4 0y (BCC, Batch Control Center) H (kA= 2= odis

I ORAE SR A P B I AN R, TEANE SR S B BER RS A RR. Wik
BEO, )RR B A = s i L B BT B R 6" (Update process cell) X1 AEH T
NE SN G5BT

SIMATIC BATCH FJIf, V7.1 SP1
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giR

7

128

WK CMP Ak ES ALX 304 X ES ERIZIH .y T AER AR b I slpr 42 1)
Thg, QI TR S7 Mk, i TP ES BEIFR MR AS. e R TR
R UR = SV s /G (A SV €11 W2l I S DIVAE S S SR e T <0k (1 4 SV U s i 1] V)

s T HeA

S8 3: 7E DMP 4wiE. WA IHE

R B g R A N (0 H AR R FEREA T IR AR A IR 2EA%R 2] CMP (5T H .
K AR T H AN 52040 7R B A DMP P gEAT AR A a6 221 B

SERIT A IS, AT I AR R I RS O T AR OGP BTA IH
“SCAF(File) >*J3#4”(Archive) > JEFET H >“#5E"(OK) > &I K B2 >“{R77"(Save).

Rt — bR 1 I H R R AT TR SRS SR H AR T, DU
R E A F] CMP.
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5.25.5

fai 4

Bk

i

5.2 1#/] SIMATIC BATCH /19 1 72

$® 4: 7£ CMP ik EMIHEATH

FEMOP R, f I H ER AR R CMP.,

oale s TR S E DMP I H .
AN T e PP A AT S

- WERAE CMP () H bR A2 AEAE— AN RIA IR H 3R IR .

#A1E SIMATIC & 22 >“C4"(File) >“fiFkx"(Delete) >“f T H”(User Projects) %R
+ > BBIRE >“HiE"(OK) >“&"(Yes) > (0K).

W10 H AR 462 CMP F H b 12 .

7£ SIMATIC & ge 4 >3 4" (File) >“MRE45"(Retrieve) > %3 IAY >“FT 7" (Open) >
B H AR B ¢ > BiE"(OK) >“BiE"(OK) >“1"(Yes) >“&"(Yes).

ViR
B I s 4 R S 0 A s R E MR B 2 1 H ()51 ? "(Do you want to

remove the references to this multiproject?) iE£“/&"(Yes).

MRS P20 A - 87 4%, M T AS 5 OS Z A fh i il
19t NetPro > 4% AS 1'[1) CPU > i AL Tl A Y S7 4k > PR >
Fx"(Delete).

BiA
IR T IUAT ST ) AS ik, WA Z0HCH B i CMP Bl

Mk BATCH I FEFITHRIRTT (ISA-88 HY5E SO FRMIER A= i B e &

— (EL] R, ERRIE A e R eSO, S AT B IR PR Ry
4“3t % J& PE"(Object properties) > 7£“S88 K% 5 X ”(S88 type definition) i3+
EE<H II>"(<neutral>) >“BiE"(OK).  SCIFIE B bR ISR L AE = AR IR R K
BB o

- EL) WP IEReiH > 7R i O bk SRt A R T > TEREE S sk e
“IR%"(Delete) >“#iE"(OK).
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5.2 (/] SIMATIC BATCH 11 1 72

5. i EHEAT NI
FERT A CMP iR T 30 H 2
R SCMIER T ALK ID?
THUZ SCAT S IR A8 FRAE T AT IO H AR A5 #SAR 1] 2
AS [y MAC Hiulik e 755 CMP 5 ELDLHC?

6. 45 H A CMP 1.
7t SIMATIC EHEARH > EHEZ I H K > FERFES A5 >“ZT0 H"(Multiproject)
>“4# N\ % i H #1”(Insert into Multiproject) >“F /%] %" (User Objects) &LIHF > IR
H >“BiE"(OK). &: JWE IO B2

7. S FFLLR M7
7E SIMATIC B HIEH > WHELIH MK > FERFESE A+ >“L T H"(Multiproject)
>“JH 43I0 H"(Adjust Projects) > £ F“PA K M”(Ethernet) >“$h4T"(Execute) > EFE L I
HF T > FHAE LA >Fie"(OK) >“RAH"(Apply)-

8. i/t DMP tlER AS 5 OS [f]f) S7 IEHIL /2 541 CMP th. {ffF NetPro.
— {TJF NetPro, 7F AS HiE$ CPU JfEE gk i & S7 148z,
— {E OS thik$¥ WIinCC N IR P IF e R P i fr S7 M4k,

9. WAt AR BT ISA-88 AL L.

— {£ SIMATIC EEBH LT YE+ > EEHETE > FERFER LT SEAFNZ(Insert
new object) >“#it 413 2 8. 55" (Batch process cell).
- ET) MK PR R poc e > ZERGESE SR > 58 #£7(Object properties)
>“S88 K% X ”(S88 type definition) JEIH & > X 5 K A“Id F2 B 75"(Process
cell) >“fiE"(OK).  HbA: 77 i B B o0 A F ks IR SR (D
10. Ky g fie 2B = R T A RR 2 75 5 CMP BT I H 75 MP 2t 26 7= 1l R 0 1 44
GEICIR
7 SIMATIC #3810 1) ME T, &8 MP i 29 AR Rt A = R ot 44
.
M. gPFIE FEZIH ) AS X% (CFC E#%) Fil OS 44,
12, LA R T, AP IR LA ISR, A IR se i, K Bk IE S OS
TN A= e
13. AR = 460 (BCC, Batch Control Center) H (it Az = $di

Y H B R T 5 CMP . B CE& I eI H PR st FE .

SIMATIC BATCH FJIf, V7.1 SP1
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5.2 1#/] SIMATIC BATCH /19 1 72

5256 SIMATIC BATCH 43 Ai X2 Ti B L H 45 R R IR

fai g
WEARBATE Y SO R 20 T SNBSS HDEMEKR, kAT A
o CMP HiftbA: ™ s AL Fr i B H P RE 2 AN A B
o AR P R A A Bl T e A G B
o LHUEE ) SFC M AT e A T
H P HEER

i

] B I DR AT TR ST B T g T D AT SR i A 1 T 2

g

7E SIMATIC ZEH# T ES LHBRIED R
1. 7F SIMATIC &SI IF 2T H .

2. NZIHPrAIH (AS ITH D HER 1ISA-88 1 5 SUIF M B AL i A2 e .
OS It H Ex4ho

3. WPt A IR, RO R A SR, SO A SRR BRIE & OS.
B, St SRR A T ah AR oA, A S

4. KAt i RE IO ISA-88 SR E CHUFHBARIZ I H BT A ITH (AS T H) .
OS Wi H Ex4h; eI,

5. BBt A BRI IT, AROF AR RE A R, S IR REA S, K R IE S OS
I A Kl .

WAL, AR EH AR T AR, BOA I =),

6. fr AT A Dhae Al SFC KA CMP ¥ T il H o2 A5 #0AH [ 6 )& TRl — AN A .
PRI — i P B TV, SERT A H (AS TiHD v EBHAREN Dhaek., i&n]
LUK SFC R IR S7 R )7 1A KR e,

— RGN H F) ST 7 h ik PrE e >“IE TR (Options) >“FE%&”(Charts) >“5 #t
A" (Update Block Types) > EFER A S7 2P > F—25"(Next) > R HE
W, SEd9RE"(Status) EEET R EIFCMLIIER. WRFEEH, WE
NEH"(Update) XHEHE > HEFEEFIMRAER > T HEHXA R T,

— AR T H SR ) SFC 2R ALAT ] CMP v BT R SCAE

SIMATIC BATCH FJIf, V7.1 SP1
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5.2 (/] SIMATIC BATCH 11 1 72

7 BATCH fR4%-#% L8 1ED I
1. BHERHEAE =50 PE, AR R AE P-4 N ES R a2 H bRl .

TR MBRAE A Bl 2R f, 2GR A P O T L L sl A D e 4 4
A Bt (BT PERTATD

2. JHE R B RFER, ARG BB BATCH JAshhMFL". 4T IR AE = il ot ik 5%
>“FE 7" (Program) >“#7 it i 2 5. 70" (New process cell). BBt AF: 2= il f i e 5l

3. MIRHT I SO IR SO R AT L A3

Nz

FEPAT IR 1 RO ER 3 207, WG] P4 TRIG. JoRSATER A, #A
L RAEMTAREE P HE

£ OS k%54 ERBED T
MIEx OS M55 i S B HHEA: ™1 Ko

Nz

THEWPE ] TYEE TR . 3 55 il DRSO T RAEATHE A i

A A AR R DT R (FAQ)

1. CAXBE RN EE R EAERM B E k.
B WERRAEHEALEA A AR A G RN IBCH BOE AR 46 1t
AR B R T (R IEbRidiEFE o) .
FELL A vt Jm k.

2. A AR BT R AN RE SRS, B ANRE ARG R B
DR SRAT 6 R A B B RAS I B8 R Bl 2 v, R A T W 2 Sh A REHS e AT
SR R BT R A R R IR 2 AR

W ARG Hn e, N E S A SR S — i ElA, DU e e
FEAEBRIN I TAE R . WURAE—JT AR B oE i 7 IXIU AR, AR A BLAE(E T LLd
IERI S0 ST IR

SIMATIC BATCH /i, V7.1 SP1
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5.2 1#/] SIMATIC BATCH /19 1 72

3. WA HITH R .
il AE BCC i J HFd AR il ) 73 Bl S s A Bk CROBNIRHE) o ST
ARG e, NAZAEAE AR AR UG AE b BT 20 FB X B i 44 1R PR A PR
AR TEHE, WIS R NGB, 2T X BN IC 5 B B U T 7>
e

4. TN WAL (EM, equipment module) 4 BRI o
A fF BCC Hr 1 BBk F o e R) 43 L I B #4445k (EM, equipment module) 1)
LRRTE S CEFONAGHE) o Bt AR = R R IC 2 G, O AE 1E AE H EE 43 BOEr 1)
B AT A MBI . WU G R HE, AT K S AN A B, DA WA T
J5 A OB /3 T o

5. 1t SFC M /iR MBUE M P
A 7R BCC B AR oIl /) il SFC AL e I M A PR e CREBnS 1%
HE) o BEBttA R T2, NAZAEXS TR o B A A I BOE (. IR
PO UEAE, R S A G B, AU R REANIC 5 FOFH B OB 0 Be . W 2RI =)
3 B (L A TSR, AR 2R PRI ORAFAE RN CHEAT SE S TR &0,
AT A G L

SIMATIC BATCH F i, V7.1 SP1
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5.3 L/ PCS 7 ij-F

5.3 f#H PCS 7 %

FEGIEEHT R SR H B2 IUH i, AT LA SIMATIC & BEgs i PCS 7 3. MIHIE
TLAGIEE NI H s 2 I, 200 H AT IH R RN A E BATCH iRk 4545 A
BATCH % )" #Lif) PC .

B3 #

7t SIMATIC & HLas, IEPESE Ay 2SO (File) >“Frge Il H”(New Project) 7%, A5
o ST U HE PR U PH A T A o

SIMATIC BATCH % &

TE 58 = AN TR HE“WIR L6 ) % w] 75 35 H oh 4 ] 2 ”(Which objects will be used in the project?)
h, 42t TSIMATIC BATCH G . e HR I I0,  [A] ISRE 71 [R] X i A R A ) 7 53 Ak
SANET . EBFTRMIHRA . PCS7 M S5in, KAaE4EE Y o PC .

SIMATIC BATCH Fit, V7.1 SP1
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5.4 W HXEH

5.4 S yit)

5.4.1 PCS 7 - % %0 H2K%HY

PCS 7 ¥ 35 H KR

WREAE PCS 7 ZHH A —4> PCS 7 HiH, WNi%ft SIMATIC & H s {iH] STEP
7 BRI PR S RIX I TAE, IR AS DRORfE—E.

A RWTAEZ IH b B R U, 35 2 P e 2 5 Bl P i F] - Bl e — =

5.4.2 PCS 7 OS - B % H 27

T WinCC Ii § K&
1F WIinCC 42 gsh, i sigg PCS 7 OS WIH A (fildn, M2 H 3 H 586 S0k 51
FIHD , W OS 1 H kR 28 U TE 52 3 4 SR FIEAT . X2 MHENLE S5 2 i
N WAL N R 7 S O il FE AR 8 i it — SOk e — v

SIMATIC BATCH F i, V7.1 SP1
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5.4 I HAZ

54.3 BEHZANHEA 3 0S MRS

EZABH 8 OS FREET ST BFHASR
fi ] SIMATIC BATCH, &l LIEAEREZ AN 3l OS higdT— A& A S7 7.

Bk
o UK OS AR SR I H IS AT MU= A S7 FRIY (AS THD IR
U G OS B TS .
o bk, XEVENL LR Al BATCH k%45 .
o TEiki OS I, Wi E I AS"HI. MBI RS E, 75 SIMATIC & HEE
o, R T E TR OS: “Bish (Extras) >“F £ 4 OS”(Translate several OS) B
F >“B i (Translation mode).
RGuorAn
%Fgg'fﬁiﬁ TiEImh 0S 1
FMEE OS 1 hATHST - RRFmE
Hyraiatye AS TiE 1 + BATCH FR55 58
RAFRIER + |/FAEXH OS
AS TiH 2 ERTRERNGEN , ST
P8 AS TE £k 2 OS 1
AS TiH 3
AS T 4
e

. Lok

0S3 0S 2
BRFDE BERFIE
REENR AS T8 3 iz 0S 2 ERILUMBAE AS TIH ,
OS 1 A AT #THRAEMKER REZWBERMNEFET 0S1 £

gy

WAR KRS ST FiFe BRI ul OS h, WIATRHFINF it S7 FEFemdk s £
OS .

SIMATIC BATCH FJIf, V7.1 SP1
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5.5 212 BATCH R4 #EA1% 1 4l

5.5 207 BATCH R 23R F 1

5.5.1 AR

JRE

REREHICI H ) BATCH g5 #3 A1l BATCH %) HLIE W /E A PC Ligfr. #HE FaK
AT H RS s B IR i BX e PC F, 72AE SIMATIC & B 4L I
i BATCH fli45#% (BATCH #iilliR%5 %% DB i4s#%) FIEA BATCH % 5 Lol fil
—/ SIMATIC PC 3.

Nz

AN FVF5F MAEZA“SIMATIC PC 3"t % FA AN HFERF (WIinCC. SIMATIC
BATCH. ...) , #RJ5il 1L HiXEe“SIMATIC PC 3”5 % e [fl — AN S WL & e i1 4
IELLBIEE— PC i,

SIMATIC &3 8rh BATCH i H 45 #H) (AEMED

_SIMATIE Manager - Mein_Multiprojekt = |EI|1|
File Edit Insert PLC Wiew Options MWindow Help

% Mein_Multiprojekt {Component view) — D:Projekte'¥710_Proj in_Mul 10l =|
E--E%@ Mein_Multiprojekt Object name I Sumb... I Tupe |
E‘"\‘E‘? 2_Integ SWinCC Applikation WinCL Appiikation
. E Aszs JHIE Rligemein s
E"g H‘I\ZS_SEEL it E“]Konfiguration P station configuration
=0 g;”u - [22?' aten BATCH Applikation .. - BATCH Applikation Clisnt
D Gilohale Deklaratianen BATCH Applikation - BATCH Applik.ation
@ <Project access protected:
-6 PoelMuwert
|
D 88| ¢ B dn|e %% |5
& |« NeFiter > W | wE BEDN
| L | |
Press F1 to get Help, | |PC internal {local) 4

SIMATIC BATCH F/it, V7.1 SP1
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5.5 418 BATCH JR%#A1% 1l

o FF BATCH A AKThes

e i X ] RE

[ BATCH Appiication Client| BATCH 7% /' JLB TR | o 4145 BATCH %5/ 1 (VT 141)

[ BATCH Application BATCH #4234 | o 412 BATCH R% 28 (71 139)

Ptttk 24t
_ BATCH Application (stby] | [V /2T 4 R G o ZATLA BATCH Jlz554% (71 536)

BATCH il il 45 7% 8k 24
WAAE RS (&HD

- WinCC Application o ZyiE OS (UL 215)
£ 03 PCS 7 OS ) WinCC
MR
BATCH M AREFZE AL

“BATCH MNP & I HL"EK BATCH By Sdi#s, misthA: =4 .0 (BatchCC)fi#%k
2B P A R M A DA R b A e s A

BATCH R AT2f7
“BATCH [ I RE" %
e DB Jg5astiiH:  HI B 176k
o BNZk DB &AMy, AL YRR AEGE
o (i DB 55-dt: /A HiArfn
e BATCH ¥l %#% (BCS, BATCH Control Server)

BATCH AT [#% ]
“BATCH MR [# HACRICAR N R
e DB Jladsastii H: I BUREdh Y
o 4k DB gdt: B, A RS AR
o {rZk DB JR55dt: /A AR
e BATCH ¥l % %% (BCS, BATCH Control Server)

SIMATIC BATCH Fit, V7.1 SP1
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5.5 2414 BATCH R #R15 1 fl

5.5.2 407 BATCH fR%-58

)
o WWUhizAT BATCH filkg54% 1) PC g% —4> SIMATIC PC ufi, Jf{E HW Config 4t
% SIMATIC PC W2l HA“BATCH W HFET".
o INRAELEAK ES PC FA#i ] BATCH IR&#%/% AL CAIiH TR , WAL FH R E
— AN R SRR LN R PC 3, 7ESbyhd, BTSN LR AR
R % PN R = INEY ORI
N\
ARV AEZA“SIMATIC PC 3% % LA N R (WIinCC. SIMATIC
BATCH £5) , #RJFili il Jyix £e“SIMATIC PC 35”5 G40 BE [FAE T 3 WL 4 i e
WA PC 3!
7£ SIMATIC B P38 T 4E

1. 7E“4144"(Component) 4 & Hh ik £33 H
2. AR A4 A\ (Insert) >“3”(Station) >*SIMATIC PC 34”(SIMATIC PC Station).
S50L: Aamr sl H R T ) SIMATIC PC 3
3. WHEI PC i) vHH LA FR:
- JE#EIL SIMATIC PC 3.
— P A A 4R 4E” (Edit) > %2 8 #”(Object properties).
- TEJE N LR A TR

SIMATIC BATCH F i, V7.1 SP1
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5.5 218 BATCH R4 #H1% 141

4. 7t HW Config 14175k SIMATIC PC k.
— 4k, ¥E#%% SIMATIC PC 3
— VPSR A A gmE”(Edit) >*“4T FF X %"(Open object).
49 HW Config 1T
— MEEAEH s N — AN A Y R

filiff H o g fe:  “bavE"(Standard) >“SIMATIC PC 3%5”(SIMATIC PC Station) >
HMI >“BATCH R FH#2 5" (BATCH application).

WERAE I T0 A BATCH g5 4, MIZEF“BATCH M AIRER (% M)’ (BATCH
application (stdby)).

1w Config - KH1F931D1 _(ol x|
Station Edit Insert PLC View Options Window Help
[DEE8 %S| 0e b o8
TMkH1F931D1 {Configuration) - 2_Integ =10l x| 8=
||| Eind: I ﬂﬂ gf!l
-IE WinCC Application Prafile: IStandard LI
2 F BATCH &pplication
4 [] BATCH Application Clisnt gg PROFINET 10 ;I
4 I |E General D [ SIMATIC 300
5 D [ SIMATIC 400
5 E}-- SIMATIC PC Based Contral 300
7 ~ ||| =8, SIMATIC PC Station
< | > =0 BaTCH
: i E CH Applicati
4= | o) FC E BATEH Appllcatlon [Ei
_I_I [d BATCH Application Clie
Index Module Order numb... | Fi.. | M. | 1. | C.. l Cl Cantraller
1 WinCC Application - -2 CP Industrial Ethernst
2 BATCH Application HCI CP PROFIBUS
3 BATCH Application Client L= CI Hedl o
4 IE General IE_CP -1 User Application -
5
5 | | BN
7 Server Components Master for Batch f<|
3 Peell
q LI
Press F1 ta get Help. | | [cha »

5. Pk 4 “uh"(Station) >“fR 174w i%"(Save and compile).

eI R, [§ BATCH Application %% SURAE U414 SIMATIC PC 3516 F 77 .

SIMATIC BATCH /i, V7.1 SP1
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5.5 2414 BATCH R #R15 1 fl

55.3 407 BATCH & Hl

FH)
o Wi hiadT BATCH & ALY HFEF 1R f PC 414 SIMATIC PC ¥, J4E HW
Config H#41% SIMATIC PC 4154 HA“BATCH N T2 /AL,
e BATCH &/ HlLtBnlfER 223 OS % ML (2% Hl) 1 PC ¥ Ligdr.
£ SIMATIC 38 F IHRAE P ]

1. R k£ H .
2. EHE A4 (Insert) >“%5”(Station) >“SIMATIC PC 3#5”(SIMATIC PC Station).
Zi0L: FEAHTIUH T TR SIMATIC PC 3.
3. WHE I PC S-SR
- W, %EFEZ SIMATIC PC i
- P A A “GRiE" (Edit) >“Xi %8 4" (Object Properties).
- fERJE AN AT L AR
4. FEARFINDER, I H e s BATCH % HLI82eke—4 SIMATIC PC 3.

SIMATIC BATCH FJIf, V7.1 SP1
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5.5 218 BATCH R4 #H1% 141

5. 7& HW Config #1141 & ix 4% SIMATIC PC ik
- Mk, EFEZ SIMATIC PC 3k
— BEPESE G A 4R (Edit) >*“FT FFXT %" (Open Object).
i3 ¥ JF HW Config.

- MEPEE A A HE R PN IR WRAE— & PC _LRINIEAT

BATCH % FHLAI OS % /ML, WI{Ei% BATCH & HL EFGEA S —A WIinCC % FH %
o

ik Hak P %45 “fpUE"(Standard) >“SIMATIC PC #5”(SIMATIC PC Station) >
HMI >“BATCH N2 F% /7 H1"(BATCH application client).

1w Config - KH1F931D1 _ (ol x|
Station  Edit Insert PLC  Wiew Options Window Help
D@58 & G| 0 da Do R e
TINKH1F931D1 (Configuration) -- 2_Integ 10l =| ol x|
||| Eind: | ﬂﬂ gf!l
[ WinCC Application Prafile: | Standard =l
EATCH &pplicati
e L AT A on =9 FROFIBUS DP R
3 F BATCH &ppliation Client i =
4 & IE General 388 PROFIBLIS-PA,
5 - PROFINET 10
5 B SIMATIC 300
= x| ||| =@l SIMATIC 400
4 | » Bl SIMATIC PC Based Contral 300/400
-8 SIMATIC PC Station
4m| = | [0) PC =21 BATCH
_I_I [ BATCH Application
Index Module Order numb... | Fi. | M| 1. | C. [§ BATCH Application [sthy)
1 WinCC Application 71 |1 A TL
2 BATCH Application : {21 Contraller
3 BATCH &ppliation Client 1 B CP Industrial Ethernet
4 IE General |EEER CI CP PROFIBUS (-
5 Cl HHMI
[ 11771 1 zer Annlicatinn i
= Client far Batch Peell e
g
3 =
Press F1 to get Help, [ | ﬁ .

6. KEPESE I A4 5" (Station) >“fRf7 34w 1%"(Save and Compile).

FEARLE T, [ BATCH Application Client it 4 R 7E L1 SIMATIC PC 3 F i

5.5.4 7 BATCH Jik%-23F1 BATCH & il 2238

TEFM GIRE=HI RS PCS 7; PC 4IZSHIHAL) (Process Control System PCS 7; PC

Configuration and Authorizations) ', T 2|GE% 1L BATCH i 45 Ml BATCH &/ #lL I
LRSI AR 7 N R R B s B A RS o

SIMATIC BATCH Fit, V7.1 SP1
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5.6 L) JZRNIHHY

5.6 T B EA

5.6.1 T BRI

fai g
W T 2%, TRRG A N EIRALE PCS 7 R4 Hh SR A gt FE s oo T 245010 )7
. AEL) JZZHPEIN CFC/SFC K3, OS i al OS #HAF b i i 55 % %
TERBHIEH

SIS H N, PO R ARGEMER . M~ 2] LR SO, W Rgs
15 SIMATIC BATCH 0 AEHE I SCE2 . IR R ZHOA x4 @, “ISA-88
KA 52 X (ISA-88 type definition) LI P (1% 5 28780 J& M g 2 11

LI H TR, B & 25 H”(Multiproject) %%, T2 &AHH, B %
e H R R T,

Xt SIMATIC BATCH fIZHA%E, T K FTaRi) =N ZEF SO HR S b 51 CEH R
A = 2 9 -

25 project_1 (Plant Yiew) - C:,SIEMENS' STEPT',... [ =] E3 | RESILY AR -7\ K¢ s Nibi
=GP [kl SANRYOCEC:
=] PCel o
E-ELlnit o RIFEHLLICIFR (WL 153)
-- equiprment rodul o L (ﬁ 154)
o RARIHLCAER (T 155)

SIMATIC BATCH FJIf, V7.1 SP1
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5.6 ) IZRNGH

A= RF IR T EE X

KA 1ISA-88 (1995) b, IX =LA R ST I AT LR 3 S T 255 e

A 5 &3

R IER

T 2 % FEIRH AT RE SN — LRt IR T (X REVS
) TS AN B AT E RSB RE
LB VI 21 B o 1 IS ol GV 3 1 708 A A o = T

LI 3% FE— NIRRT A DUE X2 A0, XS ITATE
FCO7 BT . BROTISEGIAT: hAl, BRI, AR EAE A

BRI 4 2 FE— AT DUE XA, QiR L e e
Blo W BRBBEIE 2N BEEIBL Wi, Rl il
A A

BEEFLTRT (BRI

I H R RAAFAE K, HAEAE WInCC R4 75 &b . AW, Pl

PSRBT S AR A 44 5

o

BOAHOL T, a2 R E WAL TR ARG . vt a4 R AU SRS

S

144
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5.6 ) ZLRIGHA

BRI 74

X HA MY SFC RASLH] (71 152)8 BATCH #2 HY (T A51) K, nl#&IL T2
B XACAELEAH DN (AR = 2 Sc e . HAT TAG_COLL nl A7 e il FE s se ke
IUNIT_BLOCK LL 2 EOP. EPH 1 TAG_COLL e n] 77 768 55 (Unit) X %387 () S
Jerpr. EPH Hefil TAG_COLL Henf £ il {E“ ¥ % 15 H " (Equipment module) X 538 1) 3¢
et IEPAR Bl N ORAFAERE AR = IR S0 e

AT T M ThREde (R, il 284%) EIRMMFEES] (SFC) FEFR W LI EX
L BATCH 24 e fbderp s nl il 5 U2 2 S FJekd fé SIMATIC BATCH ks Bl
Reufe e SR, DB AR B 2 B OB R  HEAR 1) 4544

S

| SIMATIC Manager - [Integ (Plant Yiew) -- C:4SIEMENS\STEP7',57Proj\In... =]
£ Fle Edt Insert PLC Wiew Options Window Help -8 x|

| 82| & |\|E| _| |__| |: s | EE [ < NoFiter >
- %ﬁegﬂrewm

- () Peellz itk UMash
El {us] Reskter &1 (|

- {z7] UClean

{27 UCook
{27 UHeat i T
© Lz UMash | LClean UHeat
l -] Reaktor_AZ2

- {ua] Reaktor_43
- {ua] Reakior_44 I@i
[#-{ua] Reaktor_A5

" Reaktor_B1 _ILI Reaktor_al
4| I b

Press F1 to get Help. | A

SIMATIC BATCH FJIf, V7.1 SP1
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5.6 ) IZRNGH

5.6.2 WA INE IR R EHR

RS R
W ETA, AT I Sy SIMATIC BATCH [ =202 454, i isedt 1o
HREie, Bk pocirdl. WS —goh eld. RV ags -
JEY ARSI 2D A 8.
B, ERSCAR GBI ROT E R b ARG, AR AR . filhn, R
B — AT B &AL (Equipment module) RTHI. 4R L2 Bl F AE 33 B e 2531«
RSO AR b, AR T2 JEHI 3 A FE 0.
B B3
RS AR T EER AN AT AE BATCH 2 8 (8f EPAR #b) .
L4
5% project_1 (Plant Yiew) - C\SIEMENS'STEPT",S 7proj\S7_Prol
57_Prol GFE [ Clean [ Heat
= {ai] V=B [ -Tranzfer [ Mazh
EI Subcellz
“o{ud] Unit2
=-[Ea] Production
=-{ma] Va0
- GF
|1 GFE
-{uE] WS20
~{uw] WE30
{540
[+-[E] Tank
- [ VE

SIMATIC BATCH FJIf, V7.1 SP1
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5.6 ) ZLRIGHA

SE I ) -
M FEEIC: CPP = RAFWRY 1]
'Ziﬂji: %%ﬁ\ ﬁlill:ll:l\ ﬁ
BT A KR V510, V520, V530. V540
B AR 7E GF XIh: GFE. FE4R 1. . M AL, Hidk
AR P020. P021. P022. T390. Y400. Y405
SE) 2 B REAE FE R :
T BAm BRI B, s, IR
[ J5k T (5T
e g B AR, XA S BT A e A e A B
HLIT: BT AT BE MY BB B
B W B
B — P BT T CH#AETE
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5.6 ) IZRNGH

5.6.3 T B, U AERFTZHEFIREA

i
FERC T3 I B AL B RE AR OCRI R ICR P I AE R D IR A T BB
B2 Bk T8 LB B n R ik

JRHITT RS I . BB LA RIC T TR Z R R R

BRHR B [
—— | SFC XExpl £
& SFC XHZpl | | Lo rP -

N (EOP, EPH) |

1.1 2B
»{I[UNIT_BLOCK

=M
Y
By RUP
l
I —_——
EOP | A % Rrop ¢
IEPH - —%  RpPH
* fEH
= |
BE _,—1
TAG_COLL | L3 IEPAR ...
TAG_COLL
(CFC )

—t—o EEO0E A, HlM: —NEEETESE 0 F n A TAG_COLL
- [

—e 1EnA

—o0 081
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Bl

AR TCHIAL AL P RO

o HFEHIC

e H

LI SR EoN

o HRLICIEK

5.6 L) JZRNIHHY

s
IEOP WA ERE O
IEPH WA B L

IUNIT_BLOCK | HuiGiks 15 4 itz -

TAG_COLL |t ff
[T

ERETE [

RP SLWIE AT
RUP [V iy w ida g
ROP -fic )7 154
RPH W 77 B B
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5.6 ) IZRNGH

5.6.4 EERENBRED (CFC BFR)
5.6.4.1 [Pl

ERUERBRED

7t SIMATIC BATCH 1, & IR 5 RN 2020 (RCTBY B fEia AT W) #5 Sa 0h 22
Be 77 B9 B PR AT it R4 1) o B8 25 B BEEA T T e AT H B0 2 (AN I AR DA R W45 B B I 24
RSB 5 B B 45 il dr 4

H V6.0 2, SIMATIC BATCH J7E LFE RG]l SFC XM Hithfe (G2 W qE
SFC B (1 152)"#64y) « 1 H., SIMATIC BATCH 4 4ka:4 4t BATCH #: LAk 4
ARG AL BRI 2 M @ R GES LR BATCH 2 T8 (W2 151)"343)

BATCH Ok - SIMATIC BATCH V6.0 2§ [ Hiuas

7 SIMATIC BATCH V6.0 Z Hi A, SIMATIC BATCH 5] a2 il 4 s & B
B w2 H e (AEPH, IEOP Al IEPAR xxx) SEILM). iXLed & CFC

BesiOLis, 45 SIMATIC BATCH 222 flin) 2%, ‘Bl CFC KR i s b Bz il
AN 25 R A R i A\ R H T

SFC k%! — )\ SIMATIC BATCH V6.0 FF#41% H

H SIMATIC BATCH V6.0 &, nf{iH] SFC Mkt T H M8 O & B &, 7
SFC B R hp b s £ i BER B H O — M5 441 SFC 284 (= BATCH K¢

P o BN BATCH KA SR Hoe s b 808 Won e/ ficss CFC ¥ SFC 287
MRS (Flan, BATCH) FErf, Jal LA7EIS Bt thdfi A CFC .

ET] RHF HIAFE

BATCH $% LA BATCH SRR P2 I IL DI REAF it /E SIMATIC A& BEZS T) ALKl PR Y 22
AR CFC Bl
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5.6 L) JZRNIHHY

5.6.4.2 fH BATCH #Mk

Dike
BATCH #1151 SIMATIC BATCH 2 {5 F w Sz B LA R Iy fg:
o P FIZELT:
IEPH/IEOP Hef st Hir. eI AL =kl B AL BEEL (@l SFC AMEAL
KaH P Il P a (BIaEshalkEifs) o AP ST /7 R & g it
PR
o JERk I Ty 4 L B AR AT HLIT s
IUNIT_BLOCK He [ TSzt H 1 .
o WEEEE S =y MOT R S A I AR, R ARSI 5%
TAG_COLL B Fsz8itt H K.
o ALk e (A R A «
IEPAR e T2t H Y. #ib2Er=fhi@ st IEPH/IEOP Hul AbBEER I 7 S50 (%
EE) HANXEeHrh,  AhEPOk g AR GIRMED SN IEPAR B, DRI o] FE S
H IEPH/IEOP i io fib A= p 42 ks &5 AL A7t e A== £dis
IEPH/IEOP i) IEPAR Bl F 78 A o B e iR 36 75 458 .
BATCH # O Hitid
H NEH
IEPH ) TRy P R
IEOP PR R

IUNIT_BLOCK | & FIL #7543 it

TAG_COLL WCER T UARY . I SR e B 45 A ) i R
IEPAR_DINT | XURE BB A ) S K

[EPAR_BOOL [#i/R (D) B2 i 24k

IEPAR_REAL | S8 G730 HERA S5k

IEPAR_STR FRE U B Sk

IEPAR_PI pup TN TR S 6o

IEPAR_PO IR R E S 2

IEPAR_ENUM | BZS2R A (JH /s LIRS ) Hitn R A ¥ S0
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5.6 ) IZRNGH

xF BATCH #: O H i 7ELRH Bl
HR5%% BATCH #: ORI ThRE . BAE A N S5 ek, w1225 CFC Wik I
NI IAE LB

£ CFC KR k£ —4 BATCH #1)5, K4 F1 BN AT IT LN oMo .

5.6.4.3 i SFC k7

Thek
SFC 2% (SFC #x#E) A1 SIMATIC BATCH —ifdi [, W SZil N4 ThRE:
PR (384T
I, 8] CFC B (ZEAYN EPH/EOP) whff) SFC 28RSz, e A4t At A= 77 45
IR A ARG T P A A (B A B e s ) o N ERALER PR A I FEAE 8 S i 2
AR, RN AE P DR S AT A4 A = 5 .

BATCH ¥ O & IUNIT_BLOCK B b F
RM7ERE 4 SFC 2RA 2 J5, ARk Sl ] BATCH 2 0dk.

T P IC 5 20 Be BOR AT FLG
BATCH £ HHH S8 H 1

TAG_COLL IfgeHk i Bt hns
B fEAd ] SFC ANy, n]fi I bsrHE FB 521 F 71 Th g

AR B 2P P A K AR (B, DRI IR ANE . TAG_COLL B T5e Bt H
e
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LFERZ (ES) THIAE
5.7 GI#T) X

5.7 BIET) B

5.7.1 {#F BATCH E % 3c#F3£

5711 “TREBRITTEH A

fai g
TETUH T alg il 7 50" (Process cell) X% 5L SIMATIC BATCH 403
PN TN A 2 g o Je JE v b ) “ISA-88 27 5 XU (ISA-88 type definition) I~ -
AT A
5B SO R IT
R RREE s (B PUTH. BEERSE) 1@idl, HTod— ezt
o AFEFITAIRAE T XA B A PV 4% (103 42 T i 0L P 3
‘IR BRI R RS SR
o {E—AIHPK, HAEAIE IRy T (Process cell) 20, el BE4
). BRG], 2 IhREZE0 .
e Y7F SIMATIC BATCH i =R /7 I, bk B fp e Ayl . X Kok 240
FEIS RG22 B B A2 e U Hh BT it IR T A B G R RE £ B BE
ZIH

Z 10 H A ARSI H S AR E Ao B2 G (Process cell) X% . BTS2 R, w4
PIAE ST H A SASH G,
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5.7 BI#T) X

5712 ‘B BREICHE

fai 4

BRI I BT

B ST 5 48T

LR TET, QIR LI (Unit) A5 R4S 5.

o WUREIRAS R ISR QU R IT IR, WIFE R QIR Hon SRR, ARGk
FR SR A gt e 4 o0 (Unit).

LI IEF P NI (e u o v & B N & v 5 I 1P o B DN I 5 v N
2 ARSI B ST . BiG, ATEZ T JE MK “ISA-88 57
& SL"(ISA-88 type definition) 15 H 5 B “ FL T (Unit) X588,

FE— AR RITH T LUE X Z AT, AR — DR W ER 2 A0, IR0 s
AL NIRRT Ny PR ARG 2RI EE .

FE“FLIT"(Unit) JZ R g vk, af A JRl—200 B 810 — 30 B rhadk$ 50" (Unit) 1
HIEARRTG. R SEARIAL T 5 — T E v, e AR 2 i I H b DL B 1 JE
PRI TE R o

A I HLE(Unit) 2SR % g P (object properties) X TEHE 1 [1)“S88 KA g
X"(S88 type definition) LI £ >“Bi- 53/ 5 £235” (Predecessor/successor) #4131 T %
THAE

5 IUNIT_BLOCK &3 ¥ 5T 43 e

154

h T AE A GRS A IR BT, “Bnn(Unit) R4S T i — AN B R b A i
BATCH #1115t UNIT_BLOCK 11— /NSl . #4452k 1D AL A 2 B A\ 3
IUNIT_BLOCK e, DUEREAS B IC I BL »

6 PLC BT M IMALAS S, IUNIT_BLOCK {f n] - Ty bk A = il FH ot Ciin
A BA_EN: b4 ffifEsm) o
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57 GI#T) EH
5713  “BHBHER K

&
TEHICR, Q%A R (Equipment module) X %2R i) 2 4 S0 e

o U EEAT R IC AR PRI SR, ARG, G H B A A LB A A
e’ (Equipment module) Xf %257,

o UGS FHHAE BTG N AR B A SO, R AR N RSO 2R, )2
H SN RIS A W SR B, PRSI R PE I “ISA-88 K1Y &
X "(ISA-88 type definition) LI~ i & & “ ¥ /- FL " (Equipment module) X 5287,

JB B ST e 2 R

FE—ANATCH ] LUE X Z A BB, WECRLEGER L. P B B A 2 A e
BYBL, W, ARl R EEE
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5.7 BI#T) X

5.7.2

5.7.2.1

mEL E&

WA T B

FRUBMTRETT BEEHFER

ARENE. BRARE T RREERENER, 2% TN GIrESI RS PCS 7;
THERSA) (Process Control System PCS 7; Engineering System).

AUt A LA I B B AR R v B AT R IA

AR A A A TR R B
AR 2 P A R A B I

156

faE L] ERIFEARE (I 157)

MR S5 BE I FE HL G (Process cell), (L 0" (Unit) 50 & B B2 (Equipment

phase) XL G KM (1 158)

A HLICA TR (I 159)

PRI TP AT AT D fE (5T 198)

Z I H T e AT AR (7 202)

Fi AZK 4 EPH/EOP i CFC % (it h61)

SIMATIC BATCH FJIf, V7.1 SP1
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5.7 GI#T) X

5722 e L] BENEARE

PBERE
WM S BT T SRR S DL AR
o EYH
o REEHEARYINERA LTI ORFERR AN (25 WIinCC ) (HID = i
JELHRIRD
£ SIMATIC EH#+ T8

QIS —NRRA G, AT HEA RS .
1. 72" 1) 7(Plant) #LIE sPAEGE AN 2 S0k,
2. W AR T (Options) >“T.)” 24¢"(Plant hierarchy) >“¥% &”"(Settings).
3. fE“HE X T) J24%"(Customize plant hierarchy) X iFHE AT DL N % &
— BT AT RE I B KR T BATCH 24, S =ANRBAHG. W
RYEAL RS Ie, W2 T 3CE 8 M2

— A THr iR (Include in designation) EIEHE, 7] i & EAE 45 2 U 0=
YA AR S S Z YRR (HID)
ATTES A E A I A D3 R0 PR M v B % BB O i 44 R
575 HID b GRFLfr A “4n4R7(Edit) > 52 )8 #:”(Object Properties) >“3 751
#1J& ¥ (Control and Monitoring Attributes)) -

4. i E " (OK) BEATHAIA .

SIMATIC BATCH Fjit, V7.1 SP1
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5.7 BI#T) X

5.7.2.3

SECERERIT, “BITE B & B BUR SR A

J G BATCH JZ24%, 752 R 2SO I I 43 B B2 570 (Process cell). “If
J6”(Unit) 2% % B B (Equipment phase) 5% %288, 4 0 % 28 8k 15 5 He'e, BATCH
JEE

BIEEH I 2RO 5, RG R nAr S H A 37 Be I R 56" (process cell), “H
JG”(unit). “BEEHT B (equipment phase) 2t “H " (neutral) XJ %8R —As, wl %~
75 O o BE g 2 SR I (R LA

7E SIMATIC EHBFHHREIES B

RS

158

1. 7E°T) "(Plant) #E WPk £6 = g fFk .

2. W a4 g (Edit) > % )8 " (Object properties).

3. V)2 ISA-88 KM 5E S (ISA-88 type definition) &1 .

4. J KRR (Object Type) i )2 B AR PT T HIEA GERRHIT, FICELB &L
o o WBERE<HE ST ST, WX T SO e, KRR AE ] BATCH 4.

5. it (OK) JEATHEIN

il JRYSCAII B o 5 P i R A DL

“<H > (<neutral>) %t %R AL 2E ] FE HLT" (process cell) 7% BATCH %% . Bk
) BATCH J2 A IAT R B EA TR 5288, (AT SIMATIC BATCH 41754H
K. EN% 2577 (Object type) #, L SIMATIC BATCH ASFEAH G ik £ )2 % S0
e BoRTEREE S, Bln: (RID)

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01



T FERZ (ES) 1119 &

5.7.2.4

fai g

5.7 GI#T) X

T8 BT T 2 I

FE IR (Unit) SRS IS S @ v, e [R] I H =g — 3 H (AN R oo &
ANFTTIY S, IXAE T LAB IEAE B REBC i R, AR ) SRR R TSRO RN R
JGo

WA A Z A IO I, B, Ree M PEsE,  DMEAE R B e FE it
IR 0

AR F T AT I S D R 4RI, DA TR — AN a4k

7E SIMATIC B HAEHKEBIES B

TR J5 4k 0

1. ZE“L) "(Plant) #1 B H ik £ 50" (unit) 2092,

2. EPR IGNAE" (Edit) >“XT 5 8 157 (Object Properties).

3. VI EI“ISA-88 J3 7L i S (ISA-88 type definition) £+ o

4. DEPESE 2RI HT S 00" (Successor/Predecessor) 1441
ik Pra v T BRI

5. K Yuion B EART: Ot fEUTT H LG (Available Units) & A I 10 )5 4k
5, R 2.

i MV IR 25 4k 1" (Successor) & H, H B A5 4k1i"(Successor) J&
P
6. iy’ (OK) A E

SR WER R ARIURAL S AE I H b B2 T H I E I RS AR50 A D e
BRI 2 O ERAHN B I H

(e R AR (Successor) B L1 B0, AR ity <o | LI B s e RS o .
JE(Available units) i1, EVTREARURTE. 1R C2 RS OIRL T A By
RSO CH S IURRAIE S I F R P RS (R 20
o, AT S
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57 GI#T) 7k

IR
AR P G S AR, W) TR T I JE RO 2 R AR i3 50 (Predecessor)
WY, FIEGRIFE, W LAAAE 2 A0,

FEZ A+ TAE

L
i PR 1L R 0" (Process cell) % IR J2 9 ST AE 22 00 H K& 300 H A HAT H TR 44
PR
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LFERZ (ES) THIAE
5.7 GI#T) X

57.25 #HA CFC BRI

L) R CFC EIRAIHM

RO ST SIMATIC B R TP EL T CFC BIERM OIS T ZRaIdm. T
] R E N CFC BRI, R &0

o T HAMMN SFC A SEl BATCH 2 M2, nlAR L T2 5 A A Y.
A= 2 oot e, B TAG_COLL ] A 7 i A2 e e v
IUNIT_BLOCK L& EOP. EPH fil TAG_COLL i 7Ef# 5“3 75 (Unit) %o %27 i)
. EPH R TAG_COLL W fA-ifi{E“ I & A5 (Equipment module) X 528 AL 1)
PR LN

o OIS TR TR (. #H#5) 1) CFC EIZRMIFiH] (SFC) T
174 7E BATCH 24 3CFe

o N AL U I i i SIMATIC BATCH i FLLh REHLdR & 1) )= e sk, LA
A7 RSB AL SRR BHAR L) 454

| SIMATIC Manager - [Integ (Plant Yiew) -- C:4SIEMENS',STEP7',57Proj\In... [H[=]
£ File  Edt Insert PLC Wiew Options ‘Window Help == =]

D] 27 értllnllgl _| [& 2| [5s o[l & [<vorrer

% Integ
L=l Lal
=t - Brewhi
. - PCelll ook} Uk azh
& . remmemE || 0
- {27 UClean
----- [27] UCack
: -[%7] UHeat i e
“-[27] UMash (I UClear UHeat

I -] Reaktor_AZ2
- {na] Reaktor_43
- {na] Reaktor_&4 I@i
- {na] Reaktor_&5

#-{ns] Reaktor_B1 _ILI Reaktar_4A1
4| I »

Press F1 to get Help. | A
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5.8 11: CFC KI#& T i BATCH #1712

5.8 7 CFC EEH#i A BATCH #1ik

¥4t BATCH #2115 (“PCS 7 F”(PCS 7 Library) >“SIMATIC BATCH 3"(SIMATIC
BATCH Blocks)) #i%| CFC K.

£ CFC BRFHAT TR Bt
CFC & TN T BATCH M LASZHL R4 LRE BT 5

162

5E SHLTT
SN HIUEE— CFC K%, WEERSE S/ T SEMER IUNIT_BLOCK 3£
B,

¥ b e 5 SIMATIC BATCH i%E#%.

WA B RO S — R 1. X3E I IEPH 5 IEOP Hkogmi. ikt 54H
Nif¥) IEPAR xxx S5l e ab e (H it SFC AN E g fE by —4fiA
CFC El#. ¥ IEPH/IEOP Huffi= 4t QSTART. QHOLD. QABORT.

QTERM. QRESET 5 4bFHHAH N AN L% (] SFC AMBALIEEH i

LR R S 4 P 9 5 SOy 2
i IEPAR BAE BATCH FUJ AL B HORERS AP P, T IEPH o Ao
IEPAR, I FTCSERRL .  Is R 45 UF f1h BEA )2 0 A R 5
o SR, AR BRI (0 B R A
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#AEF M, 03/2009, ASE02171120-01



T FERZ (ES) 1119 &

5.8 11: CFC K# 1'ii A BATCH #1712

5.8.2 IEPH #11 IEOP 2 13 iy )

CFC EZH iy EEMN

o £ CFC &k, T4 IEPH. IEOP 2 Il Heh Zi42 Iy 47f A 21 4k 3 1) iy
T o

e |EPH I+ RPH (BL7BrB) AN 5. IEOP HUHF ROP (FLJy#4E)
utlin[iiwapi

o T H G 4 A SIMATIC BATCH f£iX 3] SFC, W4Zi4i% IEPH. IEOP 5 SFC 4F
AL R f) T A3 e

IEPH/IEOP SFC 4MFMA

QBA_EN (i) BA_EN € 7N

VSTEP_NO (D STEP_NO (BN

VBA_ID (i) BA_ID € %)

VBA_NAME (i) BA_NA € 7N

Q_OCCUPI (i OCCUPIED (BN

QSTART (i) START € 7N

QHOLD (D HOLD (BN

QSTOP (i) STOP € 7N,

QABORT (i) ABORT (BN

QRESET (i RESET (BN

QTERM (i) COMPLETE € 7N,

QCONT (i CONT (BN

o JELRAFRA N RITR CEERED , SFC AL T AAT
— ENASTART =1
- SELFCOMP =0

SIMATIC BATCH F i, V7.1 SP1
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5.8 11: CFC KI#& T i BATCH #1712

o ARG R ER SLPRIR AR P4y SIMATIC BATCH. X5 B3k T 41 Hi%:

SFC MK IEPH/IEOP

BA_STATE ChrtD USTAT_L Chr A

o JLAZHH (IEPAR xxx) W4ii%4 IEPH/IEOP Hff) EPE_CONN #iiti. 7] LU
THISHEL:

IEPAR_REAL gt

IEPAR_DINT L 3x]

IEPAR_BOOL ZHEINE

IEPAR_PI WANDIE

IEPAR_PO ikt

IEPAR_STR FrFH

IEPAR_ENUM ey

o XIT IEPAR_ENUM #z$26%, ZE“ENUM’H 1/O Abd5 e M 4 8k, et =25
o, XS RO S B EESE A (N 1 = JF 12 = 55D

e |EOP/IEPH MRS H (Ve AR AN — Mt Bl 3L IEPAR B,
o WIHERES IEPH/IEOP B4R b BUARAF R A4 TR

o {EfTH IEPAR B (BR™i /R FIMAS RSN i, aZitdia e ERR . N IRABRABEE .
ERIMELA ZAE B E (R R
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Chart Edit Insert

CPU Debug  Wiew

Options

Window Help

5.8 1 CFC K& 13\ BATCH 7% 114

=10l x|

DE&| 4 = BEE & |6

Fex=w x| A0 daaa ®mEms

Heat
IEPH
Interface Equip

S Al

PEAL-2&ddition

enable b—|E0 E& EN (E& EN B0
‘Heat'—|3H T TYEE USTART Eo
1gf0 |DW UEA ID QHOLD Eo
v+ 5N UBA NaME QETOF E0
16f0 |DW ICTRL QABORT EO
IW UETAT L URESET E0
o—(B0_OCCUR IED QTERM B0
0—B0 ISTART QREADY E0
0—{B0_IHOLD QCONT Eo
0—B0_ISTOR QLOCK Eo
0—B0 IABORT QPR B0
o—B0_IRESET QREFRESH E0
0—E0 ITERM VETEP_NO DT
0—{B0_IREADY QUSTAT L DU
0—B0_ICONT VEA 1D DU
0—B0 ILOCK VEA NME SN
o—(B0_IFARAN EFE_CONN DI
0—E0 IREFRESH Q_O0CCUERI Eo
VLOOP_I W
Tenp
IEF2F, REAL
Intarface Equip
DI EPE_CONN [ aseva m
B 5P_VAL | eact var =
E ACT WL
0.0 R LOWLIMIT
so0.0 |RUPLIMIT
Addition
aDD_R

Inz

N
Heat a2
o—|E0_auT QAUTMAN B0 [—
0—|E0_MaR IDLE Eo[—
B0 START START ING B0 [—
B0 COMPLETE BUN B0 [—
B0 HOLD COMPLET IN B0 [—
0—|E0_RESIME ERROE_COM E0 [—
B0 ABORT COMFLETED B0 [—
B0 STOR HOLD ING B0 [—
0—|E0_RESTART HELD B0 [—
B0 EESET EESUMING B0 [—
En Start— B0 ENSTART ERROR B0 |—
En AFtre— B0 ENASTART HELD_EER0 E0[—
0—|E0_LOCKCOMPL EESU_ERR0 E0[—
0—|E0_ LOCEHOLD ARORT ING B0 [—
0—|E0_LOCKABORT ABORTED B0 [—
0—|E0_LOCKSTOR STOFF ING B0 [—
0—|E0_LOCKERROR STOFFED BO [—
T—{B0 5CT QEXT_ERR Eo0[—
0—|B0_BCT_Tac OF_ERR B0 [—
0—|E0_SELFCOMP LI ERR E0[—
S21£R=et—|B0 SELTRESET EXEC_EER B0 |—
Instrius—E0 INSTROUT ERRG B0 [—
o—|B0_CYCLEXEC T_OFRQG BO[—
0—|E0_T IMEMON 5_ERRG B0 [—
0—|E0_EXT_ERR Ba STATE IW[——
B0 CONT
Ho—|E0_OCCUE IED -
E0 Ba EN
I Ba_ID
SN Ea Ha
IT STER W0

|

o

Presz F1 for help.

[WN_superuser |&/Shest 1

[0B35 EFH_F

SIMATIC BATCH /i, V7.1 SP1
EeEF M, 03/2009, ASE02171120-01

165



LFERZE (ES) 111 &

5.8 11: CFC KI#& T i BATCH #1712

A B & RE LR TR LR A= S SR

IAZY SIMATIC BATCH #2845 () B 46 ot PG S AR (L 5 . ARG PCS 7 0S Ly
BRA4E 7% SIMATIC BATCH 75 %548 FH I e e 57 22 DA SO 2B 7% IEGEIEAT . e
P44 TR AR ID AL/ PCS 7 OS 131 Lt

NEBIX— /L, AR LR TURh LA

IEPH/IEOP RAEHETER
#lln, SFC (AMEHLED . MEAS_MON. MOTOR %:4%
QBA_EN BA_EN
QOCCUPI OCCUPIED
VBA_ID BA_ID
VBA_NAME BA_NA
VSTEP_NO STEP_NO
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[EPH. IEPAR_REAL. MOTOR kLA J ADD_R B[] H ) S 45«

£3,CFC - [EPH_Heizen_A2 — 2_Integ)\Brewh1\Reaktor_A2\Heizen_mit_Para] =101 x|
[ Chart Edt [nsert CPU Debug Wew Options Window Help =18 x|

D& e DO & - | 6
8= % AOMdealBESMmMN|

=
Heat
1EFK
Insarface Equip daral |
enable b—{BO BA LN aBa_EN Do
"Hear *—{3H T_TWOL QETART BO
1520 [p@ vEA_ID QHOLD B0
v |5 umA_waeE aaTor B0
1580 [ow reTRs QAECRT B0
USTAT L eezsEr Bo|—1 |
o—{B0_oEcuR 1ED. QTER RO
o—{Bo_1sTART QREADY BO[—
o—{B0_IHOLD QconT B0
o—{B0_13T0F QLOCK B0 [—
o—{Bo_tamopr qpaRAt B0
o—{B0_tRE3ET B0l
o—{B0_ITERK VSTER_NO 0N
0—{B0_IREADY QUSTAT L D]
o—{B0_tcosT vBa_ID
o—{B0_ILOCK VBA_NMME 38
o—{B0_TPARML EPE_CONN DI Movox
o—{Bo 0_0CCURT 20— ot oz
VLOOP I W [Hene:
o—{Bo Lok 33T B0l
o—{B0_LOCK_oN HO_ERR D0 |—
F o—{B0_AUTO_0N QGR_ERR BO|—
IEPAR_REAL o—Bo L _prsEr e B0 |-
Insesface Equip 180 m3s QsTor B |-
D1 EPE_coms Q3P VAL R o—Bo_car QITART BO[—
100.0{R 5P VAL QACT VAL Rf— o—{Bo rB_om QC_QITART BY
R AcT VAL Lemoo—|BY QC.TD_oN || ttaw_awr soj—
0.0 [r rewmmir 16850 {BY QC_QSTART
so0.0 [R_UPLIAIT o—{B0 L10¥_SEL

KT RYAKT| | ﬂ

Press F1 for help, [VN_superuser |A/Sheet 1 [DB35 EPH_Heizen A2 EPH_Heize

IEPH. IEOP 425l 3R mg& 3

7t CFC =&, w2y BATCH #: 13t IEPH. IEOP 43It IEPAR_ENUM, MIfi fui/ff%
ARSI ZAE "ENUM” B 1/0 Ab45 5 M Bl de iy (e Ab 45 12l Sk 2 4
PR s

PR R AP 4 T W GREE AT AL
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5.8.3 IUNIT_BLOCK 42 HH 38

CFC Bz I EEH N

e CifE PLC LU TG, fE“HIT"(Unit) 2SR — AR E L IELAT —A
UNIT_BLOCK f#)=24,

o W ABAFR. T IUNIT_BLOCK, 33 4 ob 21 e i B ol %

e 7E IUNIT_Block [FJ“UNIT_NAME #ii NAb, AI48E RICAFR, WAREARRET ) E%
I ICERR. T A RRBE G244 R SIMATIC BATCH 414 # .

i
IUMIT_ELOCK

UNIT Elock
@—EQ0 OCCUPIED g_0CCUPTI EOf—
o— E0 PEMD_00% VEA_ID DWE—
" |EW UNWIT_MWAME VEA_MAME M —
d6#@ |[DW UERA_ID AMAT _SP SHj—
** |EM UBA_MAKE VA_COUNT I |—
Eh UEF_MAME A:_05_ERE EOf—

Sh UEF_EEL

5W FOEMULA

Zh MAT _MAME
d6#@ |EY ESTEPMODE
16¢@ |[BY EUP_STAT
16¢@m |[BEY ICTEL

@ (I EP_COUMT
SM MAT_SP
epnable b— B0 BEA_EN
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5.8.4 TAG_COLL 2 1 He 38 )

CFC B K H &R

o UURTEHA A IEPAR BRI AR, WXL B ANREYE N IEPAR _xxx 7E IEPH
o IEOP H{i i, NAZiifE CFC &+ 46N TAG_COLL. filan, &L e oo
I 25 BB A A 20

o R (IEPAR_xxx) WZii%H:%] TAG_COLL ) EPE_CONN #iitH .
o WIUATE TAG_COLL F5E I FEARZE R 2K,

e TAG_COLL HJehZiifE il 2 HAT ISA-88 A% M GEFRfLIG: Hot; WABHD 1
V= B

TAG_COLL

TAG_COLL

Tasg Collaction
41— EO ERM EMD EOl—

"ODATA_P"—{EW F_TY“PE EPE_COMM DI

ACKMOWLEDGE
IEPAR_ENOL
Interface Equip

1—{E0 EM EMO EOj—
DI EPE_COMM]|@_ZP_WAL EOj—
m—{E0 EP_WAL QACT _UAL EOjp—
EO0 ACT _MAL

COMPLETED
IEPAF_B0OL

Interface Equip]RElol=F IIEI )
1—{EQ EM EMO EOj—
DI EPE_COMM | [8_%F_WAL EOj—
@—{EQ0 EP_MAL BACT _VAL EBOj—
Manual 1 EQ0 ACT _NAL

O —AMD

TEAMEITIOM
IEFAF_RERAL
Interface Equip
1—{EQ EN EMO EOj—
DI EPE_COMM]||@_ZP_WAL EJl—
.2k SP_VAL QACT _UAL El-
E__ACT WAL
-d@a@ @ |E LOWLIMIT
im@n @ B UPLIKMIT
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5.9 7 CFC ERF Al HHm A SFC 2R/

5.9.1 A SFC 87

i
n]{fif} SFC/CFC #x#ft T HAE CFC &4 SIMATIC BATCH {7 SFC 288 e Hisz
. Az SIMATIC BATCH!

42 SFC 5245
FHZ T4 CFC BRI —A SFC KM (B Fl—N szl it B SURFF .
SIMATIC E 288
SFC :
. B SFC k=
« 7 SFC HEE4ESHK
A
CFC :
« £ CFC BX"i¥EA SFC HK#
- HiE SFC ZERIREHI
AT

7t SFC 1, 1% SIMATIC BATCH {4t ~ %1 SFC 2574,
o EOP (&H#E)
o EPH (&&MEO

¥85E 7 SFC KA1 (EOP 8 EPH) LIS RIIAFR, iXx4xf)dti%Ed: SIMATIC
BATCH 4211,

AU P A, D SFC AL :

o LA ERAT/M B i sk

o WHBAM/MBNBOEE (ZHD

B ERAE I B R B BE A

TR AN Y SFC 287 (= BATCH 28818y f7fi e IR e e

£ CFC v, “HBEBVHRPEE S sy SFC A R4 (Fll, BATCH) JFErpH4L T Xt
BATCH 57, iy H.nl @ i i s /e 4E CFC &3 BLEIX SRR e,
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5.9.2 BIEH SFC K%

£ SIMATIC B Ea3 T TAE (AHAFHED
1. 1E"4111"(Component) #E iz #£°S7 F2)7"(S7 Program) X% .
2. P A A A (Insert) >“5H A\ Fr 415" (Insert new object) >“SFC A" (SFC
Type)-
3. JEPEHISFC KM i %, . EISFCTyell]
4. EFEE R4 (Edit) >“X % & 1" (Object Properties).
5. “J& It SFC 2% (Properties SFC Type) At ifHERI 24T IT,
- 1E“%HF"(Name) ', SEBTBUARAEMREIAFR (A 2K
— AR 1 FB g5 DL R Y E A FR
— I3 %50 (Options) 11K .
— 1E“JE5I"(Category) T, WERAEOP S EPH" LA K& 75 Vi b/ A | Bk
TIVE N BRAE DR
— FE“PEHI5n"(Control strategies) ~, %I T 0 SFC BMAI K= HIHME . ik
PRI R SFC SEHlfY) SFC A [ i e .

A
W B EOP 8 EPH” A R A S AR . AE R e (HEZEF=28A0) 1)
BATCH 41 &XHGHEH, HizHuxX s SFC 2% !
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6. VLS i 2 4" (Edit) >“T FF %1 5:"(Open object).
Zik: SFCHIJF, JFEanBii) SFC HM.

EASFC - [SFC type(1) -- Integ',57 Program({5}]
[f] sFC Edit Insert PLC Debug Wiew Options Window Help =] x|
D& =2 Blm| 28 el
2 2 == ] &lal =Em| K
— B
X
F
- |
= START
£
|5
Ex]
ahl
— END
AR Run AL | ;I_I
Fressz F1 faor help. OB35 [Start) 2

7. FEUC ] FARVE SFC L H 45 % 55 VR B 42 1
8. VI BIRFEALIE . EFESE Ry 2 “gmiR"(Edit) >“RF{L"(Characteristics) 5 1%
9. FEIEH N B (RN I SR
i
AIZE INT AT DINT o258 i M2$” (Enumeration) 51 2) Bo M2 B 257 . s 257
1N ST_enum” R 4@ A7 fil#E 110 #2110,

“#28"(Enumeration) 41 JCIEHI AN SCAS . B FAE AT HEEPE A28 2 S AT AE
SIMATIC & B 2% rh ff)“JL 52 7 Bl]"(Shared Declaration) %% T 61 % (M4

KEEH2EBE )5 ] T SIMATIC BATCH 1 SFC Sl (1 B 43 i A0 MR 40

A XS AT g B2 LA s X SFC RFIEI T 2 PE4IME BN, 155 % SFC e )
($% <F1> Bk =R a2 B)"(Help) > H 3" (Contents)) .
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5.9 11 CFC &1 GIE# I A SFC W

5.9.3 fRESH
L
7t SFC (LA A1 7d: SIMATIC BATCH M BE M (B8 Rl seng .
EASFC - [SFC type(1) -- Integ',57 Program(5)]
[f] SFC Edit Insert PLC Debug Wiew Options Window Help -2 x|
Dlelg| f]ee] Bjm =8| el
A | &1 alal BlEm| w
IT Characteristics for SFC bypell) Conkents OF; 'Characteriskics'
Charackeriskics Marme
= :
— -- Contral strategies @|Cnntml skrateqies
==| | =43 setpoints & Setpoints
£3|| | =T Process values i Process values
—_ o AR
N = Control values (8 Control values
= [#]- Parameters
22|l |55 it memory i Parameters
a—|:I| -- Timners B E'.'t mermary
— | 5 note texts i Timers
-4 Block contacts i Mote texts
-4 Position texts i Block contacts
(& Position texts
[T run A4 | B
Fresz F1 far help. |EII335 [Start] i
RS HMR
Wk SIMATIC BATCH % & R A2 4.
S8 ETEE T VAN X
WOEM | E"BOE(H (setpoints) FAIE T | WA ERIE/MT BC IS H: 7 Bl el LT E X
EE o)
HINYIRL | 7% € H” (setpoints) FFAE WA ERAEIO B S AR At k) 23 Bk
R | BRI PI/PO LRI E S5 i S g 35 mp
PR | 8 ] SR AE (Control 25 1) S W 44 FR
strategies) 1L~
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7t SFC H#IED R
1. MefF B 5 SFC o EESFCTuR0],
2. VEPESE A A gmE” (Edit) >*“4T FF X% (Open Object).
SFC 41JF, JER7HH) SFC 7L,
3. D13 SFC MIRFIEML I . IEFSE P 2 Yn4E” (Edit) >“RE{E”(Characteristics) ok # 1%
&=,
SFC A MR IERLIEI 2547 IF

4. fEMMLE T, /SR RORFIE (Bl e Edial 445 SIMATIC BATCH #f
RIIFITAT B8 AEAN 25 T SR

AN, BT ESEA 5 SIMATIC BATCH M) & k.

Bin e Ay 5 T SR 73 P B 2
1. FERFAERR B e %22 1 % (Control strategy).
SFC KA T BOEAEHRE Wos a4 I AR R ek 51 e
2. {EMLIOESEHE, LAk HE I b 42 w23 IO IR BeE K
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594

fai g

A

5.9 7I: CFC &1 6)& I A SFC KX

£ CFC B hid A\ SFC 2KAY ¥ sz

B A7 SFC A )5, RInPE L N BB AE o/ figy SFC KA RS (i,
BATCH) #izh3| CFC k. SublAmy, 288 FB 4 & HIBIIH, R e i, W
BIE B, BEENS BN DB, MR SFC RISz, CAT T AR

KA ) SFC KA IR CFC I H s, E“B3"(Other Blocks) T, 5 i
NESY L SFC R RS (i, BATCH) .

AR B SFC RS, U SFC M (ufh FB) Rl il BImiH (R A D
H.

¥ SFC sl E AL CFC KI5, Al HakAT H%.

KRAES: (X CFC K3 AT R SFC 8.

SFC il ISR T-4i 4 1 i B (i B X B 7R 7E CFC B3R

AR FEIZRI I S, W RE I R SR H4T I (Open) £ CFC R PR ILATIT
I AT G4 o

AT PSRRI (CM) TR DL At AR = il 1) T3

75 SFC ™, BRI EBRA/Hr B S B A RAL, B RAE RS HEAIL B v O 5 (R4 32
/O [ FK. —BoE ST EZ AR 10:

I/0 £ X

<% > €7 K H SIMATIC BATCH 1k PCS 7 OS i #5E1H
<&#>_Q (it el (i SFC A7 2D

<ZF>_Al €PN SR EOPUR Y EREAEIE PN

<4 #5>_ AO CHir ) JiI-F SIMATIC BATCH 1 PCS 7 OS K3 il
<4FR> M G A >k H SIMATIC BATCH (4RI 1 s (5>

<ZF>_MQ Chth) PrEHES i SFC A RUMIEHMUS)

< #>_MAI S%S, PR R R IR [ 5 A\

<%F>_MAO | (i) M1 PCS 7 OS KWk Fe e

< ¥k>_B (B ) NHEVCID ORBE . AR ]
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/O 2 %% B X

<#F>_BQ (Rt NHEVC D ORBE, AT

<% Fr>_BAl S%S, NHEVC ID OREE, AT AR

<#%FE>_BAO | (i) NHEVC D ORBE, AR AT

* A PI 5% PO #5257
o A /O F T S -

EERAR X
Ccs C#IN) | K1 SIMATIC BATCH 5 PCS 7 OS ff# il %
QCS Crd) 0 SEmE O SFC A 3 SR B
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Chart Edit Insert CPU Debug Wiew Cptions

Window  Help

5.9 7I: CFC &1 6)& I A SFC KX

=101 %]

=IC

Functioen 2
EFCtype

a—AUT BALTH AN
S—{KAM IOLE
@—{=THET STAETIMG
@—{ COMPLETE ALY
G—{HOLD EERDY_TL
B— EEZUME COMPLETI
a—{AEOET EREOR_C0
a—{ =T OF COMPLETE
G—{EESTART HOLOIMG
a—{EEZET HELD
1—{EMETHET EEZUMINIG
1—{EMAETART EEROFE
B—LOCKCOMP) (HELD_ERE
G—{LOCKHOLD) [RESU_ERE
@—LOCKAEOQE] [REQRTIMG
GB—{LOCKETOP) [ AEQETED
B—{LOCKEERD) [ETOPPIMG
a—CE STOFPED
A—{ECT OF _ERE
B—EGT_TAC LI_EERE
GB—{=ELFCOMP] [EXEC_ERE
@—{=ELFEEZE EREG
1{IMETEQUT T_0OPEAG
B—{CYCLEXELD Z_ERERG
@— TIMEMON | [QOCCUPTIE
0@ @— Eeald_HL AER_ID
o m— Eeald LL AEA_MA
o a—Eeald QETEP_MO
Eeald_AI AER_ER
im@  m—PI_HL ACE
o @—PI_LL Ezald_AN
@ _a—PI Eeall_g8
PI_AI Ezald_AP
""—PI_M FI_AD
FI_WAI FI_®
a—FI_E FI_HWP
@—FPI_EAI PI_MAD
PI_HA
FI_MAar
PI_ERD
FI_ER
FI_EAQF
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A H S Th e R Bt A = e A

WA IR SIMATIC BATCH £ i) B bt Dh e de ittt A 4ds . /£ PCS 7 OS itk
T, RGiR B i SIMATIC BATCH 19X — sk D, I Bon IEEIs T ANt
e AR ARRANE 1D K 2 PCS 7 OS IIHE

N, ZRA LN TR %

SFC K7! HEhLIhRE 141, MEAS_MON. MOTOR...
QBA_EN BA_EN

QOCCUPIED OCCUPIED

QBA_ID BA_ID

QBA_NA BA_NA

QSTEP_NO STEP_NO

Skl BNy
AT REAE A BB AR BRI A IR 55 2 X iy &, A ZRBEE R B -

ENSTART
ENCOMPLETE
ENHOLD
ENRESUME
ENABORT
ENSTOP
ENRESTART
ENRESET
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5.9.5 BREITH

i, WA HANETH A 2 /R HO6 (QUNIT_BLOCK SEFIED DLERENS
SIMATIC BATCH T M4 #5540, i/ BATCH 41 A THAE 1 4T FFAH N 1K H 75

7E SIMATIC B H8S T HIB/E S B
1. i 3% 56y 4“8 377 (Options) > SIMATIC BATCH $7JF BATCH 4L A XHEHE .
2. {EAREGE T, PR I R R TT I SR CE R TT SR
3. fE“Wh(Protocol) X ikH, i <" (Display).

L
BoNEERHENHER . EER O ITH ] H R E
3

SIMATIC BATCH ™ i (5T 80)
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5.10 11 CFC [FZ 1 BYEFITHAN )L FEbn SR

5.10

5.10.1

£ CFC BRI P il En R

£ CFC BEIR A Mism A P il FRrr 2 R A

£ CFC Bl alg s A F I ErE R

A PR L rT AR I DA T RE L (i, R AR
e ffifi] BATCH : ¥t TAG_COLL (5 BATCH flexible V5.x FAH[A])

o fflbrHETREL TAG_COLL, Nkt H4Fk TAG_COLLECT FLAX 7MXM# (H
V6.0 2 SIMATIC BATCH H #8245

FE IR ek bRt D) B tp G AN B . SRS /E BATCH 21X EHE (L A= = 25 Y
(“YE 18" (Generate) #¢41) #1874 . TAG_COLL/TAG_COLLECT e/ pliidd Fbras iy,

{#F TAG_COLL BATCH &k

i/l BATCH £ By, TAG_COLL Sl TRl R (B LU e ez AF . JF AT U A
KM AR AOCHEIR, 12 W TAG_COLL # VB PRI (02 169)i 7« Bl i A it
FEARZER AL m i DAL B, Il fE BATCH 1A% EHEH 34T 12 2.

fF TAG_COLLECT Ihfgsk

180

IR AE ] SFC RMHBHATAR, @A A TAG_COLLECT #r#ED)ae LAl e
FE.  BEJS AR FEAR A AN E BATCH LA XHEHEF & L. AT 7E e DhRg e
PO AR . RIF A S P ACR T IXEE S BdUa, AR
A= R RS AR 2 AT

A

o 4y T1f TAG_COLLECT FB/FC JAfighi e Nid R H7ct) BATCH ZHAX e (24
B, WAAHE CFC B 22064 — ik TAG_COLLECT (#)—~5:4

o FBRHUNAE S7 FEfFak CPU A ZME—(. SR, X THEA AL, DA RIEEEA
T H B2 0 H g E
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5.10 7 CFC L 8 EFITTAM ) i F fr 28287

510.2 Pk QIEHTIRET
A7 PRl R R SR ) Tk
o ENi1. STHIGIEF FB.
o LI 2. QUM CFC EIZIPK IS A— .

B 1MTRE: KIS RIE AR N FB 288 TAG_COLLECT

1. 7€ SIMATIC & HEZS AL b, B REIE R s 2“4 (Insert) >“Yi A\ Bt
%”(Insert new object) >“ThREEL"(Function Block) 7& S7 F b S0 32 b ) ¢ 5 o g
e,

2. EPExThRE, ARG ERER L 2 dn iR (Edit) >“F] FF X 5" (Open object).

3. (EMC A ERE A A (VE M ANSHO W T (.
TiHA
IHAUH ] SIMATIC BATCH foiF RS2 .
Bool. Int. Dint Il Real.

4. NZHOTI A @
— WAL, S7_check =true (HITHI#AD , I H“S7_unit = Unit" S5 W T
RRLHATR) .
- S7_edit = para, HTiZFEX G0 EH 1) 5~ AT .
— S7_measval = true, H T4 A 55 B IR A 5 RS
ey
— S7_archive =long-term 5, short-term, JHF A 3h 4> B VR4 A8 & 1) 78S .
5. MEFINfieH, SRIFIEFEE a4 g7 (Edit) >“Xf % )8 1" (Object properties) .
6. N FB TS 4.
7. BRERIFTIT A D Re D X AE i) 1L (properties) &I .
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8. ¥ )@ PE“S7 _tagcollect” GEFEFRZE) BEE M“true”, FilEPE‘s7_m_c’ W& N“true”, LUE
HE AR R E, HAXFEREE, A2BEMSE0RI%S PCS 7 0S, Hinft#
P IR

Properties - Function Block E |

General - Part 1 I General - Part 2| Call:  Aftributes |
Attribte Walue

1 =7 _tagoollect true

z2 =7_m_c true

3

4

5

&

7

g

9

10

Inzert Fow | Delete Row |
Cancel | Help |

9. i (OK) N X sL gk .

10. #TJF CFC %, JI1¥“S7 5" (S7 Program) U432 () Thfig Heffi A 3] CFC K%
G
gi: FB M TAG_COLLECT BonfE“H e, B Bon7Eriis: FB H R4

(i, BATCH) Ry, 3 Haf e B TS H e Fabr 25,

Pt BA
FB 2% TAG_COLLECT WZiAFffERE (BlnIted™y v, LUER 7 BATCH 414
XU HE H A e Ak XA S 1 o AR

11, 4 30 6y A“Ze 0" (Options) > SIMATIC BATCH 41 JF BATCH Z1 A% HEHE ..
12, 7E 2B 1 ik it 2E P2 22807 (Bateh types) X% .
13. EA I X 3k 55442 1) (Generate) %411 .

i HEOEMH (MASED ke Hd BRS8N Jf s (LD .

14. Hfi i (OK) Ml B i A «
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5.10 7 CFC &1 G ERITTAN )7 L Fpr s

gE. QAL I, XS FEAR SIS ] RS A P R R AR . IR A S RO E
“S7_measval’2(“S7_archive”J& 1, FF A ECL R oc) d FEAR =" 5 WIinCC RS H H.
FE, AT AR T A I (R AR B kRS (Process tags) MEIR R RS e AT kAl s A

i
WREA K TAG_COLLECT Dhgedh s N & & B E“S7_m_c =true”, W% A BN
“S7_m_c =true”, Kl FH TSR HH
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5.10 11 CFC [FZ 1 BYEFITHAN )L FEbn SR

5.10.3  F_FhiEFF: Qg CFC BRI HmBEAIAKAR

i

o &>~ b

. 7E SIMATIC & BEgS ZHEL E H,  Jl R e FE 2 i 2“4 N (Insert) >*“4& N &t

%"(Insert new object) > CFC 7t [&| 3 313 N B CFC K3k,

1% CFC B3, AR5 IEPEE A ar 2 “dmi8"(Edit) >*4T FF X1 5" (Open Object).
T M B (View) >“ B R A\ /Hi H” (Chart Inputs/Outputs) $17F 1/0 .

TEBE, WA AR A A SR T AT (B2 40 IN B AN S 5L

JSEE R A EYE (FESEUNCEYE - 48 B (Properties - Variable) %G HEH . F i i
PR BT IE RS, SRS LR SR a2 X 2UE 1 (Object Properties)) :

— S7_check =true (FHTHA) , S7_unit = unit* CHLXERN TR TR .
— S7_edit = para, FTIIRERTGAR K ) B AT 2o

— S7_measval = true, 1A 3170 BC VA4S & (1 )14

B

— S7_archive = longterm E{ shortterm, JH- T 2h7> lc ARG 2S5 RS o

¥ariable Properties |
Generall Information  Attibutes I
Attribite alue &

1 =7 _archive loncterm *
2
3
4
a
G
7
g
9
10 hd|
[ mtes

Ingert Bow | Delete Bow |

] | Cancel Help |
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6.

PEE"(OK), AR .
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5.10 7 CFC &1 G ERITTAN )7 L Fpr s

7. IEFER 4 B R (Chart) >*441%"(Compile) >“%i 3% K& 9 A" (Chart as Block

Type).
8. 7L H"(General) LK, FaE THINE: FB 4. o BfARY] (i,
BATCH)

9. V)43 8 1 (Attribute) LI,

10. 7EUL, K5 B E“ST7_tagceollect” GFEFRZE) BB Ny true”, FFLE A 3o B IHAY AR & i,
Wk R s7_m_c"& & b “true”s Fl TR SHUN AL R PCS 7 OS f, 1 HAL Y
SERL T AL ERAE JG A v WA A

Compile chart as block type |

General  Attributes |

gpstem attribute value
57 _m_c true
57 _blockyview big
S7_tagoollect true

—L = D |20 | -t T | e i f P [ —

— =

Beferense; |

Dot Fon_|

k. | Cancel | Help |

1. B i€ (OK) B I i .

SR FB 8 TAG_COLLECT n oz RV TR e bR, R &I s
21 5 9 B LR L B SE A .
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511 HIrZ L FITF H 12L& 7 BB

5.11 HATE IEMAE AT &1L & BB

5.11.1 BAT& 1L BE

& X

HAT 2R 5B BOgt & UL FE SR A4 R i, Het) b, RUN IR 0 45 2 ST b
Ja 5 COMPLETING JIfiJ¥.

SEf). EESH
SERZEPEY B RUN 72K 2 5 4 RHECR I 450, AR 5 7 e )5 3))
COMPLETING JliJF(I%E—2 . WAMEBAE RS2 EHIT, 1% STARTING-RUN-
COMPLETING-COMPLETED i/ %484k, 1XS8lii /7 i 4 Ffi ke, B Tk A2 i A 52 $8 A
B T-1iek SIMATIC BATCH 540,

START START
A
1 2
Valve open Valve close
DosingOK

2 1

END END

RUN COMPLETING

“AAT AR BT AR BEE Y BU IS R AT LAERTAT LY SFC A h s #E i SFC
Sl A, X LR P i 5 *SELFCOMP”,

SELFCOMP=1: HATZ LI A B
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186 #A/ETFF, 03/2009, ASE02171120-01



T FERZ (ES) 1119 &

5,11 HIrZ& L FITF F 12L& 7 b1

511.2 FEETLIERRENE

& X
JE AT AP B AN & il i B A Aok 45 A B . 4t RUN > 45 7
(Ready_TC), PHtixFhixssHrBenl LAl ANy R4l . IX—4MiBar 2 n] LU AR 5
ik SFC TR 1)“% 41" (Close) 5 /& SIMATIC BATCH i id“>% [4]”(Close) fir 4 & H
a8

SEf: B

JEBN PR BB BUK RUN B . B NLE B BOE MRS, RUN B E R, BB
Ba it izbrBeCoe k. “COMPLETING” 2 $R R el L ##:41: S35k SIMATIC BATCH & i (1)

OISR = E P
START START
4
—
1 2
Motor on Motor off
2 Speed OK 1
END END
\\
RUN COMPLETING

READY_TC
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5.11 AT 2R 1L R ATT2L RT3 4551 B

HERK AR L, BAM B S 24T RUN T (RUNRED H, XEE
#& RUN I FXE S, 03455 RUN BT — IR ITA S IGAPAT, WL ZIAE" JH )
254" (Start Condition) & 15 -~ ¥ 5 7 J8 14 b 47 L ¥ &

1 |[run = =][Aun
2 |[REaDv_TC [ v|[ReayTC
3 | =i &

CAAT AR BT AR B Y BE R L T LLAE BT AT SEA Y] SFC SR sl F A SFC
SeplsRp A, X AR X B i 5 SELFCOMP

SELFCOMP=0: HE\47& 11155 M B
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5.12 &4 m IR iE

512  x#&FREHEAIHE

£ SIMATIC PCS 7 V6.1 Z R A, l AP i izl W2, f&
QS 7 I R BC 5 G 4 s P et SR SL AP AT IS T R IO AT T #AC. - 5 SIMATIC PCS
7 V6.1 B R, ] DUR X R

BUE, 104 mT LU Fiop (K SR K He e P HEAT BOCIE SR XL B B Lo Lk
e m ik, FlmspociRh CRaRE) BURS AN seIRHE T -

B TEAE ES Al BCA & Hot, FERUENCT N AR E P A E . i et
P v B SR A AR, 1% BB R] A5y i .

W
=

O Jm PE (70 190)

R v e Jm e i gs #og (0T 191)
AT (I 192)

fir F 2% (a2 g (5T 193)
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5.12 i 7 MR I/

5122 QgL EME

2k
o I = 1]"(Shared declarations) SCFJ, [l AEI H H A “ B & &
" (Equipment properties) 1303 .
P&
1. %= A" (Shared declarations) U3¢, 7F F RS, ke dE A BTN
% "(Insert new object) >“¥ £ J& 11" (Equipment property).
2. hEgEMEGS (BRFE R .
3. WA R b e 8 e s B 2R 8, AR5 H A — M sl & f i . 6 T
H”(Location) ##E25M, E B ) =ANRAYYE" (Source) . “H Fr”(Destination) 1“8
i (Via). A GKLERMEME L, WSH AR 3 SO
4. HESEMEET TR N A G, B e (OK) Bl A N 2.
R
BUAE AT LR iZ BE & B E D TS e T o R IEAEAFE 20 H , T DM SR
Hi”(Shared declarations) >“7£ £ Ji H # ###£"(Adjust in Multiproject) @iy 275 MP HH i3
G (1) B A5 S8 1k
Z N,

R JEm PE 2 Bogs FRou (0 191)
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5.12.3

2

w

W
=

BN

L

5.12 &4 m IR iE

K e & IR M5 L4 T

OB T & m .
7€ SIMATIC &Rl gs b Bon T #WIK.

C ERE R AR TR SR YE, AR R E PR A BT TS " (Insert new

object) >“¥% % /@ H:"(Equipment property) | F i 4.
VEPEw A m ik, A ok kPN 5 )@ #E7(Object properties) | N 3L a4 .

FEAPRRERT N Hr AR Tk T B & Bk . AZSEB A4 FRas 15 L2 ] P ) J 44
T o

fEE"(Value) HEHF, FA— i@ PEsctlif. Wik mibassas, warbiqe
“E"(Value) HEH i R Hr 812 b T I RS IE 36— ME

S SEREHER A EUR, SdiiiE”(OK) FZAHLE AT A A 2o

BUE, Prig e i TR mIEA.  FEA it B 2R 2 )5, Rl 7E G i Jy /e
HC 7 2 e s AP X 2 J PR AV A D 7 BE A T

HASHITH (7 192)
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5.12 45 JE MR A
5124  HEHRITAH

i

W
=

192

WSR2 A oo A AR w & @ v, AT DO X e e gl & ool . 7
SIMATIC PCS 7 V6.1 2 A, Bocdlik i, BRI S IA T H I, X
223313 UnitClass” % 4% J& Pk «

7.
8.
9.

. 7t SIMATIC & FEZS AR E T, AR AR 19k 28 (Enumerations) SO 141

H—AH 2" (enumeration) X% . ARG XA TR E — AR, Bl R T
7. M@ W Group_A. Group_B XFE 4 FRifi A £ /N (Value) X%,

CATHAEIER AR (B R o) QA ErE. iz R oo oo

HKAINT EDINT”, 4R )5 M “M28”(Enumeration) 741 ZEHE e BRI KB 2 AR 2

S SEEHE TR AR, S HE”(OK) A A 2
CBAE, BEAROTABCA QIR —ANRTTAl. ik, WEIERER TR, A

B Rk BB 4" (Insert new object) >“¥% £ J& ¥:"(Equipment property) I~ ¢

ETES

LR AR, AR R E PR YT BB M7 (Object properties) 1 SR LA A
C ERFRAET, R R AR R BT R we A B e, A e R e (Peell

Group).

7" (Value) HEH EFE— NI 4

FIIF A AR A P~ BT, (Configure batch process cell ...) 2 AR UHE
BATE A A R T RE e, I LA RO R B AT AR A

10. WERAZ T — A s MMEAE B Jm P, T DR iSRS e e s i 4

WAL W Peell’SCfEk, SRJG ST I RE s oe L oo dl”.

HATMR R 2 A Rs DAl G AN Rocdl.  BIRERCITIN, WA b SR T 414 o BT
IrBCH A AT

i I 25 A48 2 70 (0T 193)
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5.12.5

Bk

P&

5.12 &4 m IR iE

ik A& e TG

FERCTs it et DU SR A2 A G DT B MR s, ekl e ) A,
I HICI R 2 HEhi %, AN BEiE Uy

AR LT 24T T

. PRI (Options) >“¥% B (Settings) >“Ti H 1% &"(Project settings) s iy 4, R

PG M (General) ZEI0-R R A “HEHE 4&44F3E1T PR CIE £ (Unit selection according to
conditions) EEHE. T, B CURF ISR B B FTC T Bl e T AR 1 BRIAE
FERCTT dmt s P AT R 7 Tl i 4R 5" (Recipe) >“Br @24 ..."(Header
parameter ...) ] 7“4} lic”(Allocations) &1 < .

BN LR T LT /B, ARG e e (Edit) . WEREA R e, W
“HrEt"(New).

LEFTIF I RHTEHE A BT B " (New) o IXFEIG A — AN IR 25 41 o

Fi B " (Change) #44, LLER ST L 3EE .

Fob, EER IR EE, R)E RN 2P (Next).

Bop, EReHAT (R (Available) R PP L B R IR A AAAE, EAS A
A

URBEAT RIEE =2, WL i A\ % s VDT 5 (R 4L

a2, Hali5e K (Finish) f24l.

T DU A AR s S Al e m P E R SR 2 AN &

PR E(OK) S H A EHE o

AJ LUZ AT RC 5 R ) m FH 5c o 7E“sr lid " (Allocation) 3EITRHH . oo/l i SIMATIC
BATCH #R4E 8L 7 B BEF BT AT H I 2 AF e, HANREGwW
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5. 13 HFHE L FEH I HI T T

5.13 BN RN - I BVt E i)
5.13.1 R ITHIR A R
s
154 7E SIMATIC BATCH Hf G gt 77 o3l 002 25 8 Bl 2 peaod P B TG ISRk, IF
WIRTE KIS CFC IR MBSLOllAS . T 0N, e X FoImm,
SUR L e SIUE
KR Y TR D 45
e FOHSE RN, VR B R . MR,
HYEL PR (V4) Rt kAL,
T LLGIEE E OB 2T 4 S R
Ly T L G A 7 PR B o A B
Y SIVN Jo T AR ML TR T ORI T 7, ISR, T
W BRI R AR | el S e A I o
KA o FR{EM. WKERIE (EOP) TS A
o MBI WaHB (EPH) HIZEILE K
o FRRAM, TAG_Coll B2k [
T 5 A TR R B TR0 43 TR S B8
Bk TTRIE B TE I # SR, X AT 1B
B
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5. 13 JFHELFEH I HI T

KR AE SIMATIC & 3 28 11) BATCH AN IEHEP I TAHE . HARAA T BT
o LEINH TREEZINH T
o [ )& SFC AL & BATCH £ 1HHk

5 S R A 2R

]
WAL = A A 28R (Bl Bl 2R 7D /e SIMATIC BATCH H LICRALfiliid 417
R AT IR S on . DTG B R P i 35 0 AT 5
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5. 13 HFHE L FEH I HI T T

5.13.2  HIiHPFRREHFHR
HARRIHIR

KMHATE BATCH 45X HHEP 44,

o HTSEH AL

o [Rk—ANR%, SRJGIEEE F N SCER 44 SIMATIC BATCH
BATCH AHA&XTEHE

Canfiqure Bakch procezz

LA RIAIE, WAHE BATCH A TRHER e MIE i fib A= = R0 R o RTT LR 5

CR“+") J5, R MBI AT et A R o RIS R I P s AE R A A A

M1y« 7" (Properties) N1 .

rel "Rrewdh1” inInfeq’

WG AE il LAZE AL LR T AL AT T
T5i"(Options) > SIMATIC BATCH

| rreq!Rremk1RArh b res

Trocess cell dats Maperlie:

@ Iriey = 2! Batch typoa

E- ﬁ [ j
E _‘1I Lieschpton by [IRERHpTNN
: |I| [7] Draca o | Azt rhanoEr nn Q2350200 10.CF. 435020 a0
Do A nf TRAs e Last crergeto datatvpeson  |D20S6R00= 01,10 0,033 Al

i m{s] Mhase apes

f pgJEE 0ozation hipes

§ O ma] Process lay ypes

: E-l;' k quprrert properia:

F| @ Balihiilar e
Ill [55] Rzawer_al
B Riamer_b?
0] [ga] Rzacer A
B3] Fizaccr_id
e Meaer A3
H3-{a] Heaecr B
Fi-{ua] Fizae_B2
E-|L| Hazwor B4
-] Rizaor_Cl
0] 5] Rzacer EX
E-@ F==<rr_F77
f-{aa] M==scr_ LD
t4-4T3] Fizsoor E2

e, I Spple |

E atch tupes

Geroratz |
2= |
Mz |

“atazal
| G iencle =l
0 Er
A0 Wanrd:

Mizpla)

—— fddional bunchons ——

Font |
lmpot. |

Larcel I H=fp
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LR (ES) 141
5.13 75E XL FE #0197 Al 2

i

|

A

7|

S

Wi FRIR 523 R

prr =1

/N"(Display) #&H i LU R e, BT G2 N IR T b
WA 5

" 42 S TR ) G B R 5 2 B S,
s A R K.
BRI 53 2 DL S A T A R AR 4 L
(Display log) 4, ] LI ZAF 4 B ek 65 30 s,

e AEIE T PN=F
# Bt
(4] ik
T R R (BRI JE) , TS b b o
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5. 13 HFHE L FEH I HI T T

5.13.3

BT H A AT D e

BATCH A iEHE 4T BATCH 2881 () AT $14TTh B

Dhke BTk Xt % TP
HERR {1 A S YA | e SFC K. M4 EOP/EPH ID {1 SFC KA g4 AE
I B AL
e BATCH #:18: M BATCH 2 e fry sz A4 ple it Az =
KA BN FRAEBY B R bR
W WA, SFC 26 8ak TAGCOLLECT FB #
W, ARG B2 By P A T T . LR [ R
T PH ST is ek, Blanfefsshak 24 CFC B q .
o o B FE T DX 3 B BB B A E RN FE AR 25 DA B AH W ) 28
o BN RZH
o IIFEFREEAKA
Uil o KA AT DUAE AT S 2 rp MR B 2R A . P B 28 e
o FPEUREM (ptid) | MRREEIE. BT AT OS SAEE R e
o JiEEA SR UAE L A R A ], 17 HLAE R 2k B 1) iE 2 v
N Bl XFTERVERAL. MBS FipRas sy, HEixt%
S 3 S T L 6 A g PR 5 S 0
o PRfEM
o LIFEFREEAAY
o WHIEME
Y o BRI S AT A P ST R A 0 1) s
o PR{ERAM i 4h: SFC 2
o IIFEFREEAA! g SFC MM, T % “GIEH SFC Y
(T AT1)" 57
B mTh e A FTED:
FTEN DL T 20 FT BN R B T AT b A e 2
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5. 13 JFHELFEH I HI T

o [TBIEEH
o PRAFARM
o IFEARZEIM

o A

Thie Brigxt % Hiik
MEnThee e FIUEUERE CWCRAFAE) | SIS ICRI R S, AR AT R D ds ik pE L
B o Ui JE T

H & A=

7R AT R E T RE H &
BN HE, AHE N RDE R SR PR R RAT IO DIRE, A

Ja Bk iR (Display) 145 .
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5. 13 HFHE L FEH I HI T T

5.13.4  ZTiHPFRIREHFHR

HAFRIUIR

200

AES I F o, SRR P S AL
AR I H IO FE AT H G R i P, B B i ok T
A,

UEREEATH N 3T H IR, s nT LU € Bt A B A2 I H B st A3 k)
VUI3E P12 i 3t S DR 2 T H R RN I CSeVRgdRaeqt) « IXRWIEATLL
TEFEARE 22 10 H LA SRR T T CGEBD A Sl 284,

o
Z 10 H R P A I H BATAR TR (BRI SE 42

BATHA I H 5 O A IR s . it 2R A R ARSI H b A
M,

RIRIAAE BATCH HAXUHEP A O U HE a] 7R 20 A0 A ) R T T
o iy 4 “1E " (Options) > SIMATIC BATCH
o HEFEEZUIH, REESE T4 SIMATIC BATCH

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01



LFERZ (ES) THIAE

BATCH AT iEHE

] A

5. 13 JFHELFEH I HI T

ARBFEE, IAE BATCH LN TR AE A e e e b Az - 2RI 5. Pl R ITAT

(") AR P AT RE AR PR RN B
75" (Properties) [

Configure Batch process cell ‘Kitchen' in “zEn33_01° i

2En33 01 /Kitchen/Batch types

AN G 1 Je VA s AE R AT AEA 0 1) e

Process cel data
|§ zEn33 o

Propedies

(-1 Da!a lypes
%1 (@] Units of measure
{4 Dperation lypes
5 () Fhase lypes
(E] Process tag types
(3] Equipment properties
= {5 Balch instance:
= () Stove_1
[ {ga) Oven
[+ {£5) Pan
{55 Pot_1
(55 Pot_2
® @3 PoL3
_ﬁj aewport_1
_:] Desk_1
B _‘ﬂ Add_Ingred

i Batch types

Desciiption
Last changed on

2008-06-17 132356401

Batch fypes

~Log

':‘: 2] Diain
4 _‘ﬂ Fil_Sohd
(32 Tumn

HiRER

SERE TN

71" (Display) #4417 LL s e 1.

G A 1 ) B AL B PR 50 TR R R AN 2 s AR H AR O, Bl
M T BT d i BT e o s ik
RS ik oy ﬂf%iuﬁé&ﬁébun@ﬁﬂ%m

TR IEFA SO B

R Har A4 B H " (Display Log), I BALLSCAXT G 5| B Ak Won s w4k 2
(] LRl

5] i
W TV B RS

SIMATIC BATCH /i, V7.1 SP1
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5. 13 HFHE L FEH I HI T T

5.13.5  ZTiH$HIATHATINEE

BATCH A iEHE 4T BATCH 2881 () AT $14TTh B

Dhke ikt % iR
HERR {1 A S SEiA | e SFC M. Mii4y EOP/EPH ID [t SFC 274
FCERAE I B2 A
e BATCH £:r1#t: M BATCH 32 113 fry sz 2k pli e
ApE A G E AT . BRI B i FEARZE
LUDIN
o FEZIIH LAY, b4 MZ I H T I H 1)
SFC 278y, BATCH 22 L Bk alefte A= =287,
V. R A sz e, SFC 26k TAGCOLLECT
FB #5 ek, WIAEdm B2 ji b As T Al thig. ik
FOUFRIFEE H T PH T is e, wline s shoi e
i CFC KX 5.
1E% LAz B e B I 2RI R R E 45 2 T H A0 H S
PATICThRE G, RIAEREHE Fp 3 £t AR = 287 A 1
BTl I H o ARG BT BTk I H 128 b 7 A
—5,
o o B FEITIE DX 3 G B B R AR R R AR 2 DA B AR
= INAEACE S I
o IIFEARZEAY
Uil o HikA AT LR BT 3% SO A i B i 25 7 . i P g 2R
o JHPAMURAH Cniigig) | WA EYE. BT RSB SR
o SR Bro EEAMKIR AT DAL BT A, 1 HLAE IR
— AEARNE SR L. ST HERESEA, B B IA
T I FRBRAEAAL,  HEH G R S B T LUKt
o BAFIH YRR S B AT
o IIFEARZEZAY
o Wi EtE
Y o B EATLEE R ) A YMEE N Y I ST B g )t i
o PRERAY i 4h: SFC M
o IFERREEAY K gmts SFC MBI, nr &% “GIEE SFC 25
(A7) 55
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5.13 75E XL FE #0197 Al 2

. BN

Tk Piext % s

W mzh e He2t ek FTED:

e LRV AT B8 TR0 AT 25

W e o FHPHURR CRAAD) | ST R RIS, T U B

I AT
BB
(e
AR
B m ik

HELLJE L

AR

B4 (Generation) H ik .
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5. 13 HFHE L FEH I HI T T

5.13.6 LT HKEANIE KW HATIhEE

BATCH AZAXHHES KA g

Thig

Brigxt %

iR

B InThag: 4TE

AR

PARM AT B RE ST 0 A 4k A = 28 2

BEonThag: W

o I EHRIA CWUERAFAE)D

FIH BT SIS B Se . 7T DL i g &

o KL FEHLL R 1

o [rBRM

o HRAERM

o IIFEARRERA

o WHEYE
H& oA R T WoRA R H K

AR S W iEH &,
R feAE SURT I A 2R (G AT H A

KA
(AR S g A R T R A H A 250
Y 1F AR S G DAL A 7 S
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5.13 75E XL FE #0197 Al 2

5.13.7  CMIERTH + KA HATIIRE

FERA AT gL AR PR R BRI B R ThRE

Tike FriExt % TP
AR o fitrErE e SFC M. Mifi5 EOP/EPH ID [f SFC 4 ik
BRI Be R AL

e BATCH #1085t M BATCH 42 H e i sz A et A&
FERA IR FRAL . BRI B A i R bR AR
7,

o A M EMIBRIH (1) SFC 2578, BATCH 4% 1k
A A A R

W EAAE A2, SFC 2% TAGCOLLECT FB

BB, WIAESR B2 AT AUBAT A B e, IR F

[FFEEH T PH sl ie s, wlindeshel i CFC

HEIEH

Hre o BrEzA TERTG DR S O B A e P 85 LA A% O A
o FREHH MRS H
o RHEEI
Wi o HomAH AT BAE FIFE SO 52 P MR KA P B
o FPMUREKM (nEApd) | ERARIBEEENE. P S SR -
. B (AR AT LALE S F P, T FLEE R A )
P R LTI, X TR B A R 4
e M, SVER B S BT LU R U 0
o R IR AT
o FEE
o WHELE
i o BrEzA AL 2 7 R R B R
o BRAERA flsh: SFC KA
o IRpESI 156Gk SFC I BN, 7 2% “RIEE R SFC PRI
(A7) 557
it 2 e f HTED:
ke L2 B AT BV BB T JIFAT i
1TE
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LFERZE (ES) 111 &

5. 13 HFHE L FEH I HI T T

TiRe B Xt % Eiip
B m o HPEHERTY CUnRAFAE) | B ETA 5 H SR EIXS G s . mT AR G e sk PR
Thke o LAY Lo,
o BN o [rEiM
o PR{EARM
o JIFEARZEI
o WEEME
HE bk pe EoRBPITIERC D RE H &
B TR ER CPATIIDIRE, ARG Hah
7" (Display) % .
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T FERZ (ES) 1119 &

5.13.8

fai g

EHALR

5. 13 JFHELFEH I HI T

Y SRB A RE 8 1 SR

[R]— AR AN R G247 5 ) FEL IS A B B B AR D i i A R i 42 1

S o

Py B Bergg dt T LUE S — LS ReAE Tl sl A 8 () B el (—dAioe

D SKRSEI. 4 T REMEAE H SR AT P PR S, T B B R 0 SRR A

S o P IS B HAH N IR BOE A S BE I A2~ 50 SFC KA TRER G H b ATARS . 12
Py s, DO 20 SCIPR i Sems LURAT Pl Sems A4 Rk i) — 4L BUE EE A A

FERCTS oy S Hnt AT @ TP e 1 2404 T |

iR

SFC KR A2 FR AR ] SRS 42 B — 2

HIRABTERIRIG, RGN HBaR SFC KRB BRI IR A PR BAT] S St
HISENE 4 FK, JF HARGEEE AR AT B

TR P R A SFC 288 (IEPH FI IEOP) IFSHISKRMS Z4FK . Pl SR K 44 Bk 7] B
A5 SFC KRN A ARILAL, XA REAEAARHRIN - AEHHR CRIEHHR) .

o {fiJf] SFC 25/, A& SFC My, o n] LB KL ThBE R MV £ I B A fe 2
BRI SRS R . BRIEZ Ah, TR RN I SR PR 1 (N — S S R A
*x.

e U PCS 7 I H B Wi 4k 23 4E (BATCH 41L& XHEHE) +  7F BATCH 414 XHEHE
WS ET P B 2R DL RO R A R AR T B IR A3 A 4 S SR S B B 2 Ak
e LS AT

o f{iiffl SFC (SIMATIC & #$M1 SFC Zwthas) « Wl Bl sess b L s vk LUK
IEPAR_ENUM 3 2 (1 IEPH/IEOP B, SR AFrias il semg .

P ) SR R 478 £ S S BE 2 PRI 2 S e L R s e Bl b, KRS ) g 7 BATCH fic

7 omiRge R

L
A BRAE BEOR K e QI MBI S
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LFERZE (ES) 111 &

5. 13 HFHE L FEH I HI T T

Kk SFC REMPE (SFC i)

208

SFC 441 JF SFC 2%,

3. 41JF SFC MIFF AL . ZEFESIR

N
SFC B R HERL K B 4T IT

SFC  Edit Insert CPU  Debug  Wiew

1. YPESFC K4, [EHSFCTwpll)
2. PR A4 g (Edit) >“T I % 5"(Open object).

it

Options  Window  Help

4n’E"(Edit) >“R¢1E"(Characteristics) 5 # 1% LA

=10 x|

E&| %R Bm edn ¥

sas|aameme

I_Iae' £ 8 f; ab

{H: Fill -- SB_Prj’ Automation System’CPU 41744,

=10 %]

Characteristics ko Fill

|Cn:-ntents Of: 'CharacteriskicsiCantral skrategies'

Contral values

= % Characteristics
Setpaints
- PrContral strategies

=
=

|Name Disilai name|Number
CIh

[ o= ]
=
=

Pararmeters

-4 Bit memary

Tirmers ‘| I _'I
-]

[
[T » ] STARTING ARUNMINGH COM|| |

Prezz F1 far help.

kressste 4
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T FERZ (ES) 1119 &

4.

5.

5. 13 JFHELFEH I HI T

FEE, 2B s e AR SIMATIC BATCH AT f il ems . 45
R PTATH R 5 S S AR A O R R R B v

FE MBS SAEHME, DL A 42 1 SRS 73 FC 1 0 5 fEL o

i ff BATCH 210G HE i AL i Fe L B NSRRI A 5, A7 (CHBD 4R
R SRR AT — DM LBR RS . e

#H PCS 7 T H I 4k 44 (BATCH A X EHE)

1.
2.

5.

i 2% iy 2“1 T " (Options) > SIMATIC BATCH #] Jf BATCH 41X G HE

W RS BAE B BRAL, WG AN 280 (a0 fw_param) o 7EAME E B B
FAPRNIE BT O B AL, SR 5 B B i 44

i RS HAE R

. i S s 280 (Control strategy parameter) & EHE. i f il S &

#1”(Control strategy parameter) &2 Gt A4 Il ()" (Edit) #8H. 74T HFI“FW_heat
(1347 T SR ™42 1) SRS S P X T A v Dy A T SR WL 7 I e (. (S il
SR

TE“ T BC B 2K 1 (Assigned data type) 412 HE 4 0 43 e 1E A 42 i skems (ol
FW_Heat) . M. FEfdiIemiey, RV 4 il s w25 ]

i i " (OK) b BATCH 4LAHEAE .

i OIS s e BATCH A IEHEF, IFar A AT N A P ik 5

iR
itk PCS 7 I5t H BRI S 4175 5 BATCH AN 1EAE 415 UL

SIMATIC BATCH Fiif,

V7.1 SP1
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LFERZE (ES) 111 &

5. 13 HFHE L FEH I HI T T

X SFC 1E/ES B (SIMATIC &H S CFC 4aig5e)

1. e R A > #4257 (Shared declarations > Enumerations) SCA43 s A — /N FiAk

2. MBS INHTE .
3. FTIFAAZE BN B & P IO B2 U HE 2 1 S B " (Control strategy).

4. ¥ CFC ZwiH 23+, ¥ IEPAR_ENUM B2 Fr 5 1) IEPH/IEOP. ¥f IEPH/IEOP £k
[\“EPE_CONN"#i 4 5 IEPAR v I [ [7] 4 # N\ H.3% o

5. 4771 ENUM Bt I/O [#1“SP_VAL i N\ X} 5 J 1 I 18 FEA 28 RIS A

SR A{F BATCH 41 AXHEHE 8“4 1% (Generate) #2412 NR AR 5, LA 772
CHBED) Gt 4 SR mss 72 £l 28 8 4 s — AN ebr ks

PBISEIRR S
{5 BATCH 410 T HE 52 X LA b W 4 5

775 5 X

3 P s B R

be ARG ) SFC R
£ A PRI Y] SFC

SIMATIC BATCH FJIf, V7.1 SP1
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LR (ES) 141
5.13 75E XL FE #0197 Al 2

5139  HREHREHEILERE (ZWHE)D

N T SCVRAEZ T H Hp 0 AN 30T H A 3R AT 3 A A A DA e O SR IR R G 1 A e
PR 2 T H PR AR SRR R KA (M) BIZIUH AT H

7£ SIMATIC 38 F#4E
1. 75 BATCH A AR HE g £t 42 7 28 427 (Batch types) X%,
2. ¥t 4% (Propagate) 1441 .

gE. A R RO AR RS R (Propagate types for entire process cell) i if
HEFT T

3. WUE T EAE R I .
4. Hh)A sl (Start) %4

SRR K Z I H P2 AN IH o 247 BRERE S, Fra e I H it A

R
I 2

N Fﬂ}

SIMATIC BATCH FJIf, V7.1 SP1
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LR (ES) THIAE
5. 14 &AL/ I WinCC JFEIT VT -T2 #

514  HBAMLHRE WIinCC IHR KRS HHE

faifr

A Bl P S B R N EE AR B E.  SIMATIC BATCH JfAvid siX £430
AN, i A WIinCC il AR AR A AR LS . 0 T REA B D A AT SR 11 S
24,

o UAZRUENHE AR Ol B ) AR & (Archive measured variable) 10 51 H.
o WAZi4rAC WIinCC IR AR &,

F15 — HEAR SN EK)ZE"(Archive measured variable) #7

SRR BEAE Ry D S5 P S S S A A U = 1) 8 5" (Archive measured variable)
I, AL R

o fififf] BATCH #% k.
— fE3% QACT_VAL ] IEPAR B8]
— {& BATCH ZHAREAE H (1) A = 2 A0 5
L
XA E SRR . A8 BATCH 41250 UG HE K AR B D BE I, S48 v 1 B X

SPANELA =R UAE BATCH LSRR HE 4 N T O, X o i 25 %
i3] CFC [PH1sLBiH

o (il SFC M. £kI%F SFC JIME ¥ e L A “ V44”41 (S7_archive &
)
i B
KT SFC 25, Ik E HAEAE SFC 28 FE BT, SFC BRI pr b A= =25 4
78 BATCH ZH A5 1EHE A #5 % H 211

RN S AL BB B

“UA% U 5 142 5 (Archive measured variable) t ] DIZERE FEXF AL R 3 E . A itt,
24 (Parameters) 10  7E“JARS”(Archive) 1w m] L {3 % & 2 2%

SIMATIC BATCH Fit, V7.1 SP1
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LFEFRZ (ES) THIAE
5.14 A&/ 1 WinCC 17E119 - 27

BRI BE

o AR

o RN (=D

o KA (= KIWD
SFC %1% SFC L5 gk

A

wRAE CFC B agd 7 SFC AU SEf], W SFC KAy S7_archive J&PE % E &~

FEE RS, IXRE], WERYE SFC BM A e (brid) T IHRYII¥ E(E
(Para(i)_AO) , WL ESTEFA 1 SFC sS4 H 3hiig .

T NS AE SFC SEW h B Uk i (5 SFC ZBRAUAR[R]) , A 7E BATCH ZHAX 1 HE

Hpext SFC 288 (MANZE SFC 826D wlidgdf. Dhfe Lo Bebr 28R EAT IR P . sl
T RES S I RIGIEES R, M Egw B vh R AR R R

F 2 0 - Al WinCC I &
H T UG RERS A VAR AR 5, 75 B AR 7 2 S U HE BT SR PR A B sl A 1 AR
TS S () AE B (Archive measured variable) & ikHE. A LL{E CFC HIHusg
“QACT_VAL” 425 5 5 & RS (Archive) . IXFELE I R AL St A P2 i it 25 E 3 i
IR S () AR B (Archive measured variable) & EHE. A FIZEIN, AT LLANE TR 1
FTik A sh g TR AR
WINCC JHR47E & (1 B I T SIMATIC 35 FRA rh OS Xy S J& 1 “ Gl e/ 5 U #4748
1" (Create/update archive tags) I i% & .

FFAEPIFITT
o “f|7d/HH P H kYA 5 (Create/update archive tags) LW # g . XFHHHL K, WinCC
25 H B AR N 1 AR AR £
TRk WIEA OS, 1 HAE N WInCC 48 # AR ILR 1) OS B2 8N BREIZ 1T RE
BT
o “fil| /T Fr kYA 5" (Create/update archive tags) EIUREE . XFHML T, L2
WinCC Til H & #ds h Fah @ oL s, HEMXELR, 172% WIinCC 5 B R%:.

Ui H

T SRAR T “B %5 4448 ' (Create/update archive tags) X3, U OS g i34 M)
B WIinCC /L ks Az & . {H BATCH 41X 1R HEH (1 70 Bt A AR AL . AN
IATAT 45435 EK R 7R WINCC A FEA7 AR 3K 6 T R AR 5,

SIMATIC BATCH Fjit, V7.1 SP1
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LFERZE (ES) 111 &

5.14 A1 FEHTK 1 WinCC IFEIIT I ETE#

B 3 - S WIinCC I3RS &

7 BATCH AL ZXHGHE, W LU £ AR S Beas B N S RSl -> Won”s prer 5l
MRS HU SO SR o o tioke 78 X ihEr, T RHT IR SEB S 401
WinCC Azl s, JHLAZMECHT AR 1K) WinCC RS AR

1. 76 BATCH 41X TEHE R LR AT 7 R S 4
2. feA X ko sy g R (Display) 1281 .

i i <> KBS S (Instances that use the <Name> type
parameter) X iEHEF] IF .

3. FdAIINAT, SRJEAE B Sk B

i T <4 B> 1) WIinCC #4458 5"(WinCC archive tag for <Name>) %15 HEST
TFo BERIEHE 27 T PR 3 sl AT R A

4. £ WinCC A& b & b\ /s SN R 2 A

5. GEFEFTTE I WIinCC R4S

6. AN " (Apply) 144 .

il GMEIF PRI AR IT)S, AT RATERC S P IR e R AR

2T H FHBRIED R
HEZIH GREERANTE D 1) BATCH 214X TEHE - 3 B U3 RY Sl & 1142 & (Archive
measured variable) I, LA =R URETE 2 1 H H dmft
KT TR WInCC ARY AR 5 /3 Bl gh S S HOUR ARSI H - AN ZAEZWH D JHAT
(. MUk, 50 EE G AN IH P B (Update) fiv4, LA Z 30 H Aok foBr it 2E
FERREANBNZIH . RS IE I ISP WIinCC AR AR 5 23 Bl 26 S S 40
g XTI EY, SERTUH RS WInCC AR AR ke, 1817 T
I (Merge) GittA =525 4G, FEZI0H T 5E 0T LLE 2| WInCC RS AR & (1) 73 i »

SIMATIC BATCH /i, V7.1 SP1
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T FERZ (ES) 1119 &

5.15 4jiF OS

5.15 “mi%E OS

SIMATIC BATCH & gz il < M & XH) OS (i OS) #hATlN. ik, 1E
SERCAL A A SRR O it i R e e, A2 1 OS.  SiEid R &K P A 1)
A=A G WIinCC AR & FECEIMINT) OS.  HAATESPE OS Ja, 7EEputt A=l #%
FATCHER N A A T R AR OB S B IS AT R G AR AR Bl R B
WBTE S N 3 WIinCC T H

7£ SIMATIC F 3 F B E D]

1.
2.
3.

SIMATIC BATCH Fiif,

EPEE AT A OS >“X} 5 J& #£"(Object properties).
FIF“H#br OS LLA 45 OS”(Target OS and Standby OS) 21 .

WERLEVARY I B 204 Be VAR AR 5, B “0 g/ 37 ) 4 42 5" (Create/update archive
tags) HIEME CEEmfTE il S7_archive JEMEBEE IS ED .

FLrfy e (OK) BEATHAIA
B PR B A TR (Options) >“4ii% £ A OS’ |7 §"(Wizard Compile multiple OS)
>“J5 )" (Start).

i

PCS 7 HIBRIAGw B O 2 T IX i AT 1F (OS X3 o nlad ik i H S s iy 2"
Ti"(Options) >“4ri¥ 24~ OS’ |1 5" (Wizard Compile multiple OS) > “4g ¥t
3."(Compile mode) ¥ LRI % H .

VI AT H 882 10 H v 6K S T XN T AS 3 i i 3 7 2

- BRAEARHE PCS 7 o FEAEBE S (A0 T AE TP A A 2 TG BEAT R I

SIMATIC BATCH % .

L]
{f ] SIMATIC BATCH i}, S7 FE/ e fe sy — AN AE =561 OS !

V7.1 SP1
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LFERZE (ES) 111 &

5.16 F1FF1 2L FEH 0 KA

516  ZIFEN T HIIERITTESE

5.16.1 W gaiER T Bad i B s

AL T

SIMATIC B35

i OS
(BSH4wiF OS"ET)

EEHS 0S
FOHEMEEEHE OS

RIFHE SR R TR
TEFfE ES iTEH L3

ZWENZNTER
EFRRES HEH LB

AHMRE

ZUH

Y

hn# winCC B E
(%—1 0S B#RRE)

Y
THEtEF SR L THE
(#=/ BATCH RS BEHRRE.
BATCH &R 8571 BATCH & #)

iF OS

WS AT g i OS" 5.

SIMATIC BATCH /i, V7.1 SP1
216 #AEF M, 03/2009, ASE02171120-01



LFERZ (ES) THIAE
5.16 F1FF1 | 2L FEH 0 KA

FREHEB 0S AEEHAHR

EVF 2 = R oo, R A IEAMUAOR e ). Hergil v, S ARG
A TR — AN EE A OS RSS2 B A ATAT S HEAE = A OGO B s . IX R DA
SIMATIC BATCH 55 fit 2 /= AHOC B4 Tl o A S 4 e AL A0 e, v DU+ —
AT M SIMATIC BATCH #:03 JEL 3 & OS.

o FEEHE OS
IR E I OS Skl SIMATIC BATCH &M . bWy E OS [m]if th /&
BATCH 45 2% 1iE IR OS.

o [EEMATEHE

Jirfi BATCH 1 ST E SO I frik OS b 141431 5 (Transfer messages) T
Aeftit.

R AE P R T BE
AT RegiE L SIMATIC BATCH i I FE soc s, s aiZE . (Rid) X%,
SERCIT A T RE B e (1 AL A DU I R B e A s AT AT B S, SRR PR e i A 2
2 E R BEA RN ZR .
R TR 4 36 (U1 219)i 1t 4w %" (Compile) THAESZIN . i iid Fi rh o i F 8 T
BRI AT g B IR o AT ] BEMO AR AR Bon I AN BN H A . Wi A A ]
5, WIANS AT 9% .

n# WinCC B B

WG R 33 CPUZhAE (Download to CPU), WIinCC il [ £ 4k E4%3% S A 513k 1M
A% SIMATIC BATCH, %t BATCH I % M BATCH %/ B3 B i e84k
SBRFEAAE . S AZIAE WIinCC I H N e i 5 8 shitk A 7= R4k

iR

W HAEH PC Fin#— AN HEA T4 WInCC MR (%) 1 PC i, SIMATIC
BATCH ANRE E 3R H OS iy HArEt e, HILXFHEHL, FTIF BATCH 4LAXHE
HE, ML B e Hh s PRI Al AR i R e O S e " (Settings) 4%, FECIR

B (Settings) X G HE 1“4 4" (Distribution) 115 1 8o “ 58 H"(Update) 4441, Kt %
B E LA

SIMATIC BATCH FJIf, V7.1 SP1
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LFERZE (ES) 111 &

5.16 F1FF1 2L FEH 0 KA

TR A R T

AR ICEAR AL e Ja . S HiAEI5 3] BATCH JiRg54%. DB k454 fil BATCH %/
Pl. AEA“PLC F#k"(PLC Download) Zifie v LA F 5l [ 3 FE A0 (UL 223).

BAFRMEFSTEATHEENER (RESEELASEELA)

S A S A St ST, SRR R A e E s R rT WA e S N B R R G
A1 {E BatchCC W [T BATCH % Bl B4 o BT IH IR ip e s 2 /8 R4 T Lh g
PAICIEZ

K BT FE R ICEIE (7T 261)ITELNE B, 2% “BatchCC™ 47 .
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LFERZ (ES) THIAE
5.16 F1FF1 | 2L FEH 0 KA

5.16.2  FERINH L2 4widft e~ 2 n i

Pl
TEFE R e o BATCH 418X EHE ) “Gn e DhBe AT gn 3. [RIIT, IO Ak fe i
TCEHE AR o ATAR] AT BE A A R AR WoR ARG AE DR H & ﬁn%iﬂ}%%x&, A
LTI

7E SIMATIC B HAEHKEBIES B

1. {135 24y 446 7" (Options) > SIMATIC BATCH 7 JF BATCH 4125 i A,
AR T I R R T R R AR 7 541" (Bateh instances) SCA
FEA T DX 5k L g 3 (Compile) 44641

il WAIRUE STy, Mgl ol . X —d B S alE— AN HAE&, arE
AP R TN AR

76 BATCH 418X iGHEF: 7E“H&: "(Log:) >“4i%”(Compile) ¥ & >“ER~"(Display)
HET

4. FEAME D i R R T B N RS AR R T B
5. FEA X 3 rp il i 1% 3] OS”(Transfer to OS) 4441 .

i N UEHEREEIFT R, LR g AR % B “OS X} 4"(0S objects) LI~ N 2 B
SE X G HEAE P AR Al . ZEIRA”(Status) 1, 23 SR YRR A . W
X EORA, ATUAE S OS AHSEEdE 2 75 O L pifhik .

6. %3 3)"(Start) $%4 .

gl AR OS MG gLt L. X IES0IE—MHE, TR
V1D RPN A R b

7 BATCH 4185 HEHEH:  £E“H&E"(Log) ->“f£i% 5] OS”(Transfer to OS) & & ->“&
7~"(Display) 4 ~

w N
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LFERZE (ES) 111 &

5.16 F1FF1 2L FEH 0 KA

5.16.3 AZIH LEYHIFLTERTERE

A
PR TR i BATCH 1A HHHE T (K “Gi PF D REBEAT A 76 X RS IR b A e
FOCEE A . AT ] BRI AR R EORE os T AR H . i R B s AT 5,
WA S HEAT G % o

7F SIMATIC & BB KEE S B

1. M35 4y 4635 (Options) > SIMATIC BATCH #7JF BATCH 41256 A,
2. FeFe Mg Ayt AR R T B R R A = 54517 (Bateh instances) SCFk .
3. e X B A JF " (Merge) 124

GiL: ARHEAEBGEITIT, BRI SR AEIE . fERHEHE S, AT
UG P AT 350 F (L 2 7 e P B TR, RS04 I S 25 9
erge/compiercet e

Batch process cells in the projects:

Project | [v Include |[v Compilation Path Batch process Status Result
E’ Multi2 ST I I F:\Projekte_MPE § PCell_Z Types not up-to-cat .J Compilation Gk
58 Mutisss I~ I~ F:\Projekte_MPE ﬁ PCell_Z Types up-to-date .J Compilation Ok
| | i

Start | Cloze Help |

SIMATIC BATCH FJIf, V7.1 SP1
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T FERZ (ES) 1119 &

5.16 F1FF1 | 2L FEH 0 KA

4. fritkhl, wTLDUERE S Ik R b 2 il R SR e B s PR i I E .
Wi 23k E 5 (Include) Fi“4wi%"(Compile) 55 1 e ST HE, & 150 H AT A7 14 5 I

SHRBEIORS A E . Fln, WERIEATTH FPIRES AR BAE 5o (Types not up-
to-date), MIZEAL & LI H B, M“4w%"(Compile) RIEHES HENIEH

BiH

G PE AT LUAE 22 00 H 102 T H gk T

DRI H M, IR EHERE A T ARBRIRGS (UK ER) o WRiZ0iH eaf
ST PRI A R SR, Ut S R X A

. H B (Start) $24H.

. Hi“SE 17 (Close) 144 .

. {E BATCH A A 1EHEAC M 2F 1 op (K e s il R i P R B e xt 4
- FEAT I DX ek R % 1) OS”(Transfer to OS) %4 .

i —AXPRHERERIFTIT, 1 22 30 H B I H 7R BEEOS X 5:7(OS objects) ik
TR A A I P SRR A P A SR IR I B A Bl

9. #%“JH 8" (Start) #%4 .
i P SHCAE AR OCH B GE R PRI 8 N B Y I A D1 .

0o N O O

ZhI,

o KHFRIhZ e gn et R oo sdE . X R S aE AN EE, wEd R
I H
7t BATCH 4 XHGHES . 7E“H&E: "(Log:) ->“& 3" (Merge) & ->“E 75" (Display)
7SI
i

1E“4 1401 PCell...”(Merge/compile PCell...) SHEHER BATCH 41X EHE S, 361iF

A WoR AT eSS AT LU E AN FLZ AL

o “B It/ PCell...”(Merge/compile PCell...) XFiEAEH, 76450 H b o REE
(FFETL) B YIE " (everything OK). 37 F HH 7]l B4 11 5 41 2 1E Af
1

o Mt BATCH AAXHEHES, W< WoReivd (LLEFik) o XSRS 5L e
HAHSR, BRI R oRAE SR BATCH A0 i AE .

BRI B JR K] e 5 0F H b ).
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LFERZ (ES) THIAE
5.16 F1FF1 2L FEH 0 KA

o ERIS OS MRS ML . XA ald A H&, wEEa Rk
BRI H &
7 BATCH 410 HEHE . 7E“H&: "(Log:) ->“45i%%] OS”(Transfer to OS) & & -
> 7~"(Display) %41 T

TEG AN T 82 B 2% b His 4740 ¢ OS”(Compile OS) Thfg. X FE ] 8k 7F g 1 FE 20T
AR INAEIBAT RS 4R DR ER .
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LFEFRZ (ES) THIAE
5.16 F1FF1 | 2L FEH 0 KA

516.4 KRR ITEIETERIIBHRRSL

fai g
AE“PLC -> 12k (Download) e kil 2 e didfs 203 BATCH JIk554%. DB leds as
(Edlfr it 290 BLL BATCH &7 LA

T

]

R DREE 0 — 2Pk, T BN 55 AR LA Y-
1. T#H OS JIkssas.

2. T#3) BATCH Jilk%5# 1 BATCH % )" #l..

7E SIMATIC BB B IKBRIEL R
1. M 329 4 “YE 5" (Options) > SIMATIC BATCH 41 JF BATCH 41 A&t HE.
2. AE/e M 1 bk R R B T R B R IO R
3. H R EC IR

iR AE“M <TJ > F#"(Download from <plant>) XfiftEH, §osH BATCH Ik
W JUA) . DB RESERLLL BATCH % HLIIATA PC b e FERIRS(S
£

/Lo
Download Batch process cell 'Mein_Multiprojekt® I
¥ Component | PC station | Target system | Yerify I Status
) Batch Database Server
- - - —
[ 09

Mot up-to-date

{localy

B Batch Server

¥ Master 2_InteghkH1F33101 =L {lacal} Mot upto-date
[ Standby ; :
) Batch Client

E 2 InteghkH1F931D1 =L {local - -to-dat i
[ ' Irteg 2L Jlocalt : mléﬁ;tjo ate

Help |

4. ¥ )35 (Start) 24 .
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LFERZ (ES) THIAE
5.16 F1FF1 2L FEH 0 KA

BBt AR A TR

L

WARAE ES B 17 AEA R (B ansik T CFC/SFC K3k, SFC KA., ffifFiE . 1)
JEGA AS-0S THEAFNAD WA E 564 B St BATCH Rl FE i ocidls, ARt
43| CPU (BATCH JIk%5#%. BATCH /1L .

FEVEZ T, ZUE e i )T T3 08,
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T FERZ (ES) 1119 &

5.16 F1FF1 | 2L FEH 0 KA

5.16.5  [FINZFEM T

PCS 7 WU FT A PC i CLUHGERAE Sl $efit 1k m] J -3k A: i 7 5 Ie i e 3 4 15
AN TIRE -

7£ SIMATIC F 3 F B E D]

1. (AU BT MR Pk R R H sl Z 0 H, AR JEEIL LSRR i dE PLC >4
BN #%t 4" (Compile and download objects).

“Ui 1% H R 6 42" (Compile and download objects) X i HERE B F1 JT .

2. {EXF S ik R H " (Process cell), SR Fahi g 36/ T 4% 3 & " (Settings for
compilation/download) [X 33 [¥)“Zw 4" (Edit) 12

3. EASLEIR P HEAT LU R B :
— {E“G I 194 %" (Merge/compile) JET -~ ) 22 T H e 3P A et A = IR 08

PR ST I .
— FERIH/Z 0 H 451257 (Transfer) ZET-RH . EFEH S OS AU HEAE =M e
E B o

— FERIH/Z T H N4 (Download) K. MEFE NERMALE (BATCH IR
#% BATCH &/ HL. DB fx%+#%)

4. PR e (OK) HEATHIA
FE“Yi AT 806 %" (Compile and download objects) X i HE 1“4 15" (Compile) F1“ T
2" (Download) 41, 45 5E g Bl T 20 R T A0 5 R0 52

5. Hifi“fH )" (Start) 141
Bt B3
fEZ I HY, ANFRIESEZ H rp AT R e, HACER A AN I H 45 5E G
PERIR 8 IEI
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LFERZE (ES) 111 &

5.16 F1FF1 2L FEH 0 KA

5.16.6 BTN TERITTIHE

AR 87 Ti B K ERE# T

i SIMATIC BATCH £ 1] LIZEZA> S7 i H h il BATCH fli 45 #%Fl BATCH %' L.

i, WS T =AY ST WiH, BANIH BA A PCS 7 #HAE i FAHF M 2 & 7 AL
(HA BATCH &L » 2% AL (A5 BATCH % HL) 5%~ S7 Wi H 1)

BATCH JIk 45 #3318 1.

BATCH &/ HLul R 4TIF 8 T S7 Wi H 2 AN FE s ot H o XFMEOL T, B2 IRET

T R . HaE, fE—MtA 7 N (i BatchCC) WARER R Z AN

TR I o

fE—%& BATCH k% %% LZ1T A RKITH H

fE—% BATCH Jlud54s vl LOESEAT 2 AR R R ICIiH - alke 20 H a2

G K BATCH kg5 PC e (H— U fEdas MR s oot H (Bl & BATCH
MRg5s) o XFRACERA—ANEFAE, BIIIAERT ESIS AT A IR I H AT H i AME
L NEeUN ST E NGO €101l IS SV L 5 D e | B K

P OS Wi H (PCS 7 0S UJ#HEiztTt R45) I, 7 BATCH R #eiHAL B RAY)
#. SIMATIC BATCH &l J& T4 OS i H (rid R eI H .

Pl# BATCH & P #l
BATCH %/ Bl 5 BATCH Mk 55 L [ 3 AE AL WM AE TRER U h BT 70 il e AN AR
oG, BATCH & HLRAEAIAI Y. BATCH Ik 454 Il e s el H s AT .

Wik BATCH g %54 B3 2 AN FR oIl H 145 8, WTEER S s ay 2 “F2 7 (Program)
>“BSEAFBrLFEE o (Read in new process cell) 2 jii, BATCH & /Al L& Bon—ANEFXS
IHHE, ZUHTAEIAA PRI H . kR R IeI H, iS5 BATCH Jlkgs#s it
SEIEE NS P AR o H gL TIEED .

£/ 7 H—4 BATCH Jik4-28

i
fE RO, B 87 WUH/Z T H H e & BATCH JIRg5as KU REH]
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BATCH #4150 6
6.1 a1

6.1.1 a3 BatchCC

%% SIMATIC BATCH J&, %0 LA7E Windows [I“JT447(Start) 5, T Simatic >
BATCH F#k#|LL F 411

BATCH =700y (LU FFRk BatchCC)
BATCH Ja st Fe T
B 7 gmAEes (LUNFRh BATCH Hid 7 4w 28 )

J2 3 BatchCC:

—

. $TFF Windows [f“FF 45" (Start) S5, SR EIEFEE a2 “FFiR"(Start) > SIMATIC >
BATCH >“BATCH ###l9.0>"(BATCH Control Center).

giR: WIRAER5) BatchCC MBI ZAAMIAH , sOICIREE R 30 H kR, #
2B PERRAE .

2. EFEPTHIH -

gi: EHIIH)E, BatchCC HLRIRAN, [RINATIFHEIH . W AREFEIA 30T H B AT HE
%, NHIRERR 2R .

EEEM
7t BatchCC F1 BATCH Pt 5 4% 1, #B ] LA ] S iy 2“1 50" (Options) >“i%
B"(Settings) >“iH="(Languages) 1 £ REKIES -

Z I,

T EAT R (I 229)
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BATCH #5#0»

6.1 50 FIte F

6.1.2 IREX S By

FELH B
AIE R A5 AR E 2 T B) -

i HEhRR
#8) (Help) 3¢5 MG E S ) AlE . BAA s

XEHE ) “H B (Help) #% | BASRERHES ) _EF SCHISSHE )
HIIER F1 g

P 2 I i F1 BEASSE I A [10_1 R SCHI R B

RN
B R T RAE A L N R SO RRE, TPREOCARIEAZ AL b, H2R R

BB AR

TE 35 B U 11 32 L A “XE TR (Options) >“F4&”(Font), #J LUK A B N
“/N(small). “IE#”(normal) 2 K”(large).

TiBA
M WInCC J5 3h B R34 5 Bl
M WInCC )52 BATCH £ Hf.00 88 BATCH it /7 g 280, ASRefl B 2% .
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BATCH #7540
6.1 H3) It E

6.1.3 H P 5 FEEAE

6.1.3.1 F&E AR

NESER T BatchCC /7 A AN 5. £ LA ZEME MBS MR fE . i)
R M ASR G S A 0 5. AEA I, AT LB Bt Ty 5.

A LM BatchCC H i “FL 1" (View) SZ ke il .

Title bar Menu bar Tool bar

N/ /

&3 SIMATIC BATCH: Control Center - [Libraries] L =10 %]
Program Edit Control * Planning  Oplions  WYew  Window  Help
[ 4
-
|o|&|@¢|= | 2aD(R||[-mnme X aa
1=l ‘i‘ [Libraries]
=15 Production : -
g : 5 Marne Yersion | Unit class
gl Libraries Enter text h 5l £... &l Enter text
i ) nter text here nker text ...
Masker recipes —
A& Formulas ‘ﬂ Fill_Premixer W1.0 Premixer
Cirdaps 1 sul:ustructure_lil:urar';.f Y1.0
. Materials %‘-ﬂ@ﬂ i _reactar 1.0 <all=
----- €57 Permission management S| buffer ¥1.0 <all
&l s5_mp \
Displays help on I:I%ected butkors, menus and windaws online
Status bar with Editing window with Batch objects: Overview Ilsts depending
context -sensitive « Librarys with library operations on the context for:
information + Master recipes « Library operations
» Formula categories with formulas » Master recipes
* Production orders » Formulas
* Input and output materials * Production orders
* Permissions management » Materials
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BATCH #5#0»

6.1 50 FIte F

PR

FE

TH#

RER

230

T AR S — RIRGHEHL, W AT AT EUR £ A4E
e R BatchCC,

o KT N MU KRR,

o UK E LR IE T KD,

o Bt nEEH.

SRR T B RIS, ERIThEE S AT K A % R REEFAERT B IR
A TAHRSE A, B, DCS DGR DURIN, A fEikFE 4" (Edit) > “BER
(Delete) s i %o JoikIEFEIISE FIR LK (ORI

THEAL TR T eOs R, arfil rag i s e AT ae . H BUbRdR
FHE T TEPRRHLHE O R TR A e, K& B A #4411 44
PRIOTTHE . S mT AAEARZS RS rp 1 2150 TIXLE DB PRANAE B gl T i A AR
MiZhe. ToiRIER MUK G BR .

FERI SRR ER, Ok 21 s B2 BNPRES FIRS R . B B iRy 2
YRR GRS T 22 4L o

TR ZEMIX IR, Eos R SCHSAE R, B0, S mIvil]. BAF etz
R

FEIRFL A M DK, Whos 2 A AT (R JeAbis W 55 BATCH 2 i 55 2 (14
HEHAR

o {Efh Tk BATCH Bl s )
o @ CRMETES BATCH BIs B0IER .
AESEEAIIL R, T S K ) P 2 S A
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BATCH 75 0»

6.1 7z It TE

W
=

TSR G EZ, (7 244)

SV (T 236)
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BATCH #5#0»

6.1 75y FItE
6.1.3.2  BIEMBENS
ERThRE

BT 5 A R D REARAE bR SR L

BEAh, "G (Edit) S0 b mi gt THIFRIZhEE . TR RN A PR R AT )
fE, 7E“Gi4E"(Edit) S b3 (LUK E R S

Edit menu Context menu for the object

=1alx|

&3 SIMATIC | .ATCH: Control Center

| Program  Edit Control Planning  Options  View  ‘Window [Help |

|o& 8y |=|=2a|R||F-mimrs X aa® |

izl =l 5 [Master recipes]

e

=g Batch _ S
L9 Libraries Recipg Yersion | Skakus
EI% Master recipes Entey text here if) E... 5] Enter bex

----- &t biscuits bake complete 1.0 BIE (| TEST2 ¥1.0  Releasei
..... E—H - — "Iﬂ fMalt_light_dark_complete ¥1.0 Release i
..... B &k Coo {j,-'_alldatlan 5| Fermenting ¥1.0  released
""" @ k] fern =~ Open 5| measuring out ventilator Y1.0 released
""" B 2t Malt [ Print 5| Cooker_x_Test Transition ¥1,.0  Releasei
""" EE—H mea Print presview 6 hiscuits bake Y¥1.0 Released
""" B &kl TES Broperties 5| hiscuits bake complete Y10 released
----- Formmulas ) :
1B Orders B Release for production
H-hi Materials | 26 Rewoke release
----- &1 Permission man Export
4] 4] |
TESTMP_Y71 7 Element(s) |0 selected
o akressste | (=
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BATCH 75 0»

T RE

AR ZR

TIFRS

X5 R

ERGEZDIE S

6.1 k5 It

AR REE T A %, KRR ISR T, IR A R G T
AT A PR HE T B

W B GFTRAT R I U 40

o AN

o IEPENR

o IRZRPATERAME (BN, FIIT. MERD

OIS, WA BATCH X% % F I gn e i 1 e B S i HARE & (B, o SAe
BIEEHTI AR, HIERE A (Formulas) SCH92) o B BZIhEE, WHFIEF S Adr
A-“4i%8" (Edit) >“F 2" (New).

A LU U AT IR R -
o i EH R SR A bR

o RPN, MRJEIEPEK AL YRR (Edit) >“FTFF"(Open).  MIhEEACE I FAESCk
X5, BRIy .

TG e, W] AAEE s e o A 7

KGRI JE TR, X E Mg TR AT R, Bl 3 E T .

i H“Ym 48" (Edit) >“J8 14" (Properties) > Fi iy & Al FT FF— S UEHE, ZEZAIEHE R ] L& FH
G BT X % 1 g vk

BN G 4R E iAW R AR HI P EAr 42" (Rename) fir4 1l b 42
FRo

“Efr4"(Rename) fr & JEAEM LT, B, XHFYkl. s cCCERInE, Eas s
REAEAH N )@ Y (Properties) X EHE 34T
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BATCH #5100
6.1 50 FIte F

il[Z30E
FTUAIER SCAFJe AN S0 XK 30, AT B IA S e s I 4w DUk . 41
Ghe AT AERET A AT R AAte AR, AT DA ey IR AT R, LR
I B SRR [ I e o A PO At A7
IR ERA T A A ANESR A, TR . R TCIER ORE T IA 7 B 5, iR BUEAE I R
RS REAN T H
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BATCH 75 0»
6.1 i sy flItffF

6.1.3.3 mEEE
] AAEE TR R T 52 BCC Ml BATCH Jc 7 4B 2o H %E . i H ¥ B A8 0 7
JCEMAT R RS i, B R AR ) FRE TS A o st m] DA s ik A R 3
) PRIVRS SR s o b P 2 v A2 1) S5 s DA R A 286165 TS0 R A1 PR 6 3

EEWEKE.
S B iy A “3E TR (Options) >“¥¢ B”(Settings) >“J H & &”(Project settings). % ir 4K
FTIF R THE RO EAE,  FEAZAEHE R T DA B AN H B . W R BRI G T L

IR BRI, B LR SOHCHE) R (Help) #41)
x

Used Plug-in Modules I Report I Electronic signatures I
General | Warnings I Colar I Font | Archive I ‘Wersioning

Max, number of substructure levels; |2 3:

¥ automatically resolve excess substructures

¥ allow simultaneous ROPs

v allows editing of recipes with "Release revoked” status
¥ allaw online setpoint changs

¥ Transfer online setpaint change ko active skep

[~ Unit selection according to conditions

¥ all online structure modifications
¥ Active batches must be stopped

OF I Default Cancel Help
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BATCH #5#0»

6.1 iz 1t
6.1.3.4 <83
poliN:a)acheS

AT DU P R £ 5 2
btz 3 i
236

7t BatchCC v, W/ {ff A VW Hf T RE,  [F) I3k ml fa A0 D R 2E

ARG HARIAE, ATRLE R LR S 5

PR

RIS
A
LY
A
YR B

1%
I

FEGRAR B TSR (B, BRGSO ARJE RS a4 g i (Edit)
>“PE41 {5 8" (Details) .
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ﬁﬁﬁ Ia

W

6.1 7z It TE

B [Brewhil/Master recipes]

Recipe Version 4| Skakus | Madified on
o i I

AEH defering simple T 11/15/2002 10:435:4
W=k Autom V1.0 ‘f ¥alidatian 11/15/2002 10:43:4
% &) Perfmon ¥1.0 [ Open 11/15/2002 10:43:4
Sl & Recipe_REAL R — 1T 11/15/2002 1:08:3¢
OE]EH mr_Reakkor_Al ¥1_0 Prink presisw 11/15/2002 10:43:4
héﬁl rr_with_lib_formula_lat...  W1_0 Properties 11/15/2002 10:43:4
.g]%lﬂ mt_with_lib_late_binding  %1_0 [ Release For production 11/15/2002 10:43:4
°g]g=:|:] ror_formula_late_binding  v1_0 26 Cancel relsase 11/15/2002 10:43:4
% mr_late_binding ¥10 % Delste 11/15/2002 10:43:4
4| il

PREESE A

JEBE TR AR, R 1K) A A MR T A& 87 [ P9 24 RN HE 3 o
FEB Bl I FR) A A i N SCAS a2 1) A b A T it g

WATLAFA I 2 A RN SRS R AL Aok . XU, AT
AP RNFA RN G A 2 B Ed IR b . filin, WRAE" T2 i (Main Product) 41 )
B NSO Wa”, WA LU R Wa TS ) B2 oA B e R

FERRER: E Al b A8, R AT D IRBESCR, SRR S S R S 25k
Tl o
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BATCH #5#0»

6.1 50 FIte F

LA AR A RREEE (k4 CDV) B
WRRLE AT 2R AR G B, R s

UES

iR

ITHRRHFIR

AR B TC I T AT T B2
R AR 2 BT, Z4E BatchCC ik $%“4] #.”(Orders) 34
¥

PR IT AR

FUH = T B

o WIRCLILFE LT H(Order) IR, K5 Bon B i dhil
H,

o LB O EFR T B )" (order category) U, WA R
JB& T = T

A= HRIF R

ST CR) s ReAi slBUE it AR . At AR P R AR
(I PREE S BT P2 s SR

Ve, AR A U s ORI B 2 A At AR
7o WERMAZFNER A S A, AR AR R R ] I,
FFLAHHOIRAS (it 247 WoR. (H2, FRREFT LA™
RN, AT Rz A 7 GES AR IR
) .

HAEFREFIR

FIHPRE B RAT S AT e, 5fr. CBiUE siaR I P
A" ZRAE RIS AR SIR R EE
SE] PEdIA AR .

AP FRFIR

FIPTA CEM. Bk, CBOH. Sk, ek e xRH
11 E NG E A TR L FOL S [ 1 BV Kt 44 TG 4B I ESJIN R
PREESEHL, wf LIRS C a8 Rtk ™, SR IER eI,

238
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BATCH 75 0»

6.1 7 ) fIEE
PR
AT R Z PR G TR AT, AT UFT AR A = a b,
R EE AT AT BRI BT T R A A
TEGmIRET 1 f19°0T 52 (Orders) SO ik #0%, SRJE 2" HIRI"(Planning) 3¢ bk $%9r
e
e erin

Rk CRTL+A sk Hiir4“4m R (Edit) >“421E"(Select All), 7] LUESEVIR A X %, 4
i, AR PR R R A AT A
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BATCH #5#0»

6.1 7z IR
6.1.3.5 HEREMHED
R
PCS 7 OS (WinCC) 7 BATCH % ' HL |- A A4 384T
WHED
BatchCC 1 th n] 27~ 7E WInCC IH#S S AT BE R A LA =4 i B (REH B
R R BRI ED
PR RNIXEEY B, 7 LLZE BatchCC A 1) 5l i 2 11 H 4T JF PCS 7 OS 1% i 1
(WIinCC s .
TH S sy A VLB (View) >“TH & & 17 (Message Window) nJ 47 4 Hi % 1 .
rEIFEENEELEEEIE

Recipe operation completed
R op on Funning
tion completed
ion running
operation completed

on running
on completed
on running
on completed
on running

10/13/2006

|11:EI'E| (L) Lisk: < indow: 1000

HEX

240

o EETLLEE UNEE OREM (F WInCC FE&IdEw 3R , filin, ZoRmyl. W
R,

o I EMANEREIEE, IHE FIRG5) BatchCC Ik & . 1 SIMATIC BATCH
DAF RS A AL SR AR B, B, BATCH 14 EIEF.

o EFRINEAT, ARJEERE LT SRR T FFEE IR /57 (Open control recipe) i i
Ao BT S BAH VGRS ) R T
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BATCH 75 0»
6.1 i sy flIlF

6.1.3.6 BERAEFNT R gRET O

X E%
{£ BatchCC "', X% 2 MI458) 5 Windows #5548 B 2% i) SO I RSO SCAHE 2 45 44
FEAA R
TR A I B A A B Bt A = i AR s . “fib A =i #27(Bateh process) ST
A" (Libraries). “Ffc /7" (Master recipes). “x\"(Formulas). “i] #."(Orders) F1“¥y
KL (Material) 30K FEIX S0 ARJea] DAL & SO JOR A S bt 2 (L T

Jiv AREE) .

KB B, R FT AR % 2" (Permission management) X 1EAE
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BATCH #5#0»

6.1 7z IR fF
6.1.3.7 IL/#EHZE
BT WERERE, WI4E BatchCC 1) TAF H & A B iX S pR 4
7F BatchCC HTH IT/EHE
B PR B A IR (Options) >“ T4E H &”(Logbook) .
WD RE T LAFT IS HURHEHE, 72 I HE ] DR P i g8 4 R =R e B4 .
NAFRS KA, HIVEEL H i, 85 sl 987 (Filter) o
AT DM B RCAT * B8 ? AT gE.  flhn, WA A*, R BUSIERL A TF SR X
Fo LRI 2, WU R AR HAE 2 R E ) — N R RIS
T A ) S s A ST TR 17 T AR AR B FH R e T i ) DX SR B 7R PR 6 04T
AR WMAKE AR BN AL, SEoR— N TREER, Hd SWoR T IFmH .
£ Log =]
Marne: | Tupe: <ol typesy j
Date, fram: 202002002 43 | to 11A5/2002 1:40 j
Idzer: <all uzersy j Comment: I
109 | Hide settings I
Tupe | M ame | [ ate | Uzers | Comment -
bl azter recipe Charged 202042002 4:31:25 b
b azter recipe Charge3 2r2042002 431026
kazter recipe Charge2 272042002 4.31:28 .
b azter recipe Chargel 202042002 4:31:28
rr_Feaktar 2PEAA002 31022
mr_Feaktar 2OEAAA002 31038
kazter recipe Charged 3642002 3:33:48 PM
Mazter recipe Charged /62002 33348 PM | _ILI
4 3
Comment [for a zingle log ento):
=
[
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BATCH 75 0»

6.1 50 FItF

6.1.3.8 ErEENNAERNE D
PR AR ENL LS A 7 N HRE Y, 8] LLZE BatchCC H 2 R 265 L 7

FTHSBENNABRFNED:
PR iy 4“1 T (Options) >“¥iE N H #2 /7" (Active applications).

BEDDREASIT T2 2 A P (O SRR P (R AE . 8] LA TR x B Cisfr slififeis
AT AN A N AT RE P IR 2R 1) . AR E) . 34k, e R B sk

“s Elements being processed E”EHEJ

Tiser 18 19 20 21 22 23
=\l s0601030C PCST Systemntest

P Contral Center |
= ZZRecipe Editar
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BATCH #5#0»

6.1 J55) IR
6.1.4 XS FXT SRR

6.1.4.1 MNEMFNZER

1t BatchCC ', FE#AE. FET. A, PRI RIS )25 Windows %45 2 4
HR SRS () SC A e S5 R JEAAH ]

NEEIR TR 4 AT BatchCC W AR FALE -

&3 SIMATIC BATCH: Control Center - [Control rec... [lj[=] B3

E] Program Edit Control Planning  Ophions — Yiew

Window  Help -8 x|
o 8leg|= = rsmee ||
2 x|
=1-f2q Production
. E-&] Libraries
- B-E] Master recipes
)| Formulas
-] Orders
: Materials
b ﬁ Permission management
B 5 v
=]
Bakch: ||:uat|:h_24 1
Crder: |I:ual:|:h_1
& P |§| L= @ & Flement | Text
L ¥
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BATCH 75 0»

6.1 k5 It
SRR ICAEREIA P B € XG5
BOATEOLR, WZREPE. BRI AL P 8IT R RSO IR — 2
A
R B XEHRSH
I ] 7 BatchCC h A € e Bi& HI ) BATCH X %2 ik, LLEa T P H
REER

R E SN E BB AR X SEHRAEIE I Pt BIE, " RS AR T
LANS RV T
U, DT AL T E R .

E75 BATCH %82 [BIfI5 H

i 2 i 2 “PRL " (View) >“BY FEAIL B B A 255 42" (Related objects in tree view), [
B~ FRCT A A G B oo Fg AR = 5 () 5 TR AL IR BT 43 i

EZfER:
o WEFEBRIEME (UL 246)
o [EACT (T 247)
o 23U (UL 249)
o VETITHY (L 250)
o WKl (7T 251)
o RURAEEE (11 252)
o AIHEAIRIEXZ (UL 232)
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6.1 75y FItE
6.1.42 HEEBRENE
EFMHHAR T TR
0T DU kA7 il ik BATCH FC U7 dwiEas Bl i Ilc o (FE B/ h & < H

B o ATLAEPE A A BN T BAE O T R TT) Mgk T RIZETT) .
FELL Rl b, B TR 126 r (KT E 7 A M1 S MR DA PP R A %1 0

X SALE

&3 SIMATIC BATCH: Control Center - [ [Libraries]] i 10l =l
ﬂ' Program | Edit Control Planning Options  View Window Help _|ﬁ||1|
olglag|x|=manR]||-rn1mrex[aare
A | Mame | ‘ersion | Unit class
EI§ Brewhil Enter bext here ﬂ Ert... ﬂ Enter bext
S 0-551 Flach_Bib_Grenze ¥1.0
-] Limit %t Hier_Bib_Grenze Y10 Catp
& ForReport Bl BIBsUB 1.0
0-551 flache biblio 1.0 Sl SubstrukburReport ¥1.0 1104_184018
: %1 et b.lbllo_FrageI Spdifil BibliotheksoperationReport  W1.0 <all= -
fos | flach_friegeben 1 0-551 flache bibli V10
Pl ] tst ¥01.00 Sl : i
pEa BE| flache biblio_freigeben ¥1.0 E:
o] BibOP ¥01.01 batch_01 1
= ; °-=}1 flach_Ffriegeben ¥1.0 &
------ el test-ibv1.0
[#-=| Master recipes cﬂéﬂ st yoL.00
BB Formulas Sptat BiboP yoLo1  <alls
&) Orders Splat] test-ib W1.0 <all>
[ gy )] Materials
----- €1 Permission management
4 I _’I 4 | | —Zoom—‘
B MEIN_MULTIPROJEKT 11 Element{s) |0 selected I EHﬂ
O Qunex [1943

A ThEE
o JTJTAIgwARAC T (W 276)
o JiHEERERENE (W 519)
o USUEAC/Y (U1 292)
o A AR AL /S (T 293)
o DA T~ BT (5T 293)
o iy FPIRASFIIRAS K (UL 295)
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6.1 J7 5P F
6.1.4.3  FH
FEAEBC TR
(3 IK0, T BUR S A CL TR M TEI T 255 A E RIS BATCH Ay Sidi 83 0148
MR R I E ARG O DAEXS e 55D FIEARA XTI, S
—ANERERERTT . BEA RIS FERTT, WAHZEEFERTT. WA REERT, AR EA]
AERBELEA SO RSO, DASEILEE & B 254 .
PIE VAN
&3 SIMATIC BATCH: Control Center o [=]
Program Edit Control Planning Options  Wiew  Window Help
JJP|%|E§|$|&|%EE|¥? JJ- T T | }(|@)\Qﬁ_@[|
Master ie — =
=-fa5 Batch - ; -
& Libraries Recipe Wersion | Status
W EI r1a'h-r e Enter kext here S| E... M| Enter tex
I:ulscl_nts bake complete ¥1, = =ﬂ TESTZ ¥1.0 Release i
Master | i e { -|-’| biscuits bake ¥1.0 ] Malt_light_dark_complete ¥1.0 Release i
recipes 1 )i B 2| Cooker_x_Test Transition Bk Fermenting ¥1.0 released
gggﬁzsp:o- < ----- ’| fermenting ¥1.0 1 measuring ouk ventilakor Y1.0 released
reference tollll i i [ ’| Malt_light_dark_complete * ] Cooker_x_Test Transition ¥1.0 Release i
formula ||| i [ ] measuring out ventilator ¥ °ﬂ ‘|"| hiscuits bake ¥1.0 Released
category) S ._ﬂ TESTZ ¥1.0 @& biscuits bake complete ¥1.0  released
----- Formulas
[yl Orders
-4 check_test [136]
m Materials
----- € Permission management _ILI
4 »
__El TESTMP 471
o Qkressste 0208
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6.1 50 FIte F

A ThEE
o [IHEUET ERC T (W 275)
o UTITHIZWIRALTT (UL 276)
o R ERCHIETE (UL 276)
o R ERL AR S A A A S ELIE (UL 282)
o (f HIAC /L W (UL 285)
o USUEAC/Y (U1 292)
o A IR AC T (0T 293)
o AT A G /) (T 293)
o iy PR FIIRAS K (0T 295)
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6.1 7z I rE
6.1.44 N
g AR
FEIX— XA, AT DRSS B T MR ESR G — e 0 A2, Horh 2l 65 8 Ti%28
A WRARKEAXEAN, PR EI AR RSO eiE O H, BLSEEL
FEING B Z5 1
XHRALE
Programm Bearbeiten Steuerung Planung Extras  Ansicht
Fenster Hilfe
[fo & ]== = E e e >+
=
E-fag Brewhl |a]
-5 Bibliotheken
-5 Grundiezepte
=5 Formulas Formula
-5 Formula_300702 category
& Formula_300702_2
SRENE Formuls 300702 0 B
o] &% Saz V10 Formulas
ip] 2% Satz_Erw V1.0 with
ol e Satz_Vorl V1.0 status
o s Sate_Wor_Em 1.0 displays =
w-(3] Auftrige -
~ B INTEG |
5
Al ThRE

o BUEFI A (I 278)

fa ~ R R PE (0T 279)
BB AR AR 22 50 (UT 280)

fa o~ s PE (Ut 280)

Rt AT hn i 2B 5 A AR o~ AU (0L 282)
fil F 2~ ARV (0T 286)

Wik~ a\ (0 294)
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6.1 50 FIte F

6.1.4.5 HEFET

B4 BRI

FEIX—DXCH, ST AR A0 S AR G0 7 i LT B AT PRS0 AT DO ™ AT LB
Ao ST LA AE AL BT ROE, B, R A

X RALE
&3 SIMATIC BATCH: Control Center - [ [DSC1]] _ 55 | Qlﬂ
W Program Edit Control Planning Options Miew Window Help - 1= %l
|o|@ 8 |x|=Bam|R]|[rmimrs X aa® |
x| | Batch Batch IC | Master recipe
Elﬁ Erewhl Wl Erter text ... 5] Enter... |SP] Enter test here
Libraries .%1 Charge 153 defering simple %1
G-z )| Master recipes %] Chargel 154  Geheimnis ¥1.0
g ]| Farmulas ] Chargez 155 Geheimnis ¥1.0
B3 0”'?“ / ] Charge3 156 Geheimmis ¥1.0 | (LR R
% ;m':""— e B ] Charged 157 Geheimnis ¥1.0 :
vee Eer L s .
D verkettet :3 E:argez ig Hlerzn:téfii HDI'E
B4 0sC L HHS e batch_01 1
=
~H %] Charge
2 [ = Chargel
@ B | Chargez
B | Charge3 Il
----- B = Charged
B | Charges —— =]
[ &) charges
~ ;L Gharge hd |l BV | F”“““
@ MEIN_MULTIPROJEKT I Element(s) 0 selected I E_,Iﬂ
O 8uwex [153
Kl 4«
ORARE S
@ WEHLAE = A= 1T
® LB/~ PIRE BoR
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6.1 k5 It

AT HZhEE
o IHEUR A 1T (T 308)
o HEELTHRAEYE (5T 313)
o R AN RN A AT Y (0T 314)
o M E R s (i, HoED | (W 315)
o BCEAMA A HHH AL (T 817)
o T BN s B T i (0L 318)
o EREA 7 (UL 320)
o Wit HYAs AN TE] (UT 321)
o LAY (VT 236)
o AR BPIRAN (L 332)

6.1.4.6 Ykl

ez as
BRI A A b A A S A R RL, 250 S5 AE BatchCC A EAT.

A] FHhRE
o XKL (UL 264)
o [T (T 266)
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6.1 50 FIte F

6.1.4.7 A PR A 2

WEN R E
R HE i R4 1 M T . X% T BatchCC il BATCH I J7 4 8 5 Dheg,
PUAEIX B4 s v I LRV 2 ot @ AR S A R AR . XA &3 T
SIMATIC Logon PCS 7 AR T A BESETL. W8 BLk in= &, SIMATIC
BATCH &N 7 #8404 T AT IR (A TS| ) .

T Thek

i H AR (0T 256)
SO AR (T 260)
s R (T 260)
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6.2 75E /IR

6.2 T8 € H P B

6.2.1 AURR A B 15 )

SIMATIC BATCH 37 PCS 7 #yrh0 H P& B SIMATIC Logon,  WLERAE[RIFE LT
Windows H 1 FH & BEAL

XN

e 7F Windows H13E SUFH PRI 4l (FEHR 2 Windows il4s2s BT D, FF4E e X
g,

o il SIMATIC Logon #4F7] & X SIMATIC BATCH I S (0,  FERX L6 #1073 i
75 Windows i F 4.

e {t SIMATIC BATCH (BatchCC) " rJ 4T T #I#i 4k & e :
— AP AR BR (2R
- MEIEI AR AT Gty
— FAFICH RV S CREE .0

o X T PCS 7 51 SIMATIC BATCH 414, 4 e e i g8 s i 4538 5%
B, SN HLEROLH P, A1 28 T S T A E S .
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6.2 75E /IR

SIMATIC BATCH A #fa

DLR 5 a6 U E P AR %9 SIMATIC BATCH [BRIAVEE . 78 SIMATIC Logon
AdminTool H ] LI INHE I fa . LA E, W2% SIMATIC Logon

AdminTool 155,

Y1 B3

HPAmfAe

WIRBEA R IR T 2R (1 2 A Windows 4L b2, WA - B Br 2
e A E AN IR

P e (B HPBR CBRIA)D

H sk TR ORI B 1 B B s s

T & Gl AZ ORI ATIC )T A AR
Emergency_operator TR CZiib AT 44D

R AE DY JHE . KA B RS BUE. SRHIRIAREE A S
(ERCiRZ L] BRI AL B A 7 DL R A

] AR BEAE N BT Thag CEEE 61D

R TR BUEENME C T

B

SIMATIC BATCH HI R4 8 i R @LH )" mt. MY 34 SIMATIC BATCH
W B PR, ARG AT DL OB PR B

254

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01



BATCH 75 0»

FBEH P

6.2 #i7iEM )R

LMt (b4 BB IRE.

BEA AR AT E I P A B P AT . (H2, KMt Em Ao it REUE TR

B EE T B AR !

ERIAEOL T, SIMATIC BATCH 2 7575 et 122 N G2 B 40 i e

G AT ITRCRR A B DAR 22 BATWE LM (L AT P OIRAS . s (e ) £ Pl o
R UIRES

FERBRAE B, SRR BRI (AT 4% H AR b)) JFANSE R T HA R

PR M.

HATHZ PRSI G & H A BoE XKIPTA AR, [l AT Te Ry e ik s 3

EHT BB IX R TCTE R IX LA BRI SR PTAT R bR i A2 AR

B B b BB
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2 HE R

6.2.2 e AR

R
G R  NHRE T EAL E# C e3¢ SIMATIC Logon.  SIMATIC Logon £5.55 W
AL
e Simatic Logon Admin Tool
e SIMATIC Logon Service
1§ [l SIMATIC Logon HIFEAELNK .

o AZifE Windows Hi @iz DL R4
“Logon_Administrator”fi1“Extended_Logon_Administrator”.
ST P o] LTI (08 31l i BatchCC H F) ¢ L i 2 “1E T (Options)
>“fi 6.5 78" (Roles management) k& SUH 7 1 6
Bi. B3
BATCH fiR45#% L HAFRE 22

WAE BATCH 4545 X AUR AT B, A AN AE BATCH fli45#% PC 4%
SIMATIC Logon &A1), BATCH fli4s#% PC it 3 BATCH &/ Hl.

& X Windows F /7 il 42

1. PSR A “TFAR” (Start) >“¥& B (Settings) >“¥ I #X”(Control Panel) >*“&# T
H”(Administrative Tools) >“i+ 81 #"(Computer Management) XiiEHE >“&
4:”(System) >“ZAsHb H 7 F14H"(Local Users and Groups) >“HJ
F"(Users)/“41”(Groups) .

Fair A “BRAE" (Action) >“Fr 2 1 )" (New User)/ 518 4" (New Group) 7t
Windows M2 (Windows Jil45#s) mHOIEE A H )~ Gied) A - 4.
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6.2 75E /IR

E X SIMATIC BATCH R P fa e

1. 77F BCC.
# 275 SIMATIC Logon Service [ sk X i .

2. iELEM AL N Windows [T /7 (“Logon_Administrator”Z1 (I 1) (I S 4. B
B, IFrd e (OK) HEATHfIA .

3. 1F BatchCC il it 32 . iy 4“3 " (Options) >“£ {4 & ¥"(Roles management) )5}
“ffi {05 #1”(Roles management) % if#E .
¥4 53 7“SIMATIC Logon i T H"(SIMATIC Logon Admin Tool) % it
— T DUE BEXHERE R 285> SIMATIC BATCH Gl H Mt 5 H

Windows /7 4H/Windows F J1 /3 Fe 45X S6 P/ fh . Gl ixX Mok, SIMATIC
BATCH H1[1) Windows F ¥ 35453 i 73 BC ) BATCH HI 7 Mt AL RR

— FEEAHEHER T 25y, mT LA a] SR ) Windows F P 41/Windows
FH . i, o] DUE S HE o Windows F F*4H/Windows i J' 43 it % BATCH
P fat.

4. 7y SIMATIC BATCH QI I/ #f 4 ) F 4 FLik 4% 21 Windows J 7 418k Windows fl )™ .

BEAE B A L A ET IR BUEER A G BERR . BB M 22X SIMATIC
BATCH i BURAE T 5 o BT BUBR B A 4507 1 ™ A €6

A

AR

AR FETEA S B, TT5% SIMATIC Logon (I7EZ#H DA T-t. 7E Windows
“FF4n”(Start) 325, 8 a2 TR (Start) > SIMATIC >“3C4%”(Documentation)
>“i&="(Language) > SIMATIC Logon nJ $£ 2% T/} .

5. i1#47"(Save) 1IN E .

B

R Ja 5 i

C4/E BCC kB a5 302 )n, W4 SIMATIC Logon H - 73 B HI - it (AL
FRAEHD
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6.2 #EH )R

£ X SIMATIC BATCH 15 FAURE
1. LISBR 7 G0y 8 k.

L

PR

S AT IR (0 A ) R D3 T DA BCRR, B SCRTEE SO P BORR . 3L
TR

Al {E SIMATIC Logon Admin Tool /gy 4 B ", B P ikEs s
W16 31 T A 44 e (P A £

FERCRAE D, i i BRI B AT RS A 4l

SuperusEer

2. #iili BatchCC TR Aty B (air: MEHESE M 440" (Options) >R
3" (Permission management) =Wt FA4 2 45 1) 1 “ B RS 31 (Permission
management) [ F 32 HL 4 & s . BT ITTRLIR 4% #1” (Permission
management) X i HE.

3. 7E“BAMU(Individual permissions) 255, AT LGRS P A 04 e H P AU

x
‘Wiews permissions of the logged in user I Change Log I
Individual permissions Cormputers and units
Uszer groups / Function Description ;I
B8+
- 45 Al functions
- Batches
- Formulas
- General
- %Y Import/Export
- Libraries
- M aterials
- %Y Process cell
- %Y Recipe Editor
- % Recipes |
B e abreesinnenis &
1| | 3|
Assign default permissions | Generate info file ... |
Corcel | teb |
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6.2 HENT /TR

4. ZEUHE IR G (Computers and units) ETRH, A1) LS @ VA HLE G H AT LLE
FHWBLE R = AR £

- “PrA TS (Al computers) SCIFJerb o BRI A RR, P Mt s e 5
BLAARR R I

— “<i PR T 596" (Units of the <Process cell>) SO b4y BoRiiot, HM Mtade
BORIIHRIG R

x
‘Wiews permissions of the logged in user | Change Log |
Individual permissions Computers and units

Permizzions of the user groups for computers and units

EI_E‘Q All computers
: W Automatisierungsingenisur
[WIg® Betriebsleiter

@ Emergency_Operator
WIg® Motfall-Operator

[WI¢® Operator

WIg® Schichtfiitrer

i @ Superuser

Mg Verfahrensingenieur

Units of the process cel

=]

M@ APPOR

- W APPO21

@ AP

(e BN = PR o (V)

=

:

Cancel | Help

5. Ffiffi e (OK) LLRAFHT I H AU

EHH

TG s B A N RE R (BATCH Be s 4% BatchCCO 4RI/, WXk
LB N RE AR T A P R B

fii )z PCS 7 Logon Service, 4T #7186 TEAE .
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6.2 75E /IR

6.2.3 SRR

HA
P B AT AR I AT IR EA T B 5, BIAE QIR BC ) B R L N AT s . — IR RE
Hi—A (PHSEZT ) M ar)D  SRAESOH AR .

HE T IRD BRAE:

1. ¥k BatchCC T AR M (i, s o fy 4460 (Options) >“AL A
#1”(Permission management) skt BebTE 4 Horh G b4 1 F e dr ARG
#”(Permission management)) .

P47 PR 3 P17 (Permission management) X 1HAE
2. MRE T EAE O PR :
3. e (OK) PRATHT 2 1 FH AR

6.2.4 B PBR

BIESHRUT:

1. #iiti BatchCC T H A B (ar: Mot i dr 4450 (Options) >“I A
¥"(Permission management) Bk E 46 14 O %10 R SR A A B
& 3"(Display permission management))

BT ITRLUIR 3 #”(Permission management) %G HE .
2. fnl AZE“BUR” (permissions) 3EI - g /A5 5 H P A s B

3. I HEHURF G (Computers and units) JET-RH, AT LL T fEAEMELE TSR LR T
AT LU WIS P A €
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6.3 1ZH ES ##7

6.3 BEEX ES iR

6.3.1 B FE B e EiE e\ SIMATIC BATCH

BRI ALRE B ITTHE

2K

BIESBRUT:

B
7

EZER

T HT BatchCC I, A g H AR SR T b A =X 5. MSCHEAE TRER S
(ES, engineering system) @il 7 () 5 4k 2B P=AH G B2 BT Bl i N SIMATIC
BATCH, A Geffi X4, ik, F52AE BatchCC G d B i B s ook 4

CHAE TR R4 (ES, engineering system) H G (4t AR 7= il B 5 o 3o AN T RE sG> 2
F| BATCH k454 iz AT v AL Lo

1. PESE A TR (Program) >“J5 2 1 #2875 (New process cell).
2. FEXTEME PR P R FE R CAT, SRS R e (OK) EATHfIA

RERERRICHEIR N, nI4E BatchCC FI BATCH At Jy 4 8 Hh Al X L6450 . LA, 18
A LATT AR A A5 BE 5 I e A o

fE TR ARG AT S SR OB B o il (DT 262)
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6.3 1L ES ##7

6.3.2 WMRETERETHIT T ESWEFH L Hidk

BT R A T AR

AR CLA TR (ES, engineering system) f 8125 1 54tk AE AR (KL R T U
s AFTEIE (Flan, MBI, BA, AU R TR A
BatchCC, LL{fi SIMATIC BATCH thAmBHET TIX S 5. PATILERAEIG, 2B R
LA R

V.83

7£ BATCH & HlL L E#H

LR L (V) TR REAE KIS 3% B Be 1) BATCH % HL B3k T, firfs 2’ BATCH
RS AR S AT ) BATCH HiR45 28 (FibAEr=id i) o

&, BEEEASEEXS R0 ERERAE. ANCLR AT k. w2k, )
S BIR—ANKHEHE, SR I T T IR

5k
S E TR AR S (ES, Engineering System) @1 g (4L AL 7= 1) #odhs W TREIT v, T 23
BATCH M4 #s iz &l L.

B RS IR Y 2
SFr R T R AT, o] DT ER A S B s ek CRIGET IR RS e idis 2 T iy 22 51D 1 H
Ho MR LAY — A E@E M E B R o i SR M AT S S AR R, AT LA gk
ST

MR FIA RS K mH

262

SOH R, M R IeHeIRA kA T A2 57" (released for production) Fi1 kAT FH -l
k" (released for testing) AT AL (ERCTT EERAE) A A AR A IELENRA A
1i"(Testing release) k7. FHTIFER I CHMEE 5, ¥ B3R & b T IEAE MK
fi"(Testing release) RN %o WA AR, WG R P REIRAS . WA &K
W, Wi Ay kA R (Release invalid) R . AT LU O HEAT gm0 R AT

B, 76 W (0T 236) 1, ATLUEREZAT, ARJEE—MEE, RS SRHETA
7="(Release for production) (I N33 KR A AT 2 NECTT .
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6.3 K ES 27

‘BB R L TT I BOHEAE PR R

B RTINS 2 T 2E7(blocked) F1“ Tk A" (released) R A . b
I, B EATRPIRASBCE N IEAE N K A" (Testing release).

A RICHE R, E AR ERE R AR SR R A R

e
KA RE RS S KA KA = RE
UL kA (Released) LA = B kAl (Released)
CLBHZE (Blocked) A= 1 L2 (Locked)
%Aii (Released) HEA: P AE AR R KA (Release invalid)
352 (Locked) A A B RATT# (Release invalid)
T/‘ﬁiiﬁﬂ%%/l\%kéizﬁﬂ‘]%%‘\%&?ﬁ%?ﬁ (Release invalid), WIABE A AL, A
RERF LR

BIESBRWT:
1. PSR 2 “YniE " (Edit) >“5E it #2 82 J5"(Updating the process cell).
2. FEXPIEAE PO R DB O R TR B AT, ki " (OK) BEATHAIA
SER O BT B FE " (Update process cell) SHEHE.  ffi A AHEHE S, #i4s
EHE PR ITEE . ESURN R EREE . ST & .
SRR
(] |&Roi
CriiesR, H /DA ARG BN AR 7
TG E AT ARG R0 S 2 43 i
1. W RSB I RS O A B0 SR S BE B 5%, 250 T I 43
— RAIBFEE R T PR PRI B > K L ANRHEAE, Hrp SR AT R 2 B AR
%
— EFEITFE NS, 4% Return BEAT 43
2. it (OK), AT TSI 4.
P S

R TCHARA B B . B AUE SO TR KATIRES kA 534" (Release invalid) 1) 3
T7~ FEBAER A S
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6.4 HTEYF

6.4 e YRl

6.4.1 Rl

A&

RN

264

LA RIS URI, 2520 7E SIMATIC BATCH HOB#IRE G7hhy Bl ) & XL
AR

o AR NPPELR Y DR PR
o LMINE
FERH I 875 IR TEME H (10 51 RME Y 5 U, T G ey AR e 47 o

LT TG R AT RE AL (0 RSO RR CBtn, 5 p AR
W) ., P AT e 1M SFC SR AR R R (A AL R, LA
GEO

i

YIRS L

WR T A A NAYEE B .OX 5B, WATE A SIMATIC BATCH 1 7 St i (API)
YRS AR B S (A= CDV) .

o WpklEUm B Z A 32 ANTAES

o WPRMRIL A FRHC AT, HiEZ s 16 A

o TRACHYANE, AIE N 0 3 2147483647 [ HIMH .
o PRI FR R M AL H L T IE— 1) o

o Wk} eR ) T RN T A A A 2T

o BRI, RS A ANZYRIIRC T PERA . W SRR B EAR A
MERZHA, MIARER HMIER
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EF YR

& BRI B

6.4 HTEYF

. 1t BatchCC "L #£“¥)#l"(Materials) 3Lk
| RS A AR (Edit) >“ B (New).

SR KT <Wkl> Bk (Properties of <materials>) % iFHE .

. FEYIRR (Materials) ZE 0 45 2 51 N 2

— PR
— PPRHR R TR R
— RARNPRNE R R

. R (Qualities) 1T .
AT BT (New) JZHIAS IR i iE . — Rkl nl A 2 Ml & .

W
YrRH R
YRR [ SO TR -

. B E (OK) WA ET k.

W
“PIRE ST R BT LS

b m] DL B 25 4 skl (Materials) SCEEE IR B SE b (1B 2" (New) F1°J8
4" (Properties) iy 2347 FiA & .

W R 3 4 A8 1 (Properties) 11 ER"(Delete) 7] 15t i B A Wkt .
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6.4 HTEYF

6.4.2 HEYRE

BAEL BRI

1. 1t BatchCC Wik it ({E“Wkl”(Materials) S H1)
e PR By 4w (Edit) >“J& 1" (Properties)..
FE“ B (Quality) X 1 HEHH BE OB R R B
L " (OK) IRAEFT 4 H o

> wDn

L
“JRE"(Quality) XF 5 EFICRH

WATBLEA R @ Qualiey 19 1R 303 L 1@ P (Properties) fir & 7EM T2 4514
ITHBE.

SIMATIC BATCH FJIf, V7.1 SP1
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6.5 L]

6.5.1

e G AN G R E P T

WREE: el =Ry

BATCH Recipe Editor

yes

v
Start
BATCH Recipe Editor

Create new or open
existing master recipe

Work with
libraries?

Create recipe
topology (SFC)

Specify properties
(header, RUP, ROP,
steps, transitions)

@;»

Save master recipe

If req. assign formula
category

l

Release master recipe
for testing

Release master recipe
for production

SIMATIC BATCH /i, V7.1 SP1
EeEF M, 03/2009, ASE02171120-01

6.5 Bl
BatchCC
_ES yes
requirements
met?
Start
BatchCC
Meet i
requirements: see
ES configuration Insert )
master recipe
Import ES .
data into Open master recipe
is started)
[
See
Flowchart: How to Create / Edit
Library Operations
Result:
» master recipe stored in BatchCC
under “master recipes”
If req. change header
properties
If req. assign formula
category
Release master recipe
for testing
Release master recipe
for production
267
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6.5 4l

6.5.2 miEE

e ) 3/ 2 PR R A

e B 4 R PR AR R PR FLHE A E LT

268

BATCH Recipe Editor

yes

Start
BATCH Recipe Editor

@O
v
Create new library

operation or open
existing

Specify properties
(operation header, <

ES
requirements
met?

BatchCC

yes

Meet
requirements: see
ES configuration

Start
BatchCC

|

Insert library
operation

Import ES
data into
SIMATIC BATCH

Open library operation
(BATCH Recipe Editor
is started)

steps, transitions)

Save library

Result:

operation

Release library
operation for testing
or production

Use library
operation in
recipe?

yes

Create new master
recipe or open

}

Insert library
reference

Save master
recipe

!
©

See

.| Library operation is stored in
| BatchCC under “Libraries”

Flowchart: How to Create / Edit a Recipe?

If nec. change operation
header properties

l

Release library operation
for testing

Release library operation
for production

SIMATIC BATCH /i, V7.1 SP1
PeET-F, 03/2009, ASE02171120-01




BATCH =)0
6.5 4l

6.5.3 (ollf 3SR nBA

6.5.3.1 IrASH. ARSI AXZFBIRER

wESH (AEHATO

UR EERE YRR A P Bl AL OR B AR BB R T LRIy R P AT iR DR
ARG ME 5 bRk 3o PRLAN AR Sl e R0 QU U 1) B, IR AE R
AP R EEAE AT HE A P I BEATAE . 3 PT LR IX LSS HO IS b A 36 2] AN i 25
W, BUBCTs 2D Bk i B E )5 b

WS HL ARSI AR Z R E
AR B B AT I 2 AN IRRN R P s A0, AR R 2 AN MR A 5 g
TG AT ERAE.
RO, AR less ERr . RA, TR SEE S IR RS
A IR AT g AT A AR S B gbnic ok, AXIGHRS 1S
HOSHIR R T, AP UE BRARNSEE. ERRUARER (BT 5
He

Rl BAAESE A A st AR AT IR B b 2 U 24

A
P FBAIAER 22 AAGANIR], XA, T I bl (0 RGN A K
HAAMR AKX ZH0HE BT Al
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6.5 B
P
L 1K A
Master recipe:
Recipe header parameters
1 Quantity 500 kg
2 Water 1000 kg
3 Temperature 70 °C
4 Steam
5 Flow rate 100 I/min
6 Time 320 sec
7 Speed 120
8 min. speed 25r.p.m.
Parameters from
the external formula
270

Formula category
1 | Quantity actual | kg
2 | Temperature actual |°C
Flow rate actual |I/min
4 | Time actual |sec
5 | Speed actual |r.p.m.

External formula #27

External formula #26
External formula #25 |
Quantity 500 | kg | -
Temperature 70|°C _
Flow rate 100 | //min |-
Time 320|sec | -
Speed 120 |r.p.m. i

SIMATIC BATCH /i, V7.1 SP1
PeET-F, 03/2009, ASE02171120-01
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6.5 4l

6.5.32 HEZSH

FEERTT 5IMRARZ RAIBESH
PBEERCTT M A IS, IEH LR AR, e S S S RS

SRR G Ao, S8 mT AAE L5 1A SR AN (I S B A Rk R A I 5 i
HENs A, T EAE RV IHER) A XSGR ESEG I ARSI AR 2L
PEIALRAT R D) BE e B 5

SIMATIC BATCH /i, V7.1 SP1
PeVET/, 03/2009, ASE02171120-01

Name Type
1ab float 1:m Relation
2cd integer
3ef string I
4 gh float
Formula
I
—1 category
Name Type LL Value HL — | External
1 ghi flog 2 80 100 A formulas
2 abc strin close ) .o
3 xyz strin open - User-dgflned . ® |
4 gsg floa 2 50 80 -~ relation |
o [
‘\
N |
N
- -|Name Type LL Value HL
1ab float 2 50 80
2cd integer 0 10 12
3ef  string close
4gh float 2 80 100

271
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6.5 4l

6.5.4 YniE R

6.54.1  WMARERT;

A
BIRHPBI FARE s RAT O EE 7 Mk, Il IR AR AT
RN A

LA T DLAEANAE T SR A  SOR S B0 M My o AR O0 T, 7T B
FEERC s R Pk s E R A B (AR50

H&EERCTT

N 7R RS T 7R BatchCC H A1 e 77 RO BUBUF . s A AU W] 7 anfr 4128
(LTINS Ve DX /s Wl 1 9 o

SIMATIC BATCH Fit, V7.1 SP1
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6.5 4l

1 n LAAE BATCH it 7 e 28 B 2 S b lic 7 g A BB I T e E et CP2) o fr
{H B PB4 F BatchCC HiEAT,

BatchCC

Create the master recipe

-

BATCH recipe editor:

» Create SFC recipe structure

» specify properties of RUP, ROP, SUB
and transitions

Specify properties of master recipe:
» material and production data (formula)
* unit allocations
* measured values for logging
» reference to formula category
(only if formula category exists)

v

Create the formula category

v

Specify properties of formula category:

e parameter name

» Data type (only for process parameters)
* unit of measure

Add properties for master recipe:
» reference to new formula category

-

Create formula
below formula category

-

Specify properties of formula:
» Parameter values
» reference to master recipe

-

Expand properties of master recipe:
* Interconnect parameters between master
recipe and formula

SIMATIC BATCH F/it, V7.1 SP1
#eAETF ), 03/2009, A5E02171120-01 273
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6.5 4l

FEAGE
7E BATCH it /7 g 28 v 6 2 - )y -
o TR . wE NS T IR (RUP). e #:4E (ROP) FIHc 7B Bt

(RPH) [#)4k#)

o TR . WIEIENEE T4 (SUB) 4 #
fE BatchCC ', wJUIE L 7@ (hris$o diee AR5 H. EAXErET,
AfLMREREE (ERT) W51, XSSP n, BB — ATl T = k)
() 6 B -

SIMATIC BATCH /i, V7.1 SP1
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6.5 4l

6.54.2  QIEHMERT
CIBGEOR I WY L E el b i U A LW
e {t BATCH Ki/ygmfHdsh: 1S M “BATCH N7 daiB 45567
e 7 BatchCC H': J8fffii 1]

£ BatchCC %[ ik b Bk
1. T J7(Master recipes) SCF .
2. BEPEEE A A g (Edit) >“Br”(New) >*)24%"(Hierarchical)/“ [ 2% (Flat) .
3. TE s (R AR A A B = C 5 1 A BRRIRRCA, ki i e (OK) ZEATHfA -

il MR ER sl d BN ERJT T YIRS AT (In Progress), Jf
AT G -

ARFHBE:

BUAE, SR DME A% sl &) 11 SR RS B G AR (Edlit) 52 P4k 4 4R I
J7o

o QAL SR AR (W 470)

P EE 7, EMH T I (Open) K am 24T 5. BATCH Bl U7 gl 2 BRI 4T
JF. 15 BATCH Aoy gmfa s, vl LG A0 MR I ERC a4, JFa X7
%@ (RUP. ROP. RPH. SUB ).

o fixE LRC /T IEYE (WL 276)
THRER bR S m I, THEFE R " (Properties) S i1 4
o (AL S WA (T 285)

B TR A, st ] ARGy S SR g Rl B TR PR £ B (Details)
SIS AT B . BIG, EMTR AR ket Fr s ERC T I SCAt k.

o T (7 292).
o EAH TR (7 293)
o RATHT SR (5 293)

SIMATIC BATCH FJIf, V7.1 SP1
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6.5 4l

6.5.4.3 TSR R 77

LA T
T B HC 5 R RN P A Sl i BATCH iy g 2 G 2 17
$s 0] LU BATCH ey 2 2 6 E 7 R A PEERVE MEATAT G 2 (R B a, ) H e iE
ik BatchCC #47) &

BatchCC HHI#/ESTINT

TG AR T R ZEARAE, A ZSEHT TR B

1. 7& BatchCC k4 3 e Jy B A

2. HEFEIH Ay A 4EE (Edit) >“FT FF"(Open).

4. BATCH BCLU7gmEa5F1 9T, JFRIREC T S w240 BB S5 o

6.5.4.4 e Xy

FTIFETH R X HE
A DA P A R IR <BC T A FR> SR IR
o {E BATCH il JiguiEas: 5S4 “BATCH MLy gk 537>
® 7 BatchCC f': fifidln~

BatchCC H /I /E BRI T
1. {1 BatchCC f#)“F- At J7"(Master recipes) 5 Hrh—AN 7304k e ik £ Bl 5
2. P4 A 4R (Edit) >*J& M (Properties)..

iR KBRS HI <l A RR> SR YA ITHE . AR HEE IR, P
A BB s PE (U0 620)mI . BRIy 455N, 3R a2l ] LLR e AT 20 e e A e
Ji e

H T AN 6 (RUP. ROP. RPH. SUB Flé#) DR HE TR RS i i
FICHHT TR, R EY (280 2E — EleE. o]l @6
B DX IR AT T8 U S el ik .

3. IR AT A B s, e i e (OK) ZEATHAIA.

SIMATIC BATCH FJIf, V7.1 SP1
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6.5 4l

mAREE

A BAE R AR IR R AE N Ry S . i 3 B (Help) $28 ABRAF LTI 4>
o A\ B HME LR SO SRR Bl

Properties of 'New recipe’ ﬂ

éﬁ Cukput material I @ Parameters | 1;- Transfer parameter
151 Dependencies | Process tags | ﬁchange log | @ESIG
Eﬂ izeneral | E! allocations | m Praoduck | éﬁ Input matetial
Marme; Skatus:
I MNew recipe I in progress
Version: Forrula category
1.0
Dwration:
| oo
Sec
Description:
2

el | oo |

Xt KR BEIH

i HL”(General) 1EI0 -~ 1“4 085" (Formula category) i AHE, 1T LCK HA YR
FAEP= 5 (AR IrFR M AREN RS ERL T . e e tld a0,

HHEZH: RS EL AR X HF XA (T 269)

ST BT RAXIGNGE, SEITEE. BAXINNS ERTE, B LR
PEXHEHE (4 A PPEL (input materials). “%i 48} (output materials) #1“%
#0"(parameters) 1LTR) AT PR E S G I .

FESH: HELER TS A HESH (I 282)

SIMATIC BATCH F/it, V7.1 SP1
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6.5 M

B4
AL BC TS A BET5 e 3R A DL 2844 . AE"ESIGT AT R P41 7444 .
HESH: R T4 (I 335)

EZER

FlCTT A R

6.5.45  BIEHHIARNEH

BatchCC FHIBES BRI
1. P A (Formulas) 32,
2. VEFHHLAr A SR (Edit) >“FT 2" (New).
3. AE SR RRAE P A A A S B AR, B e (OK) #EAT A

it BHOAREIIES S0 0GR BRI, T LU AT IR SRR
HAm a2 A

27t
DL RN 3 ) A gk i 4 A 5K
o R ARBHENE (T 279)
o BUEFIAN SN (T 280)

SIMATIC BATCH FJIf, V7.1 SP1
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6.5 4l

6.5.4.6 FEEANRKINBEMLE

BatchCC F H#R/EL BT
1. 7E“A"(Formulas) SCAFJesi I — A7 30 e rhd B A L8010
2. WP A Y (Edit) > & 1" (Properties).

iR BoRe<ZEN 4 FR> J& P (Properties of <category name>) XFifitE, 7 I ot
WHES, FTRAL AR A RIS GMBAZD Gl PrEkFl = aidE (2D | (7 94)
IO

3. MIANMZEARR. Btk ((REFESHO MY B e i) o~ SR 4k, i
i 2" (OK) AT -

i AHARSER, ATEEM TR P A0 IR A, el B AT
T SRR ity K 6 A 10 22 3K

B
AT RAZE R A IR R HE P A 2~ S R e . A3 B (Help) 4481 LASRATE T 1
BEANRF S8 By A\ ) B SRS BE

Properties of 'Formula_300701" E
=0 Input material |é§ Output materiall ) F'arametersl

Ligt;

Hame Phy=. unit
Input| materiall Sec.
Inpt material Degres
Inpt material (Sec.

s

b2

La%]

Deszcription from row 1;

;I MNew |
;I Delete |

Cancel | Help |

SIMATIC BATCH FJIf, V7.1 SP1
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6.5 177
6.5.4.7 BIEF RIS A

BatchCC HHI#/EP T T

1. £E“ A0 (Formula) SCAF IR FEFT# 102 I W% A SRR 2 S #A
7, A2 55 B AR N AR 1 XG0 (0T 278).

2. VEHESE A A g (Edit) >“BT 8 (New).
3. e H BRI HE A AT A R A R AT RR A

it BARAER wel & MGIEAN . BLE, AT LR A 2 X TR AE i AT 1
B BoR RS S BN, HERE SRR AN WRSHEK,

) A A 8 A

27t
PAT T HIERAE A0 A A TIE 2D I -
o i AHENE (7T 280)
o LR AR S B AL A U (UL 282)

6.54.8 fHEAXPENE

BatchCC HJ#AIEF BRI T
1. AR FEFEAX.
2. P A 4R (Edit) >“)& 1 (Properties) .

i ‘<AL FR> 1 JE T (Properties of <formula name>) X ifHEREEI s, A
SR RERME IR I F R .

3. BIAPT A IS, IFEFAT NI R

\

L]

#E* LR 7" (Master recipe) S A3, 7T UGB RS LE 270 le 4 i 4 2 2 U i 32 50
Jio WERARFNH P s (0 BBy, I ZED) 45 2 007 (R MR EARE, AR g A
e EILEE

SIMATIC BATCH FJIf, V7.1 SP1
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6.5 4
MABEME
ELLRIET R AN A UBME . 8 A B (Help) 4280 LA A3 10 145N & S\ i
HE R ST DG
@ Parameters I 1;- Transfer parameter I Iﬁ Change log
25 General | m Produck | ﬁ Input material | @ Cuakput akerial
Marme: Stakus:
IFDrmuIa_l I in progress
Yersion: Formula category
[v1.0 | test
Master recipe Reference quantity For guantity scaling:
|gesamtrezept 1.0 j I 100 kg
Description:
i
Ok, | Cancel |
FRHHIFIH

7E“H B0 (General) 175 “ K 7" (Master recipe) S AMET, A% A A B — AN E 1)
FER T . IXFE, EH]E REAE P VRIS RTS8 52 3 K B T .

HEZH: WIS R AR PR A X H R F (1T 269)

SIMATIC BATCH F/it, V7.1 SP1
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BATCH #5100
6.5 4l

6.54.9 KEERTHESHEIMEAXTIE

HESH
PR ERC T A IG5, Vid R AR S RS B . i e E PR AR
B T RIS, AR AT BB IS ECEE CyiE 2 fRE ERC 8 TE (0T 276) 4T
) .

E T IRD TR A

1. 1 BatchCC [#)“F- At J7"(Master recipes) 5 —AN 7304 e ik £ -l )
2. WEPESE Ay A dmE” (Edit) >*J& 1" (Properties).

i, <l 7 485> JE P (Properties of <recipe name>) X iEHEREEN B .
3. B AYEL. R s S H R LT R

SIMATIC BATCH Fit, V7.1 SP1
282 #A/ETFF, 03/2009, ASE02171120-01
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6.5 4l

4. 7E"Y5"(Source) A AIE S A XA H S HH 5 H] .

— e FIERMET S A R BRI B T P A XS, k.
A RE T Z S AE YL " (Phys. unit) S0 ML G, <E> R BoR(EMET R, &R
INETANERM GESWED .

— A S ASIEREREENFT . QIR S HO, R R XA T R A AN
FONN R A SRR BT, WSS, TR BIZEEN S0 .

Properties of 'Recipe_REA1'
@? Dutput material | @ Parameters | Process tagz I gﬁ’MDdiFicatiDns |
General | B Alocations | =H Product 2 Input material
Lizk;
Hame Source Material Code Low limit LS
1 [Recipe_REAT _mati vI Material 7 34 1]
2 |Recipe_REAT _mat2 _erial'.'r 34 0
3|Recipe_REAT_mat3 nput material! etial? 34 n
nput materiala
«| | |
Drezcription from row 1
;I MNew |
;I | Delete I

Cancel | Help |

5. Hai e (OK) ik ix st .,

WERIE BB B fegs B A B S Ee A A XS I S HOER B SME 2 51
24 (iES I GEE N BE (00 280)i ) » LM SHha A ME.

SIMATIC BATCH FlI}, V7.1 SP1
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6.5l
SYEER BN
HE SR AR A XV IR HE P L (Usage) 21, DU EIFR R R
=i=: CH%E
D= RIIE (BOAH S
Properties of ‘Formula_701"
== General @ Input material |@ D utput materiall @ F'arametersl Iﬁr---1|:u:|il:i-:atiu:uns |
Ligt:
Usage Hame Material Code Low limit Cuantiby High
1 == Imput material {Material? L f34 0
2 =] fi= Imput material | Material? 34 0
3 == Imput material | Material? 34 0
| | i
Dezcription from mow 1;
el | ten |
EpIEERS

SIMATIC BATCH FlI}, V7.1 SP1
284
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6.5 4l

6.5.4.10 fFHAECTT BWFIR

B 77 e
B 7 S N0k SR A e X IR /T AR . BRI TR G5 TR K @ At A8 o Bk
e A S H I
WIS F RN BRI, o LU TR 45 f b (3 E D ik ik BT R Dhiie (& 1k dmbH 77
%) .
;"‘i‘ [Brewh1 /Master recipes]
Recipe Version | Stakus Processed by Modified on
il o o o

Fy 4 mr_Reakkar_A1 V1 0 Release canceled

Pk mr_with_lib_formula_late_bin... ¥1_0  Release canceled ’/Q ""'al"jat":'” 2 34601 P
] mi_with_lib_late_binding Yi 0 Release canceled | (2 Open 2 3de01 P
] mr_formula_late_binding Y1 0 Release canceled % Erint: 2 Jide01 P
.1 mr_late_hinding Y1 0 Release canceled Frint preview 234501 P
og] g .1 defering simple ¥1.0 released For best Properties P 10:43:46 £
°g];ﬂ Aukarn ¥1.0 released for best B Relsase for production P 10:43:46 4
& Perfrion ¥1.0 released For best ) : P 10:43:49 4
.E] t] Release for testin
sﬂu.] Recipe_REAL W1.0 in progress % Delet = d Z 40247 P
elete

R B
o PSLAEMSTE S R A T SCIETE, SRS IR R Sy A e (Edit) >“TE4E Bt
K" (Details), A M 25T 7 X 35

SIMATIC BATCH F i, V7.1 SP1
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6.5 4l

6.5.4.11 fAHANER

AR

NS

R Ik 5 DX T AT 2 sUIR AR

BB SEE  H
MBS G LN SO, T DU IR S5 vh AR ik FE nl K BhRe (i dm 8 s

%) .

Marne

B [Formulas/Formula Categorie ]

Mersion

Skakus

Processed by

FRB B SRR TSN, AL B

Madified on

i

F
) == with_lib_late_hinding
) == late_hinding

B == Formula_late_binding
B == Reakkor_a1

& & Formula_REAL_700

& & Formula_REAZ_700

& & Formula_REA3_700

with_lib_Formula_late_bin. ..

Y1 0
Y1 0
Y10
Y10
Y1 0
¥1.0
¥1,0
¥1.,0

ease canceled

Rel
Release canceled
Release canceled
Release canceled
Release canceled

in progress
in progress
in pragress

ff/o Walidation
Renarne
Prink
Prink prewview
Properties
&l Release
Copy object
. Delete

1502002 11:435:49 AM
1/15/2002 11:43:49 AM
1/15/2002 11:43:49 AM
1/15/2002 11:43:50 AM
1/15/2002 11:43:50 AM
11j15§2002 5:07:09 PM
11152002 5:07:25 PM
11§15/2002 5:07:38 PM

HOAEMIE G IR AXSCIER, R F i 2“4 (Edit) >“FR4 B
¥ (Details), A1y iE 5 e X 3o

286
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6.5 4l

6.5.5 A% EE

6.5.5.1 ] 2 A FE AR

AXPEBRAF

NI R B AE BATCH FC 5 g4 vh 2L S R AE R BOBRR . % AF7E BatchCC
BATAE R T HAdO D B AT AR BATCH Be 75 & BLas h kAT

BATCH Recipe Editor

Create a new library operation
in the BATCH Recipe Editor

v

Create topology of the library operation:

» Create the recipe structure

» Specify the properties of the steps and
transitions

Specify the properties of the library operation:
» Material and production data (formula)
* Reference to unit class

v

Save library operation in the <Library> folder
in BatchCC

v

Insert a library reference in
the master recipe BATCH Recipe Editor

SIMATIC BATCH FJIf, V7.1 SP1
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6.5 4l

BAEEREN

EZudisheS

FEnfE 2

288

75 BATCH e J5 g 4 s G vl s 1 110 P2 A
o NTIRHNTr: A NECITE B (RPH) (45
o XTRHETr: AT ait. BT EAE (ROP) REC T BB (RPH) H £y

JEICTT B EARA T2 A RS E (R RICRBIEE . PERAERObR R S I 0. 9%
WACAFIEFE IO, FEFARAE PR E AR I 51T

7t BATCH JC /7 dmf a0 H 32 5y 2% CLXFh 5 1L A0 2 10 PR VE A7 fiti /£ BatchCC 1)
“H”(Libraries) S Jerf.

#E BATCH ALy it A5 1 QUGERC /7 55 K0, (EPELPES PR AE . R 8L
SRV BRTE, TR QUi I P Ve 0 B 1

FEAT BT it (G 2055 s Xt PR A A PR PEBRAEREA T o REPEARAR AR (A ] S SR e S i it
FEFICERCT PP 8RR (ESIHD S

AL IR LU TR A T P A -

o £ ARERICH 2 IRAEH

o {E— AT (RP) 2 XA H]

o (EDCIAT RIS T oo #E (RUP) w2 kA H
o (EDCIATIRIZUAC T (114 (SUB) H 2 XA

o TEERATE I B PE (W 519)

SIMATIC BATCH FJIf, V7.1 SP1
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6.5.6 EC 7 R ARAE Stk

6.56.1  REEHNRKIE

FECTT R PEBR AR HR S B OB

6.5 4l

AR R T HE T B R AR AT IR SR 2 HEAT 7 (In Progress). R LU# T IE 4 1 iy &

R Tt A R, T A R
R fith e 2 &5 3
KRR | EROT B REAE B 5 AR AL T EEAT R (In

In progress

Progress) k7.

validated

;TZEFL (i[i86Sg ﬁﬁﬁ\

R R S e B I SR YE

v
(7T 292) ") .
S5 AR R IF BRI R, )
l o, BEREER,
R
7 PR AT b S ORIy 454
S ST KA 119 B -8 P AR [ S B AR [
RAFTIRN | Ho o B
(U1 293) Tl A 0 G A S AT A A MR 2 BT 0
i RAHTER (ORI R, A RESrRa aaiz
(7 293) 7.
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BATCH #5#0»

6.5 Bl
fil % 2 &N
release KA B R T B D AT T, T
revoked B B A P RANY (B, EHESD

testing SRS AR | S, IR IO Ay CRERT . R
release P B PR A2 kAt FH T4 (released for
production) F1“C. & A F T (released for
testing) 2% 4 MR & 4ii”(Testing release). H
Brid TR, &AL TR
11"(Testing release) IR L7 FEH:AE.
FAT A BT, R R 2 R 2 I SRR
Ao WAREAEKRM, TTRERSBAN KA

0 (release invalid) R . IX I AT HHE AT %0
I EHRAT

release
invalid

F
et

KA TR E B AR T A B X

FERC T RATHIRAE R R, & nr LU A SRR RE .t T kA IR R A T
AP 2 TEAFAE X ), DR AT CAA S (e a R o i an, AT DA SRR A S B 5 R A
FHF MR- e teah, T L AR R .

YT E AT TR BT, o] A ARG G i T gt . o T 2R A H T A
BT, W AEIE L BatchCC i FE Lk s (“HEIU"(Options) >“¥% &"(Settings)) AT
L
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BATCH 75 0»

6.5 4
ARE
TR, A5 (ORI ERTT) ALK
R fib 5 40 AN
_ ET AR AN SAEBIEL 4 T3E4T5"(In progress)
In progress I~
Tz (New) ISR
v
|- S 4 Forts 7 43 B DL 2 S B A
validated K i Ph. SEEREEAIFN S B H, B
., BEEKIE.
|
o A5 RAT P IRER A 1 T S 2
.
o ARBHURINTE
AR BHAE L RN
| SERMARA | RO ST A I T g, fEX
reieases FIMESL T, A ER A A7 FIEAT
olease S A4 AR TR AT, LA RATH (b
revoked O R A W, BHHTEEO o WA P A
TS, WBEKR.
A P ER

PR
A F T B RAT A A A AT
3 B A T DN 32 S 75 A0 A L R
75

PAH] Tt A =il
QU I A (i, FHKEAT IRk 4
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BATCH #5#0»

6.5 17
6.5.6.2 UFEL

& 3L
Kl RS CLAVEEC A A P A R A R o edie (0 SRR EA TGS

R

SIS . BbE S e DL R ROy Ba 4128 (bt GBI i, A REREA T
ik,

7£ BatchCC #E#ill .00 3% T 5P Bk AT 8 4E
1. FERS TSR B A (I )y CERCT BUREERTED
2. BEFEE A Gt (Edit) >“BAil”(Validation).

SUREERARH I, ORI R S5 OB T 1A, LI R A
7 CLALAS LA SALIE H SO LT LA . S EAR P BLE BATCH BE 4428 il
i7.

L
W ARAE BATCH BTy s thFT TR )T, 08 T DU XU 8132 o 10 4% H Bk 218 A=
)RR ey o RS RTBEIN A SRR B AN e i IR

A1 ER B IE
WUEn] DAE AN A B SRR IR BT

A RX LR LT VEIE B, G S SR "SIMATIC BATCH #i 11 #:2(SIMATIC
BATCH; Plugin Concept). i & WA X Lebitl DL & anfaf /t: SIMATIC BATCH H i
HIOBerE R, EZ 5 A M8 RS AT IR 55 o

W
=

fi AR A QI BT B0 UE (0L 297)
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BATCH =)0
6.5 4l

6.5.6.3 RATHF IR E

K-
SR RE T ER R REAT IR . R Bhizar I, R oG E Sk Ay AT R

BatchCC & /E L BRI T
1. ERTESE R TT (ERCTT SO RERAED) .
2. P A YRR (Edit) >R & 45" (Release for Testing).

iR RARRE, BT AT E R A TR (released for testin) YlEs R A, L
FErp A, SR RIS, a7y REFBE T H.."(In Progress...) R3S . AT LIFE
BATCH Fit /5 4t i 48 v K A o

iR
U IRAE BATCH ey S as H 3T T BC ), W] RUBRE XU #1132 4% H A IR 51258 21 5L 4
RINEC T By .

6.5.6.4 RATH T AR

BR:
SCHLIE DI RE R G R S AF R BC T (A R . AT e i 2 I 25 18 S e AT 2t

BatchCC /e BT
1. LEMTBSE R Bl 7 CERCT B .
2. WH A iR (Edit) >“ & A T4 72" (Release for production).

ghgt. RAJE, BT C & AR T (released for productio) miEd KA. WR K
R AR AT, SRR LR, TR IR AT . (In Progress...) RE& . bR
B HTLLYE BATCH [t J7 g4 2% H AT

]
WIRAE BATCH BeJs g as P AT ITIC s, WRT DU X i 102 4% H M 1R 81 R 5L 215 Y
WRIEC TS 50 o

SIMATIC BATCH F i, V7.1 SP1
A, 03/2009, ASE02171120-01 203



BATCH #5100
6.5 4l

6.5.6.5 ISTEA Z

& X
IR e, BRI A A, PUARE T ERAMPIER 7. IAh, BEREAXSEN
— ML e R T SR HE.
ER:
o T B kAT H T IRAEAE P 1 AR T
o NASH I HIE
o ARXSHHE E NN
BatchCC HHI#/ESTINT

1. AER TS h i B B A 1 A 5K
2. WEPESE Ay A dm (Edit) >“FfiiA”(Validation).

il GURPIRBENR PN & W ok, DR B A (Bl 23 M i 3 e
T mekAD .

L
BAE T AR AT . BREAN S g 0l R R

SIMATIC BATCH Fit, V7.1 SP1
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BATCH 75 0»

6.5 4l

6.56.6 FEHTRESRETEN
B TT AT AEIR A IR 22 “HE4Th 7 (In progress). 1] LIE I IE 4 i dr & Bk A . B bl
FTTF LR SO, FRIERRE 2 1y 2Rk T OB
BIbn g X MRS Kb (B, S &kAGIRAT RS A E KRR B b (i,
ERIFLD o

EARSERSEHEEX

%5 RE X

& HEAT R T PR UERZS S 7 18 28U RS

= R A TR O R AT FH TR P 75 7T P Ske ) gl ik P r i A4
FEo WG T ZIN RS ORI, T AT LA
Thie kit i, FKHHT I 54
FEILAX 43 o

B O R A T4 WA VIR DR, AT I A

PATRON K A" (Revoke release) Bi“4H Axid Fi
JL”(Configure Process cell) fr4 )5, Bl 78N
“R AT CHUIY” (Release Revoked) k2.

k| A CLARH ST T AR O A, A A AR
A”(Revoke release) # H BUN HARAS, XAFEAAT
DI 2 HiE (i, SRR

BE AR B TR R, O R T A T O R
fii T 427" (released for production) F1“c & i
T (released for testing) IRAIEL )7 (1
BCTT PEERAE) TN SR R A &
fi"(Testing release) K7 .

Bl RATTEL R PR ARG, AT IR R A (Testing
release) RS ML 7 FEERRAE 25 A Btk AT 2hE
. AR RW, JTTESLHRRAT

" (release invalid) K735

O IEEG IR NI S 4BUE, DAPHARERAE AT VIR . RESRINTS @)
KU EHUE

QUL A I, A R TT 2 s AE BatchCC
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BATCH #5#0»

6.5 4l

6.5.6.7 AXREERET K

B AR IVIRIR SRSB4 (In progress). 30 i AH N i 44 ] LLSZE3E— 25 AR &
B BRI BN SRR, RS i Ak A K.

BIbRE X ZEMEIRZSEIRS (B, C A/ kAn CROHAESE) , AR K br.

ARREEREHE X

Elr RE =X

o &= AT Bt A IR

B = kA A RS R AXTTH T IER A BATHON KA
BRALAS R A & e, HAR R AT C
4" (Release revoked) tR#s.

&= KA CHROH R AN DG A= kA, w AT IS0 R
A"(Revoke release) ¥ H 50 HoRE, XFEgRT
AT 2 ik (lan, SEIEARR) .

BS FEMRR A BRI R R TR S, SRR R T BT COR A
75 AR MR K A1 (testing release) R 2.

B = RATTCHL SRR e e, ATk A (Testing
release) IRA&M A& AT A MMM A W
R R, TCRSE A RATTE A (Release
invalid) k7.

CEFTIFIF IR A NS BUE, DIBTIHABIRAE LTI . RESBINATS @)
KU CHBE -
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BATCH 75 0»

6.5 4l

6.5.6.8  {FFSMEREANE R IEAT AR
BOAIE ] DL Tl ZEAMT A i I e i G kT

A IRIX LG B2 A5 B, WS SR “SIMATIC BATCH #ii11-#2"(SIMATIC
BATCH, Plugin Concept). K1, #4425 Wi E SIMATIC BATCH g il ix SL it D)
Je e s o h g o

2T LSS 20 BT SR 1

1.

2
3.
4

9.

75 BATCH %)L L 2 kel i

. 1 SIMATIC BATCH i $53¢ i 4“1 11" (Options) >“i5 & (Settings).

P 345 i ddiF A B (Used plug-in modules) 337 F .

IR R, AN (ADd) $ZELR InAE SIMATIC BATCH s AN R BIME H ok e T

SN BT

7E“fif F I iR (Used plug-in modules) 3830 A 3 35 248 i Ak Ee, 4R I Bt “aff
5E7(OK) HAN AT AN

ER. HEPEVEANSS B (Plug-in details) XGHEF] IT .
ARSI Dy RE, AR5 i i e " (OK) 4Z a3 AT #iA -
ik WAREEAEFIYIRE, B E, s R E R D RE .

BiH
IR FE TSR . HAERHE, FEET T R IE R B A RE B -

L 2 (OK) BEATHAIN -

10. $ U UERC /7 (T 292) 873 Frik AT ik o

B
7

R PRI RE T 3 BT TR B AT, WIEFTIT I IR, X e skl b
PrRid.

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH #5#0»

6.5 4l

6.5.7 iWxEH HE

6.5.7.1 E3RM T H &

77 H & B X

LR RCTT HAE & A Tl i e i s . Hrh O R RO b . T A
B Rkl 243 DR UL .

JREE

7 H S EE AT A A P B R . AR P o rh, AT DO B AT ED
il HA&, el LIRS R

BATCH #iil L A I B 1E P B

1. 1f BatchCC ik sE ElL 7 fo (BIBSS M), KBRS iy 248" (Edit) >*4T B TR
Y"(Print preview). 5, ] DAEE e FE LT B RUAR AT SR R T DTN o

GER. EARERR P ST . Frik BRSOy H BB R K. EHEE O L
Jr Rk, ATLUE R R WA 4R, 4% RUP. ROP. RPH Fl# .

2. Wl AR CER
SR BRI A A AR R (T e
3. T LUE I S iy 4w (Edit) >*+T El”(Print) 45 < 1) F S H0s 11 B RCCRY

HEATEIR TS
FEACAE AR L, o T B AT DL ELRT BV R RN R E R
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BATCH 75 0»

6.5 4l

6.5.8 FHIFA

6.58.1  RH/SAMAETHER

FHIFAYT
ARG T MU B TR T 52 BATCH X5 & AT 3 AL fe
T ELR /AR X 5
o JE
o LR
o AAI
-5
S R DRAE B A N sbx IR SCAH
TR
MV FEIT4a AT LM G D e A, WA RTECE . SIMATIC BATCH filiA 2 i
EE RIS VAN
P BE

TP AR, SRRV AR S s AT, SIS TR RE

SIMATIC BATCH F i, V7.1 SP1
A, 03/2009, ASE02171120-01 299



BATCH #5100
6.5 4l

B FANIFHEF
o i FHISE Hiiy 4 “¥E " (Options) >“F: H{”(Export) 1] )i 5“5 H BI T (Export Assistant)
o i E H iy AL T (Options) >“F N”(Import) 1] J3 5“3 A BT (Import Assistant)
o EAE BTG A 8T R vk
— WATCEAIPSES R (. ER7. 25D
- —AWEATTREE (. TR
A
SR EE ARSI S dndrk, . 20D
T B SR AT PP A5

SIMATIC BATCH Fit, V7.1 SP1
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BATCH 75 0»

6.5 4l

A By 2

1. {f BatchCC i #“¥ET0"(Options) >“5: i "(Export) = i 4.

i T
2. WHE GRS (. ERT. ARKHD .
L

SN SWEAEEGIRNS Adndel, B 2390 o« -2 IrE A
Aty JFFH.

3. %5 HIE PNt 27 (Export selected elements) 44 .
i “SA7 N7 (Save as) X UHHERE R H L .

4. AR MR G SO A BSR4 R

EHBIFIA

“SNBIF"(Import Assistant) 38 & H T8 H - FEpra N R oo didlE . SRR oo Eiois YR
HEPITCSH GESH LT , RESAERERERIG. 2%, RO H bR
FEE ST RE R AR . “S A BT (Import Assistant) 2342448 B R X iHER 5 | 5 ) 4
(=

WEEITH SRR E SRR (7. . A3 5, SARMN A A
BORAE BT 0 A ARE SASCH R ER AT ER .. WERAE AT IT IR AR

PO RERICH S R A IR S, HERAE B R ok X, iFfA— M aFRek

UL R NG P HEER .

FERE A B AERE S, P A B TR T 3 A SR R oo 8l 5 BatchCC FH T T
AR oT CHARE R oD MR AT AT . DRSS BB T R
o T HE IR R LT SIMIER E R B, N AR S B R AR VL RO, A n]

TR

N

I
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6.5 4l

BIELREWT:

302

WERTCVE AT 73 BE B RO BRI TC R, 7T LU S0 AR . (K SR A

L
R EHGH IR D HICR N, ABPEREA A JRAE. AR RS A R R A2
RS R WA EgG IR H o KSR R T AAE 52 5 W C s IR IC 5 G A0 T 34T B IE

XA XN, B DTSN SEI B i, R A, WA
BF"(Import Assistant) 7523k 51H7T A XK NS EE IH A XN SEZ RPNV CR. 2
AU BC T bR b () BOESHATH AL e b5, RO EZE, “SADT SR 6E
58 X LS SR L. R TR AT R A AR L BN T I E XSS, RIS H
PR B8R S 20 R 5 B 55 T 0 TE S B B R TR RN S S AR A I, A AT LA BC S 4L

1. {& BatchCC ik #%3¢ 1.4 4“1 11"(Options) >“F A"(Import).
gEg: S AN % (Import objects from file) XFEHEFT IT .

2. (ECALIEPREL T NSO JEREY AN M sbx" (SRR, AT SO
()76 &7 (Elements contained in export file) ZAAM N N 2. X HA (T .
e AR AR S BoRAE AT GXHRT sbx SCHHIN ) o fESRAbERRE
SNBSS

3. Fd e (OK) MRS Bt LA IEFE -
gl SALEBTFREEES).
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BATCH =)0
6.5 4l

4. A A AESR B B AT A, AR S8 IR R T AE P R BB R IR T R
— B (Next). A REFERGHEMTEAE S, S RALRY) (R )" (Help)
D o
gik: KRB WTHEZRT, H&SREMANE SRS ER. ROk
PR HA W ISR A . WRAE, EHEIERR, REHIEF—

%7 (Next).

B SN2 WA G /4T I AL A = e B S e b SR A A A FR . AR RIRRCAS 1)

Bi 7, WIHER AT h & AL A& S35 78 . IXINy, BRAEE L T 25" (Next) 4415

JFS 7" (Import Recipes) GG HETT 4R SEHEN N —ANSHEHE. XFHEW T, 16598

SE /N T AR BT IR RROAS 5, B T o H R R AR TR Z B T e N HERR
5. SERITAMTEME NG, Hi“og i (Finish) 4224

fE. PrEEERICEY A BREN L.,

i

FrE#EI S cndkl. i ARXEGD ME—FSA R TEBHEE) .

SRS FEA A I T 2.
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6.5 4l

6.5.8.4 SNBFH L HEERFICEE B

B F & SHEREH 1 T RExR

bR RSO EN, THE RSB R, TARSH RS 4K, X5 1D s

(DASEICE

B4 X HE B SRR

TERTEAER 73 BoA 2R b et d,  n] AT TR AE I ORISR B . AR AR AT RS A
[7], %Eﬂé%$¢7ﬁb/{:\tﬂﬂ_‘ D iy ?

REKK B4 ik
SN (Import) 52 A TE o ot i A T

WK T A RAT (R ST AE, I SCIBC S B JUA Ik iy & T
M HERR HA ek AL HE 5 -
(Exclude from Wedn & s BR A IEHE, M ERATAT SRR T IR 20 P B A 44
import)
4 (Rename) SUETEREE T SIEHE B eV a4 IS Ol 1

iR R v S AN RS v 0 o W TR 2 7188
HEAEF IR (Reject | AA7EHGE T SIEHE H O & 58 a4 1 OL T
new name) WIR AN T A FR, W] DS ] i RV R R 44

FRo AHNA IR 4% H KB MBS o
RATSC SUE LRSS T 2IEHE H B &5 i B s 0L F -

Ity A T AT I 4 i

O T | e
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BATCH 75 0»

6.6 L1 ALY

6.6 A= PR

6.6.1 WAERE: U ela/ gt

BatchCC

Start BatchCC

v

Create new production order

v

Create batches for production order

v

Assign formula to each batch

v

Set quantities for the batches

v

Set start mode of the batches

If nec. change formula and
unit allocation

v

Chain yes
batches? v
Specify order of batch

no processing
< |

Release batches

Result:
Control recipe for making
batches is created
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BATCH #5100
6.6 A%

WA £ Ay 2 T DAl 2
AT TR R SR e ATl A SRt A o e AT
VLA SRR IR fE g - Fi e 2R i R AT B 0 73 IS R RF 2 1] o
BEXREE LA I8 T AR FE LU A A
o it HE
o AN/ ERTT
o {EHIMHIT
o JABIEAAE B )
R A RO, AT DL FERE AR AT U

6.6.2 A= 7= ) b P

ALY

7t SIMATIC BATCH ', Ot CIRE: COMERD AR BRITT B e AT & A 3
e . T CRAT I AR = LR A 7 A B ARt A P s il e o A AS TR SR e A i 4%
B Z AN 7= 0] LAIR I A 2R

2 TR T 108 S AL TS PRSI, A= BRI 3, IXE T Tk 0 g sk
SLER™, ‘BRI SOE A R AR R A . W E RS, e R S e s —
FUR BB e 18], 2 1 sh i T e A = S i se e 8l

SIS IRIERR T HoC A 4S040 (Start allocation), U AT AL RERES 5
G A B, R A )R B WSSZ RO IS S — AR, WL OR S AR
H“BEATH(in progress) BY 4 £ (waiting) AR A . SRR FRJE 3h 2 il (Start
allocation), W& LY —Fp s ZfLR DI 2“EAF" (waiting) R, #Hebrgigul, #HAE
Feos— HISAT ISR I A IR

A
U R B R € (I A B 2 AR (AN G I RARBUY ) 5 Bl LR 5tk 2k
BERAE— . T RAMRRIRHE A, AT DSR2 AL TR Sl AT 200U st a2
SERIBAN LA GES P BRI A (0T 320)) -
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BATCH =)0
6.6 #L L Y

6.6.3 FRIHEAE =

6.6.3.1 e AR

]
A U A Bl s A (A BB B/ SREVE . XPRPRE DL H R
VEL M. AH AEEE A P R

HEMAT

it SIMATIC BATCH, f&nl LRIt A 4 g 22N A== (KR RIS, i JE i 7 BJx
FAA AT AT . AR T DGR YR T T

N AE BatchCC Al id fibA: ™ 414847 RIHEREN . F B R T A0 b ™ i
SEMIBE

Create a new production order

v

Specify the properties of the order:
Order name
Total quantity for the order
Earliest start and latest completion

v

Specify properties for each batch:

* Change preset quantity

» Start mode and time (if time-driven)

* Reference to formula (with assigned
master recipe)

» If nec. change formula, unit allocation

» If nec. change processing sequence by
chaining with other batches

A

Check:
Total quantity over all batches
Run time of each individual batch
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BATCH #5#0»

6.6 7L A

HATR

£ BatchCC Oy AT H it A Ml s SOFSEREEHEA ™, AT LRI O 2 e 1k
AR A TN A AR A M P rb,  fnT LLR e e HoA 7 70 e i) 2 A
ARG, r] DU E S AR A A I L EAAT BRI 151 . W AR E R

A VRl { OE (A CYRa (G e 1) = =))W i BUR ¢ %7 A4 ARG ETND G 1= & R ARG AL (S 21 m
6.6.3.2  BIBFHIEF=ITH

7E BatchCC F I ER:
1. HPEIT 0 (Orders) SCIEY
2. P A g (Edit) > 518" (New).
— /M B (General) A1t E P77 (Batches) 355 AT HERE B 4T T

Create order

General | [ Batches I

I ame; Stakus; Scheduled gty Actual ghy: nit of Meazure
I Criler 2 Inew IEI i}

E arliezt ztart for the batches: Latest end far the batches: B atches:

[11115/2002 5:08 =] [1A6/2002 5:08 =] [0

Dezcription;
=
[~
Cancel | Help |
3. fE“H A (General) KEIH R HR i B AT IR LT 2

— PRI L AR

— ATRRTERI A R

— AR ) B R Bl )RR S e 45 R[]

SIMATIC BATCH FJIi}, V7.1 SP1
308
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BATCH 75 0»

6.6 HLAL A
4. WF R B, BHEAED.
FE—ANEIR
WA B 52 A 77 o SR L AR I LA A 2" (OK) A BIBLAE Ay 1EFITREA T
WE
g9, fF BatchCC 1, =17 #4kE N
=

WGAEN e BT, AT LR AR P8I0 20T B RN A ™ K S B S
FWEZH . R A IR A T (0T 314)

AT

H D 2 “fL 2 7= (Batches) £,

RGN E

WEZH: WRAE B AT (0L 310)

W
=

W Er i s T (5 813)

S (T 236)

SIMATIC BATCH F i, V7.1 SP1
A, 03/2009, ASE02171120-01 309



BATCH #5#0»

6.6 #LEHE
6.6.3.3  BHLEFEHEA LT R
7E BatchCC F [ &

1. GUEDHAT B, DI fk AL 77" (Batches) kT~ GIT LK@ PEXTIEHE) o

Create order
General D Eatchesl
Ligt:
Hame Status Mode Start Quantity Product Recipe/For
1| [ Batchi Parameter .. fundefined Operator 111572002 5
Jl | i
D escription fram romw 1:
;I [EaEy | Hew |
LI Automatic . | [elete |
k. | Cancel | Help |

310

2. 3L NPT A A A

— ATRME B (New) #8 GV HTIOHE AR . ARG B 2. A sl iR &
HEETH

— A AR EEE A, R IEEH(Copy), XN Pkt it
ANEHCAEFIRES, ZJa SR B A A #8s BoAT A (1 e ik

- H3h: A3 (Automatic) 14 HLE — P GE I 4R 2 YRRV SR A 0 Oy
%o
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BATCH =)0
6.6 #L L Y

3. MRPETEEL, i R HL I S B (Allocations) 7Y (Product) A RYIIYN
"(Recipe/Formula), SEgo6f oG ERL 7 8 A 2150 B

g0
Select formula
Recipe/Formula Product Formula category: -
Geben Sie Text hier sin S| Geben Si. (5P| Geben Sie Text hier ein o
&hiClean_Filer 1.1 Output1
_§E1Discharge_Truck Y11 Cukputl
&t|Clean_Filker_FSig ¥1.1 Output1
&tClean_Filker_ESig ¥0.3 Oukput1
&lClean_Filker_OR+ESig ¥0.4 Oukput1
_EIﬂReau:SIIIZMix_Test_NSC_Cu:unt_SC Vo.a P_A 1=
ShRears0zMix_Test_MSC ¥0.a P_A
ShIRears0zMix_Test_M5C_Hold ¥i.a P_A
StIRears01Mix_Test_MSC_ZROP_SC Y08 P_A
i Transfer vi.a DUMMY_Output
BtluFer_B-=RY0.a DLIMMY_Ciukput
Bfer_P-=R 0.5 DUMMY_Oukput
atlufer P-»F-=R Y0, 2 DUMMY Cabout ll

23 entries found
Cancel | Help |
4. (EHERHERED, B AXEA XS RSE, B 2R ERT B RHIE A 1
AT Jr Fo A s A Hi ok
5. EFA IR AT, Bk e (OK) F L HEAT AN o
i R n A E R T Bl gs it A: =" (Batches) BRIt LA =

aR:  HAE L (Batches) JEIR R B HEE P R TE RSO R
AL ARD , sEE AL, K5 HIEH(Copy) 44 AL A1 B 2 HE ™,
MR A A B B A

6. 7E“4E"(Quantity) ook i ERLA SR . RN THE R O 4 ik
W B R T /N PRAE, W2 A 2 9 o 1 A R A

7. W, AR (Mode) F1“JE 5))”(Start) 4% oG B B s RS i) .
8. Hhi“ffi 2" (OK) ik T B N A 25

LhHL: RN (General) LR, 7 A BORI A AT A R R I
Bro LA RO AT T i)

O

W5 R AT P (Planned) R
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BATCH #5#0»

6.6 LA LY

H Zh Rt A

e B B AL A
1. PR
2. ¥.ii“ A 3" (Automatic) %4
iR TP A T BT TT B TR AE BE R H 3.
3. FEMLALIEFEA A ERCTT, SRS Bl E " (OK) 42 .

312

LAz r="(Batches) LIk, & n] AT H“ A 3" (Automatic) #2401 A 2l g ik A=,

Minirurn quantity of a bakch:

Mairmurn quantity of a batch:

iR, Rt 477 (Generate batches) FEHE
i~ Parameters
Master recipe: % I silo=bufferr =reactor =kank ¥1.0
Forrnula: I

| 10,0000 kg
| 1000, 0000 kg

—reate batches
Requested quanktity:

mame of the batches:

Start mode of batches:

Planned start time of batches:

|21n|:u:| kg

| batch_0z

IImmediate j

|n?;15rznna 12:27:49 PM (UTC +2:2 = |

Strategy

% Maximum utilization

i Proportional quankities

Calculate batches |

Batches

| Cankiky

batch_02 01 - 21

oK |

Cancel | Help

4. WEAEMPTHAH, KA Rd e (OK) falifiil.

SIMATIC BATCH /i, V7.1 SP1
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BATCH =)0
6.6 #L L Y

it 8 US| O I XS A (RS YR 16 e B ki o S R K PN E G S PSS 6=

6.6.3.4 BAEFEITRR B

£ BatchCC H P E:
1. 1E BatchCC KJ*“iT #1”(Orders) S P 625 71T 5,
2. P Ay A 4R (Edit) >*J& ML (Properties).

i AERAGHERR, W RAE BT RS IR . HAE 7 (Batches) JETH R A H
IR R P A M I E k. “H L (General) 265040 % LU T s 1

AEFEIT R EE
B P A )
B AR nJ LU “HE Ay " (Rename)
A AT
K& TR AR PR &S Hi BatchCC 5.
Mk % e TR R B | AREIE L
S B A HEAE =R AU WoRIT T L | th BatchCC BT
A PR IR A B 2
) FLAT AR R R (VA Hi BatchCC 5
HEA P I L | T AR AE = (R B ) 7 NiEH B
By I () B W 485
S ]
A ZAT A R 1 BatchCC 5

* S RELE BT i e 7 I BEAT S
QR S A R R T AN R R, UK o

SIMATIC BATCH F i, V7.1 SP1
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BATCH #5#0»

6.6 LA LY

6.6.3.5  KftAFIRmME| AT R
BRI I3 A AT BT 2 M T
o QIEUHIA AT RN S0 A S T H (5 310)
o CREHEAE SIS I BIILA A AT L TEIEAE LT 1 B

7 BatchCC H [¥:0 5
1. {EVT 57 (Orders) SCAFJ R AL =T L
2. MEHF LI GRER"(Edit) >“ BT 2" (New).
ZiL. AT KL (Batches) J& YR ITHE R RN HHBL .

Add batch{es) k ] x|
[ Main characteristics |
Lisk:
Mame | Min Quantity Max Product |Recipe,/For
1| [ Charge3 . Parameter .. f 10 100 1000 [ DUMMY_0 L silo =huffe L
4] | i
Description From row 1
ﬂ Copy | e |
;I Autamatic .. | Delete |

arcel | e |

3. ALK A o HO g AT B TR TR D BREEAT R AT

P (UL 236)
RATHLA = (7T 334)
FT LA P I 77 (0T 331)

SIMATIC BATCH /i, V7.1 SP1
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BATCH 75 0»

6.6 L1 ALY

6.6.3.6  fREMAETHEME
fia e A @ AT =TT
o QIEUHIIA AT I E S0 BT S T (5 310)
o CUZEREIT AN LA I S S MR AN B T (0T 314) 4y
o HIPIMARLA IS IE L HIA AT

7f BatchCC T {35
1. £ BatchCC [1)“1] H"(Batch) SCAFJ&HR A2 =T B N IR ik A 7= (Batch) %1 4.
2. PRI “gm4R” (Edit) >*)8 1" (Properties).

GERL. <A PR 44 RR> ()@ PE (Properties of <batch name>) RHEHERGEN L.  7Fi%
XPUEHE, 1 AT L #4E

- WoRIFE L EE RS SOt A e A

— BCEALAE AL B R B

- o IHESUR T RC (0T 317)

- W IHE A NS (0T 319)

— Yol P B AR A BN AT S K (T 319)

— Lol 7 I AT I R] (02 321)
3. AMA BB AT R, JF R E " (OK) H LN o
i MG, RGURT LIRS E 1R SN o0 7 oAb BT A

SIMATIC BATCH F i, V7.1 SP1
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BATCH #Z#)0
6.6 A7)

AR

FERL PXHEHE i AL A = AR R i 3 B (Help) 4l nT A age 2o v 25 A sl
HE_E R SCH S

Properties of 'ChargeT"

SIMATIC BATCH FI, V7.1 SP1
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BATCH =)0
6.6 WA %)

6.6.3.7 BEERAEF= AT 1 8 B

£ BatchCC H PR
1. 7t BatchCC 1“1 §"(Orders) U A =T BN, kB fb A2 =" (Bateh) X%,
2. PSR4 EE" (Edit) >*)& " (Properties).
iR <Hb PR 2 FR> )& M (Properties of <batch name>) X 1 HE Fifi B Hi B1L o

3. " H3hE(Start mode) ALY, EHFF)"(manual). “3ZEI"(immediate) =i B [H]
K3} (time-driven).

4. AN, ARG E A Sl R AT H Y
5. Ll e (OK) EATHAA

RIREM A B

BAER X

(A ] LU S 5 i 242 16" (Control) >*J5 3" (Start) >k i 2l & kA (LA™
DAl — HLYSHINC T R SN B (K oS, AT P it R a0
TSRS | S e g HORe 2 I 1) R 8l A 8 A Sl TR H 39 o

A
FEPTS KA SCAT R B O T R sl O SE R A3k A 2 58 38 S 20 I T] 4z
(A EmIER) mt e~ mEa.
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BATCH #5#0»

6.6 7L A

6.6.3.8 WAL ECIFAEL BN BT ER

BITS BEAEAT I 6]
AT Z), — D FoeH e T A= BB 5 40 B RS Ta) 2k b
Ry HICIM AT BARBC T Tk AR B S S e A AR B e g N R
ANIGIRSE (Re V) S E= PN S INEIE (148 Vgt (&= RE P

DAY, AT LAZEALAE 7 18 M (properties) Ui HE H i 5 B 040 B

i
FIGIN 7 BCIN TR PG THRIGr iofe, T s A . A, XL iem TRl Stk
A P P R S B I 18] 9 AN 58 4 A )

7 BatchCC [P 5&:
1. 1 BatchCC (1“1 #."(Orders) X HIe A= 3R, BEF“fL A =" (Batch) X % .
2. VPSR iR (Edit) >*)& " (Properties).
iU, “<HbEFE 4 FR> 18 P (Properties of <batch name>) X5 HERH R H E
3. &E“4H " (Allocation) 1T
S0 T OR B ) FRC R AR RS

4, WA, PMESCRIC R, “HIT(Unit) SUERAE SR AR EE T B BOE T s AT A R
JCe

5. FifiE”(OK) il B k.

BT AR A B
{45 At T DAL 3 4 i 44" (Planning) >* 2754} 2”(Unit allocation) 47 7F #7641 i 0
( N ii )

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH =)0
6.6 #L L Y

6.6.3.9 ERAXSEIFEVERIEITEN

L /N
FERLAE P IS PEXSIERE S, TR A XS BT I & B 2.
A
TERBES AXSHOREN ] TZAE . i1t BatchCC W TE 454 i T HI 22 Ul i HI 2
Fi, XS HAA S
£ BatchCC H R ER:

1. 1t BatchCC 1] #”(Orders) LRI P ZE T 8R, 1E# it (Batch) X 4.

2. PRI “gmiR” (Edit) >*)8 1" (Properties).
iR “<Hb PR FR> 18 P (Properties of <batch name>) X 1 AE Fifi Bl HY BfL o

3. Pl AR (Input material). “%i i 408L (Output material) 55“2:%¢”(Parameters)
IR
i FARATIE, Horh WO HETT A bR S B R A XS A TTE .

4. RTFE, HEAXSEMME. FUEr T aeiei W B RAE.

5. i (OK) #fih T it

6.6.3.10 B RftAEHHEEE
FERAAE P (RS TEHE S, 7T DUSB st 2R 7 AR AT B 1 5 7 s B0 B 0t B

£ BatchCC I B
1. 7E BatchCC [#1“i] *1."(Orders) SCARIEH A =T 3R, e FE it /=" (Batch) X1 %,
2. kPRI 4R (Edit) >*)B 1" (Properties)..
iR <Hb PR 2 FR> )& P (Properties of <batch name>) X 1 HE Fifi B Hi BHL .
3. MEFEB"(Chaining) M.
EEOL. TR SO AT A PR S AR P R A A
4. R, R
5. Hdi“ffie " (OK) #iiASE .

SIMATIC BATCH F i, V7.1 SP1
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BATCH #5#0»

6.6 7L A

6.6.3.11  HtAF=HRERE

UER B DR AR BN A P S8 R A R 3l I AT LUK © R ER A )
A Bk, B, TR ERTI A, IR E R A C e R s e sE
Jo

7£ BatchCC F IS %:
1. EPEEE AT 2RI (Planning) >“¥% B #L4 7= )i F"(Set batch order).

gE. “UWE LA E T (Set batch order) XHUEHEST F. BT HbAE 7 S AL E SRR
SR () 38 SR AE A

2. AN 3 T B P s ) 9
3. LRI B RS b — AN P i T R e D,
4, FEPREESE A ik PR BE AT IR (K457 (Chain with predecessor) E{“3# f5 4575 I{1%%”(Chain with

successor) 14 .

5. SRJa, LRI A B Ak

BEEAE

o Mt n] LUE T “EE4E" (Chaining) 135K 1 i @ #E"(Properties) it (PREESEHD Kl
HEAE P R E LR R

o JHZhEE: —HETItA - E s, stk A - RIUTARIET

o LUNEE: HG N A st e )n, Bt A T aiE T, Rt A bk
ik, RGS B — AW, WRDES NI .

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH =)0
6.6 #L L Y

CUERE LA P WoRE T 8 U p, A — 40k . W SR Bl A 7 DA S DS
A-“HUIY 5 AT IR B9 #”(Cancel connection to predecessor), %1% 4 # T ki T .

iR

T B B (Rt 2 2 3 SO A B A P T

LA

o [A]IN % CTRL BEAN U5 A7 B ol 48 U 1) 45 ) o

o WEREEFERAHEA ™ LU IREESE Hivin & (10 B "(Display), & T iZatb A (1 a) i<
R AE I B T

AR P A LS AREES L 1 F BT IR (Go to Predecessor) iy, A LLBkH
BN DR B30

6.6.3.12  BorHtAEFERIEFTH )

7t BatchCC H 3B

1. 7E BatchCC [#1“i] *1."(Orders) SCARIEH A =T 3R, e fE it /=" (Batch) X1 %,

2. N ik F4miE" (Edit) >“J8 1" (Properties)..
“<HbAE = A FR> 1 JE 1" (Properties of <batch name>) MG HERERI 4T T
TERC T 92 v 25 T2 P RO $ IC 5 V55 (s AT I 8] s /s 7“2 47 1 18] " (Run time) HE
7
Vi
pe = 3 fa syt {1 Byl N TS D922 B2/ R AR B/ 7 PSR T R TR € SO << 1 | RS e o8 T
Py SEZ o B i) AR 58 A AR ]

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH #5#0»

6.6 7L A

6.6.3.13  HXIH TR

FBIuo B

S SRR O SR O T P A AR R LG I e R R . R S AT SRR R
FEAEMRE, B R A 23 R b AR gt A 7l ok 1) e XU 7 WE I AR v 5%

Tt B

W R “Be K HI PR #7(The longest out of use). “#1F 51k $¢”(Operator selection). “if 2
24" (Process parameters) 7L B RIEFEF TG, WXL IO WoRdE BT I

" (Units) 5%«

AT 1 & s oo (Preferred unit) 70 BCSEIS I, 0 Beh o84 2 AR 78 ok .

E:Svin VT Wi

322

TEPEE iy 2 “BRI"(Planning) >“8.704-BE"(Unit allocation).

FEFE EDCERA, AT RUR S ST N LA ™ o AEZE R KBRS, AR BosAe s — =,
ZARTHR R IT. XRE, AT DME AR R I BT Bl . IR L S
farse AT AEA M 1) 2 1 B shate A, RIVAT I R 2 SR G A A A I TR

%et batch order E

Time range
|7 Select - | frormn: I'IU'I 242002 "I b |11£1 9/2002 'I

.| 2002 Nowv-Dec
2002 w 46
Wied

Thu

Fri Sat

aun

af

= Eﬁ_ Categariel
=142 Ordert
Chargel 1141542002 °
B Charge? 1141522002
Charget 11/15/2002
0 Charge®  11415/2002

Charge2 11415/2002 "

Charned 11 MR/2007 -
1| | »

ok Cancel | _

SIMATIC BATCH /i, V7.1 SP1
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BATCH =)0
6.6 #L L Y

o Rt WAMRIEIC,

o JRAE: ARG NN LA R AT S R s AR R A AR

o WEL: IEATIEMAC TSN A IR AR DUAR TR I RS R . Hrfy
W, AR A BE OR8N LA I IR TR G 3R

o ZLtt: ATPPRMAIC. [ HIngoRIER a2 A A
VL
LA AT CAR (planned) RASIN S R LUK AR BEAL I sRaf kP s i G Tl g
JO .

FERTCH R 7, Bon BT MR s Cox A e it A=, Ik, R
J6"(Units) ~, —AMbAE =T L2 L.

ezl YN
A P e R A g i PR 57 S A5 5 ] AR Bl I TS -
o Jifisk: AR R M ETE S
o Aifik: RIERR R E RS
BEAh, T LAE I o YA 7 Sk T P DR RS 2 I 1) v

ipglip AN ape = S1RS I
AL TR L Cpldn,  — D AT AR (B, BN BEERC (B, R .
FEAE Ctr ¥, TR By AN Sk Z TRV PR DX, ) A N Tl e
o AR BEAR: AN AR
o BB AR BN AAR R

SIMATIC BATCH F i, V7.1 SP1
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BATCH #5100
6.6 A%

6.6.3.14 FEAEN T FEE B R HME

TR QIR A EC 7 AR S I BC T i, D8 S T e Hh T A Y R 1L B 9 0 T 4R L A3

PAR UL 1 A AT A 7 I 2 ] 36 B 1 LG ) PRI PRI 0 o HR IS8 Hh PR AR
A OUIE L TR B ASIE 75 G0 el 2 T E 7 I i B B RSB R TS

& X

[
Be 7 e AR, WETT 20 MR 2 R

Pie. 75 A Rt
B TR EH AL, By i S AR HER SR DL BN BRAE . FEARCT A BEE N B
ABOEZHE R SR HER A A G ARl &l W R B AERUE T BREMEZ N
T RAE R D5 T (025 R8s TR A A ] DA Py BRI PR AR Iy BB T~ B
U IX AT AR GEBRABIC 5 RIS i (€ SCFF o IRl DU AT BESRIEATL T

[ Wip:7
PrfifdJi2b (RUP. ROP. SUB. RPH) #\tu& e i, Widfes . Pl bl ks
ke HERS AR Z N EPH ok EOP DhRgd R /720 75 B R LA N 2. IX L6l
TS HETIRRARGNAL T LR (WA SEIRGIED  IF B WAREEREARCT A
o X TREABOEAE, NG AN B IEA S N R IT, R RE R 5 A8 R AT
P N A IR B CRTBEFR Y B 2R =00

LV

FAICHC A BT TG IRIE SR . RIS R I A AR IE 2 b T Bk % s
(i) sl i PR A 4F CBRABIBIAD 1™ 4.

SIMATIC BATCH Fit, V7.1 SP1
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BATCH 75 0»
6.6 #L L Y

HERITSH

RNy SRGERE TR, WA s (9 TR 5 s ah 2 v S 0 BRI ER 1 i e s
I, AHIARCEE. R RGBT PR BN DURE SR L% H RUP (J2 4%
FoJ7) 2% 8 RPH C([RZRECTT) 1o Bosms hiEatl. PR BUE MAIUE (A R U
JrRREME N, WRATEHIRC T N (AR A, AR S BRI A, T
SIS EAEVOE N7 R L n SRR IR 5 R 7 R, B e s
EAE T RS IR A, W ToiTE Gt B H BRI (A 2

WERIERE T LR, WIAERC S i fas H AL LU R 2 U S R GIE, R BnfE TR
e

o REHIZHUN RAH = (bR A R/BCTT R IRAE) * 280K A

o RIS HISH EIRME = (B A RN ERRME) * S8 ERME

AL/ T B R LRt R B

AP U AR RV RIOE (N s RS2 I s i Al GRRRAE ™ R At HEATRGL A, A T AR 1)
BUE R B LRERGUE I MIMEZ A o AT 23 IR I%E 5122 o N B AN i Fo VA ok
A I n] BE B T PRI T A BARE AR DL, AL, B fRELE A2
DL R, BRIV R AA A 7 I AR PR 8 GERE BRI 5 AEE Iy S 4 T
RGCL SRS B, I H o BEE AIC s FRAE A PR #E %% R ] BE A R 5%
WARAHMT RUP (24T 8L RPH (FI%ICT) M2 AMEILE, WSEE FIRELIZE
iR, XERBMEAL T T RES T A ZHCR IR R, Bl MR BRAEAE 0 TR,
IR ERREA ) B, THIE7R P Bos MEE I EIRA]EbE  a 10 2 SOk
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BATCH #5#0»

6.6 7L A

#LAE

326

QI A I, SchaE R gt S IchrER & (Wl & R IR A TE i
) AP AURATEE I T 2577 FEREATCTT b i B I AIE {8 BEFE A AT I
P, BAAZRAE A AT N A S b e AT AR e (1 SAR TR S AN I, A i ik
SE MRS CZRMEM k) R EAUE M. R IEHINC T T AIHE S EORAZ, WA 2 4
A

HEBUEE ), SMEElDemEn 7T REA T BRI W Rk & 45 R R
AT L PR 0 R T0, WS FE28 5AT 12 HhE U5 3% [ A L A9 U o

FERL B R IVAUE (N, AR A AR IOk B TREMBRBIMEL,  DI2)AE  sh v S iy BR
HIMEL. B TH I BRBIME RS Nl T-BL, i BhIC S B3 8 S AE L™ R A N A
LB BRI

A

AFAE ] e B A 1847 Y TR ) R ABE A B, JCHAESATIRIMRAE N W55
FYM 20 RGAE M TIRIR LSRN OL L I 2R BRI S SO0 il BEA T I AT
W, B LoKCRIRIET .

SIMATIC BATCH /i, V7.1 SP1
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BATCH 75 0»

6.6 7ML
e 1
Be 77 AT AR 25K
BE 75 F5 RR
EEF e 0) REF 1000 FF
IR/ ® LL e 100 FF
BRHE ® HL s 5000 Jt
BTG T A 6B
BT AE T R LLsp 100 0
HEAE PR HLsp 1500 100
BOEH SP 250 50
x
éﬁ Cukput material | @ Parameters | lr Transfer parameter
ﬁl Dependencies | Process kags I ,ﬁ Change log | 9 ESIa
&t General | [ allocations i Product | 4 Input material
Product: Cualiby

I \Waker J | j

Product code;

I \Waker

Reference quantity for quantity scaling: Init of measure

@] 1000 | |

Minimnurn quantity of a batch: Maximurn quantity of a batch:

@| 100 ®| 5000

Description of the product;

=
k4
Cancel | Help | -

%] 6-1 1. WHSH

SIMATIC BATCH F/it, V7.1 SP1
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BATCH ##)H10

6.6 A7 Ak

B, WERAEERE 2N ool [l TR Ty, (HRBCHRA G, NIRRT
i (B A A BRAH (0, 100) O mlids i LRI (100, 1500) 1500, LAREHUEE. A 1
VL], BUEE SRR (ZRE2) .

N AT ek T lC s B SO T A, 2 DU RSos R AR s BRAIAEL, A B 7
W, BUEEAN S H A R A S AUE PRI TR PE A, XS A o5
JrA ke

o JIHEHIZH NI =(1000/100)*0=0

o iHJ5 S LB = (1000 / 5000) * 1500 = 300

6-2 K 2. WoR 2 AL I HUE RINE o H g0

SIMATIC BATCH FI, V7.1 SP1
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BATCH £#)H40
6.6 ALY

Ui UNIT_B R E A 1 IE R0, WK AX NI ReMRME ik, PR =0, LR =100)
MM s 2 PR N RE BRI (S 3D o TR REHER TSk

o IJEINBEL FIR = (1000 /100) * 0 =0
o IS Z%L LR = (1000 / 5000) * 100 = 20

K 6-3 Bl 3 FEMRIEREAE WoRBiE FREIE (BLUNIT_B™h ik o)

WRAUE A T T RIOR P S A BRBIE, RATROT N S A AR, MERUE (A
WUE PR ABMEVE A -

SIMATIC BATCH Fit, V7.1 SP1
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BATCH #5#0»

6.6 HAL7HE

SEA) 2
[y
S = REF & 1000 T
/N LL s 100 F}
BKE HL w; 5000 F+
LI Unit_A
BUEM R LLsp 100 Jf
HE s LR HLsp 1500 Jf
BB SP 250 Jf

1B&E = 1000kg

U & A TR R G 8, SOCTd T e, fERah, B2 BERH B R 250
Kgo LA LA BN, Kok Ao

B4 8 = 5000kg

Uz o BRI G R0 6 4, WUE AR B 250kg 1404 1250kg. BL
AR — e A R F R 1500 Kg, BRIt AR = bl A o

1B&E = 6000kg

WUz A B bR EIR SR 0 6 1, Bt LUBUE (EAEZe U B M\ 250kg 1454 1500kg .
BRI, £74E 4 4> 1500kg [HLE R4 R, i EUE A I B A F) 6000kg. JE L
—OE AR DI REVEE A, (HA SR 1000kg Rk A, T
ARG AR ERLRH RG], EA SRV R AR S5, Rzt E s
BT HAS R AT o

*h it

M A A AT S ST DABHLL R gt A e o A R AT, SR R 2B BRI R
1500 Kg %% 1250 kgo T RENTATEC ;G & AU LA R . SJr i Parillidia
7.

SIMATIC BATCH Fit, V7.1 SP1
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BATCH 75 0»

6.6 L1 ALY

6.6.4 FTFFHEAE F= 33 I

6.6.4.1 FI LA = s B T

BRI A U], Al T DA IR ey R DB ROy a5 A AT R . BRI OO T
CHEE PRI KRS TIN5 i BB L7 @k Jr AT IRAE L R fte A~ 2
FeAii, WANSIEATIRAE.

7£ BatchCC H1#A/ES&K:
1. 7t BatchCC f*“iT #.”(Orders) SCfhJer, TAE/ =17 R EF“ LA =" (Batch) X1 % .
2. P Ay A “F5 )7 (Control) >“4T FF % &Il 5 (Open control recipe).

6.6.4.2 BRI BRE

{ BatchCC 11, AT LT IF Iy Bl B 7 IO A 1 (“RLEP (View) >*FshIRE 37
73" (Overview of control recipe)) . 445 AR hIRL 7, 45 LA ik ot 4 35 o 1
L7 TG B BBy 6 1 I A

Rk R e T VAT LR R

Kl ik

i T TS

9 FEAEBRAE GO T AE

A Wy e s CE GEAEARFE)
] fic ) TG 3 IEAEEAT

(o] W R

A& Hix

Element | TC 77 TG 3 [ 5 4%

i A K& MR RE
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6.6 AL L)
6.6.5 REAE P2 AL EDIR A
6.6.5.1 HAE=FIRE
RE
RUAE PR A G HAE SR AE P 2w A B M5 B (e B = B se s 2 b k2 D .
HUAE PR ASTLER T 45/ R 51 6 S 7s FHgkA T B 8T o
e K& HX
[ SRk FEREA P IR AR A P A Ay e A
ellpe:
] SHERS KA RATHEAE =N, BatchCC i1 BATCH
g4 (A=l RS 2% ) 2 )il
TS
O SR AR e et @It e kA . AEAEREHIN
T o
= W it = I B kAR, e gt~
e, BB E 8.
B S AR OB . TP
RbFE
] IEAE Ay LA =2 a4l PR IEESEAE A shlc Ty
I BT 5 R — AN B AN T AR A 2
& EfEIBAT e Rshek ek e, IEAUTA
BLE
[ IR R B s fiLAE = BRI, MErHUTI B E e
%o
[f SR FE LA PR
B RACeHl oA CNERE R T b k. bR
ELEFRE .
E ek A7 R E T A 1k ANTTREFF VK
2.
] E5E K AR EOE e Ao
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BATCH 75 0»

6.6 #AE ALY

e WA =3

I WA R A T e B TCRAR T, ¥ O A AL
P SOl A R AR
FHZ G, AR TR K A
RAHEA . WA R,
PR LB R A . R A 2k
W, TITE 2K T Bk A TR IR o
A P AR AR SEAT T, LA
B!

B BATTERY

a BEAE R PR 7 R e A B
o PRI IR RTHESR
o HTXA (ESIG)
o Wi

AR TR RER L EAI FPRE Z AN e R

XL bR E B e A B AR L

e RE& X

- Rz HEAE P O 5 B I A P A B

o £ 4] HEF= T 6, AT AT Y .

@ CLIERY HEA P COARY . e T LA 2
=,

F G HEAE 7= (4 I 7 b & 0 — AN T Y
B A, Rl s AR B b T
HORE.

) o HEP= OB, o LLHMTAEE (24T
I EIEAEHEATHD

SIMATIC BATCH FJIf, V7.1 SP1
EeEF M, 03/2009, ASE02171120-01

333



BATCH #5#0»

6.6 7L A

6.6.5.2

7 8

6.6.5.3

S&’:

6.6.5.4

334

BATHLAE

1. LML RO B TR 458 (BatchCC) kit ™
2. P Ay A " (Control) >“ & fii"(Release) .

i BRI TR e WU TR R AT, v WoR I L, TRIAC 75 R
ASORFE TR B A B, WP biie . A= b B FEARE J3 Bl A
AR HrBE I IR 5 A B P e R B e Al 1 AR

4 BatchCC M1l BATCH i 554% (bl ssds) 2 Ial IR A, b2k Haed)
e CHER RAIRAS . BatchCC Fl BATCH g5ty (LA #Hil k45245 Al Rl A5
IEH e, AL RRAT R AT S A AN o

Bt
B Ak CORAT AL P BR B CigdE S dr @ i sis B3 a ), AT LI HBE .

1. fEfAE = RSB TE 454 (BatchCC) e Pt A== .

2. MRk g 1" (Control) >“8f 52 ”(Lock).
e A e D B R,

1 FH 32 ¥ iy 2“4 87 (Control) >“BXH 4l i2”(Cancel lock), ] LU C 43 5 4tk A= 7 58 [0 34

BUE#L A
HEAEFA T ARG Ak 2 e, AR R AT SR Bl

1. AL B AR S E 454 (BatchCC) Hhik#t A=

2. NSk FE 17 (Control) >*“EUiH”(Cancel).
SR e e Bk
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6.7 1 7 EH

6.7 HL 124

6.7.1 BEHFES
RYE FDA 8¢ 21 CFR Part 11 g%k, SIMATIC BATCH X #“H 17254 T fE.

“HLT R A4 T BE SO VR T R H 1 S I U IEHE Jy 3500 52 ) Bateh, Bt 5 B BEEIRES
Fe A5 AR DUE U Batch %1% (BCJ7 . Batch 45) #AEMAN— P4 .
B2 BE DRAF AR E e e, sl AR SCRS Zrp, JFal TR R I VEl (B
) o

FESE AR A OB N AE T “ESIG X HE E SCAT LGN f 128447 DI RE AN 2 4
VEEOIRS . 405 ESIGM AR LT3 47,

Eok
s SIMATIC Logon Service 84Kl & s 8l . Wit /e BATCH &/ Bl 2
SIMATIC Logon Service 1.

] X} R ) R4 ?

o HUAER. POIETT . MITAT. FEITERIE. MWLl R AR A o
o SRR, BN OTRRIT . WTTHRLE . WU DL KRS S A SR A
AT LA ESIG T HE A 56 1 A 0 DR A TR £ AR

SIMATIC BATCH F i, V7.1 SP1
A, 03/2009, ASE02171120-01 335



BATCH #5#0»

6.7 HH 7#EH

7

1. 7 BatchCC ik it A=, TRy sk EAE, IRk a4 “gig " (Edit) >“)8
#£"(Properties).

%,

7E BATCH Py g ash, JEFRCTFL . M7 ocREre . B dE. mdJr B Btk
e, SRIGEFESE A A “4niR" (Edit) >“%t 5 B 1" (Object properties).

o BT ITF<ht % 4 B> JE@ Ik (Properties of <objectname>) % iiHE
2. B ESIG"IELIR (fE Fmpss T, e HTHEAE .

Properties of "Batchb”
0 Generall # Alacations | éﬁ Oukput material I 'i."ﬂ Chaining @ ESla |f Commernts I f Change I-:u;||
V¥ activate
Action Active Time Sequence |All at once Roles -
1 |Madify batch properties 1l 00:00: 00 F v 1] |
2| Comments for betch r 00:00: 00 F v 1] |
3|Cloze batch - 00:00:00 r r o (I
4| &rchive batch 1l 000000 r r 0 I ;I
From To Active Time Sequence | All at once Roles 1=
1 O 000000 r r 0 (B
2 r 00;00:00 r rC a (I
3 O 000000 r r 0 (B
% r 00;00:00 r rC a (I
g r 00:00:00 r rC o e L
B r 00 0000 r r 2 (I
7 r 00: 0000 r r a [ hd
configured roles | Hew |
3 Super user
@2 Operatar
Delete |
el

3. WIE SR (Activate) HILHE .
4. A H A" (New) #4411

gilk:  LAREIRT A LA R DR AT
5. {E“WOE"(Active) FI L FEIEZRE A I HRAE o

SIMATIC BATCH Fit, V7.1 SP1
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6.7 1 7 EH

6. SEACH )" (Time) F1 b R Jo, WA Z0AE T 5 B4 AN 284 FOA B A NI 1) o o R
B 45K, PCS 7 OS B & I# Bon— 44 Bl R .

7. TEWT (sequence) F1 . A B M S AU IR 2 I N2 4 BB i 17 i
e BEEADEREEAES)

8. {EHEALAIL"(All at once) FI Ik FESAT (WIRBMEIE RIMATEEZANEL) , T
(K254 BRI, K ERE A MTIF B LI THE P AT 254

9. Huli“fiifi"(Roles) 71, 4 = f o e LL AN 4
gEgL: I A 7 (Configure roles) X iEHE,
10. TH LA IE R A s

[

L AERERE S, AT R B £ €47 (available roles) £ sh B

47 (configured roles), B2 LAUH A1 - Mt

LI
ﬂ_
1

4

o A FZFEL,  RTLAR S D AU N 2 AN 4 Y .
t”(Configured roles) %13+ (1) FH P i €

G A

1. Bt E"(OK) Hi\ B .

S5 “ESIG"NHEHE ) 41 A4 {67 (Configured roles) 3 el R T b 75 B2 4 M 3
DTN o
2. J IR SO R (R D R T A (56 4 2D RIEE 11 8D o EESIG™XHIRHEMI S —
AR IATIX IS
— LERAEN(From) FWefF N (To) #irbifidy, DLEFZZ A PRSI  wf LU %
FEHT BATCH X4 HPIRAS T 4.

— AR " (New) #2411, W] RUARE S Soasin 58 2 1947
3. SEIRAESHS, e (OK).

ghiil. YN giaiT GitbFE. RPH. ROP. RUP. #:#&) I, “SIMATIC BATCH:
24" (SIMATIC BATCH:Sign) X AR FE RN A B E SRS E R 2 /3. H
KT H N T2 44 1045 B, v S S A T e VE AR S o sk 472544 (7T 339)" 15

Ire
BiH
R4 — HAI, s ReR LA AN ek JEmIER -

SIMATIC BATCH Fjit, V7.1 SP1
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6.7 HH 7#EH

BiEIZEA B TES
O 38 S L 725 42 T S TR 0 BB S0, IR R T BN TR H R . BT 1%
Y, ISR Ly 2 “XE IR (Options) >“#&."(Settings) >“F 1-2544”(Electronic signatures)
IR
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BATCH =)0
6.7 1 7 EH

6.7.2 ST R BRAF AR E S T4

fEXS (A, RF. ROP. RUP. ¥:42) dafrH, fERATHRAAEREE NS, £ H3)
FIFFRHEHESIMATIC BATCH: %544”(SIMATIC BATCH: Sign).

TEFE IR T, AR B ()28 443 SRk LA % % 752 5%, {8 BatchCC R RLE L)
O 5 5oR. W] DR A7 8 B A O SR R SO G iy 2448 447 (Sign) Ok
F I ZAHEHE .

L “SIMATIC BATCH: %:4”(SIMATIC BATCH: Sign) XJifHEFb [#)“%: 4% ”(Sign) #2411,
AP Y . TR 2B CEAS THRINETEA,

Bk
SIMATIC Logon Service HAFSAIE S F A . Hife /& BATCH &) HL bz zede T
SIMATIC Logon Service.

BILERE:
BEAE R R 2 R RS ), “SIMATIC BATCH: 4544” (SIMATIC BATCH:Sign) %
WAE E BT I RN A ORARE, RESTRRERRIEIEITES .

P&

FH 7 60 HIAE“SIMATIC BATCH: %544”(SIMATIC BATCH: Sign) X i HE 1“4
4”(Signatures) # %t

1. Hi%447(Sign) #%40 .

gL KT ITF“SIMATIC kIR % - 2:42”(SIMATIC Logon Service - Signature) X ifi
HE

2. NI A AE, SRR R IE AR KSR SR L
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BATCH #5100
6.7 1 HEH

3. LM E"(OK) HEATHAIN .

gE. B4fE B EORTE% 47 (Signatures) &K H .

— R E AR B (AN AL TR, WA 20 F i e (OK) iy
T 25 44 1A B N B — N T TF“SIMATIC & ik %% - 245447 (SIMATIC Logon
Service - Signature) X} HEF .

— WMRFTFELZ AL BN (Individually) EDUS THETIRES, R AIEEMA S G
A 27 (OK) FHRX IS HIFT IFII“SIMATIC & kil %S - %447 (SIMATIC Logon
Service - Signature) X} iEHE.

TEIXPFESL T, HATEMANITA NS4 G254 558

4. e (OK) LAIIA“SIMATIC %3¢l %% - 2£44”(SIMATIC Logon Service -

Signature) X} iFHE

Ui B

WICAE, EATRET TR I RN 5E 28 44 . AT RIS T RN L TR £E“SIMATIC 5%

A% - %:44”(SIMATIC Logon Service - Signature) i HE (1K) “Isf )" (Times) 2H 74 7 o
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6.7 1 7 EH

6.7.3 SR i N VR

"B B RIUEHE R BRI

2K

B NERRA

P FORAE W PR AE DR E BN T S, IAEIE T LABRRA N R . X R T
R AT H 284 IO ER AT A RN B, KR AT ML 284 41, IRl a4
47(Sign) R UTHE P RERSR P R AR . SRS AT DU R 2 (OK) 4 HL I PR AR

7E BATCH i Hh Lo rp b AT 417 1l 28 fy 2“4 1" (Options) >“1il H ¥ &"(Project
Setting) #1 1 “5i H % &"(Project Setting) XFiHHE, G b 19“H1 25 44" (Electronic
Signatures) I Py 1“4 44 I 5 il i A\ 73 B¢ (Force comment entry when signing) &%
HE

BRI AL A RN E R 284, Wb AP~ E i A A b, A
> WInCC Pzl & o, #£5 AP in M TEAWRN KR @, 1
A Bos TR PRI B @ .

1. 15 BCC TR by -
2. AT ESIG 7 RL 7 BT IF4 447 (Sign) s .
3. WA 0 T AR
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6.8 AL 15

6.8 A=

6.8.1 feA F= b 3 B SR

R
fif]1] SIMATIC BATCH #EATHIL/: ¥l it Z4EH] PCS 7 OS (WinCC) R4, AbHHt /™
HIls A2 2 AR 225K

® PCS70S RGMMHEIBITHA (FE2) T A,

e PCS 7 OS il & #l &5 L/ i SFC KA S BATCH #2115,
o PCS 7 #AF uk 5 ar g Ae iz il &5 (PLC) ZIAJFR) ok S I F I 00T
o PN UM I e A s RIS O E R AR

o RAE G SIMATIC BATCH Al B tb AR ™ P2l R 0 i BURR o
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6.8.2 J25 BATCH %4k %5 58

JB BFAL

6.8 A FE

A g BATCH lids a4 (BATCH #=iillik 454« fitA=r= 5l & # (Batch CDV)) it
HALE, SIMATIC BATCH JFUATMARL . HibAE P 2 i 45 28 Ak A4 P~ % 2 71 (Batch

CDV) <z B3l 3l

FEAE P P IR 25 A AL 7 Hiis i 31 (Batch CDV) BERIAL THER L4 "R

¥ BATCH IR&- B U182 EAEITRE

W] SIMATIC BATCH JTAG A FE -1 BATCH ik 55 4% gl RS BEE b IE

FEIBAT IR o

1. AR S A (1 “BATCH JF4A P27 (BATCH Start Coordinator) X% (£iF

.

2. PRI Ay A E " (Settings), ARG N AT

JR BT

& X

SIMATIC BATCH 7t WinCC )3
Ji H31a 30 (SIMATIC BATCH
starts automatically after WinCC
starts)

RRUCHELL 1) WInGC I, A7 R 5 4 it
PR (Batch CDV) Hi: H B DM I I 7EiE
.

T WInCC 21 a3l #4s H3)
Ji ) SIMATIC BATCH (SIMATIC
BATCH starts automatically
regardless of WinCC)

JEi WinCC &7 falh, SUBHEIHLEE, it et
SR 4% SRR P HOR e B (Batch CDV) #5041 3
DIE AT R -

F31)a 5 SIMATIC BATCH
(SIMATIC BATCH is started

e WInCC 245 )a2h, JUEAEHIRFES H 6y & 3 2
IR TSl R vE SENLIS AP P I g5 s At 2

manually) FEHUE T EE (Batch CDV) st bl S IE A2 IS 47K
B
o PRI R B U

WA IR CEIE R, IR A R 3
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6.8 AL 15

e, Wi LUR sl BATCH & P WL R, 0. i F S i 2 FF 46" (Start)
>“Simatic”>“SIMATIC BATCH">“fit & F=#z | #.0»"(Batch Control Center) i nJ UL 24tk E
IR cti LRI

AAAREFHIATH

st SIMATIC BATCH Fl PCS 7 OS 43 iliz 4T e A s R G P sz PC L, WIFE
SIMATIC BATCH JFia PrAFE O EESC ek, 5 RUR 3 shikmin] H -7 BATCH 45 2%

e  TF3)J)i3) SIMATIC BATCH (SIMATIC BATCH is started manually)

e iz T WIinCC H 3l ) Simatic BATCH (Automatic start of Simatic BATCH
independently of WinCC)

Vi8R
JAEET: )3 WIinCC Jii H3) )5 3) Simatic BATCH (Automatic start of Simatic
BATCH after start of WinCC)

WRCAE ES A NIERILET, W BATCH FFUAVMARETAE S Ua s, Kl
AN, FEWIEUATTH . kI 5 A3 BN T35 3l SIMATIC
BATCH’(SIMATIC BATCH is started manually), X4t PC FA“%%: PCS 7 OS
(WinCC).

[Fl—&vHENLFE R 7825 BATCH k9538 #1 BATCH 7% Sl

TiH

PERE

Wi BATCH JIk45 2% PC i AE Ay #AE TAEw AL TAESE (BATCH &/ HL i, 84
FEPATHLLTNRE (BT BRI AE =0 5% ) I al RE S B IE ft .
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6.8 HHLAE 5
6.8.3 BATCH R 25N P RRE
BATCH R 2 N HETFIRESRF S

BATCH 55 25 N HFE P PR S BoREAE 252 . filan, #4s PC 417, nI LR RITA
BATCH H 5525 LA AR

REHE %X
FEEs|aE] S
o]l TEAE kB

il £ 6 JHIEAE T
HFER W #3EAT
MR Ul EAEEAT
Fabal ) A
| X

o G | VR4

iR
flhn, £ BATCH MR55 s vl#iln), IEAEAREE . WERIEAT Bk 4 4L IR R IR 1.
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6.8 AL 15

6.84 M. WMTEHMEEAE

o] JE S AN FE LA = 2

BatchCC / Batch Overview List

Release batch

Automatic
mode

Batch is started
automatically

no
Open control recipe for ) View of control recipe with buttons
batch (optional) for control
p Visualization of the steps and
Presjti,c?rt]art ¢ transitions witrh setpoint display
i and status displays
Change yes
arameters i
no Change the parameter values in
y the object properties
Op. control yes
of batch i
no Press one of the buttons:
- “Pause”
- “Hold"
- “Resumed”
- “Abort”
ves - “Stop*
Op. control
of step i
no Press one of the buttons:
- “Pause”
- “Hold”
- “Resume step”
- “Complete step”
- “Abort step”
- “Stop step”
- “Reset step”

» Batch is closed

SIMATIC BATCH /i, V7.1 SP1
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BATCH =)0
6.8 AL

R = & B E W T

I (71 363)
JEHEER (51 366)
A (T 402)
HEAE =3 4 (7T 369)
BB A (71 372)
BUEHLAE R (7T 334)
IOHHEAE S (71 334)
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6.8 AL 15

6.8.5 A F= I ZE A

6.8.5.1 LA REHl R

X
A BATATLASEILEL R H xR
AT A
PCS 7 OS 57 T L it 15 4
AP T

FEIPRIE A D & A B AT I BT (9.0, KT IUNIT_BLOCK 2 H B, $irh &
LUK L SIMATIC BATCH g 22 (¥ .02 A LR BOF HLAR M egs g b ™. Wik socss
W HEARI, AT Jashte A, RS A S B LT AL .

HEA: 7= 42 I 8 I HE 5 HSCH RS0 ) OS TR . RS2 I S 40 o, i@ Stk
I FRIOIT it (A

A B AT AL A R A2
£ BatchCC ', AITIF I FHbA ™ M HInc Ty . ZEHIEC Iy FIRBUE 40K BATCH feJs
G s R IUE . UL I, PR AR R B s R, IALas
T Bl R I FAF VR DA T TP
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6.8.5.2

Aab I

A

6.8 A FE

HEAE = AE 2 (5

£ SIMATIC BATCH ', Caib/Er= CIRas: CBlD 3T eI kA iy
BE . BT ORI IR P 42 A A Ry (& AL i o R ) — Spoe A i 24
R0 22 ANt 2R 7 T ) I A BE

2 B O L R R S A0 RPIRAS N, AR R K5 SRR UL B i IR 3R 3l sl
B R RSt A . R E I TR SRS, AR BB E N . — FOX B R 2
eSS IV R N TR R RS SV A= B WS R

ST % I EOT A PR TR 84 i (Start allocation), T HE A ERE S BROC
AR, ARSI AR IO B S e AR, AR R A D) 2 AT
B IEAESEARIRAS . IR AR IE BRI B4 i (Start allocation), W< BBy —Fh e . ik
AP B EAE SRR eE 2, AT BT RS, HAIBUR I A,

AR I AL T R = A O ), T LU .
TR, USR5 78 2 5 E BRI E 2T, R BB e B A
S O 2 BRI (7 320)°)
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6.8 #A 7

6.8.5.3  WHEE LW

J& )

JZ AL T5 S

FEHIC 5 IR T7 S5 MIAE B A TR P LT Ja AR S UAL BE . 52, 58 IRIe T o= Ak
BRI, R R 2D AR

JRHMCTr . AERCT ook (RUP) R, SRANECS 4l (ROP) AR P0AT . W RBC s
FEJ7rHANE RUP ) ROP [A25, 2 JLANEE At (A2 AR RUP A w] LRI S 30
TERC T B, AP (FLTBYBL -> EPHD) Flfdt CPAERESAE) WILMUFHAT .

LS R A RS T YA AT SR R 0 C 5 &5 M B P R RE 5 I AT R T AL .
HIAEZE 8 AR D A A T30 IRAS . A R, BoRBe i BT HABALR
DERAEIS, BT BRARIRESA e N S5k

&3 BATCH: Control Center - Orderl / ChargeT

[Erogram  Edt  Control

|ed2zsnem0e

Scheduling  Options  Yiew  MWindow Heip

".h SN - }€|ﬁﬁﬂ£f

i I n Control recipe:Drde..

k) ROP: Orderl f Charge

i | . K| 2

[ oniine [ wWesder 60
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6.8.5.4  HAEFEHFPRETX
HAEF=FIRES
TEE ARG, A= o] GE A PR FLRZS H
DELETE Not OK RELEASE
T, PREPARING
CREATE RELEASE— | ‘
X
o)
E (Opno,”
g \ CANCEL RELEASE
Y PREPARED
<
<
3 r
ARCHIVED| & CANCEL
% OQ\ ‘ Q(\ ("},J
¢) AQ’\ < 5
s X o
O BLOCKED J¢——_ 5 m
L
7y OC/\'
8
OC/r
—
RELEASED PCell
ARCHIVING ARCHIVE
_|  CHECK Update
- ™ (Option 2) INVALID jNot O — ok
START
RESUME — |
«—— HOLDING HOLD WAITING
j1n]
> T :
I HOLD A,
5 | %o l
x
<
«— PAUSING «—— PAUSE RUNNING
/
RESUME
A
Nt @O /
«—| CLOSING CLOSE ABORTED }«—| ABORTING a
\ (/O\O
céOS@
o N v
(o% STOPPED |+— o - bninG
™ }
B, wr
Ry
N when
o ERROR RESUME~» last step
<O ) com-
- S pleted
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6.8 AL 15

it

HAEFRPREE Y

1. "ERROR”& /A 7E W “WAITING” ) i AT BRI B INFRES o ) 7801 Jist DRV
BRJE, nEH“RESUME gk S ATHEAE =, (EH“ABORT HhEbA= ™, s il H
“STOP 5 144 =

2. AP IAETERF P B I AL T WAITING™ RS

3. "CLOSED”#1“ARCHIVED" & fi Indss, eIk —0 Wos e 2o s & k.

4. “fAEFATRCIEIER R UL N R EPRAS WA R R A T I AT T AT R
1, WEIE T RER TR I AR .

EZER:
A RAS (WL 332)
AP PR (W 383)
B FPIRAS (T 382)
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6.8.5.5  WHEMBEIRTHEAE

SIMATIC BATCH K irii & (EPE, W&MFICE) HT BT .

LLi& EPH 5 EOP.

6.8 A FE

HA ]

LU ORAE T B INFERIIC M, B Belb R At LU N REACRAS, BeolRas Gilb T B4k

HMHE) Ik, TARAA:

Vs ~N

I \
{ RESUMING

~ _ -

v

- ~

A
STOP ABORT

PEYvapTYS

I \
STOPPING

\
\ ABORTING
s

{
\
~

~ o _
STOPPED ARBORTED
RESET

RESUME

HOLD

IDLE - N
(inactive) ~ } START-»( STARTING b not self-terminating
~ //

START

0;0;

N

HOLD

e

READY TO
COMPLETE
(done)

COMPLETE

self-terminating

S

\
{ COMPLETING
~ _7

~
~N

—
-
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6.8 #A 7

WZFURF LT B B BOI EAX 73

FATZ IR BB B
TR BUSAT R, R B DI R g RS -

AT £ L A B B
BRI BUEATIR, BB MBI HE SRR . M R SEORE T, EPE R
WAL RATAE R0 5

TR TR GRS B 3Rz
BlhnAE e, B RGP A2 (00 872), 0T AT s AT iR SR F 4 o

6.8.5.6 HATZ 1 MEE BT 1R BB T B B

BATZ L RIECTT B B AR B AT 4 LRI BC T B B

X BATEAE RS B B, IR O NS RS 2 IE AR T RS B B e IR
N SR T AAT ARG I B R I

. RPH stays
RPH = Recipe phase COMPLETING until
EPH = Equipment phase EPH is reset

RPH V

- Flags cmd

- Status / //

RELEASED

- Allocation |RELEASED

@
2 g
g @
wn —
0] (O] N8
[m)] = o ]
ElL 8] 2 o =B (I 0|
2z 15| £ = DooL|#E (18] uw|2|e
8 S B Bz o Fl2| (2] 2w <
z o = =3
EERH I = ol 2l
= el 7 o o 0
S s
- 5
EPH L
- Flags E/ &
- Status
- Allocation 7
IDLE 7/ COMPLETED IDLE

v

Zeit
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6.8 A1

F BT LEKIE T B
AF BAT LRI BC TS B BEN S RS 22 IEAE IS AT RS U B HER S8 IR, SRR S5 A5 B
SO R NS 2B i % AE TR SE IR S BE T i B e 2O A AT
HoER (AEBATZIEMBECTBO MfE Y. NHE/R THE AAT &R 7 B B i

K.
A
RPH
- Flags
- Status IDLE 7/, COMPLETED

RELEASED

- Allocation |RELEASED

?E
= 2
e g
» 2
0] @) O Al
=) P o )]
w o) zZ e
ElE 8 2 > |3 == -t & | W
< | 5 = @) o e 1] Wi |2
Q|5 @ z < o) P o} =0 <
Slo © Zz L @ o o3 o5 u
- o = =|2 w
=2 a a o o> 4 %
<= e o olg
o o
3 5
EPH =
- Flags Start omplete 2 Reset
- Status
- Allocation IDLE READ OMPLETED IDLE
// >
RPH = Recipe phase EPH stays READY, Time
EPH = Equipment phase until RPH completes it
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6.8 #A 7

HATZ1EME BT 41 HIBCTT ThRE I SEHBI
SERLRR A AATA IR, BNZIiRE A BT, HREREEIRE k. ERE
PR RE ROy PRI, BRI BUA Bl
PR AR BT AR, KRR DL H AR AT, I RERIR 5 "Ready_TC”
(HERSEID o BCT P2 IR 5 LS8 1 i & i R e W il I 5 A
BB BEPE 5 1 R B B AT 7 v e, BEPRas RE L e i 2 G — H
PR AR T 7e i, “MRIE R BI] #-U0UR 3l 0

B Recipel £RUP_1 /ROP_2

bt ROP
Sta-rt I Properties of "F4_Riihren® @
|
n | Lr Transfer parameter || E Description || @ ESIG || lfl Synchronization |
el A $ General | @ Input material || @ Cukput material || @ Parameters |
F2 Dosieren'| | F4_Rihren | |
: l I : LI Phase; Contraol strakegy:
1 B |F4_RE|hren (EPH: i | | <Mone = w |
| " Unit class: Preferred unit:
13’2; I | =all= | | |
= ¢
| ' Fun time: Manitoring time: Run time scaling:
a
I | 0o | [o0 | | Y
5 5
Ez-;ﬂnsieten»l F4_Riihren I = = [¥] Contirue
| : | i Description of the phase:
| Stewerung Ruhrer-MOTOR
| !
End
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6.8 AL
6.8.5.7 ¥R N EBE
FEREETRERSH HHI RIS E R
X T I AU 1 T T RE A B BAA SRR AG AT (0 18 A, I ELE 06 B I i B E
EhRAE
WERAE D BE BB BUG C 0 HEhBUE, BETrBOAE ANBEE, NS5 ISTART HiA.
M2 5N IPARAM #i N\, DL A& B BAAAE BT KB . AR5 e b Bof B e (E,
JFHE IPARAM FAFA S BUE -
BRIV 1 B & i B A SRS, 5 RE R R Sl BiE AR QR SE AT B A . AN 2
SR, AT RGN, BoJT B BN avr B iS4
A
when lock flag exists,only
setpoints are written.
|start notallowedl Start only when lock is reset. [resume not allowed |
RPH
- Flags start_lock
- Status
- Allocation |RELEASED
s
=
& x L|B O
9|5|7 212 z |#| & m FIE > 2
a9 2 5 o T 8 0 2
EPH z|2 @ - x
- IPARAM param <
EPH ) é estime
- Flags 0 2 g Start Hold Start_lo Start
- Status o
- Allocation IDLE HELD
\ R
RPH sets parameter trigger| RPH = Recipe phase Time
when writing new setpoints | EPH = Equipment phase
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6.8 #A 7
6.8.5.8  W&EMIEHIIESEIE
{fH] SIMATIC BATCH i}, nJLA:
FERC 3 R E BRI BUN A RIS HON, o2 B i BOFE LUR BB -
IR EAE Cnpide. MRS, B0 4R FIREA R TR B . XEIRE AR
A~ ROP 453K, WERSBEHES A KM, £ T ROP JHGIN, BHiPkas Ao ws FHRFT T
HEE

NI ORI BIBCE O E SRR AR AAT &R B I BU R A -

VI, BB B R R e RS . BREARSSS, H—AN 7B B R iRt
ICONT #ig A\ iz CONTINUOUS ID, [fiAjeZibie B, e i/ SEprEf e Eail
R, P R ] S O 5 AR R ) 7 A B S FHE 25 SE R, BIVIC 7 gk 2LIB AT
oA £ 3 CONTINUOUS ID,  ff IRV B 4 M BERPIR S TR SN, (HE 28 = ANEL Ty
BB S B, — HS B, CONTINUOUS ID ¥4 & . e ifs —
ANBC T B BER B BB B, 71U A M BORAS B e B b T DU UE A 5 1 A 31

RPH
(continu.)

- Flags

- Status

- Allocation

RPH

(not cont.)
- Flags

- Status

- Allocation

EPH

- Flags

- Status

- Allocation

RPH sets Continuous RPH stays continuous until| (continu-
instead of Complete EPH is started by the next ation)
command RPH l

o

IDLE CONTINUOUS .
RELEASED, RELEASED .
o
1
3
Pl S
[0 c
: : E
o L (1 i
wd | Sl o |84z
== ) Q > S| S S22 -
< 5 z =| o 7 < |RELEASED
o < =1 = [m) S5 5 w0 -
g8 |7 2 R EE
3= 18] 35 xr |55 ol x|
<z |&g| *© “| 3 Z L o
® g < z
5] QO O z
= < 8 Z
e E
@
w

LA A B B |

RPH = Recipe phase
EPH = Equipment phase

v

Time

EPH stays READY
until next RPE starts
again
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(continuation
here)

RPH
(continu.)
,,,,, - Flags
- Status
””” RELEASED - Allocation
RPH
(not cont.)
,,,,, - Flags
COMPLETED - Status
77777 RELEASED - Allocation
: [
@
Q
o
&
) oy
w ke w [@)]
g 0 % P w |25
3 S 1N - Y
> o o @ o (W
(@] @ o @ = |45
< = = > w i
i @ e} o |y
4 o >
[e]
c
L
5 EPH
,,,,, & - Flags
,,,,, ¥ - Status
READY COMPLETED IDLE - Allocation
>
Time
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BATCH #5#0»

6.8 #A 7

SRR L6
Al R NVAZ I 1 Z 2y WD HAT . FE IR X e e, SR DL 1
PAT . WIKIEARZ W NA%A 10 #0s, IF BB VA LR @ B4k 81T 758 iR
WY MR, Bk LU 2 347,
16 ES Az, THEN B BT S B SFC B 110 1 LLF S 4L
ENASTART=1 faVrEHi)H3), Wi SFC {i7ciEaiT
SELFCOMP=0 SFC h<H 4k
TERCTT G b, 200 A% Ak SEIE AT B “ B B 7 B BOSOE  J& 17 (Properties) % 1 E
“HE0”(General) L0 )4k 4" (Continue) HikHE. — HEgREasistT G, HIRE
“Ready_TC” (MERIEM) , ARG B E GRS BT HIEC 7 4R 3T ~—FrBe, A 2T
“IEAESERCHY B o

FERE G LT AT Fr BOE (A, Al DR E R FIBTBE R n] AR 3l

SRR IHDP Propriétés de "F4_Riihren
| 4 L Parametres de transfert | AS Description | €@ Esic | B9 Synchronisation |
| g Général | &l Matizre dentrée | OF Matiredesortie | Db Paramitres |
F2_Desizren L | F4_Rihrzn I Phase : Mode d'opération ;
: a3
| |F4_Ruhren (EPH) w | | <aucun: w |
| — Classe d'unité : Unité privilégige ;
SRS | <kous= | | |
Ws
; Temps d'exécution Temps de surveilance  Modification du temps d'exécution :
| |00 | oo | | ¥
| | 5 5 .
F2_Dosieren [ F4_Rihiren I [V]Reprise
s Description de la phase @
| | Steuerung Rihrer-MOTOR
i
|
Fin |
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BATCH 75 0»

6.8 A FE

6.8.6 B LA =

6.8.6.1  fEAHLAEERIFIR

R AT R

#LAE = MR F R

FEgm4E % )T 57 (Orders) SCHFJEERE— AN 4, AR IEE“HIRI"(Planning) > ... ¢
TR T IS

#LAE= MRIZ R
HAETREIIR
A FHRIIR

HAEP R PR Bos T ETT SR AT BBE RO A . SR T DO I AR R 5
RIRIPS TS Ao RS I, e A e A B sk b o, JF BLA
AOFIRPRZS (B WEAEEAT) o ARiMT,  WEREDHT LA RIS, B2 45 A
A

DR EAEHE A P ) R P A LA, WA A RS SR
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6.8 AL 15

HAEFRFFIR

A HIR YR

362

AP RS TNR G R REAIRE N O RAT . IEEIRTT. B8, IEESER A O BUE k™
DB Bt A 7~ RPRES, RVEETITYIN % CHEERT)  [KI5CISE s *42 )" (Control) 3
BRI

PR R IRy R ey b e Al B = ST 1 e Y EPN TR S ol R RV L A E PO FINPN 7 D
B, G R E I FT AT A&, A T 4 vl R

% [Categoriel /Order1]

Batch Master recipe Skakus Quantity | Mode Skark
il il il il il
E _%1 Char... Hier_mit Loop ¥1.0 stopped 11,000 Operator  11/15/2002 4
_‘%1 Char... Hier_mit Loop ¥1.0 finished 11,000  Operakor  11/15/2002 4,
_%1 Char... Hier_mit Loop 1.0 finished 11,000  Operakor  11/15/2002 4,
gl . mr_Reakkor_Al W1 0 waiking < 11/15/2002 5;
i ®| Char... Hier_mitLoop¥1.0  finished Erink P 115 2002 11
B » char.. Hier_mitloopvl.0  stopped Print presviey "} o11p1spz002 11
%] Char... Hier_mitloop¥1.0  Finished Properties 11/15/2002 4:
B= Stark
B Stop
Il Put on immediate hold
> Cancel
Comment on batch
-.ﬁ; Cpen conkral recipe
1| | 10|

HAF=ERINR D RIA C5Er. Sk, SO iER . ZR R REE
SR A S5 R BIR M ORISR, AT LU SR L, SRR IR EAT.

SIMATIC BATCH FJIf, V7.1 SP1
PeET-F, 03/2009, ASE02171120-01



BATCH 75 0»

6.8 A FE

6.8.6.2 I HIES T

] LIEE IG5 0 o B A B AR P i PR AR . RO AR P ey A
BATCH My g b 81, Prlles Boasizlii )y

BT IRD TR

IR T B 5

1. FESLAE PRSI R BURAR G F g Bt A7
2. ERAEP RIS A BAE4R )" (Control) S ik $E 2 I BL 7 3T

FF*(Control recipe Open) i 4

5L NIRRT AT I, JFLLETE T AW s (5 BATCH BC U7 g ds Hh (140 A
B0 o BatchCC T H 4k orf Ryl A r= b B de4 . SR AE = 3T R
KIS AT I EAS 73 !

£ BatchCC w, & n] LLFTIFHEHIRC TS, 38l DT T IR 7 a5 i e 0. AERUR 2R %
TRIAC 5 A, AT DU e B el 5 S AP PR IE 5 G 3R e B RIISC U5 1 R AR G s

EPESE a2 YL (View) >“¥E IR 75 & ¥ (Overview of control recipe).

il R Sh MRS W DS SRHT I (FE NI R ) o WERARAT AT #2
By, WA whsw CRREER) .
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6.8 AL 15

S

&3 BATCH: Control Center - Auftragl / Charge?
Program Edit  Control Scheduling  Options  Wiew  Window  Help
|l @ a|x|l«=28D W? JrHluurIX|,@ﬁ}ﬁ,@|‘
2| E Control recipe: Orderl Mi=]
Elﬁ Brewhl =
& Libraries
M azter recipes - TR P
g Formulas p— R eak'tO I'_A 1 1
E-igl Orders BYROP: Order1  / Charge? / TRP_1 /... B[] 3
El‘Eu Categoriel . |
=@ Ordert — | 2
: ..... _ﬂ Chargel } [ S——
- %] Charge2 | ' ,,I.I
- [® % Charge3 [ B
...... _.%1 Charged L =3 O
..... -@1 Chargeh I -:._.l-__1 - |
L . P =] CharneF ﬂ . E 1, jr =
i - |
o | m= _j_ |
Batch: |Ch.arge? __j ]
=
Order: [ Crderd : .
Jl@l@lb‘l 9|$|E|ement|Text o
¥ Charga?
X TEP
i Mew,..
X X CIP_A
ol | ©
| oOnline eide

364
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6.8 A=
&% PCS 7 OS (WinCC) LU F 2457 8. o lic /7 #1 7F BatchCC.
] WIinCC A, HRifH BatchCC #4x7E N HFEF & 1 B 4 ui el 7. 2407
FIGHC T AE OS &AL MY E i (o) A
7£ BatchCC  B#hT i HIE

f# i fir 247 17) BatchCC %1545 72 BT T MR 7 K24
M TAT IR S HCh . 1B="X0", X faEfltik ID.
LA

{FH ID 157 F1IF4HIEC /7 bfbatchcex.exe /B="157;0"
ffH 1D 12 FTHF4EHIRC 7. bfbatchcex.exe /B="12;0"

{1 ID 8 FT Tl J7:  bfbatchcex.exe /B="8;0"

{FH ID 1012 T HF#=HIlC 7. bfbatchcex.exe /B="1012;0"
SR )5 kT E (RUP/ROP/RPH/TRANS)

B ZE T I IR T, e IR ] LEH— NI #
(RUP/ROP/RPH/TRANS). IHZ e &40 T 7458 (flin ROP) th, MAi% 145K 8 3)
19, FFHERZIGER. FUICERERE R e 2R R 3 2045 I 7 L TRk
(IR FTED

FAEPEHINC Ty ik fe MO R, W BT YB S IR Y.

AT IR T HAE RS HIR y WIE BT E NS B="X; Y, Y faeftd =tk
ID A“X*HIICE. BRSPS bt R Thk. DRGSR 7E SIMATIC BATCH
AR WInCC B . D3R5 10—y h A #8705 (C-ID) f7 e, 53— th 4
AL G R (T-ID) fa . X AN EELm Ik A A kAN U

KK <<C-ID>>*10000 + <<T-ID>>
KR AH TR RRMILE, Hll: RUP/ROP,

ZamytF T AR R IRER TR, PIEARE S ENR, fill:
RPH/TRANS.
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6.8 AL 15

S

/1D 157 FTIH-4=HIBC T« AEH 1D 2 T9F ROP LI A H ID 4 4T+ RPH:
bfbatchcex.exe /B="157;20004"

{EH 1D 12 $THF#HIRC 7y« (4 H 1D 78 4TJF ROP LL A H ID 203 47 Ff RPH:
bfbatchcex.exe /B="12;780203"

111 1D 8 FTFF4& I 7 A 1D 12 4T9F ROP LU A ID 24 $7JF RPH:
bfbatchcex.exe /B="8;12024"

6.8.6.3 RATHEA =

HAEFHENHERE

FATHEAE I, Bk sy BATCH #L4 426 (BATCH #EHIISS4%) o FEREI Y AR
JELITE o

PR, SUPEECOTRIE GERT2%E) , DERsehsitAd - oE. Doyt

HoE eV R T REIE G I RAERE L ™ R A N A T I A B AR E o IR E

Jois MRS s kbR e AR AT . AERLAE s " (Properties) X 1EHER, ARbrE (H
FERATZ A7, AR EAEEBINC T 5or

6.8.6.4 SR LA R b T

RSt A

366

(A B ELR AR A o ST R DB R B R 2 B R B (et
Bk b B T LTS R Bt e, I EL 5 A 5 S S Bk HA RO AR .« ]
R B R B 3 ML P AR BatchCC TRIREZ. I, ikl T4
1 5 RS BER ORI

i
QAR AN R B A, T A R R B e, WAZAE A VR R
) ORI TR !
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BATCH =)0
6.8 AL

BRI (R
1. FTIFEHIE 7 -
2. it | g ik e (Control) >* i3 Bh7(Start) S dr 4
it HEAEPRIE . PEIRT I I A RS 1 AR AT T AL

&3 BATCH: Control Center - Order3 / Chargel M=l
Program Edit | Conkral Scheduling  Options  Wiew  Window  Help
[f@ e == R [fw = x|2preE
e ——— Lock,
(nlEek Control recipe Mi[=] E3 || B roOP: Order3 / Char... [H[=] E3
El Brewh -
th Cancel TRP
Reaktor_AZ ||,
|
EI EI HI Pt o beld Shter step | ‘.
=N ﬁg 11} Put animmediate: hold
CIP_A
1= Eesume ROP -
M| Stop; 2 |
P Abort | H
{EaEriplete End
Comment an batch
-.E'; Cpen contral recipe
o Orders
[=- {ﬂ Mew Kat
=- El@ Order3
[ =] Charge?
----- M %1 Charge2
[0 _%1 Charge3
[0 %) |Charged
b D Q1 EhargeE
EEI---Ei M aterialz
& INTEG 1| | »]
Starks a batch | Online % Wieide v
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6.8 #A 7
BB BABTT TR R

FEE IR HE PR e s, Pl A, SRR ERFESC R £ R 3 257 (Start Step).
P

FERIRC T RIS e AR N — DR RS BC TR E A s R s, filn, H
ACLA5) RUP I, A fgHzh RUP Fifil ~ 440 1) ROP.

U 2% T LR b R AR G I BC T TG 3R

FEMR S HR R BEAL B — AL 7 G 3R . XA, W R —AMAL 7 #4F (ROP, Recipe
OPeration) 4t F¥#iH R4S, WIHLE ROP ANGELE [F— i3 51 Al 1) RUP N [RIIN JE )
SUE BN A ROP HHAERpAh 4, I BoRaiiRig B

6.8.6.5 B e f B
B 1A B B kAR AR P RRIEEEE B 30 )H 8D, ] LUK B UE .

BAEE BT
1. FEALAE S B A R B TE 471 (BatchCC) ik #EAib k™.
2. P A A )" (Control) >4 2”(Lock).
iR AR R O BE T B IR

A 15 i 2“2 1" (Control) >*EX/H 8 52 "(Cancel lock), 7T LUKE CAE HAtL AL > gk o]
O RATIRES .

6.8.6.6  BUHHtLESS
AP WA LA . AP 2 )5, R R AT SR B .

BESREMT:
1. AEf A= R R B TE 451 (BatchCC) i Bt A==,
2. HEPESE LAy A )" (Control) >“EX 47 (Cancel).

P S

A A B CHOH B IRE
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6.8 A FE

6.8.7 b A= P S TR (38R AF B 42

6.8.7.1 A==l

A Pl ar &, WTRURZ) (R EAE 57 R s o B, gkeimiihal (B 5
YEO R B BTk it A

AR F=ES Rl (A= RBRSE S rh R AL)

el B X
Start Pause Hold Besume Stup Cancel
(Starting (resume (resurme
Batch) ot not-possible)
possible)

L
NHE TP S RERE AR R S

7 & X =N
iR JRBIPEHRIRCT I | %A%, AT DR AR R s R s — A ek
17 AL AE o BAT SLRI” IR SRR I 18] 9 5) 5 3

BRI R B AT IR 30
I R B R et A b, BT R AR
ARIAS, WGk R Szt !

FSRIEEE | BiEEEmorm | DU RS R A s A .
PAT, SEROELEHE | “PREF (Hold) dr AR, by & HRERT 1E45 il 5 4
1T PEHIRAE S T2 BOEIEC T B, w]
PAGRSEHAT ELH 58 o

AR Ay, E BB RS i & A S AR
—ANEERBE)RS T AT .

RYAIEIS S I o Lo O O DR S VA I RS S s R e AL T [ R YR v 2
PAT, ALTEWIE | B 2L, & S A A A 5,
TEHAT D T LA 7 A5 4 G 7 T 2w AL T RS IR T e
BB
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6.8 HHAEH
4 =34 R R
Phi LEVSBINE T (1 11 | 2 A AR HAT LE A P42 P CL 282 45 P A 7
AT R EIIR | G e 7 I B 1, Tt R [T SRS
7o
&k FE A FIRIIE | L A K O TR S IR A e
7o R P A AR S | 4 A I, TR AR
ST A B 7E LA 2 7 o PR £ B
i,
PR, RGP T A B T
ZEHLZE P P b S P2 L Th RS, 5 S IR B e
FRL B LR P AR, DA B 1T T LA £
e
H ik PRI 7 B, | i A 4 TR TG T WS i L 2 72 .
17 L A PR RS L R, B A
ST A B 7 LA A 7 o £ B
R
F A PRI, RGBT
ZEHLZE P b A T R L T RE T, S I T
FEL B LR P AR, DA BT 1T T LA £
A
SERALAE
8L RS T KL S A R 2
I AT P R T T B G, HE7 A B5E ek
PR A i 2o 17 s 1
T AS FEHzat R A e

370

Z: L0 AS BEFEI kA (5T 392)"HE )
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6.8 A1

Ptk A A 2R Y SE 1

&3 BATCH: Control Center - Orderl / ChargeT - [Of x] I
|el@ e+« 28D /RE||[rnnrs X ppre b
-:]'ﬂl n Control recipe;Dide.. K I
4] Lisanes .
-] Master recipes
+ ﬂ Fomrmulas 4
B-a) I_:Iu:lm ¥
=) Categoriel I*
e (.
% Chargel > 2 i -
‘3 Chaige2 -
Chaige3
e el
B * Chages .
e | |
Charge?
@ Ordes2 sl s
=4 New Kat |
=% Orderd |
D s Chage1 L] |
D o) Chaige2 i
D J Chaige3 = sE
D) o Chaged
) D) ol Chaiges e,
# -] Material: wail |
L,
~ ® InTEG ] 1| | . = 4
[ Onlne [§7 Weider el
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BATCH #5100
6.8 A/ 157

6.8.7.2 B PR EE R4
TP B, ST DU e Akl p I 2 s BIRL J  i FTAT B J FR e 3 (RUP
ROP. NOP. RPH). BtA/MNERfEH“SE b " MBI w4 XM 4, EWnl bl
sr R A —1 0.

EHIEA BT LRI RS

FER IR T I PTRI TRt % (RUPL ROP. RPH. # ) , JRAECI R hiE
FTH 2. JCHR AP PR A& W K, B LACVE I -

Qpen object
W= Stark step - starting-the step
® | Fause step (after step) 4—+— Pause
Il Pause step (immediake) - Hald
I1» Resume step - Hesuming step
Complete skep - Complete-step-at-any rate
W Stop step - otop-step-Resume-not-possible
% abort step -4 Abort-step,-Resume not-possible
Reset step - Reset-step, revoke-allocated-designation

Breakpoint k

Comment on bakch element ...

Comment on messages. ..

@Sign...

Select unit ..

Object properties Alt+Return
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7=HIZ

NERAE T AL T REANC 5 BRI N o

6.8 A FE

FRERSICE T [ dr < & 3 =N
JA3h (Start step) FEZA R ARG | AT R T2 & S0 R SR s 2 258
JiRAT Jsb (RUP. ROP. EPH. #

%)

RiFP EPERZE)

FEZAD B P il

] LU 2 3R )5 B 15" (Pause after

(Hold step (after step)) JIIHAT, METE | step) M s LGRS (RUP.
WL EHPATH |SUB. ROP) . S a4 ML,
SE o RN A Ine il | WA R G vl Uy Vsl
—o TR IEC T B BN 4
1k, T AR AR SERAT 2 5 A
FEVEAL R — AR R 2 [ — 20 iR
—/NiE AP (RUP. SUB. ROP)
W, AR S — HAEAE, HRER
“PREPAT A
SLEMRFFS (Hold step TEAZAE B HIAC | ST DA “ORHE i 2 S B BB 1)
immediately) Hi#AT, A%&5e | (RUP. SUB. ROP. RPH. #
BOURTBGEIE . | B o R T T S R T Y
B,
L0475 (Resume RN B | “GREEHAT " i & ] AR SE AT B2 5
step) S ATERNC T . | 2P (RUP. SUB. ROP) . 4ifid
PR TR BB, WX L By 2k 1] )
BEXRRE /NP
=
Ab TR GERZS 20 0] LA F gk AT
A A E TG .
s2/lib (Complete step) | 58 /b (AT o %A A AT LA R AAT 2RI D

(RUP. SUB. ROP. RPH) [JHCTs
BB BURE EA AL T RS .
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6.8 AL 15

374

REEE B S X 5304
%135 (Stop step) FEZDAF IR I | A 5 12D i AT LA R TGV IE ff 5E
J7 AT 2> (RUP. SUB. ROP. RPH,
R .
Cst B Tk el L kb, 4k
REAEATIHE R B AE DA ) T
Hik3E (Abort step) EZS by Ee [ EH RS A L& L L IR 5
Ji IRAT - Hf2E (RUP, SUB. ROP. RPH,
) .
ke kbR,
B B AT D O B AR b SRS 1) T
i
B4 (Reset step) BALE AT tbgE, A IH S 2 B R e
AR AP SHUHA (RUP,
SUB. ROP. RPH) H fiTfi it J7 B B 1)
43 1D,
BN R W Wr sl LR HIAC | BEZAHOME R, v S5 i A W
(Set/remove breakpoint) | 77c#E 55, FFH | (W 381)"#4).
WIR ML R
A= TR . KA
(Comment batch ININFERE . nIAERE
element ...) AP IEATZ T
)R e AT g
k.
4 EIEE... (Comment FTFF— AN HE LA
message ...) LA SO o 11 2 S 1
HIFRIAENEE (R
o E . R R
R R
R
%4 ... (Sign ... ZIhRe T IS
IHHE“SIMATIC
BATCH: %%
#7(SIMATIC
BATCH: Sign) LA
LTINS
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6.8 H A= F

REER B H S aXx RN
B TT... (Select FTIF—AAr eIl
unit ...) gt = IR T ip )

THHE. %IRRT

MTedsET om

e
X% @ (Object TP % )8
properties) ”(Object

properties) X} i
HE, w] N SREA
RPITIEX G145 1S
AT i
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6.8 HLAF
5P
5 S 77 20 TR B L 5]
&3 BATCH: Control Center - Order1  Charge7
Program Edit Contral Scheduling  Options  Wiew  Window Help
|lelgla|= 28082 [»unreX 2p 80 &
i derl / Charge
EE Brewhl
Libraries
i aster recipes
FH-&| Formulas
= o Orders
L——_I{ﬂ Categoriel
B35 Ordert
%] Chargel z
_%1 Charge2
= ﬂ Charge3 ) |
. -%1 Charged Open objeck Lot == 00 L L
.ﬂ g:argeg Stark stem
:% Eh::gZ? Put skep on hold (after step) wait
-@ Order? Put step on hold {immediate) e }
EI{ﬂ Mew Kat Hesume steq |
EIEI@ Order3 Eimish step =
e E &% Chargel Stop step i
| Charge2
| Abort st
[ &) Charge3 SHEE SR CIP_A
= B _.ﬂ Charged HESEEStEn e iz ||,
D -ﬂ Charge5 Breakpaink
[EI---[EI b aterialz —Ii
Comment on batch element ... ——
Comment on messages.. .
Cbject properties AlE+Return
1= -
B INTEG | a | H|= | M
| online % weide [ez | 2
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6.8.7.3

A

6.8 A FE

O NIBAT LA TR

P BT R s JE, A RENERIBC T 6% (RUPL SUB. ROP. RPH)
SO BN PRI bl S ANTERE, TR A (i e e (i o e A
R

Xt AR AR P AR AN 2 B S B S 1 P TR

AT RA 4 Ly T0E BN A N 2R, Bl TR R R S IR
FEB SCA AR SS 12, SERTAIBC R s KB IR s o

fon] LU AN AT RIS AT Pt AL RS, LRSI A Ok A

BT IRD TR

1. 3R P E - ey CAERARITIP .
2. GEFRFEHINC T U BRI (FERIE T S R

3. TE RIS Hrp ik £y 2 “HEAE F=1E B (Comment Batch) o “HitA4= =70 & RE”"(Comment
Batch Element).

4. FEXSIEHEHHA DT (R SCA, AR5 Rl " (OK) S AT R ATE .
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6.8 AL 15

6.8.7.4  EIEITHIE BRI IEHE

A B AT AR "I SR o3, T LAERE AR s AT 18] s g 484 B -4 s 25 T30
THE R (BT EakED

R
FEQUEE R T WIS T AE R4, BRAE IR CHRA R | (T 487)#87y irid «
FEHIRC )y 24T T

I

AT IR AR R 2 WoRE T A OSBRI $TJF T HIRC 7 1 BatchCC . ey Ho
BatchCC ', Ry A& L or.  #4F R o N A" (Apply) $E A ERAE B 454
[PAF55 GRS 5 NBUE £ BatchCC X EHES)

B A AN ki e /MK (Minimize) 57456 1”(Close) #:4F T8 2RSS IXkE ] i
BARPRAE DO UEHET 2%, BT H Tl R

B RPATERE IR 2 5, bhln, BN TP BRI R, e 53 e i A H A FH A
5E7(OK) BEATHAIN LA 4P AT.  — BB X R 7 AR GO IEHE,  BRA4E Bt
THHES AT A B E i . R T DATEERAE DO T AE 1) % A 5UR (Input
material). “%i ! J50EF (Output material) 1“2 %5”(Parameters) &3 ddm A (W HFED
B, DO ERE A& N GRS BATHEAE P B4 E . AERI AR DO T AT AR, AT L
FE RV A Al 285 N 1 SEBrAE

7E WinCC # &/R

7E WIinCC ™, o fffl G fersirn me B8R AT DA T30 DRI AT D3 2R A SC P TRl NC s
Mt N B RESR B RAL B
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BE R B2 X

B VRN SE PR B R T AFERR AT DORHRAE i A F Iy vh b A7 o3 5

6.8 A FE

Parameter 1
== 4711

Operator dialog |

— ———

Parameter 1
== 4712

Parameter 1
== 4714
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6.8 AL 15

6.8.7.5

TARREE

B
Gt
El

380

7E WIinCC T 41 B B4R RRoR

7E WIinCC i 21 B SR e THEAE P2 A BEAGERAE BT SR . ARG A R T 4T T
BatchCC 347 At 5 3

T SR A A S s A
A RAE SO0

N T4 (ESIG)
TN

1. BATCH il i 55 5 1R 52 A2 A7 i ZEAA AR DO TR R Bl A, B ff e o o v 2 P 2%
o

2. BATCH 2l e g5 s 4k 2 o ulic 77 pridd e, IF s — M A E IUNIT_BLOCK
Pl A A ARSI WIinCC R GIEACIRES)

3. 7 WIinCC K 5, #4415~ H %% Unitname. EventState, Ll REAE Bi3E R,
4. FEAE BT LS AR R R IUNIT_BLOCK Hiti, FT7F BatchCC - REU i dah 1k

5. #RJ5 BATCH il R4 28 47 IUNIT_BLOCK [¥ififii N, i S A B A R GRHY
K& .

TiBA

B IURL )5 B T 4 AT

5 XA 2 s KRR R e 7 HHIRE) SIMATIC BATCH #:4F 51427

X mPRC T, RA SR IS T BAE IR AN, A RR A FEAE e 4 —il
Mo

A TR T R TTRE A R, T RLSIRA SR 0T R AT, BRh
TCor PR B B BN (2D

1 WIinCC s, 275551 IUNIT_BLOCK ¢ (Unithame.EventState 48 &) Hi%
(IR N

VER—ISEBR i, AE 75 IUNIT_BLOCK [ () 5o Ju 4 o 3 447 — %A
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6.8 A FE

6.8.7.6 BB W A

BIESBRWT:

FESLAE P P BIYIE], R4 O3 AT DAAEFT T A2 ey vh o R ey o st B B el W
R RTEES I T 6 R 55, I H R L0 A R I 7 $AT 2 AT W7 ST oo
R, SR CEBA ST . RawtEisfrbad, JFHB e iz e . 15
Jioe R AT LA bR 3, JF BAERINC T k8 AT .t nT LU R 20 3R s fin 2
TR

1. $TTFIEAT A = I HICTT CIARARAT I
2. P AMEBIE T TE .
3. TERISE H rp e $ v 2-“WT )1”(Breakpoint) >“i &"(Set).

W A R ARG T e e, I H R N AL Af BT A" (Breakpoint) >
B"(Remove) S 4, Al DL BRI A

Ve MMBREGE IR CRAas U SIEHD N, AN RS TR < B3R 3.
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6.8 #A 7

6.8.7.7 ERARE

Bid

382

R R UL IRES:
IDLE IDLE
(inactive) (inactive)

Without operator action ~ With conditions

— =

RUNNING HELD STOPPED ABORTED
(running) (running) (stopped) (aborted)
Transition Transition does not
checking your analyze
conditions conditions
READY COMPLETING COMPLETED
(ready to complete) (completing) (completed)

Transition is fulfilled and Transition completed
allocated to successor Predecessor step

step

i
fas ] LU 5 5 iy 2 “XE IR (Options) >“# & "(Settings) 5 iiuZi(h,
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6.8 A FE

6.8.7.8  HAFSRRE
AL PR T W R I A5 B
o ITHUR A BN N (Blhn, SR EAMHK R IT, WA B
o WHRMBIA R (I, RBOE. IEAEMVET. 2EEE. 25RO
o FINAVERAE, fltnEEvE . KRS, OBUE. HAERIER
A0 RS B i H A B -

HEAE 72 35 RS B R
TEAEPTFRA R IR A B
o SNt

Rk

I R A bR Y

Error,
hand,
runtime exceeded

Allocation status
Present command,

Idle status breakpoint

Deadlocks

¢ Operator prompts

Group display for subordinate objects:
Blockages, delays, operations
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6.8 AL 15

S 7 BOR & s

Sr BRSNS T2 PR,

557 kRic (FOCUS) — i i

bl o | ™ @ | @

ABLAUFMARKE (FOCUS)

TEILANLAGE_BELEGUNG X 0 1 0 0 0 0 0
TEILANLAGE_BELEGT X 0 0 1 0 0 1 1
EPE_BELEGUNG X 0 0 0 1 0 1 0
EPE_BELEGT X 0 0 0 0 1 0 1
BB 2% |£% |RUP |RUP [RPH |RPH |- -

I BB 28 |£% |RPH [RPH |- - RPH |RPH

S HC LM B % E R ILR (EPE) FERAAR KA D

Syl el EPE MHFRIC AR S, 7EZACT . RUP $E I BAz i 70
fc, DAK EPE MI7)Mc. AE F-Rer b, IX IS b1 B Bk 20 e -

B R HETT #7id
| RUP - | RUP
BOHE BOHE ‘ ‘
gl Ve a
) 1 RPH RPH
ROP ROP ‘

RUP # & A UNIT

384

..  RPH# &AM EPH
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FA R 75 173

RPH

6.8 A FE

RPH @ ren

RPH # & B/ UNIT 5_ RPH #% 5 A/ EPH
SEREN BF — BRI
SR &R X
L | ROP S 2T PSR4 RUP BT 207G
Mixer
- [RUP HIE DAL PSR E 2 L S T RUP
Mixer
» | rop ROP IE/EIZ1T P L4 9)i ROP
|
! S5 I B PSS RPH T 10 1 % I B
~ RPH
|
| A I B LAV I D2 4 RPH
“  RPH
|
3 | ST ST e
RPH
|
> ' B/l AS-OS b OS ¥AT 5| AS [fi%E 1
- RPH
|
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6.8 AL 15

D BRI B — WFETT

386

40 2K X
! S ¥ T PSR B RPH T [ 870
e RPH
|
! WG EAMA P D 2L RPH 7 10 27T
¥  RPH
|
° | WL DRI | A RPH B a5 A I B
RPH B
|
o o OB AMBE S | %R DA RPH
RPH il
|
L | N 3 B S o
RPH
|
' b AS-0S s OS ¥4 AS [
? RFH
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6.8 A1

HY
3
b
@t
Em
S|

A28 (R PR b IR e B 7 T G B IR T 5 3R s o WERAT 5 RAFEIA,
MR Bl RS o

|
¢ Heat
|

UNDEFINED _IDLE
(undefined) (inactive)

5

11>
STARTING RUNNING RESUMING
(starting) (running) (resuming)
Heat Heat Heat Heat
0 1 il ]
HOLDING HELD PAUSING PAUSED
(holding) (held) (pause after step) (paused after
step)
O ¢ O ¢ X X
STOPPING STOPPED ABORTING ABORTED
(stopping) (stopped) (aborting) (aborted)
| )
CONTINUOUS READY COMPLETING COMPLETED
(continue) (ready to complete) (completing) (completed)
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6.8 AL 15

MRS ID — W S f a4

Wil LR B R s . FESGE P I, BRI REDRE W7 s e A B 42 AR o W i B4 DA 42l
K455 5 T RAL KR S bR

ARt & W o S ERAE DA SIS

PEARZSAR IR — BiE

2 BATCH %/ HUS T IEAEREAT AR 2 0 S e A E R DUOR A R A T oA, B ES
BiE. £ PLC PR BIUE bric5 S, WRERNPE. WERBE THABUE, R

NEBE (% eEBE, ERBUE .
Heat Heat
© | ® |
Write lock Start lock
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6.8 A FE

B BPR AR R — BRAER RS
£ BCC &t = it A vh B AT 4 D38 s — M T B S A kL 5

= Eﬁ, Orders
=y Cat A
= @

i} i Bakch

(=8

Xk AR ST T FERINC s o AEFEHINC ) J0 R A 22 B R i 0 =R AE D3R

Heat Heat
| /] Q.
Electronic gignature Unit allocation required ~ Acknowledge operator
Required dialog required

WERAERA P IR 7 03 b s L3 DA SRoR I bz —, k2B R vh Wk A L 2284
ABIER ML AR B IRSEPATHEA ™ o A B A N AP R RC 75 T FOFAE PR EESE
ARG A 2

o TEHTEL>ZKL..
o HHIAIRAE A URHE > FTIT“% % &8 1 (Object properties) X% HE LSS T I F 0l 5 2
o HEHILA > EFEHIC...
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6.8 #A 7

FEOIEPRESIRRRE — WERERF, SRS MSREEE

YRR R IEFESERs WA 2D . Sifl:  IEAESSAF5ET SIMATIC BATCH AS (1%
WEHE 2D

[P 2 R IEAESE AR ANER R AP 28 (fan, 1l APL A MES $UT)

CHAT S AR D B A s i 45 S54RI

NEEF SRS SREEE

FYINEPRESIR /AT — BN R HAER

WENEMAEL (BT RT0. BT BRIEET 1D I DO R . RS
AIPRERR T N D . A TR TR Ol 7 3AT, FAELC R RSP A

WoR:
Sub-object has fault Sub-object blocked Sub-object waiting Sub-object requires operator
action

B gsib, Pk REFECED BIREER, BT, TR EEER AN
Ao RTERAE ROMAEAE . FRICIERE. H AR AL BAE BCE I RN, T B E AR T A
NEATERA DN
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6.8 A FE

EERFn] DU LA ISk Bon (B + T3 .

Heat @t ><
| |

Error Manual mode Runtime exceeded Deactivated

Pi B

AIREATRAL, R LR LA

o WIRGN R DAFAE AN R BAHATHRE, EEgOI R i RE RS ER A
“BEAT

o WA N I TCHEL T AT RS, WIS se P s PRSI S S gl . R
A BRI R RS A TR EFIRE

o WIRALTT TCR E SO BRI IR SRS A B s g0 . A i
FEHESRE R, WA SRR R AL P ] A A

fas ] LU FH 5 5 iy 2“3 IR (Options) >“# &”(Settings) 51 izt
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)

6.8 HA 7 15
6.8.7.9 TG AS FEER bk

5 AS ERETHIE, nTRMER IR CBSD "(Abort (Emergency)) w4 EREAE A,

&3 SIMATIC BATCH: Control Center - [Control recipe: Auftragl / test_07 1 [running] ]
E] Program Edit Control Planning  Options  Wiew  indow  Help

=18] x|

JJ.--u e X|[QQ® |

9 & ad F & BEMNT
2l --
EI—@ Production =
Libraries
Masker recipes
-k Formulas
-y Orders
EMEQ Lesk
-G Auftragl
----- ¥ best 051
----- %] Test 061
..... . |= W .
..... . tesk Brint
_____ E I - Prink presview
..... B %] kest Properties
‘I ..... BB et B Stop
L —— M| Pause after step
B se_rmp Il Pause immediately

Batch: |test_07 1
Crder: RUFtragl Comment on batch
2% Open control recipe

> abort

Bbort (emergency)

Diose_to__container

|1IZI

P A =] @] B fler

Refresh entry

4 tesh=
x Buffer
® wferCut
x reactor r
4| b
392

i (%2 “(Abort (Emergency)) fir 4, s LN HE):

——r| =

— Zoom bar

|
L

]

a7 %
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6.8 A FE

‘ol (%% "(Abort (Emergency)) i F4E A 8

AT A Gk, % dr A RESE I A o Vg BN RS S
ORI BATEHHAL RS A1 0t 1A 2 A (1 B AR KR o
WERAEAFFER] AS BRI PIE CRBD @4, Mk 5 ER K ik i 4/
AR . HApiidl, SCH ekl AS BRI S RGN, oA A5k -
VI R SN R /N

PItt, FEAFAE AS JERIN, AREORIEIAT by e S PRI SEBL P 1B #R AT
WIRAEBA E] AS MBI APIE CBRD @S, MITCRPRREWAT, LB RS
AP e geb b Pl Z T34 AS hINHUE B IR ok . B
FRREESL, FEHEH SIMATIC BATCH B i 75 B HL AT = A

I R el PN P A DA o = W 1] L A DR Rty O A S Tk (1 e SO G LR R
Jo AS ERER, HLPHAE T oG D B ] Be il 2T 3h S AT

SIMATIC BATCH: Control Center |

Attention! Thiz command abarts the batch, even if there iz no AS cohnection.
The interface blocks of the occupied unitz may have to be releazed manually.

Do you really want to abort the batch?

SIMATIC BATCH API AEfta Ik (B2 .

BatchCC %1k 1" BATCH &' Hl5 AS Z a2 AAEIERE IR R . B
BATCH % /" Hl 5 AS ZIIFER SIS IL T, shar a4 .
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6.8 #AL 7 1EH)

6.8.7.10 )8 CPU JHIRtAEr=#4E, SFC KH!

i F SFC KMHE4T CPU )3 J5 b4 =14k

CPU {5 11 JF b5 55 2 S BUEAEBAT LA™ A i rh Wttt = . kel IO ek
ik, TR

7t SIMATIC BATCH i, fAEMRAfER4Las. NI4T AE(EH] SFC RALIN X120 3%

A SFC KA HIAT A
{i BCC P libanit £/ diir i, SR RAUR S FaEME. FS LA BoR
b E] CPU k. € BATCH RABA_STATE P il BIT31 (=441 . X4
TE%IE T AT RE LT3 H3) T SFC, JFEILE A T BATCH JRZ&“BA-STATE”
CHIAE 31D, AW RET-2h 4k S mUGH AL

B ROP: Order1 / Batch4 / RUP_1 / ROP_2

ROP on Unit_05_FKT

1

’
11
4| | i
|Stakus: running + Errar G A
6-4 HEAE PR
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6.8 A FE

CPU )3 2 JG I8 24T M th SFC Szl v (R AN B 48 e B «
o Witk SFC
o {i¥F SFC IRA&

Properties SFC type E |

General A4S Operating Parameters | Optians | Version |

— Defaultz
Step contral mode: O perating mode:
: a0 ]
¥ Command output SFC startup after CPU restart
% |nitislize SFC

[ Cyclic execution

[ Time monitaring " Retain SFC state

— Start optionz

[ Autostart

[ Usze default operating parameters when SEC chart starts

Cancel Help

& 6-5 WA T HIiRE SFC W
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6.8 #A 7

CPU EJi /5 SFC EalEH: “Vithit SFC”
H%: CPU C&fFik, I H SFC [EahiT b ik & A “YIihik SFC(Initialise SFC). SFC

396

R TR e P S T

SR {ECPU )i, SFCHATHIMAML, RIHRMARAAL T s IRZs (IDLE) Jf HA)

A PTATID o IR A — AUTO B MANUAL .

FEEE AN, Al A sl & e TFa il a3 i<, sAE A"

M BATCH k& A8l 4.

#E OS Ptk SFC WALAL: WiltAT FahEAE 2 N A s BB F ol Bisl. R

APAT R B DiRE . SFC R ikiztT.

@WINEE—SERHERI::PEEII,.-"HI'A_FUHICTIDNl,.-"TemperaI:urREgler : Idle CONTROL... E3

ﬂl Faceplate | v Update Sequencer pﬂmﬁesl Etmml

START
1_Step Step Temp_..
(B Bd -
A[ATETRI], CONTROL ON ACGNTRGL OFF/
| lide o [ [ 7

L AUTD | |

M AI Huold _ﬁ Resuns
BUTO | _I Abort |¥ Complets g Stop I_
@ |85 Festan LA Flezel

mrrm Ll

I Time M

me Manitaing

|Skeuerung ?a_mpREGLER

| 6-6 Ji5)) SFC

23 BATCH HAEF=: )T A TTAE TR AF 5 e o I 4Rk . G ifse 1k rp T ik

e I FIAELLE I R RS AT HEAE
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CPU EJ)5/5 SFC BaifEM: “fRfF SFC RE”

6.8 A FE

Properties SFC type E |

General AS Operating Parameters | Options | Version |

— Defaultz

Step control mode: Operating mode;

v Command output
[ Cyclic execution

[ Time moritaring

[T | AUTO |

SFC startup after CPU restart
" Initislize SFC

— Start aptionz

[ Autostar

™ Use default operating parameters when SEC chart starts

Cancel |

Help |

J7%: CPU C&fF1l, JfH SFC MR ahAT I E h“k¥E SFC IR

state). SFC &= Hi ik 192D AL 45 1k

SIMATIC BATCH FJIf, V7.1 SP1
EeEF M, 03/2009, ASE02171120-01
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6.8 AL 15

£ OS H#4E SFC "J#4k: 7E CPU EJH 2 5, SFC UIIHsLprik&E R, CPU E1E2
AT PE . SFC S P BT Fah#E. H P Ef N B s P2 Fah".  nf
PUEFR AR EEHATIOD . nTdUTgke:. BUREEIRDiAE, W NI MRSt 2 v e an
[ gk 4k .

@WINEE—SERHER1::PEEII,.-"'lnl'n_FLlNI(TIDNZ,.-"Dnsieren :Run DOSIMNG: Run AS ...

-Wl Faceplate | v Update Sequencer properties | Start u:-:unl:litil:lnl RS

in

[4[ 4T »[» T\ SELECT MAT » DOSING /

> Fun » DOSING T [T =]
MANUAL | | W|_|_|_|_E

R s ] Hold |L)| E ||7 Command Output
sUto | Kl sbet |l Conplee | m| sep | Cwolic Execution
@ £l Restart | ]  FResst | [~ Time Manitoring

N

BfE BATCH #ibA™: 1) E A STE Tl A1 Ja Y€ I 4REL . G Blifs 1k b g it
PR I RIAELLE B2 R AREE A THEAE

EL#HY: SFC: FHT SIMATIC S7

WE2ERASAEALHt: SFC: HT SIMATIC S7, E#: ft CPU fF1LHHE[Z )G
4b¥E SFC

SIMATIC BATCH /i, V7.1 SP1
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6.8.7.11

6.8 A FE

g CPU JEHHitAr=#1E, SFC 1 BATCH £k

¥ SFC +1%)F BATCH # O Hit4T CPU )3 5 It A =1k

CPU {5 1EJF Bl )5 H 8 2 S BUEAESAT BOAL A ™ R AT Wttt 2™ . 24k Ek, U Ek
fik, IT A A

7t SIMATIC BATCH ', fF/EMFialgefZHaA. THEAN 7] SFC v-kif BATCH
P TP )20 3R

SFC %1 BATCH #M#k

BATCH Bt (IEPH. IEOP) it SFC i1 RIfPRA . CPU HJH 2 Ja Mtk 447 A KR4
Ay SFC iHRIBHT I W BRI E . BB W61k SFC”(Initialise SFC) F1*fr+F SFC AR
A"(Maintain SFC state) 2 [AJ/74E W1 F X .

WIgaM SFC: 7t CPU Hi 52 )i, SFC dHATHIAGA, BIERAEIRAS AL T s 48RS (IDLE)
JEHAIB AR, BT ARFFAE — AUTO 8t MANUAL. BATCH et A5
257(IDLE) R . 2™ AN DT B BRAS "BA_State” sy 31, i D IR A (0
SFC KU CPU A a5 itk A /" — = th A 4

fR¥E SFC WR#&: 7£ CPU HH )5, SFC LLHSEBRRASE/R. CPU 1L Hilus 2
Wokh . SFC 445 M AT Tt M G N Ba D20 F5))7 . LAk FE 2k
ST . ATRATARSE. B B D) 6E .

SIMATIC BATCH F i, V7.1 SP1
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BATCH #5#0»

6.8 #A 7

BATCH iR SFC HHRIF PR EEIR 78RS

s

114

[

[ ErD
|44 » [* ]} SELECT MAT 4, DOSING /
> Fun » DOSING T [T |
MANUAL | | W|_|_|_|_E

Pl st L1 L il Hald |L)| Resuma ||7 Comrnard Output
s0t0 | X kot | ] Complee |m| Stop | Cwolic Execution
@ Bl Restat | |  Feset | [T Time Monitaring

N

6-8 iz474k, OS L) SFC i

# Interface Equipment Phase Block

- BB

Function
icki_FKT1 > @ hefncionsnming
TIH|B
IT Start lock [™ Runtime exceaded
¢ Enable for batch Sikark Hald HezLime
[¥ tlozate &bt LComplete Stop
[T Continuous operation Fieset
6-9 IEPH, OS Liynl4itk

BAEHLAEF: A 5 E A TUE Tl A n JUE (T ke, 0N slifs kb ik dte A= i
FIAE LU K120 rp AR e ATt A 7

SIMATIC BATCH /i, V7.1 SP1
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6.8 A FE

fELR B SFC: AT SIMATIC S7

HEEROSAEALH . SFC: T SIMATIC 87, E£@: 1t CPU fFILJFEHZ)E
4t SFC

SIMATIC BATCH FJIf, V7.1 SP1
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6.8 HLE =1
6.8.8 REAE 7= Ab 2 3 8] BF i
6.8.8.1 EM e

faifr

FEMLAE P PEbIYIa], IR A (BOEMED W LA ERAE BB (. ZEAME PRk
FISATIORE OB AT DUE S P ) o R N I 2 K

AR
o TR

BOEAE BTy W8], A AR S B4 T LB SR G S RIFAEL B S EM
(U B14)" & 73 -

B RPH AR B XS HE

PATRC 7B B (EPHL EOP) #8R] LLSZBIAEATHE,  (FUBT DS A 50T BRI AR
o

WERE T Be (EPHL EOP) MIA BAOAGHE IEAEIZ AT, WaAT U N E R

o R AN
IR AT IEAEAC BENC 20, WA SR A BB S B R AT 2 P A 2
b, BENS A SH U

o YRR
USRS T IEAEACBENE T AP 3R, AT S U S B DR L I G il X4t
{E 2 NFEHIRC T IEAE2 AT B RC T 20 B AR SIS s IR 4% i s i) s AT B

SIMATIC BATCH /i, V7.1 SP1
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6.8 A FE

BcnfTEm ROP 1 RUP

B e

FIT AR AL 7 0% (ROP RUP) R A 53 %o T AE AT LA ST RS B (.

SR BN
R T IEAEAC BNy o3k, IR A Sy AT 2 HUB SUR AN A AT L. B2
SR RTHE PRI OCRIN A R (Bl AR gD .

]
Wik 55— BatchCC i1 JF Vid e, WIAREX HE BatchCC BEATAEM 2 2.

FEREAE PR, o] DAZERC 7 Je B I S M DR A s o s e . NIRRT
“Agitate 1”10 77 2 B IK 2 5 1A 1 HE S A5

T I R PRI 7 70 2 ORI S T 1 B A" (Properties) iy 241 I J& M0 1 HE
WERAEAESE, K B 5 R (Input materials). “HitH 5B (Output materials) #1
“Z¥"(Parameters) L1 .

W B (Modify) #2411, 35 “n] & 240 (Modifiable) 32 10 1) 2 5ok A8 4 T g (1
B E) o WMEIEH, WMESBEEM, RJGH#HE"(OK) %4,
ESHIAA — N RIEME, W T woe(d, B EZRIEE. JA LA mE%E
ME 1 3 AE A BEAL 16 31 FL AT B0 Ol It A =il o G SREASASUE B 5 B AR R, U327 I A
S IEHE .

SIMATIC BATCH F i, V7.1 SP1
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6.8 AL 15
gk NMMBESMBOEE. WRIERCERARE, BUEEA DOLEAR, AT P AR
BTy JCER N
== General |@ Input materiall G Qutput material | 45 Parametersl & Madifications
Liste:
| Hame Type Source | Low limit | Quanti| OK | High limit
1 B -1 _Ruehr: Euehid 01 _Fahri[]
2 Standby Boalesn Falzch ([T
3 Minstand_1 Gletkommaza 1] 10 [ 10000
Jdl | []
Dezcription:;
| “
S Sx— Help
25| HKIER

HZEG I CBdd . Bl Hbs) I, mapian b .
o RS EAIR N TEET, W VAR S A H -

o WERSHORGARIC A B, 5n] bl izZ Bt e . pil, ek
My B BUR HOES BN E B (H3R A YR T LAFE Ly A h B e HE S AL

BRI A iy A E R B0E S EART IR B T, DRl Uit H bs BLERHZ S A0 T 1B X

SIMATIC BATCH Fit, V7.1 SP1
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6.8.8.2

fai g

EEsT

6.8 A FE

BRI B

R DAFEA AR 7 1 300 1) T 50 B S 5 At A 7 SR £ B e 3 i

o, A AR RSy D i Ry R Sl oo R R B SR T4, U0 AT L R e
[V S e T U

]
SR SO BEAE RN S M AT

FEREA =3 AL, AT LAAE G 7 R 5 0 S P X i A B e e
T8 b ERC 7 0 3 MG o (1 B A (Properties) iy 441 JF J& 1 X EAE «
24T () BR TR B A7) iE” (Allocations) B TR .

L B T 1 0 (Modify) #5241, T“BA e (Unit). “S50%”(Strategy) F1“id F£ 250" (Process
parameter) oK AR T gt (AEE R o WHEH, WESCRIT, AR5 " (0K)
Ykl ATRAMN R P81 3R b ke & E

SIMATIC BATCH F i, V7.1 SP1
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6.8 AL 15

FJAIeE, e R AR

Properties of 'test_101" E

[ General @ Allocations |'i."ﬂ| Chaining | @3 £s1c | Z7 Commerts | 7 change lag |

Lisk:
Recipe assi LInik Unit class Skark Run time Skrategy
1 |5ila 5102 j Reactar 00 (5ec) 00 (5ec) Preferred unit
Z |Buffer Buffer 00 (5ec) 00 (5ec) Preferred unit
3 |reactor Prermixer 00 (5ec) 00 (5ec) Preferred unit
S102
5103

1

Description From row 1

Cancel | Help

406
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6.8 A1

6.8.8.3  FXUHITJE MFRA ERSEPATHEA ™
LUN BB A RAE P W7 1 A R, 7 S SO e A SR AL B AR S A THE A
FESEGIH B T — RAVIEAALSS

iz

op2

-

FEZSBIT, ROP2 iff“Phase3” 4. aAUSEHs ™ i i 2 — A rh [ A s, R
JR A BEAE T I AR SR AT HE A

SIMATIC BATCH F/f, V7.1 SP1
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6.8 #A 7

S 2

BIRH E C 5 P IR BAT, BASEIRE SR — A0 (7 RockE P ) ROP1 I
ROP2 W2 — /N ) b2 BT AT Rl (fr 4. “B /"(Breakpoint) >“i&
H"(Set)) .

w
-

S 3
2R { e TN N BT b 1 = AR AL [1E10] L WA o s 1 o SPLG o o 21 = (V1 D W

SIMATIC BATCH /i, V7.1 SP1
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6.8 HLA =
SR 4
A g I T T I EC TR, AR A MGG L b e 5 0 4 J& 17 (Object properties) .
1E“%1 %@ 1" (Object properties) X G HEH T FF“4r " (Allocation) &I . HHi 7 A id f#
LS5
RUP I Start RO
Unit2 ] I °
Fhasze
ROP1 I. _—
1 | ’
‘ Fhasez
ROP2 I |
2 F'ha|se3
| x|
PES5

it 55 RUP 3 ECHTHot. ROP1 MW sio BELIE BT A e i A

St art FOP2

’ ROP‘I |ﬂ Fhase1 1

w
-

‘ Fhaszez

ROP2 I 2
2

—HOMBCHIG, 7R R TR AL R O .

SIMATIC BATCH Fi, V7.1 SP1
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6.8 LA =)
S 6
T I R %4k 23] ROP2, [ tbahZiist 547 ROP1. 4R 5 H8iH 8)) ROP2,
b op2
w -
> 1 b ,..!---
|
e Fhaze1
‘ ROP1 I. -
1 |'
FhaseZ
|,
|
Fhase3
| 3
BRT

— BB G, WInE E 5 Phase3 M & 4k S AT b4 ™

- s
- 1 | o
.

FPhase1 I
1

’
FPhasez L

-

|
i
-EE

‘ ROP1

SIMATIC BATCH FI}, V7.1 SP1
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6.8 H A= F
6.8-9 _LZT%'ﬂEJ'_\‘*n’H(;u/ﬁla
6.8.9.1 EBrHE
Bk
12iT#M], BATCH &AL L{Eiz4T PCS 7 OS (WIinCC). #:f)ifiii, BATCH &AL L
IBATAEIZAT OS & WL HRE A/ OS Meds N LT .
JR3E
BatchCC H i ] /R 7E WInCC VARS ST Fh AT 3 BE A T A e A = s 2. (R4 A
DR R BRI D
P /RIX LN B, 1T LAYE BatchCC H sl Wos & 4T JF PCS 7 OS (13 8 % 1
(WinCC &+
EBHEE
1 FH 3 iy 2 AL I (View) >“%i H4 & 1 "(Output window) 1] LLITJT PCS 7 OS H EVE 11
(WinCC &+
¥ B WIinCC R & 4541

TRRHE, iRzt E PCST7 OS.  #AEd R T

1. R A DR A B, JFIE RIS iy & B " (Properties) .
Zi: “WInCC 42 bl Ja ML X G AEST IT -

2. JEFFRSS SIEFE N MR F LA
iR RS AR G HEST T .

3. {EILIEF: PCS 7 0S GHAE OS) .

4. FHiE"(OK), #iiNiLFE.

SIMATIC BATCH FJIf, V7.1 SP1
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6.8 AL

HE X
A LL A E O B E DR g GEBLT WIinCC) , #iltn, oAy Bk a2 .
FH P ¥ BN R B E, e R IRJA 5 BatchCC Ik . 7F SIMATIC BATCH b
(P RELE 3 B A AR AR ZE, i, BATCH v Bk .
{FH“FTFF#HIBC /7" (Open control recipe) = a4, 7] LLFT 57 S TEEC i 4 Il Jy o
TR S5 WIinCC 4 5 & 1 (1) “LoopInAlarm” L) BEAH X I .

SE4)

FEIFEEIE- 1 G

ration completed
Fion running
kion completed
Fion running
kion completed

Fion running
peration completed
Fion running
kion completed
Fion running

10/13/2006  |11:09 (LOC) Lisk: 4 Window: 1000

an%1§=
A A HIC /7 SR B (T 413)

SIMATIC BATCH /i, V7.1 SP1
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6.8 A FE

6.8.9.2 SEQr AL T T B R A

Bk

T IS5 b B ST 7 I A IR R R
IR TR P BRERAE:

RN AT, ARJE RSO o (152 Fiy 24T JH 45 HIC 777 (Open control recipe).
4R

PRI T i HE R AR RN AT T

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH #5#0»

6.9 M1 E A E

6.9 B REEE

6.9.1 LA =R

A H S K% X

JREE

A=W ERER

I 18] [F) 25

414

A HAE A E BRI R TR RUENBEAT VAR SR T A i 2B E R . Horp O ds
PRUECE . PRI B AR B L T D BRI RES S BRI
SRR HRAE 3T T

ML — BRI 5E G, ATREI AR BT B R . bR B, R I A dh i
BroE B PEHRIRC 5 B BBl CLFSAT N 1 SR AR

AP IRRAE RS T N &0 (FRF . RUP. ROP) 41 HE 7RG i it ) Py i AR o
Rt MEAT RO 5 RO EH .

T SR B EE RN S NMEIR . SR TR T

R UAFES A P 3 AT DT AT BN AR Pl . i, il SRS A P P ho o AL R
77 ARIEATIT BTR S H

o “FTEN(Print) >“52 /%" (Complete):  ANZ:fil st o7 BIHT BN AR 7= H &
o YTENTI N (Print preview) >“5EH"(Complete): AL HiR R il

A EE A A s A HAE, S TgIRE SR (B o #AEER
BRI R

i

AR 7 B AL AR 7= 0 BB A P OGP B BT A e R AR RGP S e
i ATHAE  BE A P (BDM, Batch Data Management) /) PC L H IS B . 22 foi4
FEAZIN ) 2 PRSI BT A T U8, 2R 0 BT I 4% 74 s 11 I e

HEepE2D: 1S RTFM (PCS 7 - PC 415M$RL) (PCS 7 - PC Configuration and
Authorizations)

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH 75 0»
6.9 WA 727 EH

H B8R H 3

PR

IS TR AT ] 39042 A DX B8 PP SO AR AR UL A P IR b o

XA RGINTE S AL PCS 7 b Prik eIt 5 oK.

Ros H AU A7, Rom AU =A74F, RoRENACY I T4 WERANRE
ek G, AT RE S el T R A I RST BRI T & — o H R

fER %3 SIMATIC BATCH ) PC |t BT ENfitA =%

BIAE R 22%% SIMATIC BATCH ) PC I S R AT ED RS b2 =438, il
SBReport 234545 . A LL{E SIMATIC PCS 7 DVD I-[¥ Additional_Products >
BATCH_Report__ V7.1 812 N 2% 225087

LR, W] LU TR (Start) > Simatic > BATCH > SBReport i3 3)i% %7

VLAY
SBReport H VP IR X V7.0 19 BATCH $cdis . 15 i f O 42 I H 1% 2 1+
£4"(Archive) IR ik £ T xml A 2L V7.0.

“SCH"(File) >“¥T FF#tR"(Open report) KT ANt 1, AR AT RS e e 4th 28 7= 50
Ao AR AT S AN A R

S (File) >*4T B3R (Print Report) 4T BT 57w it & 4R .

SIMATIC BATCH FJIf, V7.1 SP1
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6.9 M1 E A E

6.9.2 A ABRAEREIRE

[IE7 itk 3

TH#

T AT A

416

‘2% SIMATIC BATCH I}, 7 EF G R 2 22619 it H &

METR SR, AT RSE R ST BN TS A BATCH £ b0 b BRI X % 4TED
TGRS AE R AR IS £E BATCH 20 rh e

A
I R Ay B RENE K A VT 10 /E BATCH 4255 By H RS oS A ™ iR 3, AR5 AR LN
B, AT AT EN T PR it AR R T 3 PDF SR

A S FL 0 B D22 L it — A TS (EREAT H TR St F SR,
TR R S A ST TP

A BB AT B A DA A A8 A B T B 38 25
o fHRANR: L TRRIIHE

o T AR I Fiett SHIFT 8. R 3)

o I AR I f2{E CTRL B AilThRe

“S M ETIR T Th AL AT HROK H B S Ok *.pdf SCEERT *.bar 0. B A& PDF #%
L (IR SRR Ab, B *bar S IRA (XML ¥ 2 bR S Sore) .
AOE T IHRY, WX S O EEAE AR AR AR R %5 2% (CAS, Central Archive
Server) [Fs#EH xS .

TR P HA1 (Extras) >“¥ E"(Settings) >“Jil H # & (Project Settings) >“H &”(Log) i%
T, SRIFEFEPDF SCEFrUE H 5" (Standard directory for PDF files), %%} 7E
BATCH il o3t FUSHEA TR . iz b a] BLEE 2 PDF SCAFR )44 0% A0 H
s&”(Name and directory of PDF file can be changed) HE, JUI7E4E S H I 0 2l A\ 44
FRAEAAL

E 4 T SRS (1 S BB RN V€ (AR it o A R Se PR R B (AR, AEH &G
2L bRAC I AME LM SE 5 T U0

SIMATIC BATCH FJIf, V7.1 SP1
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6.9 HA H A E

6.9.3 HeAE =98

6.9.3.1 BL V7.0 SP1 #& R IARY LA =

FrEy V7.0 F1 V7.0 SP1 94K

A CTRECY

BRICHETIM V7.0 4540, IRAEIRSEHE T FH T IaRSHEAE 7= 11 ) — Pl % =X SIMATIC BATCH
V7.0 SP1. 1ZA#94% X 7E BCC/RZE Il H ¥ & M IH 4" (Archive) IR . nfikik
PEIETA . V7.0 f1V7.0 SP1.

V7.0 FE4H#% 5 SIMATIC BATCH 19 V6.1.x R4 HIRE AR N o A] LIS J A7 1) “SB

RN I RE AR PE V7.0 A AL A ™ )R, DUE AT BLE Rzt A R (XML S0
XF IR A H &

V7.0 SP1 AR 2 —Fhas BT A ik s, Reilib 5 FHAEAE SIMATIC BATCH FiIAh MY
HIFEF? (W MES 240 2 (A A Hlidls LERE 20 A s AR BRHE A5 B A% 5.

TR VRS S5 A8 3 REAN et SR A O AR Bt P v TR R 2 A B U AT 582 (K
fitie

SBReport F17 )4 K %28 (CAS, Central Archive Server)

EZER

TR V7.0 SPA RS SURIAEAE > RS AN BE A I AT (1 SB RN N RE P EAT AL 2E . ib/E
77 H A e “SBReport” N H AR 7 i .

{fil} CAS (Central Archive Server, 1Yt IHRIARSS ) I N RIX— . CAS 1A
KILL V7.0 SP1 #8202 b A2 7= A RS AN BE SWos ik 7 H &, 2R T “SBReport” .
MR TIEE K.

B3, WTRAT3hE R PDF A% 5U Rl R I 7E CAS HatAT )18

VPRI

SIMATIC BATCH FJIf, V7.1 SP1
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6.9 M1 E A E

6.9.3.2 RS HE A =

S

JARS AN A

AR B A A

7t BATCH il rhotarh, 838 n] DAAEK AR rh a RS e AR = o IR L8RS T K A A
4 FDA BUUHE A =%, 9+ HAS 5913 SIMATIC BATCH 1.

S BEVARER A 3L o

PSSl DUE I (e S5 R b B AR 7=, ARG AEDREESE . CRBER ) rhik#e
i 2 IHRY" (Archive) EANFRSREAS JC I LA

W] LR A TS SRR AE ™ FTIT A B0, R SR A . SRS AE
PREESC CAHE ) IR R a2 RS (Archive).

BatchCC 1 i BRAE

418

VIR — AN E A A AR, IR AR T AAE I H B & (Project settings) A 1 HE (1)
#4”(Archive) HEI - AT &R BCE BB M. A HRHIAEAE 7 # L XML #5307

R O I 3h 42 PDF SCF”(Generate PDF file automatically), [ XML )1k
2k, e PDF 36, Z4RE 5 XML HRSAEAH AR Rl —fr & .
TE“VARS" (Archive) JETi R B gt TR T =i T A C 58 Bt AL = 1y ik
o UIITIL.
W VARS SCAF AR AT B I 285 P L 23092 . SIMATIC BATCH JE /54 4 IR 1K 8 5 44
FERD S v7 M SCAEIE . Il B 5% Windows (1] BEA TS0 AIE -
® “SQL Server'Jjik,
VAR SCIFRATAE SQL B E . b iA TR BG4 IG5 B, HATEE T4
IUEEHSH

® “FTP g5 8" Jiiko
BRSO RAFAE SQL Bdla Parh e U7 S sk A4 I B, I H A %8
KOS AN A EEAE

SIMATIC BATCH FJIf, V7.1 SP1
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6.9 HA H A E

EM7E Microsoft SQL Server H 5 RI#EAE =
3T Microsoft SQL Server Management Studio 2 i RS (4L 2E 77

1. i 3% i 2 “TFER7(Start) >“F 7 304" (Program Files) > MS SQL Server 2005 > SQL
Server Management Studio ] 71 SQL Server Management Studio.

2. 7E¥R 5" (Databases) ‘FHLE 11, GERRAbA =5 AR FR (9 an
2_25269528_55_Archive) L)L/ I4bf) dbo.tbiBatches %#%, JFAEHdisg arp ik £4T
JT##%”(Open Table).

BRI

Ui B

T H ¥ & A 3 % PDF 3014 (Generate PDF file automatically) 5 EA £ RS2 77 1)
XML JAR4H PDF REAFEAEEA R Bt vl, S HE~ G wAMes, XAl
SKAE SR (Type) 51 A o

BEZ MG E, 1Z% MS SQL Server 2005 #1).

BLER
o WH FTP RS2 (7 423)
e % SQL Server i/ (11 420)
e % H SQL Server 2005 [{°& A% (1L 422)

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH #5100
6.9 WA= EH

6.9.4 i SQL Server

6.9.4.1 B SQL Server $iEE

“GI# SQL Server it /4"(Create SQL Server database) X} 15 HE 4 1] 257 ) SQL Server
Bl SR it T 2R 71%

Js )

o [Xif. SQL WZIK
SQL A2 — AN S R SCA R SQL BRI, SQL A HE H T LAYE SQL g5
THENL ERAT A B . i RAHTH L AT 23 SQL ikss4s, 5t SQL
HR55 s HHL BV 23 SIMATIC BATCH I, A S AT />, SIMATIC BATCH
EE GBI L% SQL AL EY: SQL Ik sS5#8 45 B 01,  DAMEMATT AT LAY
#AIER SQL Bk A .

— A A" (Script in file) 4% HL:  SQL BIA T3 A7 4 — A 3T

— “BYNAR HH (P EIAS" (Script in clipboard) $2411: ¥ SQL A S BB ik, SR 5T LA
ff FHAL A BECrl + VR LI AN 2 L N HF Y (B, iddiAa) i,

A
WA IAIA A el E T TR BRSO R AR . AT S, SAEFRE IR B
ARGl SO R 1, B n“SB6_2_25269528_55_Archive_dat.mdf”.

o [XIR: f#fAHL SQL Server Al HHRE:
w5 SQL Server fEAMFHHL_LEAT, MAEAH T B QI SQL Server i
T BRI, DU R] s 61 e $Hi 15 (Create Database) 4241 61 4 B 1%

SIMATIC BATCH FJIf, V7.1 SP1
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6.9 WA 727 EH

P
1. JHEIAH SQL RS 5%
2. VEEm TS SQL Server (157 B BT RLR

7t BCC v, EFSE A k15" (Options) >“i% & (Settings) >“1i H % & (Project
settings)

BB RS (Archive) &<

HE“SQL Hlk4s#8"(SQL server) #1144 .

i EE...”(Create...) %4l

HFT IR SQL Server % J4"(Create SQL Server database) X} 1G4
B @ 50l 7 (Create database) 441 .

BT IT 1k $% H 57 (Select directory) A iGHE .

10. JEFEAE P K F oK

1. P12 " (OK) 444 .

12. ¥+ JF“SQL Server Login” i HE .

13, AEFT IF AR U ARE A i A T8 AR S S PR

@

© © N o o &

LT SQL S5 E A B A
PAE3 28 B 45 T 0 ) 2R Ge A e A8 2 B Sk A B

SIMATIC BATCH FJIf, V7.1 SP1
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6.9 M1 E A E

6.9.4.2 #% & SQL Server 2005 [ & k215
9950 SQL Hidi g, 4 4i{E SQL Server Management Studio 1141 2% 55 f 17 AL IR .

A A “FF IR (Start) >“F2 73044 (Program Files) > MS SQL Server 2005 > SQL

Server Management Studio #J 7 SQL Server Management Studio 17 & 5%,

. 7E“224="(Security) >“& F"(Login) >“HHE3 " (shortcut menu) >“FrE & %" (New Login)

NRIEBIHL

. {E“E 34" (Logon name) T [l A PR 5 Sk 44 JF 0 “SQL Server k" (SQL

Server authentication) & iEHE.

N IEEAT A
. A S IEAE S ) 0 1917 (Enforce password expiration).
. FE“ERIN B 5 (Default database) N, EFRACA =Bk A, Hlhn

SB6_2 25269528 55 Archive.

CAESHUE T, FTIFH B (User Mapping) JEa% Bt A 2= 50 2
L AERHE D, B R EMA K . (Database role membership for: ...) 25

W R“db_datareader”f1“db_datawriter”.
A F“B 52 " (OK) ARAF W

10. 7£ BATCH 2y, K B (10 Al 2 se B ATEr U T 7 (ATt By A\ 21133

H & E IR (Archive) ZEI-RH

7£ BATCH il ot 2 A 1Y C 3 B A5 % A5 B E %4 SQL Server LY.

SRR, BATCH FEhil L B #4421k (XML JIRS AT PDF 3%, Ja H I T30
HBCED ORAr 208 B A

BB
1
2
3
4
5
6
7
8
9.

P S

VAR 71

422
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6.9.5

6.9.5.1

2K

6.9 HA H A E

£ FTP MR4-%%

WE FTP k%%

{EF“FTP R4 2% 77 1 RS O 52 R A P2 s A 20 4 8 FTP IRZ-#% . T LL“Windows
200071 4F R G B4 BAKIKEE b 8. 0T84 R 48 Windows 2000 Server.
Windows XP L)L & Windows 2003 Server, 5155425140,

‘2% Windows ZH14“Internet 15 & 245 11S”(Internet Information Services I1S) LL & AE“VE4
& &7 (Details) A H SRR (FTP) Aii45 45" (FTP Server (File Transfer Protocol))
T

i H“FF4R" (Start) >“¥ & "(Settings) >“# | & "(Control Panel) >“¥s i/ krF2
J#”(Add/Remove Programs) >“Z5in/MiEx Windows Z414F”(Add/Remove Windows
Components ) >“Internet 15 & ik %&"(Internet Information Services) >“i#4115 5" (Details)
>SCAAEREY (FTP) iRk 452%"(FTP Server (File Transfer Protocol)) Z3& 48 14 .

Tt B

LHENS"FFTP ko528 A, 1WA AE RG 2 e o IRk S5 .

T T X s, BN i%H MBSA (Microsoft Base Security Analyzer, Microsoft Ji

e trds) <20t

WARBEE T Windows By k4, WIEALRAE 2% T FTP Ijg54:1) PC LR T FTP i

21, WATEL, Fedn T PRk A v E IR AT B

1. “FF4R"(Start) >“¥ B "(Settings) >“¥& IR "(Control Panel) >“Windows B k1%
"(Windows Firewall) >“%4%"(Advanced) T > 7 W 2532 3 15 E X ek i i i3
”(Settings).

2. WOIHEIEHEFTP r55-#3"(FTP Server).,

3. TEFT I IR45 1 B (Service Settings) A& HE T Lo e "(OK) .  IRAFIERISH, IF
T B " (OK) KA 1 I (RS AE

SIMATIC BATCH FJIf, V7.1 SP1
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6.9 M1 E A E

7

1.

424

A H“FFE" (Start) >“B B (Settings) >“#Z I H Rk "(Control Panel), X5 7 421
#.”(Control Panel) X “& " (Administration), T 7F“iH &AL #”(Computer
Management) XJififE, XU “it 5L #”(Computer Management).

. AESHE L PR (Computer Management) XFiEHEH,  BUch S o 1 ob % ik 45 A1 R

J¥"(Services and Applications) , 4R J57E4T HF B 1 XU “Internet {5 Sk 55" (Internet
Information Services),

AR BT R B SO BRI FTP 3l 55" (Default FTP Site) Jf 78 R L ik £ s

" (Properties).
AT AR (“BRiA FTP 3 & ¥ (Default FTP Site Properties) XiGHEST IF.  7E
X EAE S, FRATTE S AEERIA FTP b S & 2 5 b a3k T i i .

IR 4 248 ] Windows XP 18, Windows 2003 Server #:4F R248, W al LAGE— N5
() FTP 3b . BEHATILERAE, G EFTP 3l 5”(FTP Sites) S0fF%, i, I
FE RIS F P P " (New) o 2 8 i) S vb A I 44

WICAE, FEJShETI FTP 3 A2 75 25 11 A BRI FTP 3 s

. EFTP 3 £ (FTP site) £ [19“b# " (Identification) X3, 7E“fifiid: " F fAEK

FTP 3 MBI FR . X5 T IP Huhib Rl TCP 3%, B4 BB 4 A 2l (All not
allocated) 521"

1E“ %2 (connection) X B )“BR s k. ”(Limited to:) T W LU AR Z 32 Nk, X
& PCS 7/BATCH & HLHI%H .

Al DAGR B e R rh i L B R . AN (Apply) F LR AF S IR A

. B4k (Security Accounts) ZEI-R T, FRATTEEBUE AR “ i B 44 3% H2" (Allow

Anonymous Connections) 2t (EBUNE TN J5, SHI-—4KH Internet
k25 BRAR OV BN, AT DA T2 (Yes) $ ol BEA TN -
A DUOR B I 100 o i) e BRI B

. {£"F H3X"(Home Directory) £ I~ H, O B QeI e 2 BRI, AR B A7

T vH5HL L H 5% ”(When connecting to this resource, the content should come
from a directory located on this computer).

7E“FTP 3l 5 H 3%"(FTP Site Directory) ZHHE 1“4 Hh % 12”(Local Path) i NS0,
K F SIMATIC BATCH IR SCAF AR AR BR AR N o A FH SOAHE S5 (1))

Y5 (Browse) 4], 0] LAAERS T SENL G BRI RR (1 S0 . B0 U I AR
“I"(Read). “5"(Write) F1“ic3& i in]”(Log visits) =AM IEHE.

TR RERA H k% L “MS-DOS”.

AR O 58 e M UG HE P A AR FTP uh fUb AT T A RS .. RAFIEIE, JF
B A 2" (OK) < AT TG ATE o

SIMATIC BATCH FJIf, V7.1 SP1
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B n= S

6.9 HA H A E

7. A FTP S, AR L 4T 17 (Open) i 2 KT R S & 1)
FTP ufi &,

8. W RARTREIACST I FTP o i b, JRiida . 7o R it 5 e
TE”(Properties). #4771 ... K@ 1" (Properties of ...) XJiHAE.,

9. FI I A E"(Security Settings) KEI . TERLAL, RRT LA NI 5 (14 FH - 4 EH
%, JFRCEHAR.

WSRO 5 SUA SR (User-speciified information) [X s A\ £ 1
RRAG ) S H XA, i AT 2 s B (Change Settings) X i AE )
F4”(Archive) &I L.

YRR

SIMATIC BATCH FJIf, V7.1 SP1
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6.10 26471 2 4 (OSC)

6.10

6.10.1

i

FEL LM E D (0SC)

FEL S H B R 1t T WRLE Th RE ?

M SIMATIC BATCH V7.1 SP1 i@, SIMATIC BATCH &£}t 7 OSC (Online Structure
Change, {E&45itBE) Froife.

TEL 5L (OSC)
/] SIMATIC BATCH V7.1 SP1, #itrl EMESt ikl kA A 8 sh e A= i id
Jrgikg . AT LSRG A o A8 el O B S C O G5 R S A R ) R, B
it — A . A8 S D g T DUE R R e s 8 Rl 7, IR I i R kAT

(t,)

426

A 2,
PLUR Dhfe B4R T R R A
HEAE PR
- oEd TELRLETE I (0S0)
- ©az
- OkA
il iy EEEEE%‘? ZE TR 2 R AL
(0SC ﬁiﬁ)
]
. O a “» ”
L | |,
B N B
i
T
NEU:
v
AT i 7

SIMATIC BATCH /i, V7.1 SP1
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6.10 #2551 8% (OSC)

N
BAE B THAT
PeAE B SR IOE IR b A P AR I B OSC AL BEAR A T HAL T2 IR

SIMATIC BATCH F/it, V7.1 SP1
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6.10 26471 2 4 (OSC)

6.10.2  R& e FIRFE

it 25t Il

428

P 7 45 ¥ S Sn] 3 /) e AN = e g
JI AR e 5 i AT A TR
PR S50 S U R 5 B TS K

A A2 S50 S B BT A i A4l 4 BCC f“431”(Control) S8 rh#k 5], H T4
AH 6% (RUP. ROP. RPH. ¥, 204 2l 5 2)) OSC i I i
5 BCC T HF KW E

TEIH BB L (General) KRR, o] DOZF i e B o 28 5 o it AR
7”(Active batches must be paused) I, L3 1% 30 T = A5 0 JUET (5%t A= 7= A4 fig
HATIELR M. HUMIEPEZIE T, fibAz ™ DRGSR Q2L 1E AS HisdT.
AR AR T BN T I Bl 4546 T OB

OSC Hia TR AL VFIE P L L™, BOC SeBL LA FIE AT I 4 e

.

A LA D A

A BRI 2R HOSC AR HEA

- BRI AT e (Accept changes), I TERSHUR ORI
Je WS IR KA LA A S B X A 11 OSC AL a
=

- AT T AR

SR B SRR A SRR 7 4 o U Ao 0 3¢

BT A

UTAEASEITBONI, R %ty RN BLILHT BCC 2 TS ML 1)

SR 5EH OSC iR A SRR 10 5L

e OSC AL FIK: TWRINHYEE% (MBD , WAL PCS 7 08 1f
(RT3 (AT . s RSO

AL G347 A BC T I RE LA 4 FR CRELUI A RS A N A AE = I 00D AT =i A=
HFERIEE 54 8 1) £ E 5 PRA7 2« A= E J7"(Master recipes) SCPEEHY, TGI8 E &AL
OSC AP N 7% . Ak, S0 75 2 55 A7 B AR

SIMATIC BATCH FJIf, V7.1 SP1
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6.10 12451 2 4 (OSC)

6.10.3 R il

FAAE LT BRI
o TCILMIBRFAS N EIIAT 1

o ELLATH IR JCIEAE BCC BB R T, 1R o SEOH U )t e vk BB AE 2k
Sk

o INRLLRRARELAE OSC K Migtr, MIEILIRUEREIRAF 5S Bt A P R

o CIRHIATRC I QI B, B, iR RSO . B, TR
MIERIATHC T B AR B BAT S @ e BB iy B Beo 44%, Al LU BeHn e

JiBr B Bk A .
o ELR AT T SO IR TG i B s B LR e X B

- B SRR

— ALk

- WS
e SIMATIC BATCH API #1 SIMATIC BATCH Jile 45 284 AN SRR S5 T 0K
o RGN ER BRI L T2 4

e SIMATIC BATCH V7.1 SP1 1 SIMATIC IT —[affi FH B, AT AT A2 45 0 0
M. ik, WTLAZE“TR H E(Project settings) >“ 1" (General) 155 & 2% F AH M
OSC i .

o WU ENR (B, B PCS7 OS) gt fREMHI I, KK
Ml BCC T AT IFAIRSAEHE, I HdE4rE OSC Ao AT IR B e LUK I8 i R e
A2 N Iy SE

6.10.4  API f1 SBS 4T H

OSC AT HATH
o RS NURZNN, SBUERZ WAL, DM T AR R,
o LB E I P S R R At A
o ATIN CBiltw, JEIEEE I s AT 5T R SR R 0 E) S R R

SIMATIC BATCH FJIf, V7.1 SP1
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6.10 26471 2 4 (OSC)

6.10.5  HLAEFITH

HAEF=ITH
WO (A P2 46 2% 5] OSC AMHEEE S, BCS N2 Uy s A i (4 Bt
A . MEEY, BCC Wizt A: . BCC itk st B SR N H, I
JERUR L ST N RS PN AT AT uR L

6.10.6  Ek
{E OSC Bl FARFRHEA: 7= (PHIl ) A B 2 L R 2k,

R

o BATA SIS U BUIR KB H - AT LAAE OSC ARBEBE A A shitb A=

e T[LLYE BCC K HL1 LTI (Options) >“¥ E"(Settings) >“Jil H 1% & "(Project settings)
NI S AE 2R 45 7 T (Allow online structure changes) 77 .

® iz OSC At HMAIEI R T BT I ERC s PR AL A R3S MRS T /M

LIRS o

EBT IR OSC ALEHE
AT DI fovF

KA A A SV
HEFHRE OSC #bF
=584 fVF

CHE FVF

B3l IEFESFERF R N0 RVF
IEAEIETT fovF
(SERSALID FeVF

ok CEAT R fVF

=SlE! A SV
g/l AICVF

SIMATIC BATCH Fit, V7.1 SP1
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6.10 rE26 4511 ¢ (OSC)
HAHRES OSC AbFEE :
EENC A Ao
AR AR AN FCVF
e KA ANFVF
RATTRL ARV
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6.10 26471 2 4 (OSC)

6.10.7 EHTERES

AFK BRRE

7£ BCC WAL, AFINZIN£E OSC AL x ey 7o & I icE o) s e A . A0 —
AT, BBRAL TSR RS 1 ROP (B #4E) A1 RPH (L 7B .

IV S W

&

SETE BCC oAl Ty & 1 OF R ZD
SR E BCC Hh o5 il ie /i 1

B HUGAE BCC Rt TEN AU & 1 (Rl )

SR XML RS S, #il4n, 7 Internet Explorer H 7R

0 SE BSUE V5 70 3 IR S s R DA I TR AT DR ) 2% A1

RNE

7£ BCC M=l lc Jy B i e 2 D58 () i Cs (GREx) ?
7t BCC HIHAEHIRC T & IS e R R B8 (S0 I CE (REkt) ?

Case 1: An object that is already running is deleted at time t, in OSC mode. In this case: ROP_1 and RPH_1

Control recipe window Control recipe window in Extended log XML archive format
in the BCC (starting point) the BCC after the change
ROP_1 ROP_2 OSC mode: deleted
OSC mode: deleted
t
oset)

CDisAT H O MR AL 762 (ROP_1 Fl RPH_1) A4 i R7E BCC [kl 7 % 1

s

EATSAEY R H & SO HarA7 5 B SCA0SC Bl MR B e A5 L XML 944

A EIR.
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6.10 265712 2 (OSC)
Case 2: An object that is not running is deleted at time t, in OSC mode. In this case: ROP_3 and RPH_3
Control recipe window in Control recipe window in Extended log XML archive format
the BCC (starting point) the BCC after the change
EZEN [RPAT)
L

SIMATIC BATCH Fi, V7.1 SP1
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6.10 26471 2 4 (OSC)

KizAT HOMIE AL 7 762 (ROP_3 fil RPH_3) EAS S /R7E BCC [rds kil )7 &
Fep, S BoREY R H G L XML HRRS R B R,

Case 3: An currently active object is deleted at time t, in OSC mode. In this case: ROP_2 and RPH_2

Control recipe window in Control recipe window in :
the BCC (starting point) the BCC after the change Extended log XML archive format
ROP_2 ROP_3 OSC mode: deleted
—— Lrors ]
0SC (t) OSC mode: deleted
:

WA EOE H O MR e 77 62 (ROP_2 Fil RPH_2) A4l /n{E BCC [fds il 77 % [
W EATIAEY R H G Bos A 5 B OCA“0OSC Mz SMIER” e ULl XML S
SN TP

SIMATIC BATCH Fit, V7.1 SP1
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BATCH ##)"0
6.10 1F2647H % (OSC)

6.10.8  WfTHATAELGEWEL?

&
T T PR SR T A AT A A T, R C R ST A S AE .
Bk
o [ IELI"(Options) >“1 & "(Settings) >“Uiil H ¥ & "(Project settings) T H“ RV 7Lk
4546 5 2 (Allow online structure changes) T H % & .
o ERURAEE T, AR SR MCBR .
o kAT —ANFERCTTH TIA.
P&

1. QU B A 075 I — ANt A

2. FTTFP R A P IRC T S ORFT TP INC s o DAERT & e WA T HE
Rl U s, ] 1

3. Wiy 474 “4E " (Control) >“4f 14 5 24"(Structure change) >*Ji )" (Start) )i )1
R, i (Yes) fdlifiil a5 OSC AbFAH L,

— {E BCC WIMTEALIE T, 2 5em i fte L b i (Ui (mfirh) At CELt
SADR

— FERAREA, A BN HE 45K B 0 (Structure change) LA T 38 KT 1)
BATCH %/ Hl. 1 LABkIi% 45 b HF AE

— TERAFE LSS W N BRI SR A 5 R0 SOk A = 28 " (Batch editing) {22
%o WA B BNZ AT S L, R U AR AR

- {fEBCC & 1, o T gt A 1 m g THEA
4. WEIPEBRING T (A o B, R SRR A BRI .
— TR IFT 5 A a5 SO AR e BITAT S SO S s LB P A

— LESEEARL (R (Control) >“45 44 5 4"(Structure change) T, fird 452
" (Accept change) Fi1“ifi 4 5 15" (Reject change) 4> DAL A A .

SIMATIC BATCH F i, V7.1 SP1
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6.10 26471 2 4 (OSC)

5. WIREARLAAEDS 4 20 P R S 2

— FESCHAET, b A& 0" (Control) >*45 4 8 5" (Structure change) >“fE 44 5
4" (Reject change).

— eI, kR A B4 T B (Reject all changes).
6. IR ERZAEE 4 D I 25 T O

- (ERHA T, Py 2" (Control) >4 5 4" (Structure change) >4 5
" (Accept change).

- fE LR, & sz i ] 32U (Accept all changes).
7. WL H 5 P EE 6 o8 AL 4 M B U 2 R AT A

— T DAAE 58 B 4 I Ak S AT 1 2 45 A8 B0 SO R4 AL A

— T LURS B 7E 2 45 4 S SO R AT (AR

— AT LURAT S Bl 7E L 544 S SOy R g e A

C2 N AE LR AT AT 18T ) i & A R

SIMATIC BATCH Fit, V7.1 SP1
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6.10 1F2647H % (OSC)

6.10.9  BHLEFEHFEANER T

B ERTT R

AJ LLBE I iy A 5 47 A 57 (Save as recipe) Bt A= S AE B i Bl )y, SRS Akst
EHZER . A3 T OSC f I Erak. a2 547 AL /1" (Save as recipe) 1t
OSC gwfH AT H .. Jit, 80K 75 Z S A7 kB 7 AR

iR

W ARIR Y OSC il 2t T8 ERCTTAR T A F SO A AT FR E R (41
bR E B kbR ) o HT R ST PR AEIE R I AU, DU RTAREERA T ALY
(A

FE“ T3 A7 ML T (Save as recipe) SHEHEF, AN AFRRRIRA . KRG Mbsik 4 RSt
PR LIRS A & i N 5l e AR BT BT B R AT AE B L 5 (Master
recipes) . A LR HA LR JE k-

o BEURMSEAR P I Ic S B EEEE2H I /T .
o )T ARSI TR BT AN, JE HA AR A AR B TT A O R s TR
o B RC s Ak AR BEAR SO A A BT S S H AT IR T

i
THER, BH IR SRR RS HORI R, Bildn, R A 8 AR R B
TR OCR, PRI RS . U2 R R B (1 2T

SIMATIC BATCH FJIf, V7.1 SP1
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6.10 26471 2 4 (OSC)
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BATCH B 5 fmtE 2% 7

7.1 (kN

XA
f# 1l BATCH By g, v AT EBAL I sCEIEAIE SUie 7 o
GARICTIN . S AERLR LR BRI B X ) -

LI/
* JRYMCTT
o JEXSBIC s R AT

PEXT S T4k

BB
[RIZBC s th a8 545l AR I Be s 3 5 1
TER T 5 RN R
o WX JRTHH
o EXBGIM: THiH
o fEUg HALYI N EOP (BA&HRA) SRAAIE TP B ROP (HLJ5#845)
o [EMSITILVIIR EPH (B RBo FAIEC T I Bt RPH (BLJ B BO

o WRELRA: WERAEIRA 41T EOP M EPH AR 7 M Be LA A A fa] SR i
AU NOP A (1L /7 B BE

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.1 i

BB TT
JERIETT B4 PR IC IR T TR Y (RUP) 41k, W77 e R P AE RS T7 i e 9747 4k
IO RPN R S I AP 7 0N L ST I N A
RUP ({522 8R4 B
o fEWEH PV EOP (RA&HRAE) AL 7B BLi¥) ROP (Jit Jy 1)
o HA— R RPH (MCI7HrB KRB KHAN T K ROP.
- AEWSE RV EPH (BB B BIRC B B RPH sl
— Refg AR HEUT M EPH AL TT M Be A iR 4

o BMELRA: WERAERIRALIAST) EOP 1 EPH ZEAY AT 7 B Be A FH T o] S (i B E
HifE4 1 NOP

* JEGIH

PEXSS: BCJT B

UK R BB TT G R P PERA 2 ) RPH SRR ALY ROP. e 20 3%
JRPF I, AR R 2y BE 2 B oG E LUEEE g 2 SR AT LU )% e SR I BB B (EPH). 4
AR HoCRE e (RUP) (MRCTT A BRI IN S RE AT HC o0 i

PEX%: 451

AL R Ry G th T S M AL P, T SR SO B4R 4 . EOP MKy Ak
o, EPH AR5 By BedL o vl IO 7S5 IR C U5 25 B8 23 FEANR] (1R G SR 50

SIMATIC BATCH T}, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.2 J3 ) It

7.2 JE B ERAE

7.2.1 Ja 5 BATCH Bt 7 4w%E 58

EIH
sy DLtk = A R 7 Xk 3 BATCH i 5 45 -
e A\ Windows [1*“JF4R"3¢ b
e f{iff] BatchCC H [z iy &
e EilfE BatchCC ¥ JFHC 7 H3h)E 5
M Windows HJ“FFIi" 35 H B 5l
o 3] Windows f“JF4A"(Start) S5, JFikFSE a4
“FF 45" (Start) > Simatic >‘BATCH B /7 4a % 23" (BATCH Recipe Editor).
7 BatchCC # )3 3)
o {FBatchCC v, *hii Z& Jieklalihft 3 o iy 40" (Options) >*J& Bt /7 4 28 L1
#T7F BATCH Bt 5 4R %8 4%"(Start Recipe Editor to open the BATCH Recipe Editor).
o IJAE BatchCC HikFE il 7 sl EXT 5, ARG IEFE 4T IF"(Open) 4 CRlbs A %
D B B R R TR S, WA BhIC T I 2 A 30 8)) BATCH BE 7 dmiE 4 -
ﬁﬁ'aﬂ
& nT LS BATCH L 5 g 2t Bl 7 AT P T A nl RE e e, (H L RE A
BatchCC SR o 0 B i 44 B8C T
SN

E% i (7T 443)
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BATCH F 77 i #5:#%
7.2 15 PR T

7.2.2 ffiF BATCH Bt 5 4r 48 25 B E K
DAZLH L LA RSk AR A3 F BATCH Tt 77 4t 5%«
o il IEATIERL R/ CFC B al g SFC A [l Heszfilak BATCH Ik

IUNIT_BLOCK. IEOP. IEPH. IEPAR xxx f1 TAG_COLL LA}z #it = 2 g 3
(SIMATIC & #28) KB % .

WK A X b S B () R e A 4B BATCH g5 4%, SR 4E BatchCC e
i 1 FE 7 (Program) >t it 72 82 75" (New process cell) S8y A,  si7E 6 o
T CH 5 156 1] “g %8 (Edit) >“5E HT it 72 52 55" (Updating the process cell) Sz iy 4
B

i

A DATESE RSB A S Z BT OISy o A SEBX— i, W RAFESE—IRIN T3 (B
CFC [f5) #misMatiid (A3 |, JERZ IR A R Bp e el i —
4y R3] BATCH 145 7% .

PUG e & 52 % CFC KIEINT, WAZ%i{E BatchCC i B 4“4y " (Edit) >“F Frid 2 8

Jt”(Update process cell) 52 fiin 4.

o BMHERI P SIR TP IIAT ARG A HBLR. CHIP R BLSRVRAE T 5 G h g -

SIMATIC BATCH Fit, V7.1 SP1
442 #A/ETFF, 03/2009, ASE02171120-01



BATCH A7y G ##
7.2 Jiz) Rt

7.2.3 H P 5 FEEAE

7.2.31 F&E AR

Bk
BATCH Hc 7 4 (10 1 7 i AR A A Jy N B, B W 1 2 e i —> 5
foilo ST LATE St g 1 A R RN (Insert) S5 (1) 45 46 0 25 1 B AE 50 iie 7
B G T sl A M EER B (AR 1) o VRS v, )
PAZ BB Z00 ) ROP iy (FEJEZIC T i T 4idHa5 2K 2) sl vaik (FE[RIZRICTT
& 2 310 idE)2) .
Title bar Menu bar Tool bar Buttons for changing Zoom bar

the view

== SIMATIC BATCH: Recipe Editor - Recipe - ¥1.0
Recipe Edit Insert Miew \ Options  Window Help

JP|DE’-‘-WEI|§|J£ l%j{ﬁ|n o | | Ty ® @ B |
| T
" D00+ =33
BT [ Recioe /0B
RUP RUP
i <all> 3
‘ ROP ‘ ‘ ROF ‘ ‘ —
4 5 | | :
| | Instruction I Wl LI
NOP CP2_Status | : 10 Sec |
1 ' | y [60
MOP I
|
-
|
End |
. \I | | »]
|Status: in progress cﬂ \ e e \V‘ﬂ 7

Cuntext—7itive insertion of a subconkainer %r example RUP, ROP) o B psrtest 09:56 5

Status bar with Editing window with recipe structure Editing window with a ROP
context-sensitive of a hierachical master recipe with sequence (editing-level 2)
information ROPs (editing-level 1)

SIMATIC BATCH F/f, V7.1 SP1
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BATCH F 77 i #7:45

7.2 i ) RIERAT

PR

By

TEA

RERSCH

444

T bR T 7R EROT A RR S O A (ROP) BUEX & . fEtbfEid B i+
PAT R IIERAT IR G5 :

o Cp BATCH s gm¥E
o R Ham/ME N EIRE,
o PR E DK NIER KN, UK

o HAMTENER,

SRR T R B 0TS S S SRR e RN S iR
AT A 4. B, (USSR, A e Edit) >
"(Delete) S fr 4. JLUAKEFEIH A H LUK (L IR

TR FREFN 5. WE—RMEHL, Wil B i e R TiRe. R BUbRTR B
B A BRI AR T RA R T LR A R T RE CER ) o RS Bon R4
PRIGTTHE . BT AZERASRE 1R 2150 T IX LI Be VR a5 B i i nl A AR Y,
MIZhfg. ToiEIEREMHEH UK G B R

FERI T SRR ER 0K 21 2o B B BANYGES IRGS R . B B R4 o2
YRR GRS T 22AL o

R RIZE MK B, A B 1 FICMIEAE L, B, S M . B s
S L

AERASE IO DI, 6T LA B30 1 RO AT (eSS R TS
) O 2 SR

AP Bl b AT B, AT DA s 35 SR R AR 2 iR D01 38 T DO RE K ORI . HU gL
P ICT e B RE, AT e i Re AR B B o

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH A7y G ##
7.2 Jiz) Rt

ABCTT TR AR
B A R A RNy SR AT — N T UG T R FER LRSI, B AT
G HICR MBS A, LUB IR GG RR . XAME KRG FK T
TRIFI 2 TCR I R GEA R AR E A E— (1

W
=

HIT B e R R (00 446)
WFEX 5 (5T 451)
BATCH B /5 % i i 1 /2 20K 78 (UL 458)
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BATCH F 77 i #7:45

7.2 i ) RIERAT

7232 HATH®EXSEE OREDR

S UL
o <4——— Maximize in levels, until the desired size is achieved.
= 4—— Minimize in levels, until the desired size is achieved.
y 4—— Set medium zoom level (normal size)
~ <4— Fitinto used area
4— Parent level is displayed
=t 4— Select zoom area for optimal adjustment to window size.
K2 4—— Activate Context-sensitive Help
B Bk WoR I Thfesh, Sk ar UL R 7 (View) >* A 31537 (Fit automatically) 5 ¥y
LR H BN R, SIS A g AR & LI RS, NN B
BN s N .
T G

XS AN AT DL A R I BN . oA 1R ], 8 AT DRGSR R o

Close zoom bar

r-
,Zoom Bar Zoom in stages
Zoom slider I
N | 1
1]
)
Sl Display of zoom

SIMATIC BATCH /i, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.2.33 WiEMAP&E

7.2 | ) IR

fas ] LUE FH S5 1 HE S5 H ¥ & (Project settings) F1“H] /' #% & ”(User settings) K 5 2

BatchCC H1 BATCH Mt 77 4 45 % 1 5

g

WE. “JiH% & (Project settings) %G HE 405

ZAETR, WA AT T A AR S ER R T2 2 G M S . e
H"(User settings) X iGtES, B0 LLIEATA OCH P S TE 5 4. A R Aks X7 T

-&EO

o RPN A IR (Options) >“¥ & ”(Settings) >“Tfi H % &"(Project settings). %%
VEGAT T I s AR HE, ZE 206 i HE AR 448 T LLEAT 2% Fh I H % &

Project settings for "TESTMP_¥71"

Used Plug-in Modules

General

Max, number of substructure levels;

IV automatically resolve excess substructures
¥ allow simultaneous ROPs

Warnings I Colar

Electronic signatures

v allow editing of recipes with "Release revoked” status
¥ allaw online setpoint changs

¥ Transfer online setpaint change ko active skep

[~ Unit selection according to conditions

[V Importieren von Stoffen erlauben

¥ D

archived batches

¥ all online structure modifications
¥ Active batches must be stopped

| Archive I ‘Wersioning

o1

Default

Cancel

Help

SIMATIC BATCH Fjit, V7.1 SP1

EeEF M, 03/2009, ASE02171120-01
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BATCH F 77 i #7:45

7.2 15 PR T

o IEPE A IR TR”(Options) >“¥L & (Settings) >“H 7 5 &"(User settings). i%i%/F
FEFTTF R RS POREHE , 7R T AE A m] LA T 80 FH P B

User settings for 'PCST Systemtest’

Format iDimensiDns Zoom | Language

aligrment Set up graphic in the background
@ Left Display unit
Centered

Og Adapt color

() Right:
[ ]pisplay single-line labeling larger

Step/transition Hirweise zu den Werkzeugen anzeigen

(%) Block

) Rechteck

i) shadow _—

3 . o e

O Buttan Max, number of parameters in toalkips: LIIZI v |
Max. number of lines in tooltips: ! 10 & |
Max, number of conditions in the notes: : 1 & !

[ Ik H Default ] Help

YR R AT DR RO H BT BB I VEAR A SN, 15 H B SO A B (13 B (Help) 4%
Hl.

SIMATIC BATCH /i, V7.1 SP1
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BATCH Fi 7y % #i 4%

7234

EFIRE

HRDRE

AN S

EiFIDUE

Xt B

7.2 i Y IR T

ARAERIEX S

FITAT 5550 G2 AT R T2 Th B AT AE R I 42

BEAh, “GiE"(Edit) S0 b iRt THFERIZhEE . T AT R A PR T AT )
e, (e (Edit) Sz (UK 20 .

FEEFEADIREE M TP S XA WINREAE NIzl . VeI BUE S E
T A X L Th fE

V5 Bt G AR AR () 15 U G

1. BN %R

2. PG

3. XXZPATERAE Biltn, FTIF. MER -

FBCTT BT AL T8N (Insert) iz L1 .

AR, A m] U LA oA R R S B bRk A e . AR (View) >“ TR
£”(Toolbars) >“#A"(Insert) iy 275 THA,

TR AT LR LA 5 2

o Xt g K br.

o EFNG, MRIGIEPE A YR (Edit) >“4T T X1 5" (Open object).
IR GG, v LA sl s et A 2%

GBI JE TSR, X E g TR AT,

B, Wy RS .

i 1“4 8" (Edit) >* B 1" (Properties) =i i AT T —DXFUHE, AR IZAHGHEH AT DL & G
ABLE P IE X B ko
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BATCH F 77 i #7:45

7.2 i ) RIERAT

B R ER R A

ERGEPUES

jilEysed

BN E AR

450

AT LMEAE Windows HIEH A4, XPRZHOS G T, KNG e . X sk
PRI iy 4R G 4 (Edit) S b 3248t

BARFTLMER] B0 BHxS. WERARHRAREH AR, Jehri 55T

SRR, WS AR REH R R S Ik, WEREEZ A A 2Tk
RIZLrE, A 2 Fhaaiia] Lk % .

i
PATHEANSRAERS,  H AR & 08 i b B AT 45 E

L S mT AR G g 1 Hh S Rt R IR A4 R

TERTLAMBR AT A X %o IBRERAE T LAY . 007 e #R A4 H g/ BatchCC A ilER

U/ (UndofRedo) 2 dr 4, 7 LU HUH B HLIN 15
BT TR IR . 65 T L ik TR i

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

7235 EENZ
il B TR

7.2 | ) IR

IR R BE AR, AT B BL R 28

fEHERERAT L HF

R — U0 MBI I E CIERE TN B (S5HT0E) AR BB 1L
HFATH BAs e iy RUP. ROP. RPH. SUB. ESIHAIER, Hinlitd,
PUIBVRLES T g Tk s bl IO o7 S v 5 ) NS A w7 N 2 S v 5 R i
HEPE I SR IR [P BR A Y BT AR A SORGE RIS, AR I 5o D PR el
M AGEFENR Y+ 73 ST FEHE o

W IEFAIG DR A D e 5 ia 20 B AT BRI P £ — T IF I
ROP.

HEATHOHEI , HL 0 i O G M e

FHTIPEME, U5 AR AR ZcBOF s Wl bn .  BIS BUAR LN, Prfi e e BIEEHEN 1Y
TCRKHIE T . RS ITE R TR AL T EREZ AN, WX ST SR IO %

EHREZNER

WERELEREZ A XS, MAEH Ctrl SRR i flbr . ook sk, Jf HAZ
WO PR SE T T I I0 3R

BRI

WAL R THAREIN S, WHZAE Ctrl BEANE, IR o BRI TS0 e
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BATCH F 77 i #7:45

7.3l
7.3 Hic 5 #a b
7.31 =AWl

7.3.1.1 [T

JiFBET5

HA L

452

i1 BATCH U7 gt o vl LA A IG5 AL i P IC 7 (0 S5 44 SR T, mT LAKEIC Ty
JLEINIAT P AR B 2 7 S5k

o
THMA LR FEEAT I S

NV T TR SRS R, e VRS ] EOP (RS #E (ROP).  HIfc J7 B Bt
(RPH) 41 R (I BC 77 BRI EPH IORC 78 4E . X 4% EOP Fl EPH J&fEFEAFE M T
FEwTHARBER (S 543E ES A K1) -

is an ordered set of

assigned to

is an ordered set of is an ordered set of (optional)

assigned to
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BATCH Fi 7y % #i 4%

7.3.1.2

JRE

£ BATCH Fo 75 9w #84% i 7 4544

7.3 B i

NS R SR T AR BATCH e s g 45 e g S V- HC T I, 5 G5 IR SEAAR 57k

THRIAG T UL e T A4l

) T LRI, 7 025 M 0 2 T 22

Editing level 1
Recipe procedure (RP) with
substructures (SUB), ROP and RPH

Start

Editing level 2

Substructure (SUB) with
substructures (SUB),

ROP and RPH

4L
T T

Editing levels

3..10

~<_
~~
-~
-~
~~_
-~

fEHIEZEThRE, AT LAWMBARC S B AT AE - FEC Ty o, TR RN AT 20 SR I

Jerp AT .

FERFANFE R ST LARE R 3 U o
ERAR R 2L [R5 e s Sl i (720 2
MR . AEAT 2l s B Ik [l & —

SIMATIC BATCH FJIf, V7.1 SP1
EeEF M, 03/2009, ASE02171120-01
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WERRIEFEBIE, WIS 5ERHE
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BATCH F 77 i #7:45

7.3 B i 71

7.3.2 BRI

7.3.2.1 |=45

JERETT
flfJ1] BATCH P 77 g il LA QR SR e T7 o m] LLGUEE LA R E Ty -
e [ififi ROP [0 ALTi (T 455)
e Al RPH I ZLALTT (5T 456)
e i f1 ROP HI RPH [FIZ44HC 71 (1T 457)

SIMATIC BATCH Fit, V7.1 SP1
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BATCH [ 77 9 #4-4%
7.3 Bt 7

7.322 #H ROP 2Ry

g_EJLA‘
THEERT WA ROP )2 HAC T AL K. fERC T "R ICRE)T (RUP, recipe unit
procedure) 77, & LAY JLANEL /7 #:4E (ROP, recipe operation). iy #:4E B4
EOP B, X4t EOP fEEAf M) TR Bt Gl GEZS0 Y ES A a1 KHEs
)
is an ordered set of
is an ordered set of
assigned to .
is an ordered set of (optional)
ZmiBIFATH T BR-1F (ROP)

HATLE BATCH #Eiil H .0 10" (Options) >“1¢ & "(Settings) >“Iii H % & "(Project settings)
>“H " (General) JEI-R RS T “ o947 ROP”(Allow parallel ROPs) I+, 4 fig 4k )=
RICTTHIIFAT 73 3L
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BATCH F 77 i #5:#%
7.3 B Hith

7.32.3 WA RPH K EHE T
R s B T A TR B RPH K27 I EA S by . AR A, SR
EAF ] ES JEAT TR B B b . NPT BB, X
A LA E4S EPH,
Te 77 W B AN B B AR IC 77 a5 (RUP) Fif.  HEC 7 BT LAZE T 2 ROP i
Mo EPH #{7Bl 451X 26 ic 77 I B

is an ordered set of

is an ordered set of

is an ordered set of

assigned to .
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456 PeEF M, 03/2009, ASE02171120-01



BATCH JI 77 i #7:45

7.3 B i 7t

H#H ROP Al RPH /= &K J7

i} SIMATIC BATCH i n] LI AC 77, iy HLAC T B3 flH EOP [IC 77 #:1F (ROP) Al
HH I 7 B B (RPH) 41 IR 7 B4

is an ordered set of

is an ordered set of

assigned to

is an ordered set of is an ordered set of (optional)

assigned to
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BATCH F 77 i #5:#%
7.3 B i 71

7.3.2.5  BATCH i gmiESF R ERER

R
N R E o T BATCH Be U7 i as AT g RN, R R A M BEA R R T7 1k
JERICTT AR AT AR AN GO0 S AT 9w (g 1 FigmiE o 2) .
Editing level 1 Editing level 2
Recipe procedure (RP) Recipe operation (ROP)
(with recipe unit procedures (RUP 1 ...))
Start 7 Start
RUP 1 RUP 2 o7
o T
—I——|— e RPH
' N I
ROP ROP T T
| ™ RPH RPH
ROP ROP N | |
| | S SsSs
~ —_|_7
T T Ny
ROP ROP S =10
I I h
—1
End
ZRAE ) 1

G 1 IEHT LT M, R LT AR R LRSS OC R R . BT RO RE
(RUP) HIlic /7 #:1F (ROP) 2. BRYEEIIFE, n DMEHELIEAT R . %8R RVFEA
[F G [0 ROP 2N

A

B B g

FEZMCF, ATLAfEgAE A 1 GFAT ROP. IR, 85, FHAHAEL 2 T
ZituER.

HI T IZREAATF S ARE, A B AT R A SR s = I A A
PR i 45 09 AR TR o

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.3 Bt 7
G 2
St 2 FT-00% ROP Y. ROP JFE N “TFE"(Start) SHIFUGE, S8 2 T
SOFE AR . R4 ROP TR LL“4E o1 (End) SDIREER. H 1@ L& R0
BTN PR,
BATCH Rt 77 4riE 25+ LI

== BATCH: Recipe Editor - Recipe_REA1L - ¥1.0 [in progress]

Recipe Edit Insert Wew Options Window  Help

9| DBE L | S ARLL B™ W
E_-_’T!JREEiDE_REﬂl - ¥1.0 [in progress] Hi=] T[]
— Zoom bar
Fitch Culture Fermentor | — Start -
Brewh1 ||, | [Reaktor A3 L, =144
}" 142
. |3|p|_,a nnm-l!ﬂ!T_p HlﬁlT_,ﬁ. _JEJ
Pack CWW 1st Cult Fill | | Eﬂ
11 ;
| —_ =8|
Transfar CYix Synchroni- B B3%
zation line "’
= between £ .
RUPS CIP_A GIPl_p
Transfer Gy | ? | '
a l—l i
’ ‘\ T

|F'ress CIY | I l
7 I N \ online 2

I o \
1. Recipe unit procedur 2. Recipe unit procedure
(RUP 1) with ROPs an (RUP 2} with ROPs ROF sequence with the
recipe operations and recipe operations SFC structure elemeants,
steps, transitions,
A RUP is always shown within column, ie. branches eic.

the ROFs are arranged vertically.

I !
Editing level 1 Editing level 2

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.3 5 Hi i
7.3.26 R BT P 2 B [EP
JR B

R RERT, T LU 1 F REJLANRE T TR (RUP) (15 ROP (R ]
W0 AN BRIy SR 0 )25 G2 9T 16 1 6 B4 o7 LUAT LI A PR . 7
SERLTE, WA YRS A BT ALy SR RS AU, T TRF A

R sE6] (FHZE)

FE N PSR B R, AERT SR AN 5 e RE Sy (RUP) Z RN [R5k (RHLIE)

2GS R
e 47 1: ROP 10 1 ROP 6 F1i5:0 1% 20. 5. 13

e 170: ROPS5 FIROP 14 J1ii 0% 11, 16

460

==BATCH: Recipe Editor - [Recipe_REA1 - ¥1.0 [in progress] ] =] E3
Recipe Edit Insert Wiew Options Window Help - |5’|i|
oDEBE|S s |([xOD00 4+ |
SRRV -5 W MR-l
Fiteh Culture Eermentar I—FIEFETWTUP—I = ——==l
Brewhl ||« Reaktor A3 ||, Feaktor A3 || - Zaam bar -
B l 114
Pack G 1st Cult Fill :
-1/
" |17 EJ
| =
Transfer CYWE : il
m 5
Tranzfer CWyY 57 %
| 13
Freszar GGy
1+
| o
1=t Cult Ferm
| 1=
ROF_B3
15 —
|
| | ;I_I
L5

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH A7y G ##
7.3 B i

TR SR ZE Z A1 #R
T LUSE SRR )20 K B ZE B BRI o 45 IR IR D PR
1. EFERED R
2. {EIAD A ORI s i £ B 2" (Properties) 14 o
3. A H Bk 2A H“FH %7 (Blocking) & iEHE.
4. Fkiffie” (OK) JEATHIIA .
gifl: YRR, JE, WUFHK ROP/NOP SZR1ES) CANGEAE [

Rl B (ERHZE)
AERHZELL T Wkl 4 H 107 R i, &R
o ¢ ROP 10 2 i, SEIH RUP“ELARL & (1" — 0 kb B ROP 20,
e 4752/ ROP 10 fil ROP 6 2 J&, 4 )55 ROP 5 f ROP 13.

== BATCH: Recipe Editor - Recipe_REAI1 - ¥1.0 [in progress]
Recipe Edit Insert YWew Opkions Window Help
eDEBH (S s2e [N ODD0+ =3+
o e e @B B0 M K2
Hpecipe_REA1 - ¥1.0 [in progress] M= E3 —— =l
_'—H_'—Hﬁ —Zoom bar
Transfar T Transfar C : 14
-1/
i2 1 —_—
: 1]
Transfer CWY il
= 8]
i3
B9 %
Pressor CWWY
1%
o N
TEEzr LA st Cult Ferm
In 2
Cnilire [ 4
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BATCH F 77 i #7:45

7.3 Bl 75t 71
7.3.3 DR B IEC T ST R
7331 EHMEHTE
ik
DL 4544 70 28 n] 4 A\ B3 -
LT R 18 A F 4L B s A4
fid /5 F£)¥ (RP, Recipe 77 (Recipe) > # & (New)
Procedure) (71 463)
it J7 . CFER (RUP, Recipe Unit | COC 5 2P c & (HRAIZER) | (U0 483)
Procedure) (1 464)
fit /5 #4F (ROP, Recipe CRRL T REFICER C9R N3
Operation) (L 464)
fic 77 B BE (RPH) (11 464) LR 2P e 3 CHRNSER)
CRETTMBE CHEN B | (T 486)
THH (7 468) (IURLRFAL | CORCTRT I CRIAR D
J1)
G (T 465) ERZE ST CHENZE R | (7T 484)
EeAE 4R 4 (UL 465) CUERAE R TES (AR | (1T 487)
FER5 (T 466) & R (CHRN TR | (5T 489)
FEAT 2> 3 (UL 466) T s CHRNBER) | (7T 490)
YEFE 7 (VT 466) F R CHEA D | (T 492)
[ 2P 2L (U1 466) = [ (4N ) | (7 493)
[E20 il (UL 466) =[P AR
fE3R (71 467) 3 fEIR (RN | (T 498)
AT (T 467) (1 BATCH BCJ7 94 H sh4d A
A SR (UL 467) (th BATCH BcJ7 g a4 H3h4diAD
SIMATIC BATCH FJI}, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.3 Bl #ih

M7 TR MR

® ROP. JERITZMIA S HAEKIERT S (HE) o iy 4 HILHEZ KR o

o KAUMELMEIER S (M) Sy BATIERAEMPrE (EOP. EPH) [MIXI%.
fE R

S AV A2 105 2o S 1A o s N S NINEE T A PTve - 71 P R 2 ML DIVE SR E SRS 55y

It

RS

FRARIAT (I A 2Ry o ELHRS . AT 58 e BT A IC B Be Cr BASE s SR ALL T
DO Ja, AREPIWTIEAS . TR A PN N BN, A RE Al R AT R

7332  EJ#E/F (RP, Recipe Procedure)

BR
ey e G R R TR R i st . AR R, CRAEH] th3EA
PRSI A R R P LR

[(GyspEag A
By R o D T8 o s (i oc. Al DV & due R I Z5 i e sk 28
L NI (57 P v s D BUR S SN TP 22 oy AP S Wl ki

JR

BT RSP IR J I S e T IC T AR S HL . @ RO 28 %R, AR
i R E BOR RS
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BATCH F 77 i #7:45

7.3 B i 71

7.3.3.3  EJ7HITEF (RUP, Recipe Unit Procedure)

Bid

Fe oy HoeRe P s oo R TR P R o R

By IR T R B LR A ST RC T B B R R R R A
AT ) 0 SR AE S bR o XU AIARAEL, 3T T IC Ty 5 O > ) s PR A

B 77 B TCAR PP 22 T LR DUT 2hRe:
o e ia) EOP 28R HIC Iy b Bt 25
o AL S U LTI D
o JHTEBRAENESIM

o BAFLIRS

7.3.34  FECH#4E (ROP, Recipe Operation)

Wik
P T A AR IC 7 B A R TR P AR RSP e R
S h e ], BUE I RE b Al 5 X L0 E
HATLLRH AT B

o BAFLIRS

o fefgViIn EPH SRR T B B b

7.3.3.5  EJ7#4E (ROP, recipe operation) " HC 75 > B

T Ry e R T R A B

TEAZGN T, BT B BLLAERAT: B3R 2 5 EPH SRIEL G BC 5 B BUE NI

464

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01



BATCH A7y G ##
7.3 B i

7.3.3.6 FHH
[RGB T7 B S5 A . A & ml LIS R C 7 B e ok iy 48 . |+ —4lime Jy
T IR S R e H SR X, SR G TS HE SUB JEATHEHL .
TEER AT DA R 3R A TR TP . EOP KA (I 7 Ee Ve sl EPH 28 (I 7 o B
Mo WL EENEC T 20 B4 BCAN R B F T o

A
THMA LT FEAT R

7.3.3.7 FEERIH

JEBRAE AN e B BB 210 7 B G REF (RUP, Recipe Unit Procedure) 7, 2 Afi 15|
o FEBAEARRELE EE T B8 A AR 24E BATCH BE 7 4 2% Fh BRI 4T T o

7.3.3.8 BIERTES
BAE DL FR A U VFAE AL BERC U7 A IR] 4 4E L BoRde 4. ERL R R & HrtH 2 [ 25
o g4 (NOP #FIB) .

- KA A IERCT .
OUEERT BN EE !

— WA EHRERAE R THANTC T A S k.
SEf): TEOCHIIET] V27,

o AATHINIETUNAR S (Al O IHHED

— KA
Sefsl: TR A H .
— T

ST E R R TR ERAE IR R LRI 2 b o ARG ERAT BRI
INESERRfE, FEAGIA (LD .
BN CEBRED W AR R 2B T B AR I BOE (. SERME R AT DL h AT o1
fiti: SEBl: FEMGE G ? /5. EXMEEOLN, LAUE AR
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7.3 B i 71

7.3.3.9 L2774

B R R i M7 I T A2 —Roe R R, B R R .. s DR E PR
VRS

7.3.310 T
AT L 2 DS ACEHES I, X L85 b X AE T R SR A — i o

TAERE
ATy S AE R G RN A FR LA . I A R I AT 45 Tl R
ATy S0, WA — A BT U T 20 S0, A S ab B8y 57, B4
BB kAm A7 fa, (e DO HHT I, Joie s 3l 2 Fahiial. Y
WM BUE T A, Al it n s e .

EEZ53
PR 53— Fh 7 v AR 7 0 B 2 1n) Gt AP 2 (7T 466).

7.3.3.11  ®FEHZ
EHESY S A D AT EHES PR AR, 3 P AN I 38 5 4 7K - R 7 T AR B kA T
U

TAERE

AR RE Y S0, T DAAERE R AR PR R B ML IR T o Py T A £ (14 2 A S I
Fe B RAT MY o

73312 [FP&
A5 R R e R G U AT BRG] E 5 4 (ROP) (AT

7.3.3.13 [FEH
FERENAD A, AR LA 8 J& AT 7 040 2 458 7 o

SIMATIC BATCH /i, V7.1 SP1
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BATCH A7y G ##
7.3 B i

73314 {BF
PGt 220 BA—ANEC T A0 BT AU — AN RS 1R [l A2 2 R

T3 SCVFIUP SR 2 I

T3R5 PR RS RR B[ A5 P R e D 1 I SR AR o S R LM e I 2% A1
WP IR AR . AR A NAZ LT, AR VPAF AR ARG A2 R, f
EHAL .

73315 5%

DI SE AT RENI G, DU LSS AETEE LR EIF e . iR s itk
Y5, BATCH [t 5 g% s 2% H Sl A7 i BOMEE R 100 27T o

Be T B B AT o A e Bre T X B A S e TR AR AR B B A
REAF B A BE T B B

TRAFBC T I A R 2B 2542 B A A2 AT AN ZE s i NOP - (TG#4F) Bei by
B, MK 5 7 45 2% I ER o

iah, ZEBKYE, NOP Joztidnl LUH TR > CE LINsfT R4,

7.3.3.16 HBHLIF

DB TEA RN G, DU LSS RIRZEIF . DIk, By iR
e H Il BT B BOERS 10 A2

Bt AT sy — e .

SRR AT RO RS, RARGEAT S, Bl I A (Insert) =i o TR H 2 4
UNEEVASIHIEIN

1=

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

7.4 k4G

7.4.1 WA 48 e PR

BATCH P75 4n 2%+ B0 B:

1.

2.

3.

4.

5.

6.

468

P LA 2B 7" (Recipe) >“Birge”(New) > L 5" (Flat recipe) Cif T Efd ) Bk
“BEJLE: T4i#"(Library element: Substructure).

i KNI 1 RSB R

R 1 T IRE RS O CTE58) TPaNEL T 3R 451 .
AT LU B 7 R 6 2 (recipe procedural element) 81 BT a7 (1) 74584 (= SUB). X
Hi“SUB”, 1T 45 i ngmE o 1 o

— BB R, R TR IR DL ML
MO+ | =2+
iR JuEMAE B BARTEEE L.

— R SUbRAZ Bh UGN B b T A B

ik, JUERBEEAN. BT ITR MR IH A R R bs et Lo AR EEAFEITR
IS AR SRET R Zh REA 2L

= i R GEBETR) Bid% ESC LT ATV SR U4 5 e B

70 JE X TERE O RN T PR BTt . A L 5 D BRI PR S R (1)

" (Properties) 4% -

FEPIE BN T e, HAEA N @ PE TR RE R B AT T e . BT R
1B, VEAEF R P s i 5 B " (Properties) iy 4 G o 47 BEIEATIE RS
KA LT AR . EHAT R AE, T IR a2 B )57 (Recipe) > I
iE"(Validate).

T P Ly A BE 77" (Recipe) >* 5 77 47 (Save as), Kihc 7 147 5] BatchCC #f+
1) T e 6

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 BIEH

iR

AR AT 5, FORAES D LERAT " (in progress).  fEiZRA& T, 0] LABHINAS sl & A

F IR B A 7 (R E o
o

G AHIC T I, T LU AR B A 2 -

o BEANEPES TR A A" (Help) 444

o REMITLREI XL 47 (What's this) # 8. LG4 A L H RO TR I <F1>

s ft g N2

Z 1

R TR E R A R (0 472)
W07 A2 R 70 2 (T 462)
VBT bR ST R TE (9 505)
WE L TR (51 507)

WEE ST (7 516)

R UERC T (3 525)

AT 7 B TR s A (51 526)
I A (7 526)

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 7 %474
7.4 GIEEH

742 W g 48 = R T

BATCH Hi 7 4rig a8+ P&
1. EPFSE a2 BT (Recipe) >“Brge”(New) >*E &L 5" (Hierarchical Recipe) (XTI
fid /7)) E“BEJCE: fic 5 #4E"(Library element: Recipe operation).

i QIR T, KRR —ANE R RUP 247 10 (e 1) o Bl
BAER, BB —DEAHEEA ROP 4y G “JFin"(Start) f1“45W”(End)) 1% H
(G2 2) .

2. MPHEHRLTT, WEEBA MR eE CEA (Insert) >“Bt 7 727 7T

%”(Recipe procedural element))
2R — RUP,

3. LEJEPEXTEHE BT TR (RUP) 73 BC o, T RUP sRZEEREIRFESE b )
2@ " (Properties) (“7-fii"(Assignment) JEITR) .
i
RSB B IR, HS LT HRICH R XA, R RITh LR feEmpy
BT G RIS BEA S AERY B J@ MR AE TR Bos ke, IEA Pk

4. FEGRHTE AR BT LRI SR
- ETHAHEFLL Mz
DEODO+ =2+
i JURINE D RARRET L.
— R SUBRAS B A R BT AL, AR A R DR na BT IR A

gik: JUEREEEAN. BT TCR K EFSIIR A AR TR L AR TR I
MRS I ZhREA 2 o

_ ol R GEERSEL Bk ESC AT LT MG R ) e SRR

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

5. WRIKIEBRCTTCE, FEEMMN B IEHER AT R W E . EHATILERE, 154
AN AP S B b i 4 g 1t (Properties) fiv4 G Fds A3 SEEA TR HE)

6. M AL A RE . EHAT IR, IEERSE a2 B " (Recipe) >l B A
E"(Check validity).

7. kPR a2 B 7" (Recipe) >* 74747 (Save As), 4L TT R f7 3] BatchCC
(T E

gidts BUEARANGT G, RN LEREATH"(in progress). FEIZ%IRA T, 1T LABR 54
SR AT TR R (L o

H )

G AEIC 5 N, AT DU SR B AR 2 B

o BEANEPEXIAEAAT A (Help) 4%l

o WLHITTEMEBAL: FEGEE D PR R IR <F1> s K2,
Z

i A SZ T G 2 BD (UL 474)
AL 5 45 R0 & (I 462)

A AT AR 2B s 1 (0T 505)
i EAL e E (W 507)
CE R ETE (W 516)

WAUERC T (U1 525)

HATHC 7 DL T A= 7 (00 526)
HRGH KAt (Ut 526)

SIMATIC BATCH FJIf, V7.1 SP1
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7.4 GIEEH
7.4.3 TG4

7431  wWHREETHEITTH SR

TEXT B IBYE T 53 R BCTT R IE € 0. W TRER G L) R 44T 5T
IrBCe XM 2 M INZon n 2) =HA  Rgn Cltn, R T T R X
SR 5 XL R LA B0 BE R R PR RRAE, DU S 2 SN I

I FRAE Y FRICAEZ 7 IC (DT 480), 1544 [T TR 1) 20 BRAEAT R AT

HAINEB &R RITTAI?
o WURA BUEPEA AT A0, A A KD R T A
o R ELEFEHA AT, TSI P AR T (0T 476) R g

AL BRI T AT
BATCH P75 dn 4%+ B0 B
1. FTIFEETT -

2. BT
3. 7 B Rk B M (Properties) 4 GRS i A SEEATIE RS

B e 2> id”(New assignment) F4¢4H
B B3 FC” (Allocations) 1EI

4. BRI R R TV
— B A AN AT DG R 1 BT SRR A BT IE B (Unit selection) S 471 H .
— XK A TS R I T A XA B AR BT IE $E (Uit selection) 1+,

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

5. {E" I #% 1" (Equipment selection) ik £E 5170, FRIUHEFEAE G %ML T o
Feif e CRIGIRIEITD .

AR RN e B R TR, R REFE e, ARG BOH LR AICIREDT, wT
LARRIAE SR AT BC 5 S e R e R A RO B (FE W] I Zh €7 (Available functions) i+

B3R .
6. MR TE, R ke’ (Preferred unit) 7B Pk FE Dk IC.

U AR B R BEAT AR AT H G A0 IE, KA IR G B B S ek B it AR ™
7. Hfie"(OK), ihiE#E.

i 2O RoRAER T U EIEXIEHE S . R Bor Bea il eI, HRETR BT
WPTATIESE K S TTHhAT IR BL

SIMATIC BATCH FJIf, V7.1 SP1
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7.4 G
7432  WHBEXET K RITHSE
Bic 7 FoeRE Y (RUP) HFIE A c e e et (g H D, sUEH TifE Hocie$
(B HBE TR RS TR A 1) AT .
Bt (BARGE RIS 7 RUP (XS gt fae . et fed, il TRARS+H T
I EH BRI PAT R ICAAC . Bte U, R S PR R R B g e s (]
W FE AR IC S e TR X IR ) 5 X S g AR A A B G BE (R Bebr e SR AL, DA
161 5F b B
WURARAL H] FRLITAEZ /0 I (0T 480), T #4 T IR (1) 20 BREAT 154
BRI ER &G RITHI?
o P EEPALAKMMIRIC, AR Ik AT A
o IR BIEFHALMMHIT, W AT E R A& ARIE IO (VT 478)" 43 Ak
[P0 BREPAT A
BATCH BCJ7 4r 38 H P IR
1. FTHFECTT -
2. &P RUP (LRI AT S Ry .
3. {6 b skt k@ M (Properties) fiv4 G Blbs A7 %+
4. BEF“Iri”(Allocation) 3L .
5. HIEPEM LSS ML
— KK A A2 DS R I R T AR AR LTI £ (Uit selection) 33k 41
Ho
- MR ICE S A H AT M E ST X R AR H TG IE $E(Unit selection) 4
g .
6. {E“W % 1L+ (Device selection) Ik HIEPEHLICH, FERTHEREAIE A ILECL 7 FRoCHE T
[FABLE TG CRITIRIETD .
K EFEA TR BoeR e ik . BB Ie, SR T BUN R o gk
i, ny RARR A BT ooy A B Dhse (FE“n] - B B (Available phases) 35+
BR) .
SIMATIC BATCH F/i, V7.1 SP1
474

#AEF M, 03/2009, ASE02171120-01



BATCH Fi 7y % #i 4%

7.4 gI#EH

7. WURTFHRE, {E“E ko0 (Preferred unit) 3 ik H— ik HaoT.,

UER QU A AR BEAT I E 0BG, R 0 D 1 8 50 R R R G AL A It
Feo

8. Hii"ifie"(OK), Hiilikst.

iR IR R I U R R PEX TR s (B TEVE T o A BCKY
B, AT BT AR 5E ¥ B0 R LLIRAT (B BE o

SIMATIC BATCH FJIf, V7.1 SP1
#eAETF ), 03/2009, A5E02171120-01 475



BATCH F 77 i #7:45

7.4 GIEEH

7433 GEERPET&AHEERTT

N AT R PG G0, W] AR B0 28k fF . FEIXFRIG DL N B R FICRT
AW IX LS AT OFE) RITERIG T . RGBT BL (ldn, Sy T AEfb A4
b BB R BT A AT R ARG D AEREA IR R T ROR A B R
VAN ip/ I LT

R

N T RSN TTAAT, A4 L (Allocation) SE TSR H ) B TG IO C 75 R 8 P
“4A1F”(Condition) &5 .

A5 FH At P T rh o R GE R P I K 4 i £ .07 (Uit selection through conditions)
TETAOT EE T, DAAE R BT B BC 7 (R BRI

KT FMH—EEARNTE
AT AT AAEAH R EC 7 S0 G, I HonT AFE IR 2L 2 0] R IX L8 46 11 73 e 45 G
MPEAR S AR BRI, PEETRII AR REE R R S AR B R

[ W ids 24 M
1. FTIFRCTT -
2. XN TRPRCT: IR AR
3. B Rk B M (Properties) 4 GEGE bR AT EEESS
4

. LE“H AL (General) KEI0 < H BT T 40 iR (New assignment) 444 .
gE. BORSH LI JE k" (Properties of New Allocation) X5 4E .

5. 760 20172 condition) YEI i i (New) ekl
SERL TR B INA P I AT A N I R o

6. A“E i (Modify) 424
SER. HAFEH 17(Operand 1) XFiGHEFT T

7. MBI PP N AL A P (K LG s

8. i F—"(Next) $%4l.
Zh . “IB555"(Operator) XFGHEF] IT o

9. 1P RN GEFEAR A MRV E R A NN e SO s 54T

10. I N — 22" (Next) #2411 .
. HAE% 27(Operand 2) XFiGHEFT IT .

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

W
=

7.4 gI#EH

11, MBI AL P 75 10 0 e PEAE AT AL 5 2R 45 o BELE A m] e AL J0AE 5 0 T A
AT . AR ERIAT S5 T PRSI R ORISR Bl (B
D o

12, EF T —2"(Next) 124
gl WMUAT IS 5155 (Operator) SHEHE. FF AT LA B R K, 01
L

13. EHE“5E R (Finish) %41
g 7E“% A" (Condition) KEI-RH N T 5E B4 $a AR R 7 X A B i 11 3L
B

SEW. ARy (Allocation) KEIH R R R A1 A 2

— JEM: “BERIEFER BT Ot R A RMESCRES . Il KT Ak H Bk .

- A AW BT IERE TR D RE T AR o /e T HIBY BE(Available phases) T .
14, H Sk PR T S5 AL (R R ]

— RALE: P A RAT XA I SR AR R AR LTI (Unit selection) k51
i

- WFRRICE A P AT IS T X RS AR BT £ (Unit selection) 2
A

15, JEFETH 103 FCHems, AR Ja #adi i e "(OK) #2HLIR H 206 T AE .
16. Hili“ifi 2" (OK), Ak FE.

17. 80T LURRAS 75 BEAE <l Jy i Be> J& 1 (Properties of <recipe phase>) X 1fHE Hi 4% 4
e (Edit assignment) #2411, T SUX L E

A ] S e AR 28 7 Bo A R R oAl (U0 480)

SIMATIC BATCH FJIf, V7.1 SP1
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7.4 GIEEH

7.4.34 Hid BRI T & EFERTT

PR ICEREIIROR, AT LA B0 E SC— 205, TEREFICIN, T AT i ALK L A 1
OFED 1o T il B, JERTEL (k) J-7E BatchCC v BB F5 o jm k4T
MR RICY ) EAE TR O TR AAR LA A BN It

£33

N T RERS AN HIUAAT, UAHERC T R S O AN RO T R (AT B4
f4”(Condition) &I, EIXFHEN T, JBYEXUHHE 218 In“4% 14 (Condition) &I+ .

A5 P At A P P T rp o R G RCE I K 4 i £ .07 (Unit selection through conditions)
BT BE BT, DAAE R BT B e 7 (R BRI T

KT FM R —EEARTE
XA AT LAAEAR R HE Ty S0 B3, JF HLAT AR I Se 2 50 s X 28 2 73 Bl 45 ot

MPEERAE O SRR T, R — R SRR . TR RRE DL
T, JEMHEXEHESHE N 4" (Subcondition) JEIT .

At 7 B TE AR B L 5

1. $TFNT .

2. #HTRME i Ak RUP (BRI (715 5 o)

3. fF b N 3CE b k8 1 (Properties) fiv4 GRS Blbs A7 fEEIE )
4. 455092 007(F2 Condition) 55 £ .
5

. R (New) 1441
GERL: FERME R NI T T — SR AT

6. EF“TE M (Change) #4411 .
gE . B BN H 17(Operand 1) XEAE.

7. MIEFR R PR A AT ST Je

8. EFET " (Next) #&4l.
i R ER“ZEH T (Operator) XIS HE.

9. M AN HH L AR E N ERAE B IR AT AL 25 1 RIS A

10. EFE T — " (Next) 4 .
i f EOR“EEVES 2°(Operand 1) 4G HE.

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

W
=

7.4 gI#EH

11, B A e P B L P w A IR SRTC R SR (. 0 TS, IR A A S A A ik
Ir— Lol BANE . W R EERICA SGi% 5 T KRR S, A R SCHRHE B
B .

12, &~ 25" (Next) 1441
ik KRR sS4 (Operator) MAGHE.  FF & &AM FIIFT A G R B HR, H
P RE e

13. 5 (Complete) 144
g fE“% A" (Condition) JEI R HREIN T 58 gt 4% AR R 7 XA Fr g e
%At

14. e (OK) HEATHIN o
5. {E*53 0" (Allocation) KBTI Y IR LAR A

— Jifl: {E R & IEFE"(Device selection) ', i HocHb i m AR ELCRE. CH
B IEPEN LR BT

— A P IEE ROTI IR AR o A v H i fig” (Available functions) .
15. B Se i P I S5 M AL I -
— RWE: A A A XSS FI I PR G ARE FL T IEFE” (Unit selection) 38 HH H1] HY

- WRRRICE A A P RO P X AR LOCIE R (Unit selection) 4
Fo

16. EFEPTH 107> U HEms, AR5 Bl i 2 " (OK) #2LIE HY 26 T AE .

fi F H e AR 2 7 Bodb AT AR R oAl (U0 480)
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BATCH F 77 i #7:45

7.4 GIEEH

7435 RSB TAELSRETEREATTIL

S

FEAE AR L FE AL RE SR TCI ,  FEdR 5 — %00 G BE ol s ARG A i
ROTBLETT, IR Be” T e 0 o

FEL AU IR SO T BUR DUR LT R -

o HIEMIC: WORGIEEALA IR G NC, R IR N EIEICH R B
HEAEF I o

o IR KCIHEIN A REHREPR AN Al R T
o RAFGLEFE.  WAEBRAE RGBT AT T
o WRESH RS HIR PR AR B g EAE I T

BATCH Fo 5 4B a8 PRI B
1. FTIFRCTT -
2. k#%
- XN TRTPRCTT: BRI AR
— XNTREHE T P RUP GZAILIR I 5
3. fEPRESE A b 3B " (Properties) 14 GERL At A BT

4. EFESrIL"(Allocation) KB . OO i~ HC 7 48 F G 7 TiC” (Edit assignment) $
o D

5. {E“SNK"(Strategy) X IEHER, a1 AT I Fr i IR AE L 70 B 0 ) — A

6. WAREFLRESHOET, LSRN A XS
R LLMBZRAE Hhade £ BAT o0 B R AL S5, B okog T AE B 7 I Ry B 300
TG,

7. BliiE"(OK), #iikik+t.

l

7

SIMATIC BATCH /i, V7.1 SP1
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BATCH Fi 7y % #i 4%

“RAE DL

7.4 gI#EH

HA AR U11%+"(Operator selection) SEBS I, H % SIMATIC BATCH ARLZATH .6, i
SRS CRoRtEfT TR R s D EERESS O

W RUP (HAG R4 ) sl O RSSO CRA PR Ja, 7T
TR SCSRBR AT I BE 5 T (Select unit) RFEHE, A AT LA BT 0 5T

Select unit

Sevailable units:

E3

it

?J Ertet b

Ccoupied by

Batch ID

R Teillanlage A2

TwTeillanlage A1 Batchzz

=]

Cancel

WERAZICOAEAE ], HEAER— EAF R e M. R A Al R I gt
Irikse, WIZBCR RIS — AN . BT JUE 1L E R TR 2

SIMATIC BATCH /i, V7.1 SP1
PeVET/, 03/2009, ASE02171120-01
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7.4 GIEEH

7436  HRRALKETT RITHEL SRR LS

HA AR 877 Be B JLANER 7 B B I FE R 23 i
R WA 7 B BEE AL § BAAH [H) o7 BC R [RIZRBC T v WRRE N 25— AN e s i Bk AT

FEL ML
W2 AR, ok T 5 S0 5 B B AR B Tl i e, BIVEE R B o i n B B e
2w,

BERWNEL DA
PEE - MELSEL, WRFEEN A D e IEE T B . EXFER T, A
BB B A M [ B0 20 B PO AEAT— AN H e D5 B B

il

FHERIREC P NMEL D BC, NAERYIGIERC TN, CREEC T B Bor Be 21VF 2 A R Y
BIC

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 gI#EH

7.4.4 BEARFRCE 5 TG R

7.4.41 BT IR CFBARR)

ik

FTIT BN e

JB

BEFEATIRE

fEIZIRE, W LAERCTT RAEABC T R s R PR 12D O R R DR
Sl AR 2 GO (120 BRI (R A B

o ZZJr: RUP. ROP. RPH
LI T o WAL

N IERERS AT IT I AER B TR 00 b AR 0 7 25 SR B0 BRI (A 7 1

SIRICE I B S AP BRI JE AR R . nT DAgmAE " (General). “Hi A4
Kl (Input material). “%i tH 4781 (Output material). “Z%;”(Parameters) GIfES%0 Fi“id
Fikr%s”(Process tags) 3K % -

W AEAHNY BT 2 B8 R e T, RT LA € B G2 T T B Atk A 1) o e B T
IR CEFE .

.« RO
A AR R (General) 0K e 5 e 00 (RN HLICRRI0) M5 ie
RN TT IR

B E PR AT SR BB A AN R S (ISR s T BAD B ESC SC iz B Hf A
it

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

7.4.4.2 FESIF (SRS

MR

7
HIE R GAT I T R B R A S 7 D BRIUF 10 o LR O A (D REE, A
I HFEXN S ... CRTRE) T EE . .

J&
SIRICE B MR T D RE L B AR ] o I8k 78 2 ZC 7 IR AH Y FR TG A o 22 28 o
S, nTUR e RCRATH TR = e e CRESRe o v LAgmiE i
J”(General). “H AR (Input material). “%i 47 Fl"(Output material). “Z
¥ (Parameters) GIFES40) F1“id FiAn2s”(Process tags) kI 1 i 5 -

R AIIRE

A I R R R B AN AR R GO BT HAS) sfi ] ESC Bk 4 iZxt
ZIRHRATIRE

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Fi 7y % #i 4%

7443

Bk

SR

7.4 gI#EH

W yEESIH

WRAERCTT RSN G, WR— BTG P A P A T A By m] (e . R
FETLRL R AFREAT 0 0C, WAMAAEAET S0, DT, BITAT PR A AN 1 G 2 ] itk
.

U SR PR SCVE A B TSR P S Y BRI RERE DL, IR LRGSR FEAR I JEIE #% o

X HRERC T, AT RIS M R A n] i FE

FEGS T DL TCON FERE 2 B, T B I I H % (Project settings) X5 HE Y “H
FI”(General) eI o () WA 45 11204 T 5T E 7 (Unit selection according to conditions)
SEME . AE S5 2 N BT 00 1) 4 sl 2 1 S5 A RN T

—_

- AEREAE R O BB IR P R AR P 1 45

AT TP E R T 45/ R JE Ve (Properties) XT1HE, SR J5 T JF“/0 Bl (Allocations) 1% 7
+

. R gn AR (Edit) $ I T Tk 1" (Candidates) G35 .
AR T IC, RO T REAE .

N

A W

Fic 7 v P 5 | R 2 36 0 R A 1 o BT FIRUAE ) BRLE 2R
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BATCH F 77 i #7:45

7.4 GIEEH

7.4.4.4 BB Bt C9ENTIREL)

Bid

JE

SRARNTIRE

486

ZIIREH TR BB BER AL (RPH) (RC 7 20 5R. AERC T 5 eRe e AR 1 ) P
THESD, AT LU R E AL, EOP s EPH RCTT Mr Bob iR . 7R R0 7 A B 20 5 e
JrMR Py e, n UK R BRE2EA EPH (G B B S .

T AE T AR R SR IC A R THE N, AT DARR 8 B GRS T
IR EFEIERS) « WA H #"(General). “Hi AR (Input material). “%i 4
E}”(Output material). “Z4("(Parameters) (IFES%0 A FEFR2E"(Process tags) 11

R RINEAET

TORNC T A SR S REAS T B AN B, A AT N R e A A H e, slifd
BATCH x4 HLE% 5B A A 2l «

B R PR AT SR BB A M AN RN B (IS BT 2AD s ] ESC J¢ ot B A
e

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

7445

BR

JR

7.4 gI#EH

BAERTRS (RATRE)

ZIIRE TR A RAE BRI T 2

PR AR SRV AEAL BEEC 7 03 T8) ) 54 53 s di8 o AERHE LUR PURHE 2 I O T —
1 PTIX 53

o 4lift4 (NOP L)
— RN, RIECTT W A fstak. SEl: TR By H B
— i EAIA ;. HRRAE BREAT AN A e k. Sl 1EORH V2T,

o FATHERAR AL CBRAE RREAED AI9E 2.
XEFHrBe PR B AR . U S EOE . fE AS AR SIE R B

— N, B SEBR TR .

— T A, KB TFAE RS R fs R A TR R DRI D SR e R
AE SV TS IR S B A AN o

TN EEE T ROEIRAS BOE (A it 42 7" (Activate and do not block batch).
TN ERE T WS IR WS I P Wk £ 77" (Activate and block batch).

BNAE CEBRED WA SR 2EBC T DI RE MR I BOE (. BT LhR) 5 ZERC 5 DAL BN
HEGE W FESLTEOL T, A DA B SRR AL 1L B S R 900 . ARIAEAE )
Sy B AR A EA AW . SERR R T AER RS R AT AL, S RERE S 2/
o FERXAHOLT, AIUE LA A BE S

TWHITCH, HAETRERG T N RAE Rda 2 AR Ben . @ BUE T TR R
G AT H T A BT R R T3

A A4 AR5 4" (Instruction) . “# #¥1”(General). “Uii AL (Input materials). “HiHi4)

Kl (Output materials) F1“2 %" (Parameters) GIFES ) Sk 154 4 (1) 58 -

AR A R IE I keI By, #RAE T LU A S B (= R RAIEIURIES) .
EHNPIER (Input material). “%i 4Bl (Output material). “Z%{"(Parameters) (idfi%
O IR R S BRSO AR RO (E .

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH F 77 i #7:45

7.4 Gl 7

ERIEAIhEE
PRI RE T L BB AN PN RN S (S sl T RA) 8 ESC RPN G A
.

e I

2R (0T 503)

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

7.4.4.6 B (MATRER)

Bg
I IhRE, W LAYE BATCH JC 77 g #45 H4d N 5 o
FEAL S TAITCHONC TS B 1, AT AT R My A o (] AAE B MR 20 ki [a) 4
ANZANHR
TERCT BAE RO &0 b, Sl N — NI, WA T — AN, KRR R 2 4R
LA AL WRIARAFEBN AL DI R T RE2 101

JR

Al L AR H 0 (General) #E T A4 25 (Condition) 2T 3 . B R 4
i, ] U AR A S T ) b e SRk AR B Gl ROP 5% RUP [{ @ HEIZ %0
i 5 fE K TAG_COLL HeR &R BT 1 .
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BATCH F 77 i #7:45

7.4 GIEEH

7.4.4.7 HATH S CHRNEH)

Bid

ik

A

490

7 BATCH Bc s g dsrh, AEAZIIRE T LAEA > AND 7330, FFAT0 S B A
I RAT . AT 0 SC 5 0 MRS Ce AT Bl L I, A R R 21 5 4k
e sladrd .

AT S, AT LU BT AT 70 S0 A 2 A BIX eI FAT 70 3. fldn, SXFERT L
B DR SAT 2 BEE 3 A0 TGRS I, A REX PR 34T I A

Tt B

FEACERIE], G SR AR ) BT I PN BE A B B2 T — AN AT 30, XA B
Bep i — AN T A s AN TR AR, W e g AL T B s i B B
A

SR, AT SC AT ERAE A b BRI Y SR OCI . Ab T B s & B Beth AN 2
AL,

BT AT LR FREAN AT 2050 AR AT O SOh B Herh — 2%, W ml LAk
B

TAE N EHE REFETFAT 7032 (T 466), MEANAAXI G (S5HICER) A Iz 18] i —E &
s (a2 S E e

75 BATCH Be s g dis b, 4% 0 R )20 BRAE B R AR il A JFAT 20 32

1. PR a2 N (Insert) >“IF4T 43 32"(Simultaneous branch) =i 5o T 2 A% FH R AH Y
FiHl

2. FEERAPI AR R 2 8] i

R BB SR —APATRERS, T RN T 2D BRAE BATCH ey 244 kAT £
1E:

1. PSR a2 A (Insert) >“F-4T 4 327"(Simultaneous branch) Bk 5 T A H ) AH B
F5 4L

2. 44 HUBHRE BAE R BT A S0 %
3. 3 F EUBREIHS BURREHERI BT S WA TURG — A % F

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 gI#EH

LI (10 s = L 1B S B T VA = €4 | R S R TS = iy (i A e d S

o R AE TR FL R K e MRS A IR IEZ B, B K R AT 20 SE s n 21 e A0 seAs o
o HILRE BARRERR I BIR) A A B ek ESC B, Al DUPGH % EAE

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

7448  EFES CHEAER)

Bid

bk

A

492

7£ BATCH KcJs gt EHIZhBE ] LAl —1 OR 7332

Mg S A/ AN T ELHES AU 4L, IX PN G e — 4 2K A TR RS 3R 4T
Bk WANIERED SCHNADERE TG, B P EIRYOE R R PATZINY . N
FEEVEREARS, ATV 45 R LR N AE.

R R A i) — 4%, WA DUE SN IE R 3. WER e B2 2k B
4, MR RUESE MUY«

TP N EHEE PR FE 3, WERIRARI R (GTRTCERD A I Z TAI ) — 2 B A 22 ) 48
WA E BN

75 BATCH BCJs g rh, 420N i) 20 BRAE B R PP il AN B 600 52

1. PSR A AN (Insert) >“E3% 4 377 (Alternative branch) 25 o T B i (R A W 22
o

2. fEERAPIIH AR RZ ] i

UR T EERIBAT G5 RIK— DNIEPERES, TN BEE (K20 BR7E BATCH [t /s g 4 & ik
(g

1. S 5N (Insert) >“1% 384> 3" (Alternative branch) m§ ol T H A% [ A Y ]
Pio

2. R BUBRTR BH A ity ZLE PR ) SR — DX R L.
3. 4% T BRI BUbs TR 3h £ 7 SO B R Jm — M5

o AN bR RETI,  WCRAE AT EOR L, R s HR s R A g S AE N I
Gk

o RHEAE TR PR K A M S AT RSB B, OB R E 600 ST s n 21 e A0 s o
o DR BUbRIR BT IR M BT A6 A7 B 8% ESC B, AT LABGH %3R4

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

7449

Bg

A

¥R

MIERFZ R

7.4 gI#EH

RE CHRNHE)

AR, m AR R o rp i MR (AT R o) ORI T B P i #RAT . 1A
DT LAEA FIFAT 2250 (rRICTT~ [RIZRBETT ) IR AT

FERFA D A, BT DL R Y . R RER 28, IR 55y, BRI
ANy 2L A 2P R s O R 2P 2k . WRORIEFERLIE,  WIZ P AN S5 e
WY o AEAT S KB A I — S5k

U T B R R T B G TR BHT RD, TR TR (1925 B4 BATCH i /7 4 #%
AT A
1. S a2 HE N (Insert) >“[E]25”(Synchronization) B i T 2 A b i AR N 4240

2. ML (RUP) IO 52 [ TF4A, 46 UGG 35 [R5 (0 7 3t
FT (RUP) UM %2 IISEA . e RUP 2 AP AESCE R, W25 b A
LKL

1. EFEE a2 “FN " (Insert) >“[F] 25 (Synchronization) 2k 5ok TR A G AH M B

2. IS /L OB MR 422 T A AL ) TTa6HEs) bsfatt, BEREREHAL T 20
B [F 25 RS T oo (RUP) PN 522 18]

T AR IR SN R0 ri B Rl 2P 26
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BATCH F 77 i #7:45

7.4 GIEEH
Bt

T LUK RS IC A RR,  BA R A A RN [R] 2D s AT .
EBEZ=ALI PN

W SRR RO MR 73 SR TR D i 0 F e 1 BHLE Jm e, AR 2D o (87 X I HL
FrEs 4 b T o

URSRIFY R 23 SRS ) F RGP BHZE R, WA 2 mRs s Pk
UER RS (AR (R0 R WRZTRD R s X, IF BB A2 g b o

SIMATIC BATCH F/jf, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

74410 HAEFELE
TNIERAE T AN, DL SR B [R) 2D 2R ) i S A,

S5 1
=lojx]
TRP_1 TRP 2 B
F401 1 P301 |,
‘ ROP_A ‘ ROP_B
3 4
a
‘ ROP_C ‘ ROP_D -
5 B s
- o

4 0 IB1T4E M RUP (RUP_1 fl RUP_2) . WRFSZ2 Wit ROP (kb
73 ROP_A F1 ROP_B) #8E\5eik, WS ROP (b4t ROP_C 1 ROP_D) ¥

EYEER

SIMATIC BATCH FIf, V7.1 SP1
495
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BATCH F 77 i #7:45

7.4 GIEEH
SEA) 2
=101 x|
TRP_1 TRP 2
F401 |, P301 |,
‘ ROP_A ‘ ROP_B
‘ 3 4
‘ 0
‘ ROP _C ‘ ROP_D
g B
Mame
| I
[(8lacking:
I T &5k, ROP_D 445454 ROP_A f1 ROP_B. 52 #H&, ROP_C 7 ROP_A
SERZ SRV E)
SIMATIC BATCH F/#, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 G1&N
5 3
ol
TRP_1 TRP_2 TRPEZ| =
F401 |, P301 |, P301 |,
‘ ROP_A I ‘ ROP B I ‘ ROP C I
3 4 16
a
‘ ROP D I ‘ ROP D I ‘ ROP D I
149 20 17 —
=l

7E RUP_1 #l RUP_3 Z [A{FAE[RD . A RUP_2,

SIMATIC BATCH /i, V7.1 SP1
PeVET/, 03/2009, ASE02171120-01
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BATCH F 77 i #7:45

7.4 GIEEH

74411  EH CEAEHR)

Bid

A

i3

498

% ThfE, W LAE BATCH BCJ7 gaftias TG4 . FEIRIIEAR T, HARA 4
Bo FEREEMFH, RGBT DR . RIS, WAUE ST S R4
TE M R 251

7E BATCH R /7 ey, 206 TH R0 BRAE 3R i NOEPRAA R :
1. EPEE AN (Insert) >“PEFR"(Loop) ks T =LA A (R A N 42 4

2. FEPAN RIS (S5t 2y, DAm A BATD AT A, DL AR ]
AR o R  OBC T JC R I AT, BT D RERE A A AL

U R EAE BATCH ey g 4% A A 20 D RE S AL BT R I BLAT G, 4% R i )20
PRAATHRAE

1. A2 5N (Insert) >“FEFR"(Loop) B i oy T HA v (KA B B g o
2. il e — N EASTRER RN GG, BIREHE TR, AR5 1% Rbs A .
3. F T RSB LS AR TREN, HEEETENITAN S, RIER AR

PRI, 544 Delete BEMMBR A .  WRDGEFER PR P RIERS,  WIPAT IHBR
AR IR BRI

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

bk

7.4 gI#EH

oz BARTREHIN, WERAE 2 A BRBULEE, K2 R R s i B S A —
FEo

RLR [P 2] 46 R s ESC 8 nT LU izl 1

A LR VR R A -

SR TP B R AT e i — 2%

AL IR PR AR LR

FTEAR R R MR, Bk

2T BUbR 2 B (0 [R)IN T A 35 BN PA A LLRGR [ 45 h S RS AE

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

74412 fEHATER

WA

i3

500

o P bR A T EMEREA TR, LUy aitly. BRIk, W DT
iR bR . R IT s T A A AT

VL

T E R K REAE R e s i

TEMBAT S ZRE K ROP MFEMIZhAE (ZErBciemil. DS Rebrase L. EAERTR
BT P AXSEL JEXNSO

Fu BN T ()20 3R AE BATCH L J5 i 2 i N1 45440

1. P AN (Insert) >“Bt 527 76K (Recipe procedural element) i i T H
P2 A N A2 A

2. LEWIA ARG (LERITER) 2 AWl ool TR R A

HFE T EMINE, R4 Delete BEMNER N 7 -

WA R 250 I N 2%, TIPSR iy 2 gn R (Edit)>“ 22 # T 45 14" (Resolve
substructure). R )5 1A AN A BT AAE B P AE T g /AE .

THAG T U EIVE 745, IS i & “ I (Options) >“Bt B"(Settings) 7 LA
BEE RVFIIREIR L .
A& BN KHCEREE I, T LA A PR J v«

o BRAE CNBIMSBORSNG . SN T4 K. BEAE 7AiM ) PHEL, [N EaR— 4 HHRH
iSYVNe

o IMBEIRIITHH A .
AT S BT T4 SR PV R, B T AR T ISR

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 gI#EH

74413 S HITERRIDGRE

PR

i 4R 88" (Edit) >*3CA"(Text) S, AT LLAE BATCH BoJy g’ as P T IT— Xk
HE, FEZIEHER T DUNAERC T R RN R (S50 3D AERE .

PR
D SRA T S i 2 P B (View) SR RS, IR SOACKE SR EX 55510

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

7.4.5 WER T B

7451 BT P ARXSH

BRI T T AR SH
[ —AAXSHOT UHEA R A RS T P h 2 0] . A S EHB ] LR IN 7R 7
FAFP AL
TR EE SR T AXSHER T R,
Formula Recipe procedure
Name Name
Value »| value
Recipe unit proc. Recipe operation Recipe phase Equip. phase
Name Name Name Name
p| Value > Value > Value »| value
Name Name Name
Target Target Target

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

7452 SHEE

BR
PATHCTT I, AT AERCTT )2 R S JC R Z R A Z Ul (BOE AR .« fE
BOE W7 mYE (50 520) M ANEL T A I, T DU RN AR i PR R R S E A
FHR IR AL -
o
* Hir

Ui H

STRING #iERB P SCAKE

M SIMATIC BATCH V6.1 i, ity H“STRING™ 4ls A5 S50 n] 4 1) F AP 5L U 16
AN 254 A~

T H TR AT @ 250k 5 20 (B fE”(Characteristics) >*“ %52 {5 (Setpoints)) Sk i
SFC KA AR B B e A4 “IEPAR_STR™ZSALHL L fig b B i K T4
16 MIVOEH . AR, FEHANRER I~ 774

WRAE AR BRHEAE =), 5 NI E RO AS B (SFC ALk IEPAR_STR) i
i b PR P B R AR, U2 B Ve (AR B SV I ds KK BE

W51H
T AEEZON IR (BOEED 7L RS % % RUPL ROP. RPH Al SUB.

ScB: RUP H I AYIREFRT LU, ROP s AR S A PDRHK A2 FK T A5 |
Hle

¥ =i =T (RP)

A
SRR RGO IR C O AR RS ZED 51RO B MR S 8r
AU ™ BRI 2 NS

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GI#H
Hr5H
X7 RUP. ROP. RPH #1 SUB L7 A%, sk B vl DA AR IR 2 — AN 5 =
ol o
A5 ROP w1 BB AT LUK RUP RS 8ty He H AR X AVRRD il B AR S
BOLHBE . SHEM ARG .
i 9
FIH T BARIEHI S HAREIE Hbs 2 5.
R BETT L)
Recipe operation 1 (ROP) Recipe unit procedure (RUP)
Name ABC @ [Name XYZ
Value = Value
Source Source
Target Name | @ Target Name |
3 B Recipe operation 1 uploads the process
Recipe operation 2 (ROP) value fetched from the equipment phase
to the recipe unit procedure
Name ABC (upload)
Value N Recipe operation 2 reads the setpoint used
Source Name | as recipe phase parameter or transition
T t variable from the recipe unit procedure
arge (download)

504
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BATCH Fi 7y % #i 4%

7.4 gI#EH

7453 HEEIRESENBMLE

FERCIT bRl (RCTTpRe 280 1 e i, 425 BT s PE (5 520).  WPRH™ B LK

MRS E P ) AT 8RR (AF0 S, XESHOR B)JZHH S0
RAIRC T FEFocR (RUP, ROP R RPH) e ] LA kLR il Bdls A S i 2 5

ez,

FTFFIET R XHEHE
A DA I P b7 ORAT I <Pl 7 A 0k> JE M TR
e (£ BATCH #ifilHh0: 152 W.“BatchCC# 4y
e {f BATCH JAcJs 4t ash: AR

BATCH EJ5 4rig 2% P IR
1. FTIFECTT -
2. EPR A B (Recipe) >“Pr @2 4" (Header parameters).

g O BRI AR SR <B T A RR> JB I EHE . AEXTURHEE R, BT
Gy B YR, BRIC T @ik 2 A, gl LGy e e ix e m . % Jm vt
THHEL AT LAZE BatchCC w1 “4r %8 (Edit) >“J& 1" (Properties) 3 4. fir & HEAT L £ .

BT A S AN 62 (RUP. ROP. EPH. #:#) 4T TiEgnas,
WHREENE (250 O e M. T DUE g X SRR S 2 =
Bl

3. I RHHATITIR WS, K5 adinie”(OK) SHTA .

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.4 G
WNJE
&Ry LA S AR IR N7 @ k. SRl B (Help) 421 DASRAS &0 TP 2 AN
s R RE IR bR SO DG )
x|
é‘ﬁ Cukput material | @ Parameters I 1;- TransFer parameter
ﬁl Dependencies | Process tags | ﬁ Zhange log | @ ESIG
Eﬂ izeneral | [! Allacations I m Praduck | éﬁ Input material
Mame; Skatus:
I Mew recipe | in progress
Version: Formula category
I Wi.0 f 'r'u:u:luu:tp.
Duration:
| oo
Sec
Descripkion:
=
b
Zancel | Help |
X ARRB KT H
i FH &5 B0 (General) 3£ TR H (19“28 )" (Category) Hi AHE, 1T LK BAG YRR AE P=$ds
(A PR gt A ey ERd . HA M A0 7 BatchCC il a4
REREAT 4. W LALLJS 75 BatchCC Hr ik B i IE Ml
HEZH: bR S RN A AR E A (UL 269)
B

AL T B ERAE AR B O AT 2 44 . AE"ESIGTIE IR Th A 12844 .
HEZH: fREH B (I 335)

SIMATIC BATCH /i, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

7454 KELHBEMN

PHIEMN
R AR CE (RUP. ROP. NOP. RPH. SUB) [t @, #ar Ll haE A sk
FITC 2 8 SURIRT = gl (A BLASE. S ARk, S Wk a2 B ic
T B RS AT LUE I D (87 EOP. EPH 1)) Bo MM BB E. XS LL
L ESHITY .

BATCH 7 4nig s KD B

1. TP ERCTT
2. EFIC TR IR

3. LR B SCER B " (Properties) 14
“<tb Z x> ))& P (Properties of <stepname>) X ifHEF] JT.
T A o T AT (1 328 T A 5 T A mT A 2k AH DG TG T R TG 2R R A 1)

4. FEREIRAR XS UEHE R BEAT BTl B, AR i i 2 (OK) AT

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

AR

ERTLE P AETR 4 AP i@ e, 1“4 B (Help) #4241 ASRATIE -~ _EAEN 2 i
NI LR SO SR B

Properties of ‘Pressor CWXY'
G Parameters | Process tags |
$ General 2 Input material | A Dutput material |
Ligt:
Hame SOUrce Material Code Lowe limit Quantity High
1 [Input material Material’ a4 0
2 [Input material Material’ a4 0
Jl | i3
Diezcription fram raw 1:
= New |
;I Delete |
et | teb |

SIMATIC BATCH FlI}, V7.1 SP1
508 #A/ETFF, 03/2009, ASE02171120-01



BATCH Fi 7y % #i 4%

7.4 gI#EH

5 U5 (Source) I H 4R (Target) #eks51,  LUX A AR A2 225 F BUb ot
SHFBMEAD -
o FAN% RUP. ROP I RPH, LI F— gl i #i. Sbl: AR
P2 HT LR RUP i 25008
VL
BT ORISR0 51 R 5 05 50 LU (e =
RINARS .

e XIF RUP. ROP. RPH # SUB fit 4%, &Ml B n] I ALIE B~ —/ N R
Koo Sl RUP HRRE AR AT LU T R IS4 E b L H b, X R AT
DA FH R I S B (A R Ja 228 1 3 e

i
R U S H SN AL AR VSRS, A Rtk 2 4.
S T BR RN S BB HAE H A2 5

eS| H iR

iR
FEFESU MR R AR, W K2 BUFRMEI S, (ARG i e, ZEdUs
P, Z5iAE BATCH By g 3T TR A

SIMATIC BATCH F i, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

A5t Pl /N AT BB K BRABMELREAT A R

510

IR TT S A B R A s O IR AE . SR A e, e S e T H R R Bl
RE (14 5 /N FH e K {1

U SRV (AR AR S BRI CL AR JERIA,  JAT AR TR — AR P 1 e/
H”(minimum quantity of a Batch) Fl“—Mk 4= 7 (1 55 K 5" (maximum quantity of a Batch)
Z TRV SO VE IR A K

BOEEAR T REE I AE TR R PR BRI . ARG O0N, e 2ot Byl DR
S, JF R H .

TRR

WETURE B4R R SR ) e D S HUE W N BOE . ARG S A B B i S M 8L
AZH (HARE SRR D, i FRA R H A B Bl IEAEAE S/ R
{Ho  WRGEFEbRE, W T2 58 MK E L7 bl (6 56 B K 0 5 /S BR 1

TN, AR E Ja ZEUEA AR THU T RRAE .
(i1

BEAE AT DU A B o 4 s AHEAS P PR S0 SR E B . B AN (R{EL 20 + 1
BRATR PR Z 8] o

R L JL R AN
o LREHEHR R A

o s i

o HAEPEORINEE GESHFESEO 55 HRAEAL.
LR

PEIGURE ZAE D SEBRE R e KB U B N BOE . RIS M B B i S HE M 8L
AZHL (WARSE AR BB R A D, T A RIS A A B 8l BIeA
AAERCR IR . WAGEFARE, WHZALHR T 225 b JORR A BC 5 AR 8 ) S PR8I
I KBRAIE -

THELIRORBRBIE,  AEAFAERR E Ja S HUE A 28 H L _ERRE

DR PRAEAR S R ERAEL, WICTRRI A IERA IR . WERbRE S A b b BRAEAN B BRAE 2 8] (1)
V0 [ K B A P PR i 3 SRR HH T PR, U R A R O o

SIMATIC BATCH /i, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 gI#EH
&4
AJ LUKHC 7 A5 AR RR S B i 745 4 . AE“ESIG R F 4L SH 7454 .
JESH . FRE T4 (I 335)
eI

2R (0T 503)
e i /7 2 U (0T 502)
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BATCH F 77 i #7:45

7.4 GIEEH

7455  WREESEENEITTHE

QIR IE],  ATBEE — ARl LUE AN BATEAERIRC T BB MBI TR A, 72
eIk B FEBC T B B 2 1k iy & 2 AT BCE ARG T B BT R IR SR GG R 45 AL
ZRCTBT B GBI B AN SR

o CYBURAENCBAF L JE AREE BRI B (BIINBEFE) I, A ZIUXAE

o WU A N BB BB B AR S, e R B I FHRT T B (Bl
A1 RAT P SRS S SU)D .

BATCH Fo 5 4B a8 PRI B
1. IR ERCTT .
2. EHICITREF LR
3. B Rk B M (Properties) 4 GEGE i A SEEATIE RS S
ER . R EoR“< B ZFR> 1R " (Properties of <step name>) X iEHE
4. POFHAk4”(Continue) K EHE
5. F i "(OK) HEATHIN «

SIMATIC BATCH Fit, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

7456  WEITTHBEHIR

R AE T AR A BN (B MMERI 2 R dl s (BUEEES) , "Ik
PECTHr B ISR A AT SE B DR RGP TS . ERCT i, K
A A2 SR (R A Pk s LASRT I AT 35 S (I T e D8 O s . S 80 ie e, X
TR TP SR 1) 2 K

BATCH 77 g a1 0 B
1. IR ERCTT .
U= JLWIR A v
- AE BT ICR Ak 2 B P (Properties) .
gE. OB EoRe<ft A= 2 FR> 118 M (Properties of <batch name>) HE TR X G AE .
. FE“PEHI % (Control strategies) 1 7 1 % T it (K BC J7 5 12 il S

gEIR. AR NPIRE (Input material) « “fir 0Bl (Output material) F1“2
#"(Parameters) EIRof,  H IR JE T T £ I HEE 1 2 8008 L AGR LT A A S
5.

5. FififfiE"(OK) ZEATHIN .

w N

N
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BATCH F 77 i #7:45

7.4 Gl 7
7.457 fRFELBESREEE

S

FEACAE A, I 2 (RO D WAl ERAT B (Biltn . FEAs ke b:
SHSATHITE LU T AT LA RS A D o R IS B AT LAEAT B

o HIADIEL
o YKL

o WS

B ng RPH R 1E R 55 HE
PHATRC 7B B (EPHL EOP) #8R] LS BIAEATHE,  (FUBT DS A 50T GRS 0 I AR Bk

o
WIRECTE B (EPH. EOP) FilgAE G i HE \EZEIZ 4T, W w] RAZE DL P e 0l [R) 30F
ATIEFE:

o WURMHTIEAEABE D, WA AT GBS B N AT 2 f AL B
BB, BRI S ST

o WIRHFTIEAEABAC S, WIERAT 0E SR SRR & LRI R I LR A I C
J7 HIEAEIZAT R 0 T B AR IR BRI, e A S AR RS AT P AR AL

B % ROP 1 RUP
BT ARSI 7 02 (ROP. RUP)  FIHEAE B3 6k AE ] AT RIS FH B {H

WER ST IEAE AT T o3, WA ZHCE SO MR Y . B SUR S HUE AT R
RPAT ORI A2 (i EORFR e S

SIMATIC BATCH /i, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 gI#EH

EBEEBAMEN RPH, #4ERXHEHE. ROP 1 RUP 2%

AT AR € 2 AT LLERL 77 703 RPHL #RAE GUMEHE . ROP HI RUP 1) J& 1t R HE 2
WS .

I EPERC 7 TG R SR R M7 (Properties) v 24T I I X IHAE

T IR S AR (Input materials). i i #)8L”(Output materials) 5t 2

41" (Process parameters) 1E1i K [1)“A] & 24" (Modifiable) 41| #1“37. %14 240" (Effective
immediately) 41" & B Z 8B IR B B QU RPH IR DU IR HERR SR .
Pn: B RFERE (ETU(Options) >“E"(Settings)) , 1 LAYEH 2 5UE M1 HE
“H AL (General) 3£ 11 AT 15 20 (Modifiable) 51 K137 % £ %" (Effective immediately) 4]
TR ECIAME .

GER: fEtA N, T AR AE S HURm ARG S EUE .

S35 LM Y

BT HBK

NS HGEIR il Bl Hbs) I, WNanE:
o WIRSHHARIC I BN, W SCVFERAT SR A BB .

o RS HECRGR L N WEET, Rl Bz SR TR . B, i
T B BER HESEAN BB, (H4RAE AR T LLAE LT A T B I HE S

BAEAE s 3 BiE S H LA IR AE 2 DR nT BAEh H AR TOEXHZ S Bt A T .

ABAT 3R] ST (R I R 2 K T DL RS VRAl R AT

T8 nT AR B 1B O 5 A B B Jm MR v S B AR A, A ik 1 Rk 2 (S R0 AR
4 (Effective immediately) 41/, w] LA$E & i P2 S B A8 58 UG SR AE L
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BATCH F 7 %474
7.4 GIEEH

7458 WEHBHEML

HBBREE
T LER RS SR rh DAL RE A D AERES I UM R GRS Ui, A%
PHGZ BN RIER CB— MR = AR, MRS = A REET 4k, XH
MEAHOE N R RIB T TR AL

BATCH IL75 gn 845 B2 B
1. FTIFRCTT -
2. WEFEHRE

3. {E LR G R ik a2 g " (Properties) .

i W ROR<EAE A FR> I JE 1 (Properties of <transition name>) % i%HE.  7E %%
##”(Condition) ZEI5 < HP A A A e 411

4. BEATP B

— DU R (New) $2HLm AL E DA 4T

— XA AL RE SR AFREATARICIHZ X (Change) 1%L, T U iz 441
5. MR ity Z AN A I B 5

— AEPIEET]. KBRS EATR R, BB IEIERIE .
6. Ffi“HfiE"(OK) FHATHN.

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

mAREE

AT DAAE LU M IE TR i N . Sl BT (New) 5% (Change) #4415,
LA TSR TEHE . B EH 2 " (General) 11, AIFEBLALTE E 25 AT IRIHRAE 2L
FM (FUy s A . PO R LR PR WL A0 o i) (Help) 1441
ARAFIEITR P 25N A\ B HHERK) B R SCHISGHE B .

Pioperties of 'T-1' = ﬂ
e General %b Condition |

Lisk:

Effective im| Yariable oP Yariable / v |Effective im| Unit of mea

Configuration of the transition condition x|
g This wizard will help wou to end the transition, 1(1)
/4 a=h | Firstselect the bype of addresses used.
[
Descrip [~ Operand 1 rOperand 2
" Recipe variable ' Recipe variable
{” Process vatiable " Process vatishle
" Constant
Ok
" Formula
" RPE status " RPE status
< Back [desek = | Cancel I Help
Ui B

55 SFC M — A i FEAS s ), Kl SFC 2RI IR 5 R

SIMATIC BATCH F/it, V7.1 SP1
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BATCH F 77 i #7:45

7.4 Gl 7

BT NS HERE
Toie oo, fEREn] DONFEARESH] (78D kRS E. QI@HtE =, nrbliE
PP oG UL SRR E TG I S

HFEL

LIRS B BRAE MRS B O AT 2 4 . AE"ESIGE IR h AL 1284 .

HESH: R T4 (I 335)

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH Ji 77 4 5 7%
7.4 gI#EH

7459 HEEENSBEHT

SHEB KR
PR G i 20 R A2 1) e R 5 R IS D5 A TR 75 B AT R J P TR AE R A -
o HEILHIETE (W 507)
o IXEHMHET (7T 516)

H 75 AR LS B e Ak
JEICTT H PEBRAT BOFR R 2 B ST PR R AR AR 2 A L D5 T A B AN«
LIS

PEBRAE LR 208 R 8 I W e GIEEN .  78 BATCH S /7 w25 h Qg lie 7 i, 7T LATE )&
PEXTIEHE K3 M (General) IR S0, POCARER L. HA 9 8AEUZES|
77 B e 5 =R T7 IBC 77 i B (RUP) AN, A 2 R AR XA 10«

P e bl 2 5 A 757 N R Z AU A3 U5 s A
WAL T b 2 JE T (0T 505)
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BATCH F 77 i #7:45

7.4 6I&n
74510 FEITEMHEENR
& X
“ERCTTJEMEE R TR R AN B T LN BT FR R T 7 A ISA-88 FRifE (1995)
M B e XSS 8 P REIC 7 2R IRA LIRS . R RV =8l (A0 « %8 MHEE L
JHTCAC
B] 3% FEEL T B M
FEAH T A< T 4 FR> 1 JE 1 (Properties of <recipe name>) X iFAE H A AN
Bic 7 BT R S ) T SR b . IR AL S E R N T AR S .
IR WEBRERKASE |8 NER
W (General) | ZFRAIRA TR ISR, ANRER
& WORFER TR, Bl g
R4 A WA P VSR RAT — IR BE 7 B i B i ) . 5%
FCHE AN 5 SRR A5 B ) S
AR A XSRS
AR
43BC (Allocations) | 43It e 2 BEARF S B PR L T S e R )P (RUP) 414548
SE M TT FRIGAL,  DARCAE ITH S A sl i)
FFFLLIN )45 B o
FEFS IR IEHE S, W DS SO oSN i ik
JG (CASGEFETRMS) o $L4Fk s IC), 1T
M 4 A4 e v H G .
7= (Product) 7 i T B R
o AR YU b R — (R I H AR (i,
LR AV DI
2w A B R, W R T P S A
o ZEH KIZHL, WA AN ) e 2000 FEE AT I 4
PR A = B i B RRAT R BR . AEHEAE = Rk
H, R AR e SUE, DR IIA ST
BT AN BN (I
o HB/MrREEKX
i ]
SIMATIC BATCH F/it, V7.1 SP1
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BATCH Fi 7y % #i 4%

7.4 gI#EH

T

HERETHAR

& R

HWADE (Input

material)

PrELE i

X THEREE] EOP. EPH [P B AR A IEAE,
MEEA TR H 5

PG, W IREE H . tn] Y
R TR ASKMAYE, &
SHREDIRL R brE B L K B R
HAREE (AFBAZD 8 51T AN~ X
{H.

Yk
(Material output)

PyER

%5 EOP. EPH XEBEI 5 sk 5 A,
Fe A L B A
REFHESIN, WM SRR (%4 H . 7L
IREHIRL. R TR AL O,
TEIRAIR,, T AR R BT

=)

Ho
BAEEARRAE (N 0D AG AN 22 2
HfE.

2% (Parameter)

SHHE

TS EOP. EPH [P B AE MG AE,
MIEAFE R IRINSHL X TPESI, R
Ep RIS E. WAL SR, AR,
ML FAE R R DL A2 T S SRR (K B 24
SRR (WA MG A
LAGIERS

REARAE

FLUK I AR R

FH A = 35 i) A

AR R T EaA I EAR . 5 EOP. EPH
1 TAG_COLL Bz 5k (EPAR.) it
FEAE AR AT FH AR A 5

BE¥HE
(Change log)

(LECIES

L LT P B SUh 5113

ESIG

FJR FDA 5 21 CFR 2 11 # /i E i 74
s

76 IR SCIPPIR A B8 Gl L Ty PG b S
ATERAE DY, “FL P2 44 T R AR VPR B DA
SHEHEIZ I (5 Windows H ) TE & sk 37 A
B AN EL .

SIMATIC BATCH FJIf, V7.1 SP1
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BATCH F 77 i #7:45

7.4 GIEEH

74511 rERH
HHFBW T, WEERTNIFRIEEHE. TASERI TS %EE. SRRt
B 2 LIRBCT RIS AFTi%s% =,
bR IR, GnT DR BE e Fe . MR PR LR i AR, Rl Ik e bR e
PREO SEATIC I . A PP UERI AR E BIFE AT H -
o M BEUESRUEFEUE/SFE BN R AT
WEME=HH*HE %55
o R: CKBEUE SRS T R R T A
BB = B * B E | % 8)2

LA
PRl 244 2%k N (Reference Scale): 10
i /M (Minimum quantity): 1
K& (Maximum quantity): 100
Hie 7 B Bt ZH: Setpoint_A: | fH: 1
F55E (Scaling): 4tk
Setpoint_B: [{H: 5
FriE (Scaling):  Zktk
Setpoint_C: [{i: 10
FriE (Scaling):  Zkik
Batch_A HoE: 1 Setpoint_A: 0.1
Setpoint_B: 0.5
Setpoint_C: 1
Batch_B it 5 Setpoint_A: 0.5
Setpoint_B: 2.5
Setpoint_C: 5
Batch_C e 10 Setpoint_A: 1
Setpoint_B: 5
Setpoint_C: 10

SIMATIC BATCH /i, V7.1 SP1
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BATCH Fi 7y % #i 4%

ANAT RME

7.4 gI#EH

A

TR DR AEINC 7 B i N B8 /N R KSR (BB ATAT ) (IR ES IS HRE
) .

IR TS SE O T AN AN S E PRE (K 541

ToRE R 7 Bl (BET7 b B BR AR 98D

TR B BE N 2 2216, X LSRGE(E, IXLRECTT B B 2 0 T R -

bRIE : etk
R SRS H = R
S S 4 3 20
W5 it 2 10 15
ZH 15 13 13,33333333
oA = H 15
1Ek 19,5
P e : /¢
T RIS R
S S 4 3 20
e 7 o 7L 2 10 15
24 75 13 8,88888889
A= 2% 12
1E 18,72
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BATCH F 77 i #7:45

7.4 GIEEH

BRERFI B (B ERTT RED
FC 5 A A P RS R 52 B T AP fE 13

524

b 2tk

TR RIS R
S SH 3 20
I 75 o 3 10 15
4 10 13 13,33333333
WA= 5% & 15
1ELk 19,5

bRIE —

TR SHI% R
S5 2 5L 3 20
e 7 o 5 10 10
ZH 12 13 20
A= 5 12
1Egk 18,72
Il 1)
S SH TR RS (Bl
Fic 7 8 - 2B P B ) PR
4. BRAERL T B B HE Hh () R A
A= H it PR 1 S B A

SIMATIC BATCH FJIf, V7.1 SP1
#AEF M, 03/2009, ASE02171120-01




BATCH Fi 7y % #i 4%

7.5 1)

7.5 HEThRE

7.5.1 PR AL 5 R0 ST 5
i B 2" (New) 325 A Q@B i, 26BN AT TFZEC . SE R aniiag, W40

TRAEIC T o
S B
1. W IRBHT AR, SEFSE R dr A B 75" (Recipe) > B 7 4" (Save as).
2. AE N — AU AE s A 42 R RRAS
CERL R YRR, AT LT MR (Save) fr A, WAk s S i 44 BR e R A
7.5.2 LN W]
faifr
I UE S FE 0 T C 7y e A P 1) A 1 A S 2 e B — SR PR R 56
Bk
HEMHITTES . HRRGHTE AN I SR As FRED giEme i, A8
ITIIE o
BATCH B 7 g2+ S B

1. TR )7 CERCT BN 5D .
2. PG A B 7" (Recipe) >“BiiE"(Validate) .

gh s WoRgE WEERYIR, CLRMEC T Ardl 215 e WIRE B AAAE. B
TR 15 O 7S DAV LA P B s 2 T E . AR TR ERITENC Iy g5 0 PAZL
iR, U AT PAZE BatchCC HiE T,

PR
AT I X 1R 812 K 2% H e 2105 A e R PR L
R BN A S TR . S E A S T TIRES
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A, 03/2009, ASE02171120-01 525



BATCH F 77 i #7:45

7.5 Ko 1jgE

7.5.3 RATEC 7 LA F IR ek A =

K
I BERIESROEIUERC T . S 3z &I, R 5 A sk AT A R

BATCH ECJy 4rig 2% P HIPB]R
1. FIFENNAIAC T CERCTSES S
2. EPR a2 Bl 75 (Recipe) >“ & A5 F THliX"(Release for Testing) 2t“ & A T4

7="(Release for production).
i WO RAn e, AR TIRE S AA I EC A A A R
S, SRR L R, iR RS R AT L. Bt T LLAE BatchCC ik
AT

L
FERFIRIR A, ATRARGE SR AP K 4% H DA 215 DR AR K HC T 580 o

7.5.4 B & AR

A
S BEBRARBATIIEC o W SR BG4 O 28 AT (V) 2 C 5 BC 0 5, i 230 s

%f

Rﬁf BatchCC [ B B H G FC1r g i b T R A E 0 RS H B IE 77 (Allow
editing of recipes in the "Release revoked" status) ZEIil), A GESEA T4, WL H
" (General) I H 2% i A “IE T (Options) >“¥% B”(Settings) T/t 4 %1% 10 .

BATCH E. 7 4niEas H ISP B
1. FIIFBC T CERTEEXN S .
2. EF A “EL )57 (Recipe) >“HH & #i”(Revoke release).

il HOHRAT)E, CARATH IR AT IR IEAE AR, CRAR I T
7 IIBC T BAT TR S E 4™, JF Bl AZwAE ALy -

1] LL7E BatchCC i & A

SIMATIC BATCH FJIf, V7.1 SP1
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A

AR

NAEISAT IR B rtb 2 2 0 T PR A SR VR ST, SIMATIC BATCH 248t 12220
X BATCH R &S45 ML I0.  WIRIUAR RGP AFAE R, WITAx BATCH AR 554 2 8] 1T LL
BEAT A L AL ) 46t o

HII & A A U A P TC AR BATCH g5 a5 T seBUUR . R Bdla oF vt A:
7 NIRRT R BB Bt s IS A B S B AR S W da  — BARF R (Bda &
1D

X IRAE BATCH I i 55 4% mAs 122 Ml 55 s tR BB 2 5, AR MR S5 s mT AAREE A8 HTAT
[7] PR Bt i AN 2 408 K 0l B0 S SR 2 i o

BiHA

R

TRCE AT K, LURAE SIMATIC PCS7 R4 41 MR CAR RS As i, N
L] AR,

T4 PCS 7 0S %%kl

ARFERITCRIBINA, W ZEDReT I GEFEH RS PCS 7 AEF R R
4) (Process Control System PCS 7; Fault-tolerant Process Control Systems). I 3CAY
7£“PCS 7; Electronic Manuals”CD . 302 MR, ediiid T PCS 7 Hhaf i
PER B S . B, XILAHEA TR PCS 7 OS MiH4ME .

SIMATIC BATCH FJIf, V7.1 SP1
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JUR

8.1 fiy 7}

W
=

SEIAHAS - AR A ] (0L 529)
BATHRHIE (11 532)

s 5 (71 533)

JLAR BATCH [l 55 #3414 (01 536)
PCS 7 OS | LMl (7T 538)

SIMATIC BATCH FJIf, V7.1 SP1
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JUR
8.2 SLPIAE - TEHA AT FEH)

8.2 SR - AR ]
R SR T AL TUA BATCH M5 5 HITL4x PCS 7 OS (WInCC) Fy 5 bl

SIMATIC BATCH SIMATIC BATCH PCS 7 OS:
(1 BATCH server 1 BATCH server 2 BATCH client 1 OS client 1
(BATCH contr. server, (BATCH contr. server, BATCH client 2
DB server) DB server) - oo
Ll L | ———— .
Terminal bus
PCS 7 OS: PCS 7 OS: I
@) OS server 1 OS server 2 E Engineering
(redundant) | Tl station
LL L ) |
Process bus
SIMATIC S7-400 SIMATIC S7-400
I—E‘II L:::::Ml IT‘II L:::::M

(1) 7L4: BATCH fR458
Wt P& B & AW BN #e D BE Y] BATCH RSS2k szt 4. mR—6
BATCH JR45 2% B ¥k, BATCH RSS2 1I0 4 nl i {4 :
e 5 BATCH & Hl (34 BATCH fic Jy gwiE 43 Al BatchCC  (HbA:=r= HLRI AL A= p= 42
HD D SAEMbEY) G BN EAT, FH
o HEAE AR K AR EE S AR BT .

(2) =¥ PCS 7 #:4E R ¥5H) OS LR
1 FIE ) OS g5 v it Fos (7] 20 AR Edl 45 43 5830 PCS 7 4 biul (RAF|
SIMATIC S7-400 fi#2 1) MIIT4. JU4 OS 45441 WIinCC RS nJ [/ 25 JEAT H- & AH
A& s . thDigEE S WIinCC [“TURATIE BRI . A O TUR AT I A I A
H2% M (SIMATIC HMI; i&I0) (SIMATIC HMI; Options).

PCS 7 #A Rub LR AT R BIAEE PN & OS kG54 i — & I skbiy, A i e
WA W AR EEREAT o AT SRS 2 SRANERE T PRSI i) LU R R HEA T T3

SIMATIC BATCH FJIf, V7.1 SP1
A, 03/2009, ASE02171120-01 529



JUR

8.3 WinCC %/ pl_I- SIMATIC BATCH JR% #1285 o

8.3

WinCC % F#l_E SIMATIC BATCH R B HPRES B/

B AE TR R 47
BEUEHTIE T AT BATCH. WINCC 45 #5341 WinCC/BATCH %/ (LI 40 A1 sUIT A &

R A

£33

i

530

ZJEL,O

EWA TR LR RS 4 BIFE R TN _EAE ] WinCC/BATCH % )7 LI

04> WIinCC F1 BATCH Jl45-4%.

HWAE BATCH/WInCC & )7 Bl LA HPIRZA B -

NAEZHG DCF SCAf (Z UL IS 3 20D A HIBIARN & WL ANH
DCF SR HI RIS &5 .

KT RS RUAR RS 5, A 61247 WIinCC I BATCH JIR S5 23 B AR 7 1 R 45 2
SENUR A B AN TR B G5 P R RO 5

£ ES FHIT4S.
WInCC JI 45 %835 H ) WinCC il H & 2% 24T .

TTOTE Gt -
IR AT A i AR 55 2 IR B7R (1 WInCC L) i i
FEXT GG PR P IE PR e 45 11"(Control), 4R K L83 WinCC 1) i .

EFPCS 7 JUAIRESHH]”(PCS 7 Redundancy State Control), 4R & ik “iff
E"(OK).
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JUR

8.3 WinCC %/ #[_I- SIMATIC BATCH JR%-#19 & 2

TRERITER
WAECAE ES EIe i dlas.

WInCC/BATCH & F ¥l L G447

¥t 5% L L ¥“sbdata” Uk ) BATCH & 7§l DCF SC#F S il £ A WinCC % /7
PLITH H %

AR A G R
(ER IR T, ORI B RS SR AE R0 WInGC T i i

SIMATIC BATCH F i, V7.1 SP1
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BATCH fii 55 % & Y] e

PIANTUAR BATCH JIk45 s 11K BATCH 5l ik 55 s Mt AF ™~ 845 & 31 (Batch CDV) sz At
TEEIRAS . 75 BATCH RS MU, B Eigikssds: Batdil, MRS+
B BRI, A BATCH 9545 U5 1] [/ —> OS fled5 4%

RS EHLK BATCH IS5 ds K fElkbe, W) BATCH g s (& HHLD Rt AT wkbmt)
Beo RIE, RSN THL.

AR D) B B 7T R DR A

o BATCH JIi%4 PC (bl b, SnBspE iRt is i

e BATCH Jli%5%s PC (1M 8% detlE (BATCH RS 25 AN FER I 25 S WLE L0 4%
BATCH Hi45#%) .

o MR (BATCH IR S & b Bl i PAUS Sh i AR ) #h.

BATCH 7% ALY D ¥

Wi BATCH Jls-#s (ML KSR, W BATCH %) LK A 8k 2 £ 1 BATCH filk
55t o

BATCH & P HLI B sh A E 575 30

RIS

532

i

R ) e ) )

£ BATCH 45 gl 2 5, WhAeid— Bt i) 2 J5 BATCH & WA REE HTE1T .
— AN EE ST, @A STV ) BATCH k454 MbEv)ssc s, &
SV PRI R, IR RN RS 25 N R P s AT

HEZW R E 1 on, BATCH &/ WUECualT. (H), Snnt sdia iy FH s
J¥"(Quit application) %4, S AN HFET. HlEDI#—5¢m, BATCH &/ LRI 1]
R 5.

LBy 4a o AP E IR s Gl M ED SR S TR d B ED SO S we

SIMATIC BATCH FJIf, V7.1 SP1
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8.5 KR

8.5 g =

Gk i€z

M550 i RE 5 TR BATCH fiRs54% (EAUE AL #A A CRAMEIRE. ZA
Wt [A) 20 X P A B e, 1K S RS54 PC YRR — 6 A8 A ] T ) R 4% 1
Fodso I IERAT LU M S5

o WFTUARAK A B A AR HEAT I AL

o MR

o DRIEJCARPKAE K Z ) Bl — Stk

XTHORIN S BATCH 55 45% 4n A0 A IR ) Bcdla e

JLARYI#. BATCH IREH[EBENIRFF. # K& WIinCC BRI BEFE RS

® JABIICA BATCH Ji g5 ds i skUCAR VIR, & MR 55 4% (A e 2 B 32 i 55 4% (1 5L
PPEFE . W2z R A K R I, B, WS LR ) — & BATCH il
Stvo MR IE TIZIRE, BRI 0 B4 IR 55 4% (1) BATCH Hdfa 4

o —HlI T SEWIHITURMRSS AT, AE5G AT A 3k b e o= R R 2l 1k
HEe TR EDE R s R IEMREL R PCo B SE N R IS IR Y o
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8.5 AL

WEAFER

534

MBS R L T IR RE T I & BATCH 44, WILEEH55h BATCH R4 2%
W, G A Sl n R RSS2 . A5, AT RE S 25 I TR i 30 1] e A 7= ) e

FVH B

JR Bl G5 R Al AN % A 55 i TR (KD Bl P R 2D I e A2l WinCC il il [R5 B

e CEES

Terminal bus

5 e

BATCH
server 1

Redundant
BATCH server

Fault-tolerant u
replication
solution

Database

synchronisation i

BATCH
server 2

JUAx BATCH Hi 55 45 4 2% BERAE ] 53 Ah— AT T 2 S 2R (K 9 25 T e s o IX L8 10 2%

N AR A — 28R il

— HFICRXT Intel k55 #3i& ML 4% Intel Pro/1000MT .
- WTIURXTH Intel &HLENCAS Intel Pro/1000GT .
- HTICRA ) 3Com A &5

THHMI I 25 TE T A WA S 24 PC (U4 BATCH RSS20 175 K PCI il

SIMATIC BATCH /i, V7.1 SP1
PeET-F, 03/2009, ASE02171120-01



JUR

8.5 i
BB K

e 45T SIMATIC PCS 7

o JE i T A NI IR X 44 I s Ok T TR AT AR P R S

o TEEERZPAAT MAERLE (P HublFI7 M HERD) o
— FIRERD:  F TS AR S W AT L g R ok 2t B2k 5 BATCH % Bl

AT — A L IE R A A T E R — T M.
- W& PC [tk (PRI MHERD) AL Rl — M %5, 5 WIOETES I CRAK AT 2 (7]
UPTIRZIN

FTI04 BATCH REMH AL M4 IE R AR M A ST H To 6, 2487

Windows % 545 B 2% () “Simatic Shell” S35 rhdkAT

1. A8 Hsti“Simatic Shell” 301k, SRJFIEFE B R G2 LR EE ..."(Redundancy
Settings ...).

2. 7E“HATH: 0" (Serial Interface) X, EH“IC"(none) B LL R 75 “mmmmmmmmmmee "

3. M4 IERCAR"(Network adapter) X3, EF O 24135 HILAE vl H G e AR -

4. FHE”(OK) I AIRHEHE .

5. kS a2 m K (Advanced) >4 i B (Advanced Settings) #1152 i
#"(Advanced Settings) X iEHE. Al A O UG HE 0 (4B d IE A U W B ISR B
FEAS L SRR, AR AR A P .

6. FFRITCRIKEEEHATH 1 P25 5 40,

R

PUE S LS TIURIKEPT AT BN, AT LL4hAT SIMATIC BATCH %l J7E &2 il o

SIMATIC BATCH F i, V7.1 SP1
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8.6 JU BATCH [R5 a5 I 4

8.6 TU4 BATCH RS2

EXNZ EATNHREF

N2
TEPLZ
IAFEEASIMATIC PC 3% % EAIAN LT (WinCC. SIMATIC BATCH. ...) ,

R IE I XL SIMATIC PC 38" W R e A — M EHL ARSI, @l —4 PC
o MG R A SR

£ SIMATIC 2185 f & I T TR 1925 BRIAT R 1 -

1. A AR Tk £ H .

2. B A AR\ (Insert) >“3i”(Station) >“SIMATIC PC 3i”(SIMATIC PC Station).
Zi: TEAETIUH TN TR SIMATIC PC .

3. WA PC it EALA K.
— &P SIMATIC PC ¥k,
— R4 “Yn R (Edit) >“X % 8 1" (Object properties).
— fERJa MR AL AR

SIMATIC BATCH Fit, V7.1 SP1

536 PeET-F, 03/2009, ASE02171120-01




JUR

4. 1t HW Config 14145t SIMATIC PC i,

- A, EFZ SIMATIC PC i
— BEPEE A A R (Edit) >*4T TFXF %" (Open object).

49 HW Config 1T

8.6 JU BATCH [R5 a5 I 4

— MBEAF H s P AN N R

EFE

EAUERLE T, [§ BATCH Application [stby] 4 % R 7E U414 SIMATIC PC 3511 R J5 .

T H s R ik 42:  “bruE”(Standard) >“SIMATIC PC 3#4”(SIMATIC PC Station) >
HMI >“BATCH N #2)F (£ H) "(BATCH application (stdby)).

[B8 HW Config - SIMATIC PC Station(1)

Station Edit  Insert PLC  Miew Ophions

Window Help

n[5(z-1@ %) & salia] [ 28] »e)

AN SIMATIC PC Station{1) {Configuratia

= (0] PC

BATCH Application [sthy] |«

D= e L P | —

K
ﬂﬂ 0] PC

Index taodule Orc
1 BATCH Application [zthy]

2

P

Press F1 to get Help.

Hardware Catalog ]

Erofile |PCS7_VET

-

w - FROFIBUS DP
&l SIMATIC 400
=-J8, SIMATIC PC Station
{:l |Jzer Application
{:l CP-Industrial Ethernet
#-{C1] CP-PROFIBUS
=3 HMI
[ BATCH &pplication
BATCH Application [sthy

-] WinCC Application
o @ WinCC Application [ztby)

Server Components Redundant for
Batch Peell

[ BATCH &pplication Client

- [d WinCC Application Client

%

DA
KA A

SIMATIC BATCH FJIf, V7.1 SP1
EeEF M, 03/2009, ASE02171120-01
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JUR

8.7 PCS 7 OS /i1l 5 #H

8.7 PCS 7 OS _L st ] Sa .

I ) AR

UNIT &1 74

e 43 PCS 7 FAEul FATAET M I RLRT, 252002 B LU R L s :
o JUAR MBI P it (1 I 1)
o bR I SN ]

FKH T PCS70S GRAF#HD RO~ Dhfg i il 4590 &% UNIT Bt IUNIT_BLOCK
(FB 251) Al UNIT %1 141,

IUNIT_BLOCK B i [ Wi L ft BATCH il il 555 BEAT#h W R BAT 34T 508, T
IUNIT_BLOCK A HIERL F 5 5, Wl g RE g il a B Xt s th B e (1% oo hidt A=
PE IS, BT A e . WA UNIT RT3 5 H—~ 06, W UNIT &1 14
e AW o

fFH UNIT B8

A khse T PCS 7 08 UM, (HiE, B LIEBCAH OS JURMHLL MM (4
i, 2 PCS7 OS 1R FsATI) o BHTHMEEDI S A DEIER 1M, &1L
FONAZH ORI OB A B d e

WE UNIT B8

538

L

AR

BERPIAHLE] LA UNIT & 11D HAL T HamIRas,  WIAE SRR TIH I 18] TR) R I3
LR LA

TP [ 1A I TR] 18] B AR 2638 A I RE A, TORE B AR DN 280 e e 7 88 ek [k v ) B 2

iR, DR PR T LR 3h3E 24 10

AR SR RE A 1 0, Pt R AT AR AR 7 ) 2D AR b D) e T RE G R K
I 1) 55 TCvA 1 A BT FEBERS DU T, BRAE DU ity Z T3 T HORGREL AT A

SIMATIC BATCH FJIf, V7.1 SP1
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JUR
8.8 BRIFIUR M i X

8.8 BAETUR AR ST A% X

8.8.1 W 4% 357 B

MIZ%ERAS . BATERNIIRIERNER
o JURALAE T IR 55 A A 20 BAT ST T 2 i R IR 2 AN MU SE R . 1%3E M T BATCH

s 2

o FATIER: (COM 1) FARES SIMATIC BATCH —fifi . — &M IHRS"
B Tz %

o UL, FTRMERA XML LS (L) AT HNL/E M & BATCH JIed% s ] 523
JUAR S

8.8.2 AW ERE

faifr
TR REHI M A S AT H . K, ABRLAATE BATCH 41X 1 HE
BEAT I H BEE SRR A TR TP S A TOR RS

L

1. TL4> BATCH JIR 4553 1 W 4% 41 A&l ik Windows % J5 45 B 24 f#)“Simatic Shell” L4923k
PAT. TIAE SIMATIC BATCH ZE£: 3 Bh I TU4y > Hd = 1738 20 $k 21 5 245 5.

2. WERELEFR—G PC F2ed: BATCH F1 WIinCC JIR%-%%, i ffRrE Il "WIinCC 4k 4
AR T DU W

— AT D ST E IS JEHEIE (none).

- EIEMLEER A (MAC $ihit) LOURIKFERIER::  LEPER T8 = I M 4538
WE 245 A FH “Hff 2 " (OK) H2 1 DG P IZ A T AE o

SIMATIC BATCH F i, V7.1 SP1
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8.8 BT IUR M5 X

8.8.3 EEMMINGER

TUR RS 275 -

540

TERAER ARG (WIinCC ks Sk = ik g5 as i TAHE Y PC D), HAEAIE T
BATCH i sc (Bdlsfe) ZJ5, AfedkT*)n3) WInCC J& A3)))A 3 SIMATIC
BATCH”(Start SIMATIC BATCH automatically after starting WinCC) #'& . W AR5E
PO BCE, WIFE DS — MRS %8, RBESMERZ L, iR E1E BATCH i fEH
TR, KW REED), FFRR R

ARG (WInCC Ikssas StA Ik S 280 AN PC FD , #BHIE S 3)
WInCC J5 H 3l )i 5l SIMATIC BATCH”(Start SIMATIC BATCH automatically after
starting WinCC) % &',

JA BI04 BATCH JIR 55 a5 N BUTARUIHIYIR], - 8 HIIR 55 4% (1 Al 128 25 55 3 1 55 4% (1 4
JPEFE . B2 I R R B, fln, Brd /o< R — & BATCH Jik
Frame AT, WA 2 AR 55 A B P

— H i T A R ED R TR IS5 S RTINS, AESG AT 32 3h by SR EOR R S 1k
HE”o TSR EORT R ShiE K IEFIE R PC. 1 5EN oR IGS FIRE T o

HEAE P R i B

WARESE S R TILR RGP I & BATCH filkd5 s, WIZEHH A ) BATCH kg5 %
I, ARG SR B E R IR IR o5 e I, T RE 2 25 ORI ) i 303 1) gtk A 7 0 A
A

JEBRNGE HE wifi B 6 T vl 2 8] R B dfe e TR 2B i, s A2 WinCC vl R Bt R0 23
AL 25 e 1K

SIMATIC BATCH FJIf, V7.1 SP1
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9.1 M BFV4.02 ¥ SB V6.0

9.1.1 BAEAR

faifr

A
BATCH flexible V4.02 i H i # 4t %) SIMATIC BATCH V6.0 . 1F V4.02 I H Fr 414 (1)
i Dhfe#Rnl LLZE SIMATIC BATCH V6.0 H4k4:4di .

AR BATCH flexible V4.02 4 FE . S A5 i e A = Bt . A8t
s T anfl R A AL A 7 5

BREE ML P E gl Ak, B0 HE STEP 7 I H DM i& . PCS 7 V6.0. 7E PCS 7

Toolset CD _-f] Process Control System PCS 7; Software Update ¥+ vl $& 51| 75 1)
==

H/oho

K H HIHE
#£ SIMATIC BATCH V6.0 # %] BATCH flexible V4.02 ¥ P2 p (1) LT %4 -
o FRFITHSE COFRMERAL P EE A RRD
o T (V6.0 THEHIARE:  FRJTD

SIMATIC BATCH FJIf, V7.1 SP1
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9.1 M BF v4.02 |/ SB V6.0

R H IS

Bt e & A

542

7E SIMATIC BATCH V6.0
K% H BATCH flexible 4.02 4 22 vb ity LT 5 -

AT
A s )
P P BCRR

]

MR REHE A, FrEAN Bt AR ik (4Rii el PDF #30) HB NI T IR A7
WARAEF—& PC _LATHM, W“3 SIMATIC BATCH V6.0 Z BT U2 iR A7 ik AR 4k
i o

WRERT, RGN VA.02 Bolf b A EAFAE . (ERER T ZAE AT 2t G
WE

BATCH flexible V4.02 AL G URATH] (IRFFAAR)

AJAE A AN B H R 8 ] BATCH flexible V4.02 Fil SIMATIC BATCH V6.0 B,
BB, BRAE s BRI SE AN BRI AT s BT — MR e V4.02 5 V6.0
S

[ 2% V4.02 e J5 AT LA E 8l [ 2% V6.0 Bt )y

14 V4.02 Fi J5 N Be T2 4 )2 4% V6.0 L7 .

SIMATIC BATCH FJIf, V7.1 SP1
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IR (B

2% Sudd]

9.1 M BF v4.02 |/ SB V6.0

BT UL By, # V4.02 1 H # A 2] SIMATIC BATCH V6.0 i, 23F1JF LT 5

BT H i R
1 1N 4k BEA5 R V4.02 Thg RET AS ¥R,
LET | o AT A B,
gtls o EHEHHIFEE.
o EHEH F#k# AS
o KHEHGHE OS
o EHEHR
o EHEHWIE AS
2 EFF1H V6 Thie BEEH V4.02 F1 V6.0 B, B

BB V6 Dihe, IHI)RE
it V4.02 escBl, HATE
i V6.0 BRitAry g (V4.02 M
V6.0 Her] LU AT

WA DM V4.02 Sud e i H
B OAT ) V4.02 417

o WNZIUEDHT SN PE KR
o WMINHEH FEE| AS
o WMINHDF SN I OS

F R IF LSS V4.02 -> V6.0

THREVFAIE¥ A V4.02 -> V6.0 A PUANVFRTIE . = AN ALVF AT IEF— N TR VR ATIE.

T 2R A X YA VFATE

VAR5 SR

e 1xA1BPP060 = F+4: iXJ& BATCH flexible kA= a 4 B V4.02 (1 IHVFa] ik

(DA

VL

W PC rRAEAE IH A A= P~ $di 4 2 (Batch CDV) V4.02 ¥ rfiE, W) IH 4 nl ik
A1BPP060 1] ifjd“Upgrade Batch V4.02 - V6.0"FLF 40 B VF af iilE A1BSP060.

¢ 1 xA1BSP060 = PCS 7 - SIMATIC BATCH Server Basic Package V6.0 (PO 150)

A

Bt LAVETIEA — AN 0 T B

e 1xA1BBCC60 =PCS 7 - SIMATIC BATCH BatchCC V6.0

* 1xA1BREC60 =PCS 7 - SIMATIC BATCH Recipe System V6.0

SIMATIC BATCH Fjit, V7.1 SP1

EeEF M, 03/2009, ASE02171120-01
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9.1.2 MHER

Hodste Ak

i

SR e R R e A E, k8L T BATCH flexible V4.02 1 H th i #i 0] (£& BATCH
flexibleV4.02 Hid XA A RIAR) , WS T A “SIMATIC BATCH F sy KF
R LA P B

U ORI L HEN, DAL RN O OB 15 OS s HHr 1 2 v S A4 il 5% !
WRAREIEIX AN, W EIETF AR AL R AR 383X LU W F-3h HE B B

e
Ez
AVRAT 53 AR A R s PR A A 7 B P R AT, TGRS R e P
AR I : D 1K e oy eI L IR A4 B
B S bR IRRE
B
T Bk S HU AR K [ BATCH flexible V4.02 ki Hesz Gl 2 8038, IMILTFA
PERRT, W ORILIR AR BTl 16 71
R0
Do G EOHT P OSB! PTG e il e LA S RE WInCC i 1 () JBRAL, - o0 230 £
"L F"WInCC g R RFF AL
Jyuk, WA T ik BATCH flexible V4.02 T3 H HIHEN], B 7 B TFAA RS RERTHEAT
Ui DA AL IX LK
WX BRI AL , WITCIR I S b5 4 1 OS FEkE] AS LUK ML WIinCC i 45
R
SIMATIC BATCH T/, V7.1 SP1
544 EAETF, 03/2009, A5E02171120-01
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HEI 1: fFF UNIT
FEIT T 2N R i — AN sl

#EW) 2. fFFH TRANS R
o ISR IXEE TRANS B FLgs SN, W CFC KR H BEH TRANS L s .
e UNITNAME g PE(H 221 4R % 5 UNIT Heft) UNITNAME AH7F .
o EIRMINL T AN FITH) L] RS
o [ B I FITH AF_Xx Pl UNIT B,

#EN 3. fHH] AF_x Bt
o ALY AF_X B iigs BT, W) CFC IR AR AF_X esizfil,
e UNITNAME J@PEAE L2562 5 UNIT i) UNITNAME AHAT .
o RN AN T LT RS .
o KELrh—ERAT /i FE H T TRANS Sl UNIT B,

LT B4

1t: BATCH flexible V4.02 HASCAE, [RIFEEIAE SIMATIC 4 FE ds h 4 A AR = i i
JCINT) 2. WUREIHR R AR N ORI =R 2500 2 LR A 7%

o 2 EMHAERAIT (ISA-88, dREFIL) MLEE X,

o i 3ZWAHANIC (ISA-88, HJt) M LT X,

o 4 EUUH AR AL (ISA-88, wAMH) M LZH X,

PITAT A 275 T T e sl i A AL T 1) B R b Z0U 1A S R JR RSO R

iR WA IR RIT VA.02 B R BRI T JRRE N, BREENSE Y. T
T RO T A RO T R] RAAS s B RS AL 3R

SIMATIC BATCH F i, V7.1 SP1
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9.1.3 AP E

BAaEA L BBR

V4.02 Database

1. Adaptation of the V4.02
-+—— project according to the
guidelines for later data
compatibility
(when necessary)

2. Use of the
SIMATIC BATCH Migrator

Unit recipes (and process
Batch types cell data with batch
types and instances)*

Generate the Generate the
batch.orl file with the Archiv.xml file with
type description the recipe data

3. | Copy batch.orl to suitable
subfolder of the project
folder

Adapt the
STEP 7 project

5.| Compile Batch process
cell data and download
to target system

*

xml

Y

6.| Import process cell recipes
in BatchCC with

Options > Restore

A

*

y .egm

Update Batch process cell
data in BatchCC with
Edit > Update process cell

*: The Archiv.xml file contains not only the recipe data but also the process cell
data and instances. If no expansions whatsoever are made to the project, you
only need to import the Archiv.xml in BatchCC. In this case, omit step 7.

SIMATIC BATCH /i, V7.1 SP1
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9.1.4 BIBE

2 BT T BRI B 25 BT 1R 1

1. BUERIH 2 %40, DAESA LR A METRCA: BATCH flexible V4.02 % 7R
STEP 7 i H

2. ¥ STEP 7 Wi H %%/} 5 %] PCS 7 V6.0. & PCS 7 Toolset CD ] Process Control
System PCS 7; Software Update SIS IX L L IRIHAT T fiiik

3. HIhEH STEP 7 Wi H J5, % SIMATIC BATCH 1) =%
P

A ARAE SIMATIC 48 B h ALt AL R ST ) R, AW HATES 3 48
(T3 Z W B ALK (T 544)" 7).

FETL] JZhk st ST WIH AR —DX%R, RIS REES P i S X SR
#£”(Object properties) >BATCH J&#£"(BATCH attributes) it i - 24 3 73 it ik F& £ 50
XHRIRM,

4. fEAAALE T BATCH kg5 FIBEA> BATCH % /' HLEIE 4 SIMATIC PC i, Jf

fifFil HW Config il BATCH JI} 45 e b F AL E BATCH 75/ HL FH AL ot JL k17441
P

BN o

5. EASFE P AR PCS 7 4E R4 SIMATIC PC i, RJ5{EH HW
Config il ik WIinCC J F 2 5 FLHEAT 4145

6. eI INERLE WIinCC M FHRLF K A )4 OS.

7. 1£ WinCC M HIFE/F M AR OS.

8. 16 L) Er AR UNIT Huffi AT = AR 570" (Unit) SCPEJE CRRBUER:  UNIT
P pl 448D

9. SRJGTEEANRIT I N AH B FsER M A7 CFC B3
L]
W CFC ERAE R AR B ICHZ A UNIT Heali# 24~ AF/TRANS 5241, U220
W e TF, BOATER TG R R AVSCE 8 T1Z 500 3 & 1.
WA AT D TR, WAZR T AR AS JFHEIT0S 4wid”, N iz b B4 Ay
A

SR, A AR A R DT R I AE I, AN S Hh DL ]

SIMATIC BATCH FJIf, V7.1 SP1
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10. BRI Z SO brad A HID 2 BB 2 8 570 sl aa Il H A —20 GEREE
Ti”(Options) >“T.] 24" (Plant hierarchy) >“i& &"(Settings)) .

Ko AR EE, A0 WIinCC AR Al fex ek, JfF HERgii¥ OS I, Xk
WinCC A2 &5 ] (Bltn{E OS i) mRgsZk!

11. )\ SIMATIC BATCH V4.02 %4l 2 h 3 H 2R A5 B 1R el DLARC T Bl OF
KefTe ASI S H I STEP 7 15 H :

— JA3h SIMATIC BATCH #fd%s - #84%: ...\siemens\BATCHflexible\BFMIGRATION
(A LAM Toolset CD PCS 7 V6.0 - Additional_Products Z3%) .

- i\ BATCH flexible V4.02 4% 1) #5145
— HNRAF R AEEA ) H bR AT
— 8% WInCC Jil H ft] OS % FK.

— PR T EE SIS )E (bateh.orl)’(Process cell data type information
(batch.orl)) &, A& Ry A7 S B AR ¥ batch.orl 3L,

— JEPERLFE T/ T 5245 (archiv.xml)”(Process cell/recipe instances (archiv.xml))
METH, Aty A BC T Btk ) Archivoxml SCEF.

- Hli A gl (Start) # 4.
giil: ZERCT B batch.orl A1 archiv.xml SCEFARTEAE HARERIE R
— ¥T7F SIMATIC & H3%.
_ I3 4y AT (Options) > SIMATIC BATCH #17F BATCH 412457 i 4.
— 7E BATCH 210 i A hik PEfib A 7 A0 4

— Mz A" (Additional functions) T I“ 5 \"(Import) Hebl, 4K I 4 14 % PR 7 1
(1) B AR g 12 i $ batch.orl S0 FT IS IFIIN TN

0L I V4.02 T H BT A AR R A R TR IR . R R R
P£”(Equipment Properties) SCFJe b4 BB AN ERUR IR FIFE R Rt FEbs
B,

— AR S0 GO R B R T
i K WoR VA.02 TUH I S I ATEIR AT LA R R A R R

S|

12 W I R TC IO IE, ARG R RS iy 2“4 % @ 1 (Object Properties)
>“BATCH J&:"(BATCH attributes) 1, ¥ “DummyUnitClass” s fitss T.) J24
AR B TSR

SIMATIC BATCH Fit, V7.1 SP1
548 #A/ETFF, 03/2009, ASE02171120-01



IR (B

9.1 M BF v4.02 |/ SB V6.0

13. 4174 WIinCC JAR4H (1)l AR i
- N TR, WA B3hE)E Tagimport.txt SRS AZSCAR ST &3
WinCC ZZ B (ISR E . 37T BATCH 48X T HE I e it A= P 28w 42
— SRIGIEFETRESE A S Tagimport.txt SCPFRE AN S5 .
— B IERABEE T RS Ol AR i (Archive measured variable) Si%HE. 4R JH ik
PEBHInTh g szt -> oR”(Instances -> Display), <35 H 48 T-i% 388 it B A 52
il .
- 7eik, WLLE RS BLYY WINCC AR A8 . 7E Tagimport.txt SCAFHr] LUE 2|
SIHCIE Ot o
HEATHREA = IRY 0 EC AT, R UGEATIRUE . XA H PR sl S8 (BRIcss
WiIinCC IHP A5 5 .
14, JE BN IGAE LIS AL AE P2 Bl . AT R, 3 R AR A O
1IF”(Validation) %% .

gy
WURIGIE AR S 3B R, BISEs PCS7 i H i, ek Eal [, i A 2i7E
SIMATIC 4 B 2% rp 4l T bt Th e g PRtk A= P2 i B spoe et I L N 3B Hbr R .
W IR S, I SRR, AR5 RIS AT IE .
WHR AR AEBE— D IR %, WIAE R 83 Hbr 2407 )5 7T LU 8) BatchCC, {# 13% #uviy
4“I%T0"(Options) >“k 2 "(Restore) S B 7 £dh, AR 58 H = sy 2“4 8" (Edit) >“58 B
132 #.55”(Update process cell) 557 id f 8 o3k .
PiEA
1571 = PCS 7 BATCH Base - Readme.wri X479 i SIMATIC BATCH 15 &,
ZHd M5 SIMATIC BATCH f£[5— CD-ROM L.

TRANS 524 43 FL 51 3R

At )G, Transimport.txt SCAEFERI AT . 05 —A> BATCH flexible V4.02 Jiifii
(1) TRANS BRSEI513%, %8R AEIX LB AT SIMATIC BATCH 4 1if¥) TRANS 27!
Z IS T 5 KRR
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9.2

9.2.1

M SB V6.x %] SB V7.0 SP1

B R BN R

EHPA (B KERREMER

550

M V6.0 Tt H # A 2] SIMATIC BATCH V7.0 SP1 I, W Zitffif] SB V6.0 5 SP4 [k
TGV . X T Ve i H, #F2EAEH] SB V6.1 L&/ SP1 T4l

I
o

A7 FE N BATCH flexible V4.02 B B:# %] SB V7.0,
11537 ¥4 ] BATCH flexible V4.02 (4 M1 fedeidb 4T TRE %]

¥ SIMATIC BATCH V6.0 Z i ()i A % fE 2] SIMATIC BATCH V7.0 SP1 Hfigifi i
R AR T . ARG OLT, BATEEEAEH V6.1 SP1 BUE A

Z I H RS RAM I . — BT ZHH (MP) AT, 6204 E T
Mokto WA R SR IUH A MP BRI GE HHAE 2 T H A 5 X L85 H
FAEIXLETH H o A RAS I B 2 0 H 5 e RS TPIRAS P AR IX LI .

A 7E BATCH il oot AT H “ & 4" (Backup) Fl1“Pk 2 "(Restore) 4>, 4 fig

£ 1] A SIMATIC BATCH V6.0 83 = iR A F #E 2] SIMATIC BATCH V7.0 SP1. fiH]
A =g oL P2 " (Restore) i 2 PR AR R 30 SO 8 A i, B Zh bR A 2]
SIMATIC BATCH V7.0 SP1,

T E P A 5 A S SB V7.0 SP1. [RlUtk, AR RE T VAR T A7 #1267 4
e

M SIMATIC BATCH V6.0 SP4 # %] SIMATIC BATCH V7.0 SP1 i, ##ii2k7r
ANZ LR R R A s e RS . PRI, AERE SR, B T R T
(PCell 551 K43t H 8h iy 44 15 27
W TEAE R I8 58 i BATCH #iidls, #&47204E BCC H il il “1£ 1" (Options) >“%
" (Migration) >“32 %" (Finalize) & ¥ KIS Ti%5C idAE. “EH LT C (PCell B
1) "(Update process cell (PCell Update)) fir2iafT— K5, HeLeid A4 7= i
SHENEERI . AT LU BCC i k82 h g gk AT IX Be b A= 7= . 7E SR I
T, R EIROEEGRE”, (HHLAE~ TR EXFMEL N, SAUFEIRIFE
W EMRSS . AR MRIGTUAR VI E, W DAgkap ATt A7
WSR2 C IR, WA . Tl CE R R, LA IEAS IERA )
Gy BCAE R TT PR A E

SIMATIC BATCH FJIf, V7.1 SP1
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o ANSCRHAEA R EAEBEAT WA AR TUAR M 55 o L4 3 M SIMATIC BATCH V6.x B
Fr# V7.0 SP1 (Software Update in Run = SUIR, 47 R 4445651 .

o FRHRCAMITHI, i, fTH BATCH V4 JLfsel 9 J& V6.0 SP4 I, VT
LUF A
KBt TAG_COLLECT Bl 2" F2 oc R Zh Ny, BATCH S Js g4 4K ANRE TN
MR R PR R TR
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9.2.2 PATHHE

i

WA DL AR BRI o A A, K SIMATIC BATCH V6.0 28 il
A3 SIMATIC BATCH V7.0 SP1 i3 DL M e 38 .

H B
1. B HIFER T s A
#£ BCC (SIMATIC BATCH V6.x) HHl/E 443 3ot
Bt SIMATIC BATCH V6.x 75 A IH AL
S UL S R B A i A7 \sbdata™ Sk P S

> e

L
O S et n] DU e AR A

5. ffi/il“net share BATCH /D" ir &M% 45 i) BATCH JiA

6. fii B B"(Update) ez 2225 SIMATIC BATCH V7.0 SP1 {223 i i i A 3545
PIFAL o

7. A FREE R, S BRSO EE P SO AR AR . ik, G
—ANEH SO

8. HXMHM PCS7 IiH (ASMLARGHEAE LU MEL, 1ESH“FFR"(Start) >

SIMATIC >“3C#4”(Documentation) >“i& 5 £ #¥"(Language selection) 13 +4“PCS 7
- A FHAASMS R B e i R A BE B o

9. {E LHNMEL ) SIMATIC B ERZS, $TF BATCH ZAXHEHE 1847
Ji”(Generate). “f&1%"(Propagate). “f£i%7H 5"(Transfer messages) f1“
#.”(Download) T fig

10. J33h SIMATIC BATCH V7.0 SP1.
11. 7F BATCH =ity 2479 55"(Options) 3 H. [k 52" (Restore) I fiE

12. 76 BATCH i w0 F “ S Bk #2 51 70" (Update process cell) | R 3¢y & 5 gt Ak =
I FERIG,

SIMATIC BATCH FJIf, V7.1 SP1
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9.3 M SB V6.1 SP3 #| V7.1 SP1

9.3.1 FEA J
REFEHZBIERSEI

ZHEH I “SIMATIC BATCH PCS 7 V7.1 SPU#AF 21T, 74 LL T 300 H $odfs -
e 1 SIMATIC & Hi&sh, HEHEA PCS 7 HiH.

e 7E BATCH #&iHiLmy, VAR Cog ittt .

o QLA B A SO

MR
PSR SR A QMU BRI RGP
.

SRR A RO A SR RO A

o ASZFFM BATCH flexible V4.02 E#:#% %] SIMATIC BATCH V7.1 SP1.

o [t, H il A4 SIMATIC BATCH V6.1 SP3 [ PCS 7 [k A# %] PCS 7
V7.1,

e Jit BATCH flexible V4.02 " IH ¥ 1 H: AF6. AF12. AF24. AF16S #il TRANS %§
WATZaAs, M V7.0 TFHGAA TSR EAT. SIMATIC BATCH TR ARG i TiX
—UARRENE . IHRFE AL FE 284 v DG R .

o ASFF SIMATIC BATCH V5.3 [RA HEhtiL. IXFE, B2 T M 1) S RF Ry
PRI T
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B RHEAE I H B
A IRAE SIMATIC & PGS b R A AL AR THE R, 4 B SR A DA H 150 H Bt

e Ausrustungseigenschaften /£ @ PE:  BERERT, Ao WS o ik & g it &
BRI A RAEH T, E, A =g #2558 (Configure batch process cell) %f
THAE PR P B 2R AR BRI AN R gt . AR R T, K s I PR A R
IR FRATBCAH R (9 44 FK

® HiIX) IPAR_ENUM Bt
o L E

ZWAKE . BEFEH SIMATIC BATCH %t

xS BATCH £l i A g " AN R D e, ATV A ™ S0k, il e Moy
A W P T D i

HORTE I R Je v 45 A A& L 7E SIMATIC BATCH V6.1 SP3 R it 1 44 S0

7t SIMATIC BATCH V7.1 SP1 1, R A #fifr SIMATIC BATCH V6.1 SP3 H 1) #5141 3
5% 35 3 3hH ik 55 3] SIMATIC BATCH V7.1 SP1 1,

BAFSH: SIMATIC BATCH 5 H %8
Al S L, wisk @ SIMATIC BATCH V6.1 SP3 (KL 7 AR HZESE .

EXER

FH (PCS 7 - M H/AMEH B oh e SW B8 (PCS 7 - SW update with / without the
use of new functions)
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IR (B

9.3.2

fai g

SR

9.3 M SB V6.1 SP3 £/ V7.1 SP1

PATBAE

U B S DB FEAR SR A B A, SIMATIC BATCH V6.1 SP3 {5 i il A
4t %) SIMATIC BATCH V7.1 SP1 I3 L Nk 2E

R

- R IR P AT R AR

# BCC (SIMATIC BATCH V6.1 SP3) HhilfE &4y S0
iE 1 SIMATIC BATCH V6.1 SP3 JF 5 A IHKIH2AL
SRS FRUBM 1) B 8 A b i 7. \sbdata” 4t 22 SCA K

VL
A S et T DU E AL R A

1§ F“net share BATCH /D" iy 2 MBS 2477 1) BATCH i A

i F“ 538 (Update) 232580 2235 SIMATIC BATCH V7.1 SP1 {223 i i% i A 3545
PIHZAL

GRS FREE AN, SR P ST ASH B SO RROAR 2 FR . Ak, TE B
— NGB S

HHRBA PCS7 Ui H (HZMLRGAERE RS KIEE, S HTFIE"(Start) >
SIMATIC >“3C#4”(Documentation) >“i& & % #¥"(Language selection) T [ 3C#4“PCS 7
- A3 R AN FB T RE I A 5T

{ETRENTEL ) SIMATIC & B gs, §T7F BATCH IR HE i qT %
Ji”(Generate). “f&#%"(Propagate). “fki%H 5"(Transfer messages) f1“
#”(Download) LjfE

10. J23) SIMATIC BATCH V7.1 SP1.
11. 76 BATCH #= |0y, 12471 11"(Options) 2 #1747 1 “Vk & " (Restore) e .
12. 7E BATCH il 0o F “ B8 3 ik #2 52 78"(Update process cell) | R 3Cn & BOgtt A ™~

R,
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9.4 M SB V7.0 SP1 %] SB V7.1 SP1

faifr
M SIMATIC BATCH V7.0 SP1 ###i %] SIMATIC BATCH V7.1 SP1 I T4 AT LA T 5%,

P&

1. £ SIMATIC EHEh B H ES WH . HEMRMELE, ESHIKPCS 7 - /AL
FUHr h RE IR AT BB o

2. 7& BATCH AASXiHHE S BATCH #idli . A B8k AL BRI F 2
3. fEfLA O A BATCH Bl & 30t D BRAZ Lo

4. SERHE AL . B BATCH 20 Hl. 83 Sh PR > A PG s A IR
H”(Exit) fir 1B i BATCH Jlk%5#% (BCC il RZE) .

5. &R PC _ERIFTARUR. A3 (Update) 223K Ks fir 47 BATCH PC
HR IR BB 2] SIMATIC BATCH V7.1 SP1.

s BATCH %fls M 33| CTH 20 PC 